Version 10
To ensure that you are using the documentation that corresponds to the software you are licensed to use, compare this version number with the software version shown in “About MicroStrategy...” in the Help menu of your software.

Document number: 09501000
Copyright © 2015 by MicroStrategy Incorporated. All rights reserved.

If you have not executed a written or electronic agreement with MicroStrategy or any authorized MicroStrategy distributor (any such agreement, a "Separate Agreement"), the following terms apply:

This software and documentation are the proprietary and confidential information of MicroStrategy Incorporated and may not be provided to any other person. Copyright © 2001-2015 by MicroStrategy Incorporated. All rights reserved.

THIS SOFTWARE AND DOCUMENTATION ARE PROVIDED "AS IS" AND WITHOUT EXPRESS OR LIMITED WARRANTY OF ANY KIND BY EITHER MICROSTRATEGY INCORPORATED OR ANYONE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE OR DOCUMENTATION, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, GOOD TITLE AND NONINFRINGEMENT, QUALITY OR ACCURACY. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE AND DOCUMENTATION IS WITH YOU. SHOULD THE SOFTWARE OR DOCUMENTATION PROVE DEFECTIVE YOU (AND NOT MICROSTRATEGY, INC. OR ANYONE ELSE WHO HAS BEEN INVOLVED WITH THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE OR DOCUMENTATION) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION. SOME STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.

In no event will MicroStrategy, Incorporated, or any other person involved with the creation, production, or distribution of the Software be liable to you on account of any claim for damage, including any lost profits, lost savings, or other special, incidental, consequential, or exemplary damages, including but not limited to any damages assessed against or paid by you to any third party, arising from the use, inability to use, quality, or performance of such Software and Documentation, even if MicroStrategy, Inc. or any such other person or entity has been advised of the possibility of such damages, or for the claim by any other party. In addition, MicroStrategy, Inc. or any other person involved in the creation, production, or distribution of the Software shall not be liable for any claim by you or any other party for damages arising from the use, inability to use, quality, or performance of such Software and Documentation, based upon principles of contract law, negligence, strict liability or otherwise. The entire liability of MicroStrategy, Inc. and your exclusive remedy, shall not exceed, at the option of MicroStrategy, Inc. beyond that specified in the above limitation of liability. Some states do not allow the limitation or exclusion of liability for incidental or consequential damages, so the above limitation may not apply to you.

The information contained in this manual (the Documentation) and the Software are copyrighted and all rights are reserved by MicroStrategy, Inc. MicroStrategy, Inc. reserves the right to make periodic modifications to the Software or the Documentation without obligation to notify any person or entity of such revision. Copying, duplicating, selling, or otherwise distributing any part of the Software or Documentation without prior written permission of an authorized representative of MicroStrategy, Inc. are prohibited. U. S. Government Restricted Rights. It is acknowledged that the Software and Documentation were developed at private expense, that no part is public domain, and that the Software and Documentation are Commercial Computer Software provided with RESTRICTED RIGHTS under Federal Acquisition Regulations and supplements to them. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFAR 252.227-7013 et. seq. or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at FAR 52.227-19, as applicable.

Contractor is MicroStrategy, Inc., 1850 Towers Crescent Plaza, Tysons Corner, VA 22182. Rights are reserved under copyright laws of the United States with respect to unpublished portions of the Software.

The following terms and notices apply regardless of whether you have executed a Separate Agreement:

Trademark Information


Patent Information

This product is patented. One or more of the following patents may apply to the product sold herein: U.S. Patent Nos. 5,321,520, 5,416,602, 5,748,560, 6,154,766, 6,173,310, 6,260,050, 6,263,051, 6,269,593, 6,279,033, 6,501,832, 6,567,796, 6,587,547, 6,606,596, 6,859,093, 6,658,432, 6,662,195, 6,671,715, 6,691,100, 6,694,316, 6,697,808, 6,704,723, 6,707,889, 6,741,980, 6,765,997, 6,788,788, 6,772,137, 6,785,768, 6,792,086, 6,798,867, 6,801,910, 6,820,073, 6,829,334, 6,836,537, 6,850,603, 6,859,798, 6,873,693, 6,885,297, 6,898,929, 6,899,495, 6,908,583, 7,022,719, 7,056,677, 7,113,196, 7,113,993, 7,122,679, 7,127,403, 7,127,404, 7,134,397, 7,146,544, 7,152,786, 7,166,598, 7,169,665, 7,194,457, 7,197,461, 7,228,303, 7,260,577, 7,266,161, 7,272,212, 7,302,639, 7,324,942, 7,330,847, 7,336,840, 7,415,438, 7,415,439, 7,440,882, 7,457,397, 7,481,978, 7,487,705, 7,516,191, 7,559,048, 7,574,376, 7,576,201, 7,725,811, 7,801,967, 7,836,176, 7,836,176, 7,861,161, 7,861,253, 7,861,443, 7,925,615, 7,945,584, 7,970,782, 8,005,870, 8,035,362, 8,051,168, 8,051,369, 8,094,788, 8,130,918, 8,296,287, 8,321,411, 8,452,755, 8,521,733, 8,522,192, 8,577,902, 8,606,813, 8,687,138, 8,645,313, 8,761,659, 8,775,807, 8,782,083, 8,812,490, 8,832,588, 8,943,044, 8,943,187. Other patent applications are pending.

Third Party Software
Various MicroStrategy products contain the copyrighted technology or software of third parties ("Third Party Software"). A list of Third Party Software, as well as links to any terms and conditions associated with such Third Party Software ("Third Party Terms"), can be found at www.microstrategy.com/third-party-notices. Your use of MicroStrategy products is subject to all applicable Third Party Terms.
## CONTENTS

**Book Overview and Additional Resources**

<table>
<thead>
<tr>
<th>Description of this guide</th>
<th>xix</th>
</tr>
</thead>
<tbody>
<tr>
<td>About this book</td>
<td>xxi</td>
</tr>
<tr>
<td>How to find business scenarios and examples</td>
<td>xxii</td>
</tr>
<tr>
<td>What’s new in this guide</td>
<td>xxii</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>xxv</td>
</tr>
<tr>
<td>Who should use this guide</td>
<td>xxvi</td>
</tr>
<tr>
<td>Resources</td>
<td>xxvii</td>
</tr>
<tr>
<td>Documentation</td>
<td>xxvii</td>
</tr>
<tr>
<td>Education</td>
<td>xxxvi</td>
</tr>
<tr>
<td>Consulting</td>
<td>xxxvi</td>
</tr>
<tr>
<td>Technical Support</td>
<td>xxxvii</td>
</tr>
<tr>
<td>Feedback</td>
<td>xxxvii</td>
</tr>
</tbody>
</table>

**1. Document Review**

<table>
<thead>
<tr>
<th>Introduction</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before you begin: Document analysis overview</td>
<td>3</td>
</tr>
<tr>
<td>Display modes in MicroStrategy Web</td>
<td>3</td>
</tr>
<tr>
<td>Exporting a document</td>
<td>4</td>
</tr>
<tr>
<td>Printing a document</td>
<td>8</td>
</tr>
<tr>
<td>Document views in Developer</td>
<td>9</td>
</tr>
<tr>
<td>Designing and creating documents: An overview</td>
<td>10</td>
</tr>
<tr>
<td>Accessing data in a document: The dataset</td>
<td>11</td>
</tr>
<tr>
<td>Creating documents</td>
<td>13</td>
</tr>
<tr>
<td>Objects in a document: Controls</td>
<td>13</td>
</tr>
<tr>
<td>About Visual Insight dashboards</td>
<td>22</td>
</tr>
</tbody>
</table>
2. Designing Dynamic Enterprise Dashboard-style Documents

   Introduction ........................................................................................................ 25
   About dashboard-style documents ................................................................. 26
   What is a dashboard-style document? .............................................................. 26
   Adding interactivity to dashboard-style documents ....................................... 28
   Organizing interactivity features on a dashboard-style document .................. 34
   Design ideas and examples ............................................................................ 38
   Designing a simulated portal environment .................................................... 40
   Designing the right dashboard-style document ............................................ 41
   Best practices for dashboarding ..................................................................... 43
   Choosing datasets for a dashboard-style document .................................... 44
   Layering information in a dashboard-style document ................................... 46
   Planning the dashboard-style document’s outline and structure................... 47
   Placing the data and visualizations onto a dashboard-style document .......... 49
   Positioning and formatting the dashboard-style document objects .............. 50
   Enhancing dashboard-style document performance .................................... 51
   Best practices: Designing Flash dashboard-style documents for printing ....... 52

   Creating a dashboard-style document: the Blank Dashboard template ............ 53
   Designing a dashboard-style document with the Blank Document template ... 58
   Creating document templates ....................................................................... 58

   Exporting dashboard-style documents to Flash for stand-alone use ................ 60

   Formatting dashboard-style documents .......................................................... 61
   Determining the display modes users can choose to work in ....................... 61
   Enabling transition animations in Flash ...................................................... 61
   Uncluttering the dashboard-style document: Full Screen mode .................... 63

3. Layering Data: Panels and Panel Stacks

   Introduction ....................................................................................................... 67
   About panels and panel stacks ....................................................................... 68
   Defining the parts of a panel stack .................................................................. 72
   Panel stacks and automatic target maintenance for selectors ....................... 74
## Inserting and defining panels
- Inserting a panel stack: 76
- Displaying the title bar of a panel stack: 77
- Inserting additional panels in a panel stack: 82
- Changing the display order of panels: 85
- Choosing the panel to display initially: the current panel: 86
- Deleting a panel from a panel stack: 87

## Loading panels on demand
- Loading panels on demand: 87

## Defining Information Windows
- Defining Information Windows: 90

## Filtering a dashboard-style document: Filter panels
- Filtering a dashboard-style document: Filter panels: 96
  - Controlling how data updates in a filter panel: Automatic apply: 100

## Formatting panels and panel stacks
- Formatting panels and panel stacks: 102
  - Methods to format panels and panel stacks: 104
  - Useful formatting suggestions: 105
  - Formatting panel stack borders: 106
  - Formatting the title bar of a panel stack: 109
  - Formatting the background of a panel: 110
  - Formatting a panel stack for export: 112

### 4. Providing Interactivity to Users: Selectors

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>117</td>
</tr>
<tr>
<td>About selectors</td>
<td>117</td>
</tr>
<tr>
<td>Defining a selector</td>
<td>124</td>
</tr>
<tr>
<td>Methods to create a selector</td>
<td>129</td>
</tr>
<tr>
<td>Selecting targets interactively (target selection mode)</td>
<td>132</td>
</tr>
<tr>
<td>Next steps after creating a selector</td>
<td>133</td>
</tr>
<tr>
<td>Creating a selector to change panels on a panel stack</td>
<td>134</td>
</tr>
<tr>
<td>Creating a selector for elements on a Grid/Graph</td>
<td>135</td>
</tr>
<tr>
<td>Creating a selector that filters metric values</td>
<td>137</td>
</tr>
<tr>
<td>Creating a selector to choose the metric to display in a Grid/Graph</td>
<td>143</td>
</tr>
<tr>
<td>Creating a selector that updates a dynamic text field on a panel stack</td>
<td>146</td>
</tr>
<tr>
<td>Creating a selector to filter dataset results</td>
<td>148</td>
</tr>
<tr>
<td>Creating a selector that targets other selectors</td>
<td>150</td>
</tr>
<tr>
<td>Creating a selector to filter List controls in a Transaction Services-enabled document</td>
<td>156</td>
</tr>
</tbody>
</table>
Applying selections as filters or slices ........................................... 158
  Selectors in a dashboard-style document with multiple datasets ................................................................. 161
  Selectors in a dashboard-style document that is viewed off-line ........................................................................... 163
  Defining selectors to filter or slice targets ...................................................................................................................... 164
Determining whether the selector includes or excludes data: selection type ........................................................................ 166
Automatically maintaining targets for selectors .......................... 169
  Controlling targets when targets are automatically maintained .............................................................................. 174
  Disabling automatic target maintenance to allow manual target selection .................................................................... 177
  Enabling automatic target maintenance ..................................................................................................................... 179
Allowing users to select multiple items .......................................... 181
Controlling how data updates: Automatically apply selector changes .................................................................................. 182
Disabling simultaneous display of all items in a selector .............. 183
  Renaming the All option of a selector ..................................................................................................................... 184
Determining how the target of a selector displays when no data exists ................................................................................ 185
Determining how the target of a selector displays (current state) .................................................................................... 189
  Current State setting with a slicing selector .................................................................................................................... 190
  Current State setting with a filtering selector .................................................................................................................. 191
  Current State settings and multiple targets .................................................................................................................. 193
  Defining the Current State of a selector ...................................................................................................................... 195
Showing totals for selectors .......................................................... 197
  Conditional formatting on selector totals ..................................................................................................................... 198
  Showing totals in a selector ............................................................................................................................................. 199
Displaying and sorting forms in selectors ....................................... 200
Displaying title bars in selectors ................................................ 202
Formatting selectors .................................................................. 205
  Formatting the selector body vs. title bar ...................................................................................................................... 205
  Methods to format a selector ...................................................................................................................................... 206
  Useful formatting suggestions for selectors .................................................................................................................. 207
  Specifying proportional or fixed width for selector items .............................................................................................. 208
  Formatting the text of a selector’s items .......................................................................................................................... 210
  Formatting the background of a selector ...................................................................................................................... 211
  Defining the background color for selected items in Flash Mode .................................................................................. 213
Formatting the title bar of a selector ........................................ 215
Selector display in Flash Mode ........................................... 216
Selector display when exported to PDF ............................. 217

Using Grid/Graphs as selectors to control other Grid/Graphs ... 219
Cascading selectors ............................................................ 221
Widgets used as selectors ................................................... 222
Enabling a Grid/Graph as a selector .................................... 223
Formatting the background of selected items in Grid/Graphs used as selectors ............................................ 224

Enabling Grid/Graphs as selectors to update dataset results.... 226
Enabling Grid/Graphs as selectors in a Transaction Services-enabled document ...................................................... 229

Creating a selector that updates the view filter in a grid or graph ........................................................................ 230

Updating the image on a panel using a selector ................. 232

Introduction .............................................................................. 235
Choosing the right widget .................................................. 236

Creating widgets ........................................................................ 243
Prerequisites for creating widgets ........................................ 243
Creating a Bubble Grid widget ............................................ 244
Creating a Cylinder widget ................................................... 247
Creating a Data Cloud widget .............................................. 249
Creating a Date Selection widget ......................................... 251
Creating a Fish Eye Selector ............................................... 260
Creating a Funnel widget ..................................................... 274
Creating a Gauge widget ..................................................... 276
Creating a Graph Matrix (deprecated) widget .................... 278
Creating a Graph Matrix widget ........................................... 281
Creating a Heat Map widget ................................................ 283
Creating an Image Layout widget ........................................ 287
Creating an Interactive Bubble Graph widget .................... 295
Creating an Interactive Stacked Graph widget .................... 301
Creating a Map widget ......................................................... 303
Creating a Media widget ...................................................... 314
Creating a Microcharts widget ............................................. 320
Creating a Network widget ................................................ 332
Creating an RSS Reader widget ............................................. 335
Creating a Survey widget .................................................... 339
Creating a Thermometer widget .......................................... 358
Creating a Time Series Slider widget ................................. 360
Creating a Waterfall widget.................................................. 363
Creating a Weighted List Viewer widget.............................. 366
Defining how a widget is displayed in different views and modes........................................................................ 369
Defining which display modes are available to users .......... 375
Displaying a message in place of a widget......................... 375
Converting an existing Grid/Graph into a widget ....................... 377
Linking in widgets ...................................................................... 379
Specifying how prompts are answered in the target............ 381
Creating links in widgets ...................................................... 382

6. Formatting Widgets

Introduction.............................................................................. 385
Inherited formatting.................................................................... 385
Formatting a widget ................................................................... 386
Formatting options by widget type............................................. 387
  Formatting a Bubble Grid widget ......................................... 387
  Formatting a Cylinder widget ............................................... 389
  Formatting a Data Cloud widget .......................................... 390
  Formatting a Date Selection widget..................................... 392
  Formatting a Date Selection widget for a mobile device..... 394
  Formatting a Fish Eye Selector............................................ 394
  Formatting a Funnel widget ................................................. 398
  Formatting a Gauge widget ............................................... 400
  Formatting a Graph Matrix (deprecated) widget ............... 402
  Formatting a Heat Map widget......................................... 404
  Formatting an Image Layout widget................................. 407
  Formatting an Interactive Bubble Graph widget.................. 408
  Formatting an Interactive Stacked Graph widget................. 412
  Formatting a Media widget.............................................. 414
  Formatting a Microcharts widget....................................... 416
  Formatting an RSS Reader widget ..................................... 428
  Formatting an RSS Reader widget for a mobile device...... 432
  Formatting a Thermometer widget................................... 432
  Formatting a Time Series Slider widget................. 433
  Formatting a Waterfall widget.......................................... 435
  Formatting a Weighted List Viewer widget....................... 439
7. Viewing Data Related to Widgets: Using Widgets as Selectors

Introduction .................................................................................. 441
Using widgets as selectors .......................................................... 442
  Using a Bubble Grid widget as a selector ............................... 443
  Using a Data Cloud widget as a selector ............................... 443
  Using a Graph Matrix (deprecated) widget as a selector ....... 443
  Using a Heat Map widget as a selector ................................. 445
  Using an Image Layout widget as a selector ......................... 446
  Using an Interactive Bubble Graph widget as a selector ...... 446
  Using an Interactive Stacked Graph widget as a selector .... 449
  Using a Map widget as a selector ....................................... 451
  Using a Microcharts widget as a selector ............................. 451
  Using a Network widget as a selector ................................ 452
  Using a Time Series Slider widget as a selector .................. 453
  Using a Waterfall widget as a selector ............................... 456
  Using a Weighted List Viewer widget as a selector ............. 456
Creating the widget used as a selector ..................................... 457
  Enabling widgets to be used as selectors ............................. 457
  Ensuring targets are updated with hovering rather than clicking ........................................................................ 461

A. Dashboard-style Document Tutorial

Introduction .................................................................................. 463
The completed dashboard-style document ............................ 464
  Panel 1: Daily Order Count ................................................ 464
  Panel 2: Inventory Analysis ............................................. 465
  Panel 3: Employee Performance ................................. 467
High-level steps ......................................................................... 468
Creating the Daily Order Count panel ................................. 470
  Creating the Daily Order Count report to be used as a dataset .................................................................... 470
  Creating the new dashboard-style document and selecting the dataset ...................................................... 470
  Adding a panel stack and panels to the dashboard-style document .............................................................. 471
  Adding a selector to the dashboard-style document .............. 474
  Creating a Time Series Slider widget .................................. 474
  Adding a Gauge widget ....................................................... 476
  Creating a selector for the Gauge widget ........................... 478
  Specifying Flash Mode as the default display mode ............. 479
  Saving the dashboard-style document ............................... 480
  Viewing the Daily Order Count panel in Flash Mode in MicroStrategy Web ............................................. 480
Creating the Inventory Analysis panel .............................................. 483
Creating the Inventory Analysis report to be used as a dataset ......................................................................................... 483
Adding a dataset to the dashboard-style document .................. 484
Switching panels in Design View .................................................. 485
Renaming and formatting a panel .................................................. 485
Creating a Heat Map widget ......................................................... 486
Creating a selector for the Heat Map widget ............................... 489
Saving the dashboard-style document .......................................... 490
Viewing the Inventory Analysis panel in Flash Mode in MicroStrategy Web ............................................................. 490
Creating the Employee Performance panel ............................... 494
Creating a custom group .............................................................. 494
Creating the Employee Performance report to be used as a dataset .................................................................................. 497
Adding a dataset to the dashboard-style document .................. 498
Switching panels in Design View .................................................. 498
Renaming and formatting a panel .................................................. 499
Creating a Bubble Graph widget ................................................. 500
Saving the dashboard-style document .......................................... 501
Viewing the Employee Performance panel in Flash Mode in MicroStrategy Web ............................................................. 502
Enabling drilling and time series animation ............................. 502

B. Troubleshooting Dashboard-style Documents

Introduction .................................................................................. 507
Troubleshooting selectors .............................................................. 507
Troubleshooting during document execution ............................. 509
Troubleshooting common Flash Mode issues ............................ 509

Glossary ...................................................................................... 515

Index .......................................................................................... 523
Description of this guide

This guide is the primary resource for you to use to learn about designing and creating MicroStrategy dashboards, which are displays that are optimized for online viewing and user interactivity. This guide includes information about:

• Visual Insight dashboards: Simple visualizations and pre-defined, presentation-quality formatting allow you to quickly display your data in a visually-striking, interactive dashboard. You can create business attributes and metrics on-the-fly based on calculations on data that you have added to the dashboard, examine the underlying data for selected items in a visualization, and more. You can easily create filters for your data, add text, images, and web page content, select from pre-defined display themes, and organize your data to make it easy for users to analyze relationships at-a-glance.

• Dashboard-style documents: A broad selection of widgets and a wide variety of formatting options allow you to design a customized, interactive display of your data. Dashboard-style documents provide the freedom to design a presentation pixel-by-pixel, in multiple editing and previewing modes. The abundant design options deliver full control over position, formatting, and interactivity. This guide builds on the basic

Chapters in this guide include:

- **Chapter 1, Document Review** provides a brief overview of document analysis to help you understand how end users will use documents, document creation, and the objects, such as text fields and images, that you can add to documents. Use this chapter as a refresher for basic document terminology and processes.

  If you are new to creating documents, it is recommended that you begin with the *Report Services Document Creation Guide* for a basic understanding of documents before you create dashboard-style documents.

- **Chapter 2, Designing Dynamic Enterprise Dashboard-style Documents** introduces dashboard-style documents, which are a type of document that summarizes key business indicators by presenting them in visually intuitive, easy-to-read, interactive display of data. A broad selection of widgets and a wide variety of formatting options allow you to design a customized, interactive dashboard. Dashboard-style documents provide the freedom to design a dashboard pixel-by-pixel in multiple editing and previewing modes. The abundant design options deliver full control over position, formatting, and interactivity. This chapter includes instructions to create dashboard-style documents.

- **Chapter 3, Layering Data: Panels and Panel Stacks** describes how you can create several different views (panels) of data, with each view (panel) containing a logical grouping of controls that display data that is related in a meaningful way.

- **Chapter 4, Providing Interactivity to Users: Selectors** describes how selectors can allow users to change the data that they are viewing. A selector can be displayed as a button bar, a drop-down list, radio buttons, and so on. A selector can change panels or the focus of a Grid/Graph.

- **Chapter 5, Providing Flash Analysis and Interactivity: Widgets** describes widgets, which are a key part of dashboard-style documents. Widgets are Flash-based displays of report results, allowing users to visualize data in different ways than traditional reports displayed as Grid/Graphs do.

- **Chapter 6, Formatting Widgets** describes how you can format aspects of widgets such as colors, graph axes scaling, fonts, data markers, and more.
• **Chapter 7, Viewing Data Related to Widgets: Using Widgets as Selectors** describes widgets that can be designated as selectors, along with how users interact with them when they are designated as a selector.

• **Appendix A, Dashboard-style Document Tutorial** walks you through creating a dashboard-style document that incorporates widgets in a panel stack, using data from the MicroStrategy Tutorial.

• **Appendix B, Troubleshooting Dashboard-style Documents** provides explanations of some of the most common issues you may encounter when creating dashboard-style documents, in a question and answer format.

### About this book

This book is divided into chapters that begin with a brief overview of the chapter’s content.

The following sections provide the location of several examples, list prerequisites for using this book, and describe the user roles the information in this book was designed for.

The primary focus of this guide is dashboard-style documents. A special type of document, dashboard-style documents provide interactive features that let users change how they view the dashboard-style document’s data. Dashboard-style documents can contain a broad selection of widgets and a wide variety of formatting. Visual Insight dashboards are quick to create, and allow you to take advantage of Visual Insight's visualizations and pre-defined formatting options to quickly create a dashboard. For information on dashboards, see the Report Services Document Creation Guide or the MicroStrategy Web Help.

The sample documents and images in this guide, as well as some example steps, were created with dates that may no longer be available in the MicroStrategy Tutorial project. If you are re-creating an example, replace the year(s) shown in this guide with the most recent year(s) available in the software.
How to find business scenarios and examples

Within this guide, many of the concepts discussed are accompanied by business scenarios or other descriptive examples. For examples of basic documents and dashboard-style documents, see the *Document and Dashboard Analysis Guide*.

For examples of reporting functionality, see the MicroStrategy Tutorial, which is MicroStrategy’s sample warehouse and project. Information about the MicroStrategy Tutorial can be found in the *Basic Reporting Guide*. Detailed examples of advanced reporting functionality can be found in the *Advanced Reporting Guide*.

What’s new in this guide

**MicroStrategy 10**

- The Current State of a selector determines how the selector’s target displays. For example, a selector can display the first two items in the selector, or all of the items. You can specify the Current State for a document based on a report or an Intelligent Cube. For examples and steps to specify the Current State, see *Determining how the target of a selector displays (current state)*, page 189.

- You can create a selector that filters dataset results, allowing users to filter and view subsets of large amounts of data instead of loading and displaying all the data in a document at once. For an example and steps to create a selector that filters dataset results, see *Creating a selector to filter dataset results*, page 148.

- You can enable a Grid/Graph as a selector to filter the items displayed in a List control in a Transaction Services-enabled document. A user select an attribute element to filter the choices available in the List control. For steps, see *Enabling Grid/Graphs as selectors in a Transaction Services-enabled document*, page 229.

- You can determine whether and how selectors targeted by a selector are updated when the source selector is updated (when items are selected or cleared). The new Update target filters when current selection changes setting determines which items are selected or cleared in the target selector, and affects what items are displayed in the target selector's target. No matter which option is chosen, any changes made in this selector determine which items are displayed in the target selector. For a
more detailed description, including examples, see *Determining whether and how selections in the target selector are updated, page 151.*

**MicroStrategy 9.4.1 iOS Update 5**

- In the survey widget for iOS devices, you can show or hide follow-up questions based on your respondents’ answers. For steps, see *Showing or hiding follow-up questions in your survey, page 349.*

- In the survey widget for iOS devices, you can check the text in your respondents’ answers to ensure that they meet certain criteria, such as ensuring that phone numbers follow a specific format. For steps, see *Verifying the format of the survey’s answers, page 350.*

**Analytics Enterprise**

- The name of MicroStrategy Desktop has been changed to MicroStrategy Developer.

- An out-of-the-box Map widget is now available for dashboard-style documents. For steps to create and add a Map widget to a dashboard-style document, see *Creating a Map widget, page 303.* For steps to design dashboards using a Map widget integrated with Google Maps, which supports multiple layers of map markers, a density map, and affinity lines, see the *GIS Integration Help.*

**MicroStrategy 9.4**

- You can import data from different data sources directly into a dashboard-style document. The data source can include an Excel file, a table in a database, the results of a Freeform SQL query, or a Salesforce.com report. Your imported data is saved and can be used immediately in the document. For background information on using imported data as a dataset, see *Accessing data in a document: The dataset, page 11.*

- If a dashboard-style document contains multiple datasets, a slicing selector shows only the items available in the target. A filtering selector shows all the items available in all the datasets. For a more detailed explanation, including examples, see *Selectors in a dashboard-style document with multiple datasets, page 161.*

- You can add objects from multiple datasets to a widget, if you have the correct privileges and the project has been set up to allow Grid/Graphs to
use multiple datasets. For background information on widgets in general, see *Chapter 5, Providing Flash Analysis and Interactivity: Widgets*.

- You can have the rectangles in a Heat Map widget colored based on the elements of an attribute. For steps, see *Formatting a Heat Map widget, page 404*.

**MicroStrategy 9.3.1**

- Information Windows let users view additional information about an object by clicking it in Express Mode or Flash Mode in MicroStrategy Web. An Information Window can be accessed from:
  - An attribute on a Grid/Graph, displayed as either a grid or a graph
  - A button
  - An image
  - An item in a selector
  - A text field

For information on creating Information Windows, see *Defining Information Windows, page 90*.

- You can change the color used to highlight items selected in a Microcharts widget. For more information, see *Formatting a Microcharts widget, page 416*.

- You can select a display theme to use to display a Microcharts widget on a mobile device. For more information, see *Formatting a Microcharts widget, page 416*.

- You can display a Microcharts widget in Tree mode in MicroStrategy Web, or on a mobile device with MicroStrategy Mobile. For steps, see *To enable Tree mode, page 329*.

- The Survey widget allows you to create a survey in a database or on a third-party survey creation website, then display your survey in a Transaction Services-enabled document. Users can view the document to interact with the survey and submit their answers, which are then stored in your data source. For steps to create and add a Survey widget to a document, see *Creating a Survey widget, page 339*.
MicroStrategy 9.3

This manual is new for MicroStrategy 9.3, containing information related to dashboard-style documents and widgets that was previously contained in the Report Services Document Creation Guide. New features for dashboard-style documents and widgets in 9.3 include:

- The Search Box selector in a document allows a user to search for an element. Unlike other selectors, a list of elements is not initially displayed. As a user types text, matches are displayed to choose from, instead of having to pick from all available elements. This is particularly convenient if the element list is long. For an example of a Search Box selector, see Defining a selector, page 124. For steps to create selectors, see Methods to create a selector, page 129.

- When a user exports a selector to a PDF file, the selector can be exported as shown on the screen or exported with only the selected items displayed. For steps to specify the export method, see Selector display when exported to PDF, page 217.

- When you create a selector, you can determine which forms are displayed when users see the selector, as well as the order that the forms are displayed in and how their elements are sorted. For steps to specify the display of forms in selectors, see Displaying and sorting forms in selectors, page 200.

- The following widgets are available:
  - The Network widget can be displayed in Web or on an iPad with MicroStrategy Mobile. (See Creating a Network widget, page 332.)
  - The Image Layout widget can be displayed in Web. (See Creating an Image Layout widget, page 287.)
  - The Microcharts widget can be displayed on an Android device with MicroStrategy Mobile. (See Creating a Microcharts widget, page 320.)

Prerequisites

Before working with this manual, you should be familiar with the information in the Document and Dashboard Analysis Guide and the Report Services Document Creation Guide.
To work with Report Services documents, you must have purchased a license for Report Services and installed it on your machine. You must also have the proper privileges assigned to your user login. These privileges are described below:

- **Execute document**, to execute documents in MicroStrategy Developer
  
  To execute a document in Developer, you must connect to the project in three-tier (server) mode.

- **Use document editor**, to create and edit documents using the Document Editor in Developer

- **Web execute document**, to browse and execute documents in MicroStrategy Web

- **Web document design**, to create and edit documents in Web

- **Web manage document datasets**, to add and remove datasets from a document in Web

- **Execute Report that Uses Multiple Data Sources**, to view Grid/Graphs that use objects from multiple datasets

- **Import Table from Multiple Data Sources**, to create Grid/Graphs that use objects from multiple datasets

  If you do not have Report Services, contact your MicroStrategy sales representative for more information.

---

**Who should use this guide**

This guide is designed for all users who need to design and create dashboard-style documents, a type of interactive document.

Document design is the process of building documents that are used widely by other users on the business intelligence platform and throughout the enterprise. To design documents you use the Document Editor in either MicroStrategy Developer or Web, where it is referred to as Design Mode. The Document Editor also allows you to create document objects (called controls) such as text fields, auto text codes, Grid/Graphs, HTML containers, images, and so on. You can also create a special type of document called dashboard-style documents, which are visually intuitive displays of data that summarize key business indicators for a status check. Dashboard-style documents provide interactive features that let users change how they view the dashboard-style document’s data. The interaction is provided by these
types of controls: panels, selectors, and widgets. A broad selection of widgets and a wide variety of formatting options allow you to design a customized, interactive dashboard. Dashboard-style documents provide the freedom to design a dashboard pixel-by-pixel in multiple editing and previewing modes. The abundant design options deliver full control over position, formatting, and interactivity.

In general, the role of document designer is made available only to a group of advanced users who can design documents. The Developer and Web Professional user roles in MicroStrategy include the set of privileges required to create documents and controls, for each respective product.

For a review of basic document concepts, see Chapter 1, Document Review. If you need to brush up on document basics, this chapter is designed to help you. If you need a more in-depth refresher, or are new to creating documents and dashboard-style documents, start with the Report Services Document Creation Guide. For an introduction to documents, review the Document and Dashboard Analysis Guide, which provides a basic understanding of how to manipulate the data in a document or dashboard-style document to analyze business information.

Resources

This section provides details on how to access books, online help, MicroStrategy Education and Consulting resources, and how to contact MicroStrategy Technical Support.

Documentation

MicroStrategy provides both manuals and online help; these two information sources provide different types of information, as described below:

- **Manuals:** MicroStrategy manuals provide:
  - Introductory information and concepts
  - Examples and images
  - Checklists and high-level procedures to get started

The steps to access the manuals are described in Accessing manuals and other documentation sources, page xxxiv.
Most of these manuals are also available printed in a bound, soft cover format. To purchase printed manuals, contact your MicroStrategy Account Executive with a purchase order number.

• **Help**: MicroStrategy online help provides:
  - Detailed steps to perform procedures
  - Descriptions of each option on every software screen

**Additional formats**

MicroStrategy manuals are available as electronic publications, downloadable on the Apple iBooks Store or Google Play, and can be read on your iOS or Android device respectively. To download a book, search for the book’s title in the iBookstore or Google Play. To view a list of manuals that are currently available, scan the following QR codes using your device’s camera:

• For iOS devices, scan the following QR code:

![QR Code for iOS](image)

• For Android devices, scan the following QR code:

![QR Code for Android](image)

For new MicroStrategy releases, it may take several days for the latest manuals to be available on the iBookstore or Google Play.
Translations

For the most up-to-date translations of MicroStrategy documentation, refer to the MicroStrategy Knowledge Base. Due to translation time, manuals in languages other than English may contain information that is one or more releases behind. You can see the version number on the title page of each manual.

Finding information

You can search all MicroStrategy books and Help for a word or phrase, with a simple Google™ search at http://www.google.com. For example, type “MicroStrategy derived metric” or “MicroStrategy logical table” into a Google search. As described above, books typically describe general concepts and examples; Help typically provides detailed steps and screen options. To limit your search to MicroStrategy books, on Google’s main page you can click More, then select Books.

Manuals for MicroStrategy overview and evaluation

• Introduction to MicroStrategy: Evaluation Guide
  Instructions for installing, configuring, and using the MicroStrategy Evaluation Edition of the software. This guide includes a walkthrough of MicroStrategy features so you can perform reporting with the MicroStrategy Tutorial project and its sample business data.

• MicroStrategy Evaluation Edition Quick Start Guide
  Overview of the installation and evaluation process, and additional resources.

Resources for security

• Usher Help
  Steps to perform mobile identity validation using the Usher mobile security network to issue electronic badges for identifying users.
Manuals for query, reporting, and analysis

- **MicroStrategy Installation and Configuration Guide**
  Information to install and configure MicroStrategy products on Windows, UNIX, Linux, and HP platforms, and basic maintenance guidelines.

- **MicroStrategy Upgrade Guide**
  Steps to upgrade existing MicroStrategy products.

- **MicroStrategy Project Design Guide**
  Information to create and modify MicroStrategy projects, and create the objects that present your organization’s data, such as facts, attributes, hierarchies, transformations, advanced schemas, and project optimization.

- **MicroStrategy Basic Reporting Guide**
  Steps to get started with MicroStrategy Web, and how to analyze and format data in a report. Includes the basics for creating reports, metrics, filters, and prompts.

- **MicroStrategy Advanced Reporting Guide: Enhancing Your Business Intelligence Application**
  Steps to create Freeform SQL reports, Query Builder reports, complex filters and metrics, use Data Mining Services, and create custom groups, consolidations, and complex prompts.

- **Document and Dashboard Analysis Guide**
  Steps to execute, analyze, and format a dashboard in MicroStrategy Web.

- **MicroStrategy Report Services Document Creation Guide: Creating Boardroom Quality Documents**
  Steps to create Report Services documents, add objects, and format the document and its objects.

- **MicroStrategy Dashboards and Widgets Creation Guide: Creating Interactive Dashboards for Your Data**
  Steps to create MicroStrategy Report Services dashboards and add interactive visualizations.
• **MicroStrategy In-memory Analytics Guide**

Information to use MicroStrategy OLAP Services features, including Intelligent Cubes, derived metrics, derived elements, dynamic aggregation, view filters, and dynamic sourcing.

• **MicroStrategy Office User Guide**

Instructions to use MicroStrategy Office to work with MicroStrategy reports and documents in Microsoft® Excel, PowerPoint, and Word, to analyze, format, and distribute business data.

• **MicroStrategy Mobile Analysis Guide: Analyzing Data with MicroStrategy Mobile**

Steps to use MicroStrategy Mobile to view and analyze data, and perform other business tasks with MicroStrategy reports and documents on a mobile device.

• **MicroStrategy Mobile Design and Administration Guide: A Platform for Mobile Intelligence**

Information and instructions to install and configure MicroStrategy Mobile, as well as steps for a designer working in MicroStrategy Developer or MicroStrategy Web to create effective reports and documents for use with MicroStrategy Mobile.

• **MicroStrategy System Administration Guide: Tuning, Monitoring, and Troubleshooting Your MicroStrategy Business Intelligence System**

Steps to implement, deploy, maintain, tune, and troubleshoot a MicroStrategy business intelligence system.

• **MicroStrategy Supplemental Reference for System Administration: VLDB Properties, Internationalization, User Privileges, and other Supplemental Information for Administrators**

Steps for administrative tasks such as configuring VLDB properties and defining data and metadata internationalization, and reference material for other administrative tasks.

• **MicroStrategy Functions Reference**

Function syntax and formula components; instructions to use functions in metrics, filters, attribute forms; examples of functions in business scenarios.
• **MicroStrategy MDX Cube Reporting Guide**

Information to integrate MicroStrategy with MDX cube sources. You can integrate data from MDX cube sources into your MicroStrategy projects and applications.

• **MicroStrategy Operations Manager Guide**

Instructions for managing, monitoring, and setting alerts for all of your MicroStrategy systems from one console. This guide also includes instructions for setting up and using Enterprise Manager to analyze your MicroStrategy system usage.

**Manual for the Human Resources Analytics Module**

• **Human Resources Analytics Module Reference**

**Software Development Kits**

• **MicroStrategy Developer Library (MSDL)**

Information to understand the MicroStrategy SDK, including details about architecture, object models, customization scenarios, code samples, and so on.

• **MicroStrategy Web SDK**

  The Web SDK is available in the MicroStrategy Developer Library, which is part of the MicroStrategy SDK.

**Documentation for MicroStrategy Portlets**

• **Enterprise Portal Integration Help**

Information to help you implement and deploy MicroStrategy BI within your enterprise portal, including instructions for installing and configuring out-of-the-box MicroStrategy Portlets for several major enterprise portal servers.

This resource is available from [http://www.microstrategy.com/producthelp](http://www.microstrategy.com/producthelp).
Documentation for MicroStrategy GIS Connectors

- **GIS Integration Help**

  Information to help you integrate MicroStrategy with Geospatial Information Systems (GIS), including specific examples for integrating with various third-party mapping services.

  This resource is available from [http://www.microstrategy.com/producthelp](http://www.microstrategy.com/producthelp).

**Help**

Each MicroStrategy product includes an integrated help system to complement the various interfaces of the product as well as the tasks that can be accomplished using the product.

Some of the MicroStrategy help systems require a web browser to be viewed. For supported web browsers, see the MicroStrategy Readme.

MicroStrategy provides several ways to access help:

- **Help button:** Use the Help button or ? (question mark) icon on most software windows to see help for that window.

- **Help menu:** From the Help menu or link at the top of any screen, select MicroStrategy Help to see the table of contents, the Search field, and the index for the help system.

- **F1 key:** Press F1 to see context-sensitive help that describes each option in the software window you are currently viewing.

  For MicroStrategy Web, MicroStrategy Web Administrator, and MicroStrategy Mobile Server, pressing the F1 key opens the context-sensitive help for the web browser you are using to access these MicroStrategy interfaces. Use the Help menu or ? (question mark) icon to access help for these MicroStrategy interfaces.
Accessing manuals and other documentation sources

The manuals are available from http://www.microstrategy.com/producthelp, as well as from your MicroStrategy disk or the machine where MicroStrategy was installed.

Adobe Reader is required to view these manuals. If you do not have Adobe Reader installed on your computer, you can download it from http://get.adobe.com/reader/.

The best place for all users to begin is with the MicroStrategy Basic Reporting Guide.

To access the installed manuals and other documentation sources, see the following procedures:

- To access documentation resources from any location, page xxxiv
- To access documentation resources on Windows, page xxxiv
- To access documentation resources on UNIX and Linux, page xxxv

To access documentation resources from any location

1 Visit http://www.microstrategy.com/producthelp.

To access documentation resources on Windows

1 From the Windows Start menu, choose Programs (or All Programs), MicroStrategy Documentation, then Product Manuals. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

2 Click the link for the desired manual or other documentation source.

If bookmarks are not visible on the left side of a product manual, from the View menu click Bookmarks and Page. This step varies slightly depending on your version of Adobe Reader.
To access documentation resources on UNIX and Linux

1 Within your UNIX or Linux machine, navigate to the directory where you installed MicroStrategy. The default location is /opt/MicroStrategy, or $HOME/MicroStrategy/install if you do not have write access to /opt/MicroStrategy.

2 From the MicroStrategy installation directory, open the Help folder.

3 Open the Product_Manuals.htm file in a web browser. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

4 Click the link for the desired manual or other documentation source.

If bookmarks are not visible on the left side of a product manual, from the View menu click Bookmarks and Page. This step varies slightly depending on your version of Adobe Reader.

Documentation standards

MicroStrategy online help and PDF manuals (available both online and in printed format) use standards to help you identify certain types of content. The following table lists these standards.

<table>
<thead>
<tr>
<th>Type</th>
<th>Indicates</th>
</tr>
</thead>
</table>
| **bold** | • Button names, check boxes, options, lists, and menus that are the focus of actions or part of a list of such GUI elements and their definitions  
Example: Click Select Warehouse. |
| italic | • Names of other product manuals and documentation resources  
• When part of a command syntax, indicates variable information to be replaced by the user  
Example: Type copy c:\filename d:\foldername\filename |
### Education

MicroStrategy Education Services provides a comprehensive curriculum and highly skilled education consultants. Many customers and partners from over 800 different organizations have benefited from MicroStrategy instruction.

Courses that can help you prepare for using this manual or that address some of the information in this manual include:

- MicroStrategy Report Services: Dynamic Dashboards

For the most up-to-date and detailed description of education offerings and course curricula, visit [http://www.microstrategy.com/Education](http://www.microstrategy.com/Education).

### Consulting

MicroStrategy Consulting Services provides proven methods for delivering leading-edge technology solutions. Offerings include complex security architecture designs, performance and tuning, project and testing strategies and recommendations, strategic planning, and more. For a detailed description of consulting offerings, visit [http://www.microstrategy.com/services-support/consulting](http://www.microstrategy.com/services-support/consulting).

<table>
<thead>
<tr>
<th>Type</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Courier font</td>
<td>• Calculations</td>
</tr>
<tr>
<td></td>
<td>• Code samples</td>
</tr>
<tr>
<td></td>
<td>• Registry keys</td>
</tr>
<tr>
<td></td>
<td>• Path and file names</td>
</tr>
<tr>
<td></td>
<td>• URLs</td>
</tr>
<tr>
<td></td>
<td>• Messages displayed in the screen</td>
</tr>
<tr>
<td></td>
<td>• Text to be entered by the user</td>
</tr>
<tr>
<td>Example:</td>
<td>Sum(revenue)/number of months.</td>
</tr>
<tr>
<td>Example:</td>
<td>Type <code>cmdmgr -f scriptfile.scp</code> and press <strong>Enter</strong>.</td>
</tr>
<tr>
<td>+</td>
<td>A keyboard command that calls for the use of more than one key (for example, SHIFT+F1).</td>
</tr>
<tr>
<td>!</td>
<td>A note icon indicates helpful information for specific situations.</td>
</tr>
<tr>
<td>!</td>
<td>A warning icon alerts you to important information such as potential security risks; these should be read before continuing.</td>
</tr>
</tbody>
</table>
Technical Support

If you have questions about a specific MicroStrategy product, you should:

1. Consult the product guides, Help, and readme files. Locations to access each are described above.

2. Consult the MicroStrategy Knowledge Base online at https://resource.microstrategy.com/support.
   
   A technical administrator in your organization may be able to help you resolve your issues immediately.

3. MicroStrategy Technical Support can be contacted by your company's Support Liaison. Contact information and the Technical Support policy information is available at http://www.microstrategy.com/services-support/support/contact.

Feedback

Please send any comments or suggestions about user documentation for MicroStrategy products to:

documentationfeedback@microstrategy.com

Send suggestions for product enhancements to:

support@microstrategy.com

When you provide feedback to us, please include the name and version of the products you are currently using. Your feedback is important to us as we prepare for future releases.
Introduction

A MicroStrategy Report Services document contains objects representing data coming from one or more MicroStrategy reports, as well as images and shapes. Documents can appear in almost as many ways as you can imagine and are generally formatted to suit your business needs, in a single display of presentation quality.

A dashboard-style document is a special type of document. A dashboard-style document is commonly only one page long, is intended to be viewed online, and provides interactive features that let analysts change how they view the dashboard-style document’s data. By being only one page long, a dashboard-style document makes it easy to view the entire document at the same time and see all the information. A dashboard-style document allows interactivity from users, so each user can change how they see the data, within the limits of what the controls allow them. Users can change how they view the dashboard’s data using interactive features, such as selectors, grouping, widgets, and visualizations. They can explore data via multiple paths, using text, data filtering, and layers of organization.

This chapter begins with an overview of document analysis, in Before you begin: Document analysis overview, page 3, to help you understand how end users will use documents for data analysis. For more detailed examples
of working with documents and dashboard-style documents, see the Document and Dashboard Analysis Guide.

Next, this chapter provides an overview of how to design and create a MicroStrategy Report Services document, reviewing concepts from the Report Services Document Creation Guide. It also includes a brief summary of the objects, such as text fields and images, that you can add to a document. These objects can be used on dashboard-style documents as well as documents. For more detailed instructions and examples, or if you have never created a document before, see the Report Services Document Creation Guide.

The next chapter, Chapter 2, Designing Dynamic Enterprise Dashboard-style Documents, includes detailed instructions to create a dashboard-style document and describes objects that you can add to dashboard-style documents.

Warehouse data in the sample MicroStrategy projects is updated regularly, and these changes are reflected in the documentation whenever possible. However, the sample reports, documents, objects, and images in this guide may display warehouse data that no longer appears in the software.

Note the following:

- While you can connect an older Developer client to a newer Intelligence Server (such as an 8.1.x Developer client and a 9.x Intelligence Server), none of the newer 9.x functionality for Report Services documents is supported. See the Upgrade Guide for details.

- If some fonts are not available on an Intelligence Server installed on the UNIX operating system, copy True Type fonts into the Intelligence Server installation directory. Copy these fonts, which have a .ttc or .ttf extension, to INTELLIGENCE_SERVER_INSTALL_PATH\PDFGeneratorFiles. The default installation path for the Intelligence Server in UNIX is home\MicroStrategy\PDFGeneratorFiles. For the change to take effect, you must restart Intelligence Server.
Before you begin: Document analysis overview

Before you begin creating a document or dashboard-style document, you should understand how end users will use documents and dashboard-style documents for data analysis. For instructions and examples of manipulating data in documents and dashboard-style documents, see the Document and Dashboard Analysis Guide.

The following section reviews basic concepts, such as executing and printing documents and dashboard-style documents, covered in the Document and Dashboard Analysis Guide. If you need to brush up on the basics, this section is designed to help you.

Although the following sections refer to documents, remember that a dashboard-style document is a special type of document, so the procedures and concepts apply to dashboard-style documents as well as documents.

Display modes in MicroStrategy Web

When you open a document in MicroStrategy Web, it displays in the default mode selected by the document designer. Each display mode is optimized for a different type of user or analysis. You can view and work with a document in the following display modes:

- **Express Mode**, which allows document analysts to view the document and interact with it. Interactions include using selectors to change panels or Grid/Graph reports, sorting grid reports, and linking to reports and other documents.

  Internet Explorer 7 is required for the interactivity of Express Mode. If you are using Internet Explorer 6 or earlier, you cannot interact with the document. You can instead view the results only, as you might in a static PDF file.

- **Flash Mode**, which allows document analysts to access and interact with features provided by Flash, such as widgets.

- **Interactive Mode**, which allows document analysts to view the document and interact with it. It provides more interactivity than Express Mode, including formatting Grid/Graphs and creating metrics.

- **Editable Mode**, which displays the actual results of the document, while still allowing you to edit the document. All of the tasks that you can perform in Design Mode can also be performed in Editable Mode. This
allows you to make changes and immediately see how they affect the look and feel of the document.

- **Design Mode**, which displays the structure of the document, or the placeholders for the document objects, without the actual results. It allows you to create and edit the document and the various objects that make up the document. You can work more quickly in Design Mode than in Editable Mode since you do not have to wait for the results of your document to load in Design Mode.

For steps to analyze and work with a document in each of these modes, see the *MicroStrategy Web Help* or the *Document and Dashboard Analysis Guide*.

### Opening a document

The document opens in the default mode selected by the document designer.

#### To open a document

1. From a project in MicroStrategy Web, navigate to the folder containing the document.

2. Click the document name or icon, as shown below. The document displays in its default display mode.

3. To change the mode, click its icon on the toolbar.

   ![Mode icons](image)

   If the icon for a particular mode is unavailable, that mode has not been made available for this document. For steps to enable a mode, see *Determining the display modes users can choose to work in, page 61*.

### Exporting a document

Exporting a document allows you view and interact with the document results outside of MicroStrategy Web. For example, you can view results in a
Dashboards and Widgets Creation Guide Document Review

© 2015 MicroStrategy, Inc.

PDF file within Adobe Reader, manipulate exported data in an Excel spreadsheet, or create an interactive Flash dashboard for off-line use.

You can export a document to the following formats:

- **PDF file**: Export the document to a PDF file in a reader, such as Adobe Reader. You can view the PDF on any device with a PDF reader, such as another computer, a Linux machine, a Nook, or a Kindle.

- **Excel spreadsheet (.xls)**: Export the document to a Microsoft Excel spreadsheet for further manipulation and use. See the *Report Services Document Creation Guide* for tips to create a document that will display correctly when it is exported to Excel.

- **HTML file**: Export the document to an html file in a separate window.

- **Flash file**: Export the document to a fully interactive, stand-alone Flash file. All the Flash files in a project are exported in one of the following formats:
  - MHT format, which can be opened in Internet Explorer, and in Firefox with a third-party plug-in
  - PDF file format, which can be opened in Adobe Reader

The document designer determines the Flash file format. For more information and steps to change the format to export Flash files to, see the *Developer Help* (formerly the *Desktop Help*).

You are prompted for the following when you export a document, unless the document designer has specified the default exporting options for the document:

- If your document is grouped, you can choose to export the entire document or only the selected group element. Page-by allows you to view the document by a selected group element. For information on grouping and page-by, including examples, see the *Report Services Document Creation Guide*.

- If your document contains multiple layouts, you can choose to export the entire document or only the layout currently being viewed by the user. For more information on how layouts are exported to Excel, see the *Document and Dashboard Analysis Guide*.

You can export a document from within the document or directly from a folder. For steps to export a document from within the document, see *To export a document, page 6*. For steps to export a document directly from a folder, see the *MicroStrategy Web Help*. 
You can also export a single Grid/Graph to a PDF file or an Excel spreadsheet. For steps, see *Exporting a Grid/Graph from a document, page 7.*

---

**To export a document**

1. In MicroStrategy Web, click the name of the document to execute it.

2. From the **Home** menu, select **Export**, then select the file format in which to export the document. The options are:
   - Excel
   - HTML
   - PDF
   - Flash

   If an export format is not available on the toolbar, that export format has not been made available for this document.

3. If the Export dialog box opens, perform the following steps:
   a. If the document contains multiple layouts, you can determine which layouts to export. Select one of the following:
      - To export all layouts in the document, select **All layouts**. If you are exporting the document as an Excel file, each layout is exported to a separate worksheet in the file. If you are exporting the document as a PDF file, each layout starts on a new page.
      - To export only the layout that is currently displayed, select **Current layout**.
   b. If the document is grouped, data in the document is displayed on multiple pages based on the items in the Grouping panel. Do one of the following:
      - To export all of the pages in the document, select the **Expand page-by** check box.
      - To export only the currently displayed page, clear the **Expand page-by** check box.

4. Depending on the file type, you may be prompted to open or save the exported file. You can choose to either:
Dashboards and Widgets Creation Guide

© 2015 MicroStrategy, Inc.

Before you begin: Document analysis overview

1

- Open the file, by clicking Open. A copy of the document opens in a browser.
- Save the file, by clicking Save. Name and save the file. Do not change the file type.

For steps to export a document directly from a folder, see the MicroStrategy Web Help or the Document and Dashboard Analysis Guide.

Exporting a Grid/Graph from a document

You can export a single Grid/Graph displayed in a document to either a PDF file or an Excel spreadsheet. This provides additional flexibility to share and print your data, so that you do not have to export the entire document.

The document must be displayed in Express or Flash Mode. In Express Mode, the title bar of the Grid/Graph must be displayed. The following procedures describe both tasks.

A widget is exported as a Grid/Graph.

To export a Grid/Graph from Express Mode

1 In MicroStrategy Web, open the document in **Express Mode**.
2 Click the icon on the title bar of the Grid/Graph and point to either **Export to PDF** or **Export to Excel**.
   - If you choose PDF, the PDF file opens in another browser window.
   - If you choose Excel, you are prompted to open or save the exported file. You can choose to either:
     - Open the file, by clicking Open. A copy of the document opens in another browser window.
     - Save the file, by clicking Save. Name and save the file. Do not change the file type.

To export a Grid/Graph from Flash Mode

1 In MicroStrategy Web, open the document in **Flash Mode**.
2 Hover your cursor over the Grid/Graph. Icons for exporting to Excel and to PDF are displayed.

3 Do one of the following:
   • To export the Grid/Graph to Excel, click the Export to Excel icon. You are prompted to open or save the exported file. You can choose to either:
     ▪ Open the file, by clicking Open. A copy of the document opens in another browser window.
     ▪ Save the file, by clicking Save. Name and save the file. Do not change the file type.
   • To export the Grid/Graph to PDF, click the Export to PDF icon. The PDF file opens in another browser window.

### Printing a document

Before you print the document, you should configure various settings that control how the document is displayed and printed. Examples of these settings are pagination, page margins, and graph resolution. This ensures that the end result (the printed document) appears as you want it to. For steps, see the Report Services Document Creation Guide.

To view or print the document in MicroStrategy Web, you must first export the document to a PDF.

---

**To print a document**

1 In MicroStrategy Web, you can export a document directly from a folder, or you can export it while viewing it, as described below. (You must export it before you can print it.)

   • To export a document directly from a folder, hover your mouse over the document to display the action icons or links. Do one of the following:
     - In Icon view, click the PDF link below the document name.
     - In List view, click the PDF icon in the Actions column.
• To export a document while viewing it, click the **Print** icon on the toolbar.

The Export to PDF dialog box opens.

**Note the following:**

• If the PDF link or Print icon is unavailable, PDF exporting has not been made available for this document.

• If the Export to PDF dialog box is not displayed, you do not need to complete the remaining steps of this procedure. The PDF opens immediately and you can click **Print**.

2 If your document contains multiple layouts, you can choose to export the entire document or only the current layout. For a brief description of multi-layout documents, see *Multi-layout documents, page 21*.

• To export the entire document, select **All layouts**. Each layout will start on a new page.

• To export the current layout only, select **Current layout**.

3 If your document contains page-by fields, you can choose to export the entire document or only the selected group element to PDF. Page-by allows you to view the document by a selected group element. For examples of a paged document, and instructions on how to disable page-by, see the *Report Services Document Creation Guide*.

• To export the entire document, clear the **Expand page-by** check box.

• To export only the selected group element, select the **Expand page-by** check box.

4 Click **OK**. The PDF opens in another browser window.

5 Click the **Print** icon on the Acrobat Reader toolbar. The Print dialog box opens.

6 You can change print settings, such as the printer to be used and the page range to print, as needed. Click **OK**.

**Document views in Developer**

In Developer, you can open a document in the following views:
• **PDF View** (the default view), which displays the document as it will look when printed (for example, with page breaks). Use PDF View to:
  - View the document as a PDF (especially helpful to see how your changes affect the final display of the document)
  - Interactively display groups on separate pages (using page-by)
  - Navigate through large quantities of data that have been grouped into separate pages of the document
  - View associated websites by clicking hyperlinks
  - Print the document
  - Save the final PDF (by exporting it)
  - Export the PDF to Excel, PDF, Flash, or HTML

• **Flash View**, which displays a preview of the document as it will look in Flash Mode in MicroStrategy Web. In Flash View, you can interact with the document by using selectors, performing some manipulations such as pivoting and sorting, and viewing and interacting with widgets.

• **HTML View**, which displays a preview of the document as it will look in other MicroStrategy Web modes.

• **Design View**, which displays the structure of the document, or the placeholders for the document objects, without the actual results. It allows you to create and edit the document and the various objects that make up the document. Use Design View for the procedures described in this manual.

For instructions to open and print a document in Developer, see the Developer Help (formerly the Desktop Help).

---

**Designing and creating documents: An overview**

If you are new to designing documents, review the best practices for designing effective documents in the Report Services Document Creation Guide before you begin a new document.

As you, as a document designer, create documents, you specify the data that appears and control the layout, formatting, grouping, and subtotaling of
data. In addition, you can insert pictures and draw borders in the document. All of these capabilities provide for documents that are suitable for presentation to management for printing boardroom quality material. They are used to create the highest-quality, *Pixel Perfect™* documents such as scorecards and dashboard-style documents, managed metrics documents, production and operational documents, and more. For descriptions of the objects that you can add to a document, see *Objects in a document: Controls, page 13*.

To create a document, you open a blank document and select at least one dataset to provide the data to display in the document. The dataset can be an existing report or Intelligent Cube, or you can import data directly into the document. The objects on the dataset can include attributes, custom groups, consolidations, and metrics. You can select more than one dataset to include on the document. You must define one dataset as the grouping and sorting dataset; you can group and sort only by the objects on this dataset. For an overview of the methods to create a document, see *Creating documents, page 13*.

**Accessing data in a document: The dataset**

A dataset is a set of data that can be displayed on a document, dashboard-style document, or Visual Insight dashboard. A dataset can be a MicroStrategy report, a MicroStrategy Intelligent Cube, or data imported directly from an external data source. Reports include Freeform SQL reports, Query Builder reports, MDX cube reports, and reports that access Intelligent Cubes. Intelligent Cubes can be based on MicroStrategy data or imported data. The information in a dataset can include MicroStrategy objects such as attributes, custom groups, consolidations, and metrics.

These dataset objects are all of the objects from a dataset report, regardless of whether they are displayed on the report. For example, if a metric is in the Report Objects but not displayed on the report grid, that metric is listed as a dataset object. For background information about these subset reports, including the different methods to add them to a document, see the *Report Services Document Creation Guide*.

When data is imported from a non-MicroStrategy source, the data is linked to define attributes and metrics, and then published as an Intelligent Cube. The Intelligent Cube can be used as a dataset, and its objects used as data on the document.
When you create a new document, you can select an existing report or Intelligent Cube to use as the dataset, or import the data directly into the document. Once the document is created, you can:

- Add another dataset to the document
- Import data from another data source
- Replace an existing dataset with another dataset
- Replace all the datasets in the document with a single dataset
- Remove a dataset from the document

For instructions, see the Report Services Document Creation Guide.

**Multiple datasets**

You can create a document with multiple datasets, and you can add more datasets after you create a document. One dataset must be defined as the grouping and sorting dataset; you can group and sort only by the objects on this dataset.

For details on how multiple datasets join together in a document and for steps to change the grouping and sorting dataset, see the Report Services Document Creation Guide.

**Intelligent Cubes as datasets**

An Intelligent Cube is a multi-dimensional cube (sets of data) that allow you to use OLAP Services features on reports, as well as share sets of data among multiple reports and documents. You can use Intelligent Cubes as datasets, allowing you to use one Intelligent Cube for many different documents, while reducing access to the data warehouse.

When you import data in MicroStrategy, the imported data is saved as an Intelligent Cube.

For background information on using Intelligent Cubes as datasets, including how to add a Grid/Graph with an Intelligent Cube as a dataset, see the Report Services Document Creation Guide.
**Creating documents**

You can create a document in one of several ways, depending on your needs:

- On your own from start to finish using the Document Editor, which allows you to select the information to be included and the formatting of the document. You can add one or more datasets to the document.

- With the help of the Document Wizard, which provides steps to create the document.

- Using another document as a template, which allows you to pattern the new document after an existing one. The same dataset, controls, formatting, and layouts as the template are used in the new document. However, you can add to or modify the new document after it is created.

- From a report. The report is added as a Grid/Graph (an object that acts like a standard MicroStrategy report) in the Detail Header of the new document. You can also select multiple reports at the same time to create a multi-layout document (see *Multi-layout documents, page 21* for an overview).

For steps to create a document, see the *Report Services Document Creation Guide*. For steps to create a dashboard-style document, see *Creating a dashboard-style document: the Blank Dashboard template, page 53*.

**Objects in a document: Controls**

After you create a document, you add controls to the document. Controls are the objects that display the data, images, and shapes in a document; they are the objects shown in the document’s Layout area as you design the
The following document sample uses different types of controls, as described below:

<table>
<thead>
<tr>
<th>Central Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ellerkamp: Nancy</td>
<td>$847,227</td>
</tr>
<tr>
<td>Gale: Loren</td>
<td>$1,669,290</td>
</tr>
<tr>
<td>Torrison: Mary</td>
<td>$1,690,350</td>
</tr>
<tr>
<td>Zemlicka: George</td>
<td>$822,500</td>
</tr>
<tr>
<td><strong>Total Regional Revenue</strong></td>
<td><strong>$5,029,366</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mid-Atlantic Region</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bernstein: Lawrence</td>
<td>$1,060,632</td>
</tr>
<tr>
<td>Brown: Vernon</td>
<td>$331,735</td>
</tr>
<tr>
<td>Corcoran: Peter</td>
<td>$325,147</td>
</tr>
<tr>
<td>Folks: Adrienne</td>
<td>$1,047,776</td>
</tr>
<tr>
<td>Hollywood: Robert</td>
<td>$1,026,874</td>
</tr>
<tr>
<td>Ingles: Walter</td>
<td>$229,439</td>
</tr>
<tr>
<td>Smith: Thomas</td>
<td>$221,379</td>
</tr>
<tr>
<td>Young: Sarah</td>
<td>$209,634</td>
</tr>
<tr>
<td><strong>Total Regional Revenue</strong></td>
<td><strong>$4,452,615</strong></td>
</tr>
</tbody>
</table>

- **Text field**, which displays text such as:
  - Data (attributes, consolidations, custom groups, and metrics) from the document’s datasets. In the document sample shown above, the region names (such as Central), employee names, revenue amounts, and regional revenue subtotals are populated by the attributes and metric on the dataset.
  - Static text for labels. In the document sample, the words “Region”, “Employee”, “Revenue”, and “Total Regional Revenue” are static text.
  - Information about the document (such as the page numbers shown in the document sample) and the datasets (such as report names and filter information).
  - Metrics created within the document, which use the metrics on the datasets to obtain data not directly available from the datasets. These include:
    - Derived metrics, which are additional calculations, such as multiplying by a constant or using a function, on the metrics from the datasets
– Calculated expressions, which combine metrics from different datasets

– Summary metrics, which are totals using specific functions, other than the metric’s dynamic aggregation function

The regional revenue subtotals in the document sample are calculated by placing the Revenue metric in the Region Footer. Since the metric's dynamic aggregation function is Sum, the revenue values are totaled for each region. For a review of how the placement of a metric determines its calculation, see Document sections and metric calculations, page 20. To use a function other than Sum (such as Average) in the regional total, create and use a summary metric.

• **Line** or **Rectangle**. The document sample displays a line below each regional revenue subtotal and a grey rectangle to highlight the regional revenue subtotal.

• **Image**. The MicroStrategy logo on the document sample is an image.

The following control types can also be used on a document, although they are not displayed in the document sample:

• **Grid/Graph**, which displays data in the same way that a MicroStrategy report does. You can use a Grid/Graph as a type of summary for a group or the entire document, because the data displayed in it is aggregated to
the level in which the Grid/Graph is placed. In the following example, a Grid/Graph is displayed as both a grid and a graph simultaneously.

<table>
<thead>
<tr>
<th>Year</th>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2006</td>
<td></td>
<td>$8,647,238</td>
</tr>
<tr>
<td>2007</td>
<td></td>
<td>$11,517,606</td>
</tr>
<tr>
<td>2008</td>
<td></td>
<td>$14,858,854</td>
</tr>
</tbody>
</table>

If a project has not been enabled to support multiple datasets in a Grid/Graph, objects in a Grid/Graph must come from a single dataset. For example, a document contains two datasets. The Yearly Revenue dataset contains Year and Revenue, while the Regional Profit dataset contains Year and Profit. Because the project does not support multiple datasets in a single Grid/Graph, you cannot create a Grid/Graph with Year, Revenue, and Profit.

If the project allows Grid/Graphs to contain objects from multiple datasets, then a single Grid/Graph can combine the datasets to display Year, Revenue, and Profit. For steps to allow Grid/Graphs to use multiple datasets and steps to create Grid/Graphs in general, see the Report Services Document Creation Guide.

- **HTML container**, which displays real-time information from the web. For example, you can display a stock ticker running in real time next to a
Grid/Graph displaying a MicroStrategy report and interactive graphs displaying your corporate financial data.

![Financial Analysis Grid/Graph](image)

The interactive graphs shown on the bottom of the sample document above are displayed using widgets, which are Flash-based displays of the results of a dataset. For a more detailed description of widgets and how to create them, including examples, see *Chapter 5, Providing Flash Analysis and Interactivity: Widgets*.

For instructions to create any of these controls, see the *Report Services Document Creation Guide*.

Other types of controls, such as selectors and widgets, provide interactivity and visually intuitive graphic images. These controls are most commonly used on dashboard-style documents. However, their use is not limited to dashboard-style documents; you can use them on any type of document. These types of controls include:

- **Panel stack**, which is a holder for a collection of panels, or layers of data, in a document. A user can navigate or flip through the panels in a panel stack; only one panel is displayed at a time.
The document sample below shows a Grid/Graph, Employee Info By Region, on a panel in a panel stack.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Cost</th>
<th>Profit</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$720,149</td>
<td>$126,778</td>
<td>$847,227</td>
</tr>
<tr>
<td>Central</td>
<td>Gale</td>
<td>Loren</td>
<td>$1,416,036</td>
<td>$253,254</td>
<td>$1,669,290</td>
</tr>
<tr>
<td>Central</td>
<td>Torrison</td>
<td>Mary</td>
<td>$1,430,865</td>
<td>$259,465</td>
<td>$1,690,350</td>
</tr>
<tr>
<td>Central</td>
<td>Zemlicka</td>
<td>George</td>
<td>$697,693</td>
<td>$124,807</td>
<td>$822,500</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$901,702</td>
<td>$158,930</td>
<td>$1,060,632</td>
</tr>
</tbody>
</table>

For more examples and instructions to create and format panels and panel stacks, see Chapter 3, Layering Data: Panels and Panel Stacks.

- **Selector**, which allows users to interact with the document, by flipping through the panels in a panel stack or by displaying different attributes or metrics in a Grid/Graph.

The selector in the document sample above is the list of Grid/Graphs at the left. When a user clicks Category Sales Report, that Grid/Graph on another panel in the panel stack is displayed, as shown below.

<table>
<thead>
<tr>
<th>Category Sales Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Month</td>
</tr>
<tr>
<td>Jan 2006:Books</td>
</tr>
<tr>
<td>Jan 2006:Electronics</td>
</tr>
<tr>
<td>Jan 2006:Movies</td>
</tr>
<tr>
<td>Jan 2006:Music</td>
</tr>
</tbody>
</table>

For more examples and instructions to create and format selectors, see Chapter 4, Providing Interactivity to Users: Selectors.

- **Widget**, which displays the results of a dataset in Flash Mode, allowing users to visualize data in different ways than traditional reports displayed as Grid/Graphs do.

For example, the Interactive Bubble Graph widget below allows dashboard-style document analysts to drill into each bubble in the graph data.
by clicking it. Analysts can also use the time animation toolbar at the top of the widget to watch the bubbles appear on the graph in chronological order.

For more examples and instructions to create and format widgets, see *Chapter 5, Providing Flash Analysis and Interactivity: Widgets*.

Each of these different kinds of controls is referred to as a control type.

Dragging and dropping a dataset object onto the Layout area of the Document Editor creates a control. If the dragged object is a dataset, a Grid/Graph is created; otherwise, a text field containing the dataset object is added to the Layout area. When the document is executed, the Grid/Graph is displayed like a MicroStrategy report; the text field displays the elements or values of the dataset object.

The document section in which a control is placed determines not only the location of the values but also whether it is repeated and at what level it is calculated. For example, some document sections, such as the Page Header or Page Footer, are appropriate for displaying page numbers because those sections are automatically repeated throughout the document. For a summary of the different document sections, see *Document sections and metric calculations, page 20*.

A metric placed in different document sections is calculated differently. In the Detail section, the metric is calculated at the level of the attribute element, while the same metric placed in the Group Header section is calculated at the level of the group. This is described as an overview in *Document sections and metric calculations, page 20*. 
After you add controls, you can move and arrange them to determine how they appear when the document is viewed as a PDF. For instructions and examples of the various ways in which you can move and arrange controls, see the Report Services Document Creation Guide.

**Document sections and metric calculations**

A document contains multiple document sections, although most dashboard-style documents use only one document section. Using only one allows you to easily design a dashboard-style document using the whole screen. For example, if you create a new document using the Blank Dashboard template, only the Detail Header is displayed.

The document section that you place a control in determines where the control is displayed on the document. For a metric, the level of calculation depends on its location in the document, as summarized below. This allows you to create metric totals in documents, such as a grand total or a group total. When a metric is placed in a document section other than the Detail section, the metric is calculated using the dynamic aggregation specified in the metric definition.

A document or dashboard-style document can contain any of the following document sections:

- **Page Header and Page Footer**: Display at the top and bottom, respectively, of every page in the document.
  
  A metric in a text field in the Page Header or Page Footer calculates a grand total across the entire dataset.

- **Document Header and Document Footer**: Display at the beginning and end, respectively, of the document.
  
  A metric in a text field in the Document Header or Document Footer calculates a grand total across the entire dataset.

  If a document contains multiple layouts, the Document Header and Document Footer are replaced by the Layout Header and Layout Footer, which display at the beginning and end, respectively, of the layout. For an overview of multi-layout documents, see *Multi-layout documents, page 21*; for examples and instructions, see the Report Services Document Creation Guide.
• Detail Header and Detail Footer: Display just before and just after the Detail section. It is often used for column headers and other identifying information.

• Detail: Displays the main content of a document. One row prints for each row of data in the document’s dataset. Typically, this is where you place most of the attributes and metrics. The Detail section provides the most detailed or granular information.

A metric in a text field in the Detail section calculates at the level of the dataset.

• Group Header and Group Footer (if the document is grouped): Display at the beginning and end, respectively, of the group. Each group in the document has its own Group Header and Group Footer.

A metric in a text field in the Group Header or Group Footer section calculates a total for that group.

For a more in-depth description of the various document sections, including explanations of where they appear when the document is generated and the type of information they typically contain, see the Report Services Document Creation Guide. For a more in-depth description of how metrics aggregate depending which document section they are placed in, as well as placing metrics in Grid/Graphs affect the calculations, see the Report Services Document Creation Guide.

Multi-layout documents

A multi-layout document contains multiple documents, each in its own layout, creating a “book” of documents. Each layout functions as a separate document, with its own grouping, page setup, and so on, but the layouts are generated into a single PDF document.

In the table of contents shown below, the first-level headings are the different layouts. Each was a separate document that was imported into a
About Visual Insight dashboards

Visual Insight allows you to create interactive dashboards that you can use to explore your business data. Simple visualizations and pre-defined, presentation-quality formatting allow you to quickly display your data in a visually-striking, interactive dashboard. You create and interact with dashboards in MicroStrategy Web. In Developer, you can view dashboards, with a limited range of interactivity.

In MicroStrategy Web, you can interact with a Visual Insight dashboard in the following ways:

- View the data as a grid, graph, or widget:
  - Add the data to a graphical representation, such as a bar graph or pie chart
  - Display the data in an interactive widget, such as a Map, Graph, or Heat Map
• Filter the data, by the elements of an attribute or the value of a metric
• Group the data, by selecting the attributes to page by, and then selecting which element to display
• Sort data
• Drill into the data
• Move attributes and metrics around the template, quickly swapping objects between the rows and columns of the dashboard
• Add data from existing reports, documents, and Intelligent Cubes

You can quickly and efficiently create a meaningful display, since you do not need to switch to Design Mode to change the data that is displayed in the dashboard. You can quickly create a dashboard from an existing source: a report, document, or Intelligent Cube. You can also import data from different data sources, such as an Excel file or a Salesforce.com report, directly into the dashboard.

Once you select the data from the source, the data is automatically added to an interactive grid. You can immediately begin sorting, pivoting, and filtering data. For information on working with Visual Insight dashboards in MicroStrategy Web, including instructions and examples, see the Document and Dashboard Analysis Guide or the MicroStrategy Web Help. For information on creating dashboards in MicroStrategy Web, including instructions and examples, see the MicroStrategy Web Help.
Introduction

A dashboard-style document is a special type of document. A dashboard-style document is commonly only one page long, is intended to be viewed online, and provides interactive features that let analysts change how they view the dashboard-style document’s data. By being only one page long, a dashboard-style document makes it easy to view the entire document at the same time and see all the information.

The designer can create more flexible data presentations with dashboard-style documents than with documents, since more users can be served with a single dashboard-style document. Each user can interact with the dashboard-style document to display only the subset of data they are interested in (using panels and selectors) or only specific attribute elements or metrics (using a selector). Panels and selectors are described in detail later in this book (see Chapter 3, Layering Data: Panels and Panel Stacks and Chapter 4, Providing Interactivity to Users: Selectors).

Like documents, dashboard-style documents provide a wide variety of formatting options to allow you to design a customized, interactive dashboard. Dashboard-style documents provide the freedom to design a dashboard pixel-by-pixel in multiple editing and previewing modes. The
abundant design options deliver full control over position, formatting, and interactivity.

This chapter assumes that you understand the various MicroStrategy controls (such as Grid/Graphs, text fields, and so on) discussed elsewhere in this guide; understanding these controls is important to understanding panels and selectors in dashboard-style documents.

About dashboard-style documents

This chapter describes dashboard-style documents and how to create them. The chapter includes the following sections:

- What is a dashboard-style document?, page 26
- Adding interactivity to dashboard-style documents, page 28
- Design ideas and examples, page 38
- Designing the right dashboard-style document, page 41
- Best practices for dashboarding, page 43
- Creating a dashboard-style document: the Blank Dashboard template, page 53
- Exporting dashboard-style documents to Flash for stand-alone use, page 60
- Enabling transition animations in Flash, page 61
- Uncluttering the dashboard-style document: Full Screen mode, page 63

Flash Player version 10.1 is required to view and interact with dashboard-style documents in Flash Mode.

What is a dashboard-style document?

A dashboard-style document is a display of related sets of data on one screen. A dashboard-style document is commonly used to assess company or personal performance, to take a status check of the company, or to monitor personal work or work group contributions to overall goals of the business. Dashboard-style documents summarize key business indicators by presenting them in visually intuitive, easy-to-read, interactive documents. A
dashboard-style document allows interactivity from users, so each user can change how they see the data, within the limits of what the controls allow them. Users can change how they view the dashboard’s data using interactive features, such as selectors, grouping, widgets, and visualizations. They can explore data via multiple paths, using text, data filtering, and layers of organization.

The following dashboard-style document presents several common dashboarding qualities:

Common dashboard characteristics in the example shown above include:

- The gauge, which shows corporate revenue at a glance.
- The two graphs, which display regional and product performance in an easy-to-understand format.
- The buttons at the top right (Corporate, Regional, and City), which allow a user to view different areas of the business, providing a quick status check across the company. This set of buttons is one of the interactive features of the dashboard-style document. Interactive features are described in *Adding interactivity to dashboard-style documents*, page 28.
More generally, a typical dashboard-style document contains the following characteristics:

- Only one page, so that it is easy to view the entire dashboard-style document and see all the information.
- Used online rather than printed out.
- Provides interactive functionality so users can change how they see the data. For example, a user can select exactly which data to see by selecting metrics or attribute elements to be displayed in a Grid/Graph.

There is no single feature that you use to design a dashboard-style document; you can choose selectors, widgets, panels, and other controls, to create a personalized, custom dashboard-style document that suits your user’s specific needs. Various formatting options such as gradient colors and 3D effects also help you create dashboard-style documents with a style appropriate for the boardroom.

### Adding interactivity to dashboard-style documents

A key aspect of a dashboard-style document is the interactivity it allows. Interactivity lets analysts dynamically change the data displayed in Grid/Graphs or change other objects on the dashboard-style document.

You can add interactivity to your dashboard-style documents using a mix of the following features.

#### Analyzing specific attributes, elements, or metrics: Button bar

In the dashboard-style document sample above, the buttons in the Subcategory Analysis grid can be used to change the product category displayed.
The dashboard-style document initially displays data for the Music category. Click the **Books** button to show data for that product category instead, as shown below.

### Subcategory Analysis

<table>
<thead>
<tr>
<th>Subcategory</th>
<th>Revenue Forecast</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Science &amp; Technology</td>
<td>$ 868,612</td>
<td>25,658</td>
</tr>
<tr>
<td>Art &amp; Architecture</td>
<td>$ 432,156</td>
<td>29,554</td>
</tr>
<tr>
<td>Business</td>
<td>$ 416,906</td>
<td>29,422</td>
</tr>
<tr>
<td>Sports &amp; Health</td>
<td>$ 328,404</td>
<td>27,743</td>
</tr>
<tr>
<td>Literature</td>
<td>$ 281,417</td>
<td>40,312</td>
</tr>
<tr>
<td>Books - Miscellaneous</td>
<td>$ 249,584</td>
<td>39,979</td>
</tr>
</tbody>
</table>

This example uses a Grid/Graph and a button bar selector. For a description of Grid/Graphs and procedures to create them, see the *Report Services Document Creation Guide*. For a description of selectors and procedures to create them, see *Chapter 4, Providing Interactivity to Users: Selectors*.

### Analyzing across the company: Button bar

Another example of a button bar in this example is the buttons at the top right of the dashboard-style document. An analyst can use them to switch views, displaying a different set of grids and graphs which show a different set of data.
When you click the **Regional** button at the top of the dashboard-style document, a different set of grids and graphs is displayed, as shown below:

![Graphical representation of Regional Performance](image)

## Analyzing ranges of time: Slider

In the dashboard-style document sample in *What is a dashboard-style document?, page 26*, an analyst can use the slider along the bottom of the Regional Performance graph to change the length of time displayed and specific range of time covered in the graph’s data.

The dashboard-style document initially displays regional performance for August 2005 to February 2006. You can move the slider to change the range of time, for example, to display March to May 2008. You can extend the length of time displayed by dragging the right end of the slider to lengthen or...
shorten the slider. The graph now shows performance for March to September 2008, as shown below.

![Regional Performance Chart]

This example uses a Grid/Graph and a slider-style selector. For a description of Grid/Graphs and procedures to create them, see the Report Services Document Creation Guide. For a description of selectors and procedures to create them, see Chapter 4, Providing Interactivity to Users: Selectors.

**Analysis at a glance: Gauges, thermometers, cylinders, funnels**

You can use objects such as gauge graphs, funnel graphs, gauge widgets, thermometer widgets, and cylinder widgets to provide dashboard-style document analysts with a quick view of important KPIs. These graphs and widgets are good for analyzing data at a quick glance. They are most effective when placed near the top of a dashboard-style document.
The image below is an example of a gauge graph that is used at the top of a dashboard-style document to highlight corporate revenue and regional performance.

![Corporate Performance (YTD)](image1)

Revenue in millions of dollars

The image below is an example of a funnel graph that provides a quick look at current revenue projections.

![Current Revenue Projection - $1,342,500](image2)

*Select Funnel Series to display Opportunities below*
The image below is an example of a thermometer widget in a dashboard-style document. It allows a dashboard-style document analyst to quickly glance at the number of units sold.

The image below is an example of a cylinder widget in a dashboard-style document. A dashboard-style document analyst such as a regional manager can quickly glance at the cylinder to see how much revenue was produced.
For descriptions and examples of the widgets that you can add to a dashboard-style document, as well procedures to add them, see Chapter 5, Providing Flash Analysis and Interactivity: Widgets.

Organizing interactivity features on a dashboard-style document

The result of a user’s interactive selections can affect multiple objects simultaneously. You can design this using a panel stack, which is a collection of panels, each of which can contain groups of objects. Panels help you display only those groups of data that should be seen at the same time.

Additional features let the user navigate between panels, and quickly change the display of data within a panel. Each is described below.

Layering data: Panels and panel stacks

A control is any selectable item in the dashboard-style document’s Layout area. This can be a text field, line, rectangle, image, panel, panel stack, selector, or Grid/Graph object. When designing a dashboard-style document, controls are organized together in small groups. These groups of controls are placed in a holder called a panel. Because the controls are grouped together on a panel, they can be presented to the dashboard-style document user one group at a time. This lets the designer create several different views (or panels) of data, each view (panel) containing a logical grouping of controls that display data that is related in some meaningful way.

A panel stack is a collection of individual panels, stacked on top of each other. Only one panel can be displayed at a time. An analyst can flip from panel to panel within a dashboard-style document’s panel stack, displaying exactly the set of information he wants to see grouped together on the screen.

The sample dashboard-style document shown in the examples above uses a panel stack to provide the Corporate, Regional, and City “views”. Each view is an individual panel in the panel stack.

For more information, examples, and procedures for panels and panel stacks, see Chapter 3, Layering Data: Panels and Panel Stacks.
Providing interactivity: Selectors

A selector is an element of a dashboard-style document that allows a user to change the data he is viewing. A selector can be displayed as a button bar, a drop-down list, radio buttons, and so on. A selector can change panels or the focus of a Grid/Graph. Examples of selectors are shown below:

<table>
<thead>
<tr>
<th>Head Count</th>
<th>Regional Revenue</th>
<th>Monthly Profit</th>
<th>Head Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regional Revenue</td>
<td>Monthly Profit</td>
<td>Head Count</td>
<td></td>
</tr>
</tbody>
</table>

Selectors allow a user, in Interactive Mode and Editable Mode, to:

• Flip through the panels in a panel stack to display the different panels. The selector for the panel stack in the sample dashboard-style document is a button bar, which appears to the analyst as the “view” buttons.

• Display different attribute elements or metrics in a Grid/Graph. For example, a user can slice or filter the data on a graph by selecting specific regions or metrics. In the sample dashboard-style document, the slider is the selector for the Regional Performance graph, while the category buttons are the selector for the Subcategory Analysis grid.

For more information, examples, and procedures for selectors, see *Chapter 4, Providing Interactivity to Users: Selectors.*

Adding title bars to identify objects

A title bar is simply an area across the top of a panel stack or Grid/Graph. You can choose whether to display the title bar for each panel stack and Grid/Graph. When it is displayed, the title bar contains a title and several buttons.

• The title identifies the panel, panel stack, or Grid/Graph.

• The buttons allow users to minimize and maximize Grid/Graphs.

For examples and procedures to add a title bar to a Grid/Graph, see the *Report Services Document Creation Guide.* For examples and procedures to add a title bar to a panel stack, see *Displaying the title bar of a panel stack, page 77.*
**Quickly changing a report to a grid or graph**

Quick switch is a button that allows an analyst to quickly change a Grid/Graph from Graph view to Grid view and back, with a single click. The quick switch button is available in both Interactive Mode and Editable Mode; you cannot use it in MicroStrategy Developer. However, you can use either Developer or Web to determine whether quick switch is available in Web.

The button to perform the quick switch is located at the top of the Grid/Graph, as shown below.

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bates</td>
<td>Michael</td>
<td>$1,088,907</td>
<td>$163,911</td>
<td>$904,996</td>
</tr>
<tr>
<td>Becker</td>
<td>Kyle</td>
<td>$508,234</td>
<td>$77,867</td>
<td>$430,346</td>
</tr>
<tr>
<td>Bell</td>
<td>Caitlin</td>
<td>$1,040,481</td>
<td>$157,039</td>
<td>$863,411</td>
</tr>
<tr>
<td>Benner</td>
<td>Ian</td>
<td>$520,737</td>
<td>$79,664</td>
<td>$441,073</td>
</tr>
</tbody>
</table>

For instructions to enable quick switch, see the *Grid/Graphs* chapter of the *Report Services Document Creation Guide*.

**Provisioning Flash-based analysis and interactivity: Widgets**

A widget is a type of Report Services control that presents data in a visual and interactive way. You can think of widgets as interactive Flash-only graphs that dynamically update when you select a new set of data to view. The dashboard-style document user can even interact with some types of widgets to manually select a set of data to analyze. A variety of widget types, such as Gauge, Heat Map, and Stacked Area widgets, are available for use in dashboard-style documents. Although each type of widget looks different and is used in a unique way, the main purpose of all widgets remains the same: to provide dashboard-style document analysts with a visual and interactive look into their data.

For example, the Interactive Bubble Graph widget below allows dashboard-style document analysts to drill into each bubble in the graph by clicking it. Analysts can also use the time animation toolbar at the top of the widget to watch the bubbles appear on the graph in chronological order.
For more information, including examples and procedures, see Chapter 5, *Providing Flash Analysis and Interactivity: Widgets*.

**Graph styles for dashboard-style documents**

The following graph styles are particularly suitable to use in graph reports included in dashboard-style documents:

- Gauge
- Funnel
- Area
- Vertical stacked bar
- Combination: Line and horizontal bar
- Bubble
- Pie

For information about designing these types of graphs, see the *Graphing* chapter in the *Advanced Reporting Guide*. 

© 2015 MicroStrategy, Inc.
Design ideas and examples

Additional design ideas can be found in *Best practices for dashboarding, page 43.*

- Design a dashboard-style document that monitors individual or group contributions to overall business goals. Provide a gauge widget or thermometer widget so users can measure their progress toward goals at a glance. For example, use a widget to showcase some key metrics, such as average number of transactions per customer, or average revenue per customer. For more information on widgets, see *Chapter 5, Providing Flash Analysis and Interactivity: Widgets.*

- Design a dashboard-style document for regional sales managers at two levels: One level shows an overview of sales in the region, and the other level contains grid reports displaying details on each account representative’s individual accounts. The following two images show samples of each of these levels in a single dashboard-style document. The first image shows the regional (or Territory) overview level:

![Territory Overview Image]
The next image shows the second layer, displaying details of the accounts for each account representative:

![Sales Management Dashboard - 2008 Q1 QTD](image)

The layers in this dashboard-style document were created using panel stacks and selectors. For more information, see Chapter 3, Layering Data: Panels and Panel Stacks and Chapter 4, Providing Interactivity to Users: Selectors.

- Design a key performance indicators dashboard-style document that lets users look at one or more gauges to instantly assess key performance data. Provide graphs that let users compare current performance against established targets so they can identify opportunities or issues. Include a
report or two that provide supporting data so users can see what is behind the performance numbers. An example is shown below.

- Design a financial dashboard-style document that monitors all key financial statements in one screen. For example, you might include an income statement as the main feature of the dashboard-style document, then add a smaller grid report and a graph report below it. Add a selector to the income statement and connect it to the two supporting reports. When a user selects a line item in the income statement, such as Total Operating Expenses, the supporting reports show detailed operating expenses in the grid, and actual and planned operating expenses by quarter in the graph.

**Designing a simulated portal environment**

You can create a dashboard-style document with the look and feel of a portal. To do this, add several Grid/Graph objects to the dashboard-style document.
Each one will display a grid or graph report. Then add the following functionality to each Grid/Graph:

- Add a title bar to each Grid/Graph. Be sure to enable the Minimize/Maximize feature on the title bar. Users can click a button to minimize any “portlet window” to use their screen space efficiently and to focus more easily on pertinent reports. For instructions, see the Grid/Graphs chapter of the Report Services Document Creation Guide.

- Connect one Grid/Graph to a related Grid/Graph. This means that when the user changes the data displayed in one of the reports in the dashboard-style document, the connected report automatically updates to coordinate its display of the related information. For more information, see Using Grid/Graphs as selectors to control other Grid/Graphs, page 219.

### Designing the right dashboard-style document

The following table lists common goals for dashboard-style documents and provides suggestions on how to achieve them. This table can also provide ideas about what you might want to include in your dashboard-style documents.

<table>
<thead>
<tr>
<th>Dashboard-style Document Goal</th>
<th>Features to Use on the Dashboard-style Document</th>
</tr>
</thead>
</table>
| Present a style appropriate for the executive boardroom. | • Use drop shadows, gradients, 3D effects, and rounded rectangles on various parts of the dashboard-style document. For examples and procedures for these effects, see the Report Services Document Creation Guide.  
• Use 3D effects, bevels, gradients, transparency, and curved lines on graphs in the dashboard-style document. For examples and procedures, see the Report Services Document Creation Guide. |
| Instantly show details in a densely populated dashboard-style document. | • Enable tooltips in graphs, so that users can mouse-over graph data to see underlying data in detailed form.  
• Apply quick switch to Grid/Graphs so that users can switch between Graph view and Grid view, allowing detailed data to be seen in a table.  
• Use Grid/Graphs with title bars to allow an area to be enlarged to see details on complex graphs or grids.  
See the Grid/Graphs chapter of the Report Services Document Creation Guide for examples and procedures. |
<table>
<thead>
<tr>
<th>Dashboard-style Document Goal</th>
<th>Features to Use on the Dashboard-style Document</th>
</tr>
</thead>
</table>
| Present many layers of data in a single dashboard-style document, keeping the layers organized and focused. The layers, or views of the data, must be instantly available to the users. | Use panels and panel stacks to provide the layers of data in the following ways:  
• Multiple independent layers within a single dashboard-style document page  
• Multiple independent dashboard-style document pages layered within a single dashboard-style document  
For examples and procedures, see *Chapter 3, Layering Data: Panels and Panel Stacks*. |
| Allow users to change the context of a dashboard-style document. For example, a user can change the following for a specified set of graphs or tables:  
• The focus of the KPI  
• The timeframe being viewed  
• The subject areas displayed | • Add selectors that target attribute elements so that users can change the context of the data. You can use a wide range of selectors: radio buttons, check boxes, drop-down lists, and so on. For examples and procedures, see *Chapter 4, Providing Interactivity to Users: Selectors*.  
• Define an attribute in a Grid/Graph as a selector that targets a panel stack or another Grid/Graph. Users can then click an attribute element in the Grid/Graph and initiate a context change in related Grid/Graphs on the dashboard-style document. For examples and procedures, see *Using Grid/Graphs as selectors to control other Grid/Graphs*, page 219. |
| Design a simulated portal environment. | You can create a dashboard-style document with the look and feel of a portal. To do this, add several Grid/Graphs to the dashboard-style document. Each one will display a grid report or graph report. Then add the following functionality to each Grid/Graph:  
• Add a title bar to each Grid/Graph. Enable the Minimize/Maximize feature on the title bar. Users can click a button to minimize any "portlet window" to use their screen space efficiently and to focus more easily on pertinent reports.  
• Connect one Grid/Graph to a related Grid/Graph. This means that when the user changes the data displayed in one of the dashboard-style document reports, the connected report automatically updates to coordinate its display of the related information.  
For procedures and examples, see the *Grid/Graphs* chapter of the Report Services Document Creation Guide. |
| Create dashboard-style documents in Flash that can be used even when disconnected from the network. These dashboard-style documents include full interactivity, visualization, and data content. | • Embed Flash dashboard-style documents within Microsoft Office documents, including Word, PowerPoint, Excel, and Outlook. For more information, refer to the *Office User Guide*.  
• Embed Flash dashboard-style documents within emails and distribute them. For more information on this Narrowcast Server feature, see the Narrowcast Server documentation. |
### Best practices for dashboarding

The goal of most dashboard-style documents is to magnify specific points of data, making them easy for users to identify. To achieve this goal effectively, you must make certain decisions before you begin creating your dashboard-style document.

These best practices are grouped into the following sections:

- *Choosing datasets for a dashboard-style document, page 44*
- *Layering information in a dashboard-style document, page 46*
- *Planning the dashboard-style document’s outline and structure, page 47*
- *Placing the data and visualizations onto a dashboard-style document, page 49*
- *Positioning and formatting the dashboard-style document objects, page 50*
- *Enhancing dashboard-style document performance, page 51*

#### Dashboard-style Document Goal

<table>
<thead>
<tr>
<th>Feature to Use on the Dashboard-style Document</th>
<th>Description</th>
</tr>
</thead>
</table>
| Use interactive Flash graphs rather than static graphs to provide an engaging way to view data and understand relationships. | - Use time series animation to allow users to play graphical “movies,” driven by data, that provide rapid insight into business trends. Users can rewind and fast forward through a time series. They can also pause the movie and drill down for more details. For an example, see *Creating a Time Series Slider widget, page 360.*
| | - Use the library of visualization widgets to extend the display of information beyond traditional graphing. See *Chapter 5, Providing Flash Analysis and Interactivity: Widgets.*
| Unlimited visualization extensibility via Flash uses MicroStrategy’s integration with Adobe’s FlexBuilder 2 IDE to allow you to: | - Build any visualization you need using FlexBuilder IDE integration and add it to your MicroStrategy library of visualizations.
| | - Customize any Flex-compatible visualization and add it to your MicroStrategy library of visualizations.
| | - Use the Adobe FlexBuilder integration to add MicroStrategy reports and dashboard-style documents to any Flex-compatible Rich Internet Application (RIA). For more information on MicroStrategy’s Visualization Framework, the FlexBuilder plug-in, and the visualization editor, see the MicroStrategy Developer Library (MSDL) provided with MicroStrategy SDK. In particular, the *Understanding the Visualization Framework* section is helpful. The path to this section in the MSDL is Web SDK -> Integrating with an External Application -> Visualization Integration.

<table>
<thead>
<tr>
<th>Feature to Use on the Dashboard-style Document</th>
<th>Description</th>
</tr>
</thead>
</table>
| Use interactive Flash graphs rather than static graphs to provide an engaging way to view data and understand relationships. | - Use time series animation to allow users to play graphical “movies,” driven by data, that provide rapid insight into business trends. Users can rewind and fast forward through a time series. They can also pause the movie and drill down for more details. For an example, see *Creating a Time Series Slider widget, page 360.*
| | - Use the library of visualization widgets to extend the display of information beyond traditional graphing. See *Chapter 5, Providing Flash Analysis and Interactivity: Widgets.*
| Unlimited visualization extensibility via Flash uses MicroStrategy’s integration with Adobe’s FlexBuilder 2 IDE to allow you to: | - Build any visualization you need using FlexBuilder IDE integration and add it to your MicroStrategy library of visualizations.
| | - Customize any Flex-compatible visualization and add it to your MicroStrategy library of visualizations.
| | - Use the Adobe FlexBuilder integration to add MicroStrategy reports and dashboard-style documents to any Flex-compatible Rich Internet Application (RIA). For more information on MicroStrategy’s Visualization Framework, the FlexBuilder plug-in, and the visualization editor, see the MicroStrategy Developer Library (MSDL) provided with MicroStrategy SDK. In particular, the *Understanding the Visualization Framework* section is helpful. The path to this section in the MSDL is Web SDK -> Integrating with an External Application -> Visualization Integration.

© 2015 MicroStrategy, Inc.
For information on the objects that allow you to implement these objectives, see the following sections:

- **Chapter 3, Layering Data: Panels and Panel Stacks**
- **Chapter 4, Providing Interactivity to Users: Selectors**
- **Using Grid/Graphs as selectors to control other Grid/Graphs, page 219**
- **Chapter 5, Providing Flash Analysis and Interactivity: Widgets**
- **Enabling transition animations in Flash, page 61**
- **Adding title bars to identify objects, page 35**, for panel stacks and Grid/Graphs
- **Quickly changing a report to a grid or graph, page 36**, for Grid/Graphs
- **Linking to other documents and to reports (drilling) in the Report Services Document Creation Guide**

For general best practices related to designing a document, see the Report Services Document Creation Guide.

### Choosing datasets for a dashboard-style document

A dataset is a set of data that can be displayed on a document, dashboard-style document, or Visual Insight dashboard. A dataset can be a MicroStrategy report, a MicroStrategy Intelligent Cube, or data imported directly from an external data source. Reports include Freeform SQL reports, Query Builder reports, MDX cube reports, and reports that access Intelligent Cubes. Intelligent Cubes can be based on MicroStrategy data or imported data. The information in a dataset can include MicroStrategy objects such as attributes, custom groups, consolidations, and metrics.

You can use existing reports and Intelligent Cubes as datasets in a new dashboard-style document. This can save you time and help avoid unnecessary duplication in your MicroStrategy metadata. You can also create new datasets for your dashboard-style document.

- **A dataset should have enough data to be useful as a rich source of analysis for many users, but it should not have extra data that is not needed on the**
Dashboard-style document. For example, do not include product item information when you only want to display product category information.

- As you gather or create datasets, focus on important indicators such as performance stakes, trends, and variances.

- Users typically browse a large number of reports somewhat randomly, looking for interesting trends. You can gather related reports to use on your dashboard-style document, so that all the data is available together in a single context. Users can then locate the data more easily and analyze it more efficiently.

- When choosing reports to incorporate into a single layer on a dashboard-style document (a dashboard-style document page or panel), consider the ratio of graph to grid reports to display. Common graph:grid ratios range from 4:1 to 1:3. The average graph:grid ratio from a general sample of dashboards was approximately 2:1.

- Consider using a dashboard-style document to replace 8-12 existing reports in your MicroStrategy project. You will generally use 3-5 reports on each layer of the dashboard-style document; dashboards generally have from 1 to 3 layers (see Layering information in a dashboard-style document, page 46).

- Consider using a dashboard-style document to replace three to four existing documents in your MicroStrategy project. If you have three documents that contain data from a related subject area, you can use each document as a single layer (or panel) of your dashboard-style document. Having all this related information in one dashboard-style document can provide a more productive analysis experience for your users.

For example, you have three documents for your human resources department. Each document is related to salaries and other benefits, headcounts, or hiring. Create a dashboard-style document with a panel stack sized to take up the entire screen. Add two more panels so you have three panels in the panel stack. Then re-create the first document on the first panel of the dashboard-style document, the second document on the second panel, and so on. Add a selector of three tabs (buttons) at the top of the panel stack. Users can tab between the layers of human resources data, depending on whether they are interested in headcounts, hiring, or
Layering information in a dashboard-style document

- Plan to have from one to three layers for your dashboard-style document. You can visualize these layers as pages of your dashboard-style document; analysts will see one page at a time. Multiple layers allow you to design a dashboard-style document that contains much more information overall, but presents only a reasonable subset of that information in the layer currently being displayed.

  ▪ Create layers by adding a panel stack to your dashboard-style document. Size the panel stack so it is large enough to take up the entire screen. Then place enough panels on the panel stack to equal the number of layers needed in your dashboard-style document. Each panel becomes one layer of your dashboard-style document. Finally, create a set of tabs above the panel stack by adding a button or link bar selector, with one tab (button) for each layer (panel).
• Consider grouping data by layers according to subject areas or business dimensions, with one subject area or business dimension per layer. For example, one layer might show income at the corporate level, while a second layer might also show income but at a departmental level or a regional level. The final layer might show detailed income data. This lets you serve diverse user communities without overwhelming users, as they can each flip to and work with the dashboard-style document layer that specifically interests them.

• Consider grouping data by layers according to regions of the country or regions of the world, so that, for example, sales metrics can be displayed within a given regional context.

Planning the dashboard-style document’s outline and structure

• Use Microsoft Excel, Paint, PowerPoint, or another tool to create a mock-up of the dashboard-style document. The mock-up should convey a clear vision of the information, structure, layout, and formatting. Send the mock-up to your user community to gather feedback on its usefulness. This can save time creating and formatting a complex, finished dashboard-style document that may need to be redone.

• The Quick switch feature lets users toggle between grid display and graph display without requesting data from the server. The Quick switch feature can therefore help improve response time for users.

• To minimize the amount of data passed between the web server and the web browser:
  □ Use the grouping feature and/or incremental fetch, for dashboard-style documents designed to be viewed in MicroStrategy Web. For instructions to group a dashboard-style document or implement incremental fetch, see the Report Services Document Creation Guide.

  □ Use selectors for attributes and metrics if a dashboard-style document will be viewed using DHTML. This is not necessary if users will be viewing dashboard-style documents in Flash Mode, because all dashboard-style document data is downloaded to the web browser when the dashboard-style document is executed.

• Group related reports so they can be placed in a small panel stack, each panel displaying a single report. As users flip through the panels, they will be flipping through the related reports. The reports in a panel stack should not be reports that a user might want to see side by side in a
dashboard-style document; rather, the reports should show different levels of detail about the same or closely related data.

- Plan to provide visualizations. These can include any of the available widgets, such as a gauge, thermometer, heat map, and so on, which can help users understand data at a glance.

  Do not add so many graphical objects that the focus of the dashboard-style document is no longer the data. Too many visualizations can detract from the importance of the data.

- Plan to provide interactivity. This can include any of the available selectors, such as tabs, buttons, and sliders, which let users change a report’s metrics, attribute elements, and filters, or interactive widgets. Interactive features let users customize the display of data without needing a developer or designer to perform any work.

- Consider common user workflows when designing a dashboard-style document. Think about how analysts are going to move through the dashboard-style document, what links they will want to click, and so on. Try to embed this workflow directly into the dashboard-style document. Do this by placing objects so that data can be interpreted from the top left to the bottom right.

- Granularity should increase from top to bottom on a dashboard-style document. For example, place objects that display key performance indicators at the top of the dashboard-style document. These objects might include large graphs such as a funnel graph (also called a pipeline), a pie graph, widgets such as a gauge, and so on.

- Allow users to drill within the dashboard-style document to determine the level of detail that they need to display. Use pre-defined drill paths to direct the users' analysis. Drilling can provide more details and more information without interrupting the workflow. Use links to other dashboard-style documents, documents, or prompted reports to provide the drilling paths.

- Decide which objects on the dashboard-style document should share the same formatting styles, and which objects should be physically aligned with each other. These decisions are important time-savers if you make them before you spend a lot of time actually formatting objects and fine-tuning object placement.

- Use effects for trends, summaries, and other high-level data. If users want to analyze details in a report, too many effects can make it difficult to understand more detailed data.

  For example, if you apply the curved effect to the line in a line graph, the exact points where the line hits the graph are adjusted so that the
line can be curved smoothly. This looks nice, but users who rely on seeing every detail will have difficulty. If you want to apply the curved effect, you can also provide a grid report alongside showing exact values. An alternative is adding tooltips which display actual values for points on the graph when you move the cursor over the graph.

Placing the data and visualizations onto a dashboard-style document

- Place reports into appropriate areas on the dashboard-style document, and then resize them as needed to achieve your planned appearance. Placement should take into account the user workflow and granularity discussions above. Also, a user usually looks to the upper left first, and the bottom right last. Large graphics grab a user’s attention, no matter where they are placed.

- Keep the number of objects on the screen to a minimum, to achieve a clean look. Use graphical objects sparingly. Make use of abbreviated text in text fields as appropriate, to make the best use of space. You can add a tooltip (a mouseover) to explain any abbreviations that may not be clear to all users.

- For any graph or widget, provide a tooltip (a mouseover) so that users who are interested in specific details can see the actual values behind the general trends displayed by graphic visualizations. This is an excellent way to support two sets of users who need widely differing levels of information on the same subjects.

- Provide a quick switch capability for all graph reports, so users can switch with a single click between the graphical display of data and its corresponding grid report showing individual cells with specific values.

- Provide a title bar on reports (Grid/Graphs) on the dashboard-style document so users can maximize and minimize the individual reports. This ability to minimize and maximize reports provides users with a portal-like environment, with each report behaving like a portlet window. This allows users to control how space is used on their screens, and to focus on the data they are interested in.

- If you have a panel stack on the dashboard-style document, add a selector so users can flip between the panels on the panel stack.

- Sliders are best used on graphs that specify a date range. Sliders can not only change the time frame of the data displayed in a report or set of reports, they can also change the span of time being analyzed.
• If you have related reports on a dashboard-style document layer, add a selector to one of the reports and connect it to the related report. When users choose to see a certain aspect of the first report, the second report automatically changes to display the related data. When the user clicks on one grid or graph, his selection serves as a filter for the related grid or graph. For example, in a pie graph showing revenue for all products, a user clicks a slice of the pie graph representing electronics revenue. The connected report below the pie graph, displaying detailed sales numbers, automatically updates its data to reflect the user’s selection, displaying sales numbers for various electronic products.

• Add selectors to different parts of the dashboard-style document so users can customize the data they see at many levels. For example, add a selector at the top of the dashboard-style document itself, so users can switch between layers of the dashboard-style document. Then add a selector at the top of an individual layer, so users can change metrics, for example, to change the focus of that layer of the dashboard-style document. Finally, add a selector to each of the reports on that layer, so users can focus the details of their analysis on a specific area.

Positioning and formatting the dashboard-style document objects

• Use the color palette to match your corporate standards, or create any other color desired. Consider the following best practices:
  
  ▪ Colors are especially effective when used as a background that visually groups a set of reports or other related objects.
  
  ▪ Contrasting colors support quick comparisons between two measurements, such as actual vs. forecasted values.

• To make visual analysis easy, use drop shadows, rounded edges, geometric lines and shapes, color gradients, transparency, and borders to visually link related sets of data. For example, group related sections of information under the same title bar and use the same background color to tie them together visually.

• Include text fields as needed. For example, a concise text field explaining a set of buttons can make the difference between users who are confused by a busy layout, and users who know exactly what to select so that the data displayed provides the information they need.
• Edit titles as necessary to make sense of your final display.

• Improve readability for grid reports by adding special formatting, such as background colors or a drop shadow, to alternating or important rows so those rows stand out.

• Add thresholds to any important grid report data. A threshold is special formatting that is applied automatically when a value in a cell reaches a certain number. For example, if any of your regions returns sales numbers that fall below a specified low mark, the appropriate cell of the grid is automatically formatted, perhaps with a red background and bold numbers, to alert you to the condition. For details on applying thresholds to grid and graph reports, see the Basic Reporting Guide.

• If there are other reports or documents that cover analysis areas related to data on your dashboard-style document, consider adding one to three link bars, which are links from the dashboard-style document directly to the separate report or document. You may find it helpful to ask your users what common investigative paths they might follow after using the dashboard-style document. Links can help make that transition easy.

• If a grid report takes up too much room, make it smaller and add a scrollbar. The data will remain accessible but the report itself will use less space on the total dashboard-style document area.

• Display your finished dashboard-style document in the same format your users will be viewing it in—for example, HTML, PDF, Excel, or printed—and ensure that the display is effective for your planned output.

Enhancing dashboard-style document performance

• Use as few datasets as possible when designing the dashboard-style document. For example, one dataset with 1000 rows displays faster than ten smaller datasets. However, be aware that combining datasets can create a Cartesian join, which inflates the size of the combined dataset and results in slower performance. For details on how multiple datasets are joined, see the Report Services Document Creation Guide.

• Having all the data in the rows negatively impacts the rendering time for Editable Mode and Interactive Mode.

• A selector with many items (for example, the buttons or check boxes) increases the time it takes for the dashboard-style document to execute. For example, if you increase the number of items by a factor of ten, server execution times can increase up to 50%. In essence, a larger number of items translates into a larger dataset.
• Flash Mode provides better performance when selectors have many targets. (A target is a Grid/Graph and/or panel stack affected by the selectors.)

• A selector that controls attributes displayed on a Grid/Graph performs faster than a selector that controls attributes that are not displayed on a Grid/Graph.

• When you place a panel stack on a panel, you are nesting panel stacks. Nesting panel stacks increases client rendering time. To reduce that time, include data in both panel stacks, not just the nested panel stack.

• In Flash Mode, after the dashboard-style document is initially loaded, manipulations such as choosing a selector item are executed on the client machine. In contrast, such manipulations in Interactive Mode send additional requests from Web Server to Intelligence Server. Since Flash Mode uses minimal server resources after the initial load is complete, system overhead is reduced for multiple users concurrently manipulating their dashboard-style documents. Therefore, Flash Mode has faster response times for manipulations, regardless of the number of users accessing the dashboard-style document. However, these same users must accept longer dashboard-style document execution times due to the initial loading of Flash.

• Graphs perform better in Flash Mode than in Editable Mode and Interactive Mode.

Best practices: Designing Flash dashboard-style documents for printing

If your dashboard-style document contains Flash content, such as interactive widgets, consider formatting the dashboard-style document to help ensure that it is displayed correctly when it is printed.

The following recommendations are designed to optimize print quality for a Flash dashboard-style document printed on 8.5” x 11” paper. When printing your dashboard-style document using a different paper size, you may need to modify the settings below to accommodate your dashboard-style document. Be sure to test your dashboard-style document by printing it to ensure that the content is printed as expected.

When designing a Flash dashboard-style document for printing, make sure of the following to help ensure that your dashboard-style document is displayed correctly:
• The paper size selected in the printer’s print options should be 8.5 x 11.

• The dashboard-style document’s Paper Size option should be set to Letter 8.5” x 11”. For steps to modify the Paper Size, see the Designing and Creating Documents chapter in the Report Services Document Creation Guide.

• The left, right, top, and bottom margins for the dashboard-style document should be set to .75”. For steps to define the page margins for a dashboard-style document, see the Designing and Creating Documents chapter in the Report Services Document Creation Guide.

• The Document Zoom Level option for the dashboard-style document should be set to Fit Page. To specify the Document Zoom Level for a dashboard-style document open in Web, click Home from the menu bar of the dashboard-style document. The Home options are displayed in the dashboard-style document’s toolbar. From the second drop-down list, select Fit Page.

• Leave a margin of .1” between any content in the dashboard-style document and the dashboard-style document’s rightmost edge.

• Leave a margin of 2.5” between any content in the dashboard-style document and the dashboard-style document’s bottom edge.

• Be sure that the dashboard-style document is exported using the PDF file format when the user chooses to export the dashboard-style document to Flash. To do so, select the Export to Flash option to PDF. For steps, see the Report Services Document Creation Guide.

Once you have configured your dashboard-style document with the above settings, users can print the dashboard-style document by first exporting the dashboard-style document to Flash. Once the dashboard-style document opens in a new window, users can then print the dashboard-style document as they would any PDF file. For steps to export a document or dashboard-style document to Flash, see the MicroStrategy Web Help or the Report Services Document Analysis Guide.
datasets, fields, formatting, and layouts as the template dashboard-style document. After the new dashboard-style document is created, you can customize the new dashboard-style document as you want.

MicroStrategy provides predefined document templates, including the Blank Document template and the Blank Dashboard template. Use the Blank Dashboard template to help you create the look and feel of a dashboard-style document with the key features described below:

- A dashboard-style document is commonly only one page long, so the Blank Dashboard template uses only one document section. The height of the document section is defined as seven inches.

  For descriptions of the various document sections that are available in a document, see Document sections and metric calculations, page 20.

- Grid/Graphs are formatted with a background fill and a border. Title bars are displayed for Grid/Graphs, and they use a gradient color (a two-color combination) to provide more sophisticated formatting. The Grid/Graph has a fixed width and height; if the Grid/Graph is larger, scroll bars are displayed.

  These defaults help you create the feel of a portal if you include several Grid/Graphs on your dashboard-style document. A user can display all the Grid/Graphs, or minimize the ones that are not relevant at the moment to focus on a particular Grid/Graph.

- Panel stacks are formatted with a background fill and a title bar. The title bars, which help users identify the objects, are formatted with a gradient color. Again, these defaults help you create the feel of a dashboard-style document or a portal.

The following dashboard-style document, which is shown in Design View in Developer, was created using the Blank Dashboard template. It contains a
Grid/Graph and a panel stack. Notice that the Grid/Graph is formatted with a light grey background fill (the Backcolor).

These are the default settings of the Blank Dashboard, so you can change them if necessary. For example, you can change the height of the section, display additional sections, remove title bars from a Grid/Graph, and so on.

Other predefined dashboard-style document templates provide other common structures for dashboard-style documents, such as four evenly-spaced panel stacks to place contents in, one panel stack on the left side of the dashboard-style document and two smaller ones on the right, or a text field across the top of the dashboard-style document for a title bar with a panel stack below it.

To create a traditional document rather than a dashboard-style document, use the Blank Document template.

For information on title bars, see Adding title bars to identify objects, page 35. For a description and an example of a Grid/Graph, see About Visual Insight dashboards, page 22; for more detailed examples and procedures to create and format Grid/Graphs, see the Report Services Document Creation Guide. For a detailed description, examples, and procedures to create panel stacks, see Chapter 3, Layering Data: Panels and Panel Stacks.
To create a dashboard-style document using the Blank Dashboard template

1. Click the MicroStrategy icon at the top of the page and select New Document. The Create Document page is displayed.

2. If you have the appropriate privileges, the View document in Design Mode check box is selected by default. Clear the check box if you want to open the document in the default mode specified by the template’s designer.


Add a dataset

Datasets provide the data that appears in dashboard-style documents. This information can include attributes, custom groups, consolidations, and metrics. For background information on datasets, see Accessing data in a document: The dataset, page 11.

4. Click the Add Dataset icon on the Dataset Objects panel. The Select Dataset dialog box opens.

5. Do one of the following:
   - To import data into the dashboard-style document, click Import new data. Select the source of the data, and then choose the appropriate options to import your data. For detailed steps, see the MicroStrategy Web Help.
   - To select an existing report, browse to and select the report or Intelligent Cube to add to the dashboard-style document. You can type a name in the Find field to locate a specific report. Click OK.

   The selected dataset and its objects are displayed in the Dataset Objects panel.

   If you have OLAP Services, be aware that the Dataset Objects panel contains all of the objects from the dataset, regardless of whether they are displayed on the report. For example, even if a metric is in the Report Objects but not displayed on the grid, that metric is still listed as a Dataset Object.

6. For each dataset to include in the dashboard-style document, repeat the steps above, beginning at Add a dataset.
Add objects to the dashboard-style document

7 Add objects to the dashboard-style document.

- For steps to add a text field, which can display data such as attributes and static text such as labels, see the Adding Text and Data to Documents chapter of the Report Services Document Creation Guide.

- For steps to add a Grid/Graph, which displays data in the form of a standard MicroStrategy grid report or graph report, see the Grid/Graphs chapter of the Report Services Document Creation Guide.

- For steps to add an HTML container, which displays real-time information from the web, see the Adding Text and Data to Documents chapter of the Report Services Document Creation Guide.

- For steps to add a shape, see the Adding Text and Data to Documents chapter of the Report Services Document Creation Guide.

- For steps to add an image, see the Adding Text and Data to Documents chapter of the Report Services Document Creation Guide.

- For steps to add a panel stack, see Chapter 3, Layering Data: Panels and Panel Stacks.

- For steps to add a selector, see Chapter 4, Providing Interactivity to Users: Selectors.

- For steps to add a widget, see Chapter 5, Providing Flash Analysis and Interactivity: Widgets.

8 Format the dashboard-style document and the objects on it by applying 3D effects, borders, drop shadows, gradient colors, transparent backstyles, report banding, and more. For examples and steps, see the Formatting Documents chapter of the Report Services Document Creation Guide.

9 Group and sort the data, as required, as described in the Grouping and Sorting chapter in the Report Services Document Creation Guide.

10 Add totals, if required, as described in the Adding Text and Data to Documents chapter of the Report Services Document Creation Guide.

Save the dashboard-style document

11 From the Home menu, select Save. The Save As dialog box opens.

12 Type a name for the dashboard-style document and click OK.
Designing a dashboard-style document with the Blank Document template

You can create a dashboard-style document using the standard MicroStrategy document template, which is named the Blank Document; all the standard document sections are displayed by default. However, you can hide or display sections to help you create a dashboard-style document.

For steps, see the Report Services Document Creation Guide.

Creating document templates

In Developer, you can create new document templates to:

- Create the template from scratch, using Developer, as described in To create a new template for dashboard-style documents, page 58.

- Import and export dashboard-style documents between projects to use as document templates, as described in To export a document template, page 59, and To import a document template, page 59.

- Copy dashboard-style documents across projects using portable documents. Unlike a document template imported and exported between projects, a portable document can contain dependencies on schema or application objects, such as a dataset. After importing a portable document into a project, you reconcile the document to the new project. For more details on portable documents and the reconciliation process, including reasons to use them and instructions, see the Report Services Document Creation Guide.

To create a new template for dashboard-style documents

If you want a dashboard-style document to be available as a template so that you can format your other dashboard-style documents based on it, either save it or copy it to the following folder in Developer:

Project name\Object Templates\Dashboards

The dashboard-style document will then be available as a template for selection in the New Document dialog box in MicroStrategy Developer or the Create Document page in MicroStrategy Web, when you create a new document or dashboard-style document.
The Object Templates folder is hidden by default. To display it, follow the directions below.

**To display the hidden Object Templates folder**

1. In Developer, from the **Tools** menu, select **Developer Preferences**. The Developer Preferences dialog box opens.

2. In the list of categories on the left, expand **Developer**, and then click **Browsing**.

3. Select the **Display Hidden Objects** check box and click **OK**.

**To export a document template**

In Developer, a document or dashboard-style document can be exported from one project and then imported into another project to use as a template to create a new document or dashboard-style document. The document or dashboard-style document cannot have any dependencies on schema or application objects, such as a dataset.

1. In Developer, select the document or dashboard-style document to export.

2. From the **Tools** menu, select **Export Document Template**. The Browse for Folder dialog box opens.

3. Navigate to the folder to save the file in, then click **OK**.

   The document, named `document_name.rst`, is saved in the selected folder.

**To import a document template**

In Developer, after you export a document or dashboard-style document from one project, you can import it into another project to use it as a template to create new documents and dashboard-style documents.

1. From the **Tools** menu in Developer, select **Import Document Template**. The Open dialog box opens.
2 Navigate to and select the file to import as a document template.

3 Click **Open**.

The document template is saved in the **Object Templates\Documents** folder in Developer.

### Exporting dashboard-style documents to Flash for stand-alone use

After you create a dashboard-style document, adding widgets, selectors, and other Flash content, users can view it and interact with it in Flash Mode. If you export the dashboard-style document to a Flash file, users can also view it and interact with it off-line, without a connection to MicroStrategy Intelligence Server or MicroStrategy Web Server. The Flash file is a fully interactive, stand-alone Flash dashboard-style document. The Flash file allows HTML content, images, Flash content, and other types of information to be exported in a single file that can be opened by an Internet browser.

For background information on exporting dashboard-style documents to Flash, including whether to export to an MHT file or PDF file, see the **Document and Dashboard Analysis Guide**.

---

**To export a dashboard-style document to Flash**

1 In MicroStrategy Web, click the name of the dashboard-style document to execute it.

2 From the **Home** menu, select **Export**, then select **Flash**.

   If the **Flash** option is unavailable, that export format has not been made available for this dashboard-style document. For steps, see the **Report Services Document Creation Guide**.

3 Name and save the file. Do not change the file type.
Formatting dashboard-style documents

Determining the display modes users can choose to work in

The document designer can select the modes that are available for a specific document by enabling each mode that you want to make available for users to view the document.

For descriptions of the modes, see Display modes in MicroStrategy Web, page 3.

To select display modes to be available to users

1. In MicroStrategy Web, open a document in Design or Editable Mode.
3. From the left, select Document.
4. To make a mode available in the document, select the check box in the Available display modes column for that display mode. For example, if you want to ensure that Flash Mode is the only display mode available for the document to be viewed in, select that check box.
5. Clear the check boxes for any display modes that you do not want users to have access to for this document.
6. Click OK to apply the changes and return to the document. The next time the document is executed, only the display modes that you selected are available in the View menu or on the Standard toolbar.

Enabling transition animations in Flash

You may notice that when controls such as Grid/Graphs and panel stacks are first displayed in Flash Mode, they fade in as they are being displayed. These visual animations are transitions that you can enable in Grid/Graphs and panel stacks. For example, you can specify whether a transition animation takes place when a user chooses an item in a selector that affects a Grid/
Graph. The affected Grid/Graph can fade slowly onto the screen once a user selects an item from a selector in the dashboard-style document.

You can select the type of transition to use and also the speed of the transition. Examples of the types of transitions include Blur, Fade, and Wipe Down. The speed can be:

- Very slow
- Slow
- Medium
- Fast
- Very fast

You can also set the speed to automatic; the speed is then determined by the type of transition.

To enable a transition animation for Flash Mode (Web)

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.

2. Right-click the Grid/Graph or panel stack to update, and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3. From the left, select **Flash**.

4. From the **Selected Transition** drop-down list, select a type of transition animation for the object. This is the animation that is applied when users switch to Flash Mode.

5. From the **Speed** drop-down list, select how quickly the transition animation takes place. If you select **Automatic**, the speed is determined by the type of transition.

6. Click **OK** to apply the changes and return to the dashboard-style document.

To view the transition animation, you must open the dashboard-style document in Flash Mode.
Uncluttering the dashboard-style document: Full Screen mode

You may want Web users to view a dashboard-style document or other document without all the navigation information—toolbars, menus, and panels such as the Datasets pane—located on the interface. Hiding the navigation information:

- Focuses attention on the data itself
- Allows easier analysis of the data by maximizing the amount of the dashboard-style document that can be shown at one time

This view in MicroStrategy Web is called Full Screen mode, and it is particularly helpful when analyzing a dashboard-style document that contains multiple Grid/Graphs, sections, and images. Full Screen mode helps you create interfaces that are easy for users to read.

For example, the first image below shows a Shipping Analysis dashboard. The screen area at the top is used by the various MicroStrategy Web toolbars and menus. The same dashboard-style document is viewed in Full Screen mode in the second image. More of the dashboard-style document is displayed in the same space.

### Shipping Analysis

The Shipping Timeliness report focuses on the effectiveness of the Distribution Centers in fulfilling orders. Days to Ship represents the number of days between an Order's Order Date and Ship Date.

<table>
<thead>
<tr>
<th>Region</th>
<th>Percent of Orders Shipped by Days to Ship</th>
<th>Order Fulfilment by Days to Ship</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fargo</td>
<td><img src="chart.png" alt="Chart" /></td>
<td><img src="table.png" alt="Table" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Days to Ship</th>
<th>Number of Orders</th>
<th>Order Totals (K)</th>
<th>% Orders Shipped</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>219</td>
<td>45</td>
<td>8%</td>
</tr>
<tr>
<td>2</td>
<td>148</td>
<td>37</td>
<td>10%</td>
</tr>
<tr>
<td>3</td>
<td>1,023</td>
<td>422</td>
<td>50%</td>
</tr>
<tr>
<td>4</td>
<td>1,193</td>
<td>257</td>
<td>91%</td>
</tr>
</tbody>
</table>
Shipping Analysis

The Shipping Timeliness report focuses on the effectiveness of the Distribution Centers in fulfilling orders. Days to Ship represents the number of days between an Order’s Order Date and Ship Date.

<table>
<thead>
<tr>
<th>City</th>
<th>Percent of Orders Shipped by Days to Ship</th>
<th>Order Fulfillment by Days to Ship</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fargo</td>
<td>![Fargo chart]</td>
<td>![Fargo table]</td>
</tr>
<tr>
<td>Milwaukee</td>
<td>![Milwaukee chart]</td>
<td>![Milwaukee table]</td>
</tr>
</tbody>
</table>

MicroStrategy Web’s core set of toolbar buttons and the Grouping panel still appear in Full Screen mode, so the user can interact with the dashboard-style document as usual.

- The toolbar buttons allow you to quickly switch viewing modes, save, print, export, and deliver the dashboard-style document, among other tasks.
- The Grouping panel allows you to display the different groups of data in the dashboard-style document.

Full Screen mode is available in MicroStrategy Web only; you cannot use it in Developer. The following procedure shows you how to ensure a dashboard-style document opens in Full Screen mode by default.

**To have a dashboard-style document open in Full Screen mode**

1. In MicroStrategy Web, open a document in Design or Editable Mode.
3. From the left, select **Document**.

4. In the General area, select the **Always open this document in full screen mode** check box.

5. Click **OK** to apply the changes and return to the dashboard-style document.

The next time this dashboard-style document is opened, it is displayed in Full Screen mode. Users can switch between Full Screen mode and normal view by clicking the Full Screen Mode icon.
Introduction

A control is any selectable item in a dashboard-style document’s layout area. This can be a text field, line, rectangle, image, panel, panel stack, selector, or Grid/Graph object. When designing a dashboard-style document, controls are organized together in small groups. These groups of controls are placed in a holder called a panel. Because the controls are grouped together on a panel, they can be presented to the dashboard-style document user one group at a time. This lets the designer create several different views (or panels) of data, each view (panel) containing a logical grouping of controls that display data that is related in some meaningful way.

A panel stack is a collection of individual panels, stacked on top of each other. Only one panel can be displayed at a time. An analyst can flip from panel to panel within a dashboard-style document’s panel stack, displaying exactly the set of information he wants to see grouped together on the screen.
About panels and panel stacks

A control is a Grid/Graph, text field, shape, and so on. You can display different controls in a dashboard-style document so that users can navigate them as if they were pages or subsets of the larger document. These “pages” or layers of data are called panels, and a group of panels is referred to as a panel stack. Panel stacks allow a designer to create several different views (panels) of data, with each view (panel) containing a logical grouping of controls that display data that is related in a meaningful way.

Panels are essential building blocks for interactive dashboard-style documents, which summarize key business indicators in easy-to-read interfaces. For an in-depth explanation of dashboard-style documents, see *What is a dashboard-style document?, page 26.*

Use panel stacks to provide interactive data layering. You can create:

- Stacks of analytic layers on a single dashboard-style document page by creating two panels, each containing a different Grid/Graph. In Interactive Mode, Editable Mode, and Flash Mode, a user can flip between the panels, quickly replacing one Grid/Graph with the other. Using panels in this fashion permits many independent layers of data within a single dashboard-style document page.

- Multiple layers of dashboard-style documents by adding multiple controls to each panel of a panel stack. This creates layers of complex dashboard-style documents.

- An Information Window, to display additional information about an object. When a user clicks the object, the Information Window pops up over the object, displaying an additional visualization or additional information, based on the object. Information Windows are displayed in Express Mode and Flash Mode, and in documents displayed in MicroStrategy Mobile. For an example and instructions to create an Information Window, see *Defining Information Windows, page 90.*

- A panel of selectors, which allows users to filter targets and interact with the various filters (for an example and a more detailed description, see *Filtering a dashboard-style document: Filter panels, page 96*).

The first two methods are described in the examples that follow, *Example: Layering Grid/Graphs on panels, page 69* and *Example: Layering multiple dashboard-style documents in a single document, page 70.*
The rest of the chapter describes how to create and format panels and panel stacks:

- *Defining the parts of a panel stack, page 72*
- *Inserting and defining panels, page 75*
- *Loading panels on demand, page 87*
- *Formatting panels and panel stacks, page 102*

These procedures apply to panel stacks and to filter panels, with the following exceptions:

- For instructions to create a filter panel, see *Filtering a dashboard-style document: Filter panels, page 96.*

- Filter panels have an additional setting that determines whether or not changes to the selectors on the filter panel are automatically submitted. For instructions to change this setting, see *Controlling how data updates in a filter panel: Automatic apply, page 100.*

**Example: Layering Grid/Graphs on panels**

For example, you can stack two panels, each containing a different Grid/Graph. In Interactive Mode, Editable Mode, and Flash Mode, a user can flip between the panels, quickly replacing one Grid/Graph with the other. In the following image, a Grid/Graph is displayed on a panel. Notice the name of the panel, in the title bar at top of the panel: Employee Info by Region. Notice also that the Grid/Graph is the only control on the panel.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Cost</th>
<th>Profit</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$720,449</td>
<td>$126,778</td>
<td>$847,227</td>
</tr>
<tr>
<td>Central</td>
<td>Gale</td>
<td>Loren</td>
<td>$1,416,036</td>
<td>$253,254</td>
<td>$1,669,290</td>
</tr>
<tr>
<td>Central</td>
<td>Torrison</td>
<td>Mary</td>
<td>$1,430,865</td>
<td>$259,465</td>
<td>$1,690,350</td>
</tr>
<tr>
<td>Central</td>
<td>Zemlicka</td>
<td>George</td>
<td>$697,693</td>
<td>$124,807</td>
<td>$822,500</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$901,702</td>
<td>$158,930</td>
<td>$1,060,632</td>
</tr>
</tbody>
</table>

Above the Grid/Graph is a list box containing the names of the panels in the panel stack: Employee Info by Region and Category Sales Report. When you select the Category Sales Report, the other panel is displayed. Notice the name of the panel in the title bar: Category Sales Report. Also, notice that
this panel includes a text field in addition to the Grid/Graph. The text field reads “Forecast based on 2002-2004 data.”

<table>
<thead>
<tr>
<th>Category Sales Report</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Month</strong></td>
</tr>
<tr>
<td>Jan 2006 Books</td>
</tr>
<tr>
<td>Jan 2006 Electronics</td>
</tr>
<tr>
<td>Jan 2006 Movies</td>
</tr>
<tr>
<td>Jan 2006 Music</td>
</tr>
</tbody>
</table>

Using panels in this fashion allows many independent layers of data within a single dashboard-style document page. You can also layer dashboard-style documents in a single document with the use of panels, as described in the next example.

The list box is a selector, a type of control which allows a user to interact with the panel stack. While selectors are discussed briefly throughout this section, more details on creating them and examples of their various options are provided in *Chapter 4, Providing Interactivity to Users: Selectors.*

**Example: Layering multiple dashboard-style documents in a single document**

The example above placed only one or two controls (Grid/Graphs and a text field) on each panel. However, you can add multiple controls to each panel of a panel stack, creating layers of complex dashboard-style documents. For example, the following dashboard-style document contains a gauge for corporate revenue, a bubble graph for category analysis, a line graph for regional performance, and a grid report for subcategory analysis. A button bar labeled Select View is displayed at the top left of the dashboard-style document, and the Corporate button is currently selected. This
dashboard-style document provides a company-wide view of revenue and performance.

If you click Regional in the Select View button bar, another dashboard-style document is displayed. As shown below, this dashboard-style document contains an area graph for daily revenue, a grid report for category analysis,
and a bar graph for subcategory revenue. This dashboard-style document provides a more detailed view of information, at the regional and daily level.

Each of these dashboard-style documents is on a panel, and the Select View button bar is a selector that allows you to switch between the panels. Using panels to layer multiple dashboard-style documents in the same document can organize related information and provide increasing levels of detail on different dashboard-style documents.

**Defining the parts of a panel stack**

The **panel stack** is the holder for a group of panels. You must add a panel stack before you can insert more panels (a new panel stack already contains one panel). The **panels** contain the controls (Grid/Graphs, text fields, and so on) that display the data, such as metrics and graphs, that a user sees. A filter panel contains selectors only. (For information about filter panels, which allow users to filter targets and interact with the various filters, see *Filtering a dashboard-style document: Filter panels, page 96.*)
The border of the panel stack is visible to the user. The border settings include 3D borders, drop shadows, and rounded corners (displayed in Flash Mode), as well as standard border options such as color and style. The background color comes from the individual panel; you can format each panel to have a different background color.

Most of the settings that control a group of panels are set in the panel stack. These settings include whether a title bar or pop-up text is displayed, as well as size and position information.

The **title bar**, when displayed, is an area across the top of the panels that shows the title. You can choose whether the title bar displays the name of the panel stack or of the panel currently being displayed. By default, the title bar also displays Next and Previous arrows to allow users to change panels, although you can hide these arrows. For an example of the arrows, see *Panel selector arrows on the title bar, page 79.*

The **current panel** is the panel currently displayed in Design Mode. This panel is displayed on the panel stack when the dashboard-style document is viewed by the analyst.

If a panel stack contains more than one panel, a user needs a way to change panels. By default, the title bar displays arrows that allow users to move through the panels. If you choose to hide the arrows or hide the title bar, you need to add a **selector**, such as a radio button or pull-down list, to allow users to display the different panels of a panel stack.

- When a user switches to PDF View (MicroStrategy Developer) or to Express Mode, whichever panel was current becomes the only panel displayed, as well as the only panel that can be printed. The user cannot change to a different panel in PDF View or Express Mode.
- In Interactive Mode, Editable Mode, and Flash Mode, a user can click the selector to switch panels.

A selector is not part of a panel stack, unlike the other items described in this section. A selector is a different type of control and is added to the dashboard-style document separately. The title bar, for instance, is an area of the panel stack, and each panel is contained in the panel stack. However, a selector is an important and necessary addition to a panel stack because a selector allows the user to switch panels. The selector can also display the names of the different panels, so that a user can tell at a glance which panel he wants to view. The default arrow selectors on the title bar do not display the panel names. For more information, including examples and procedures, about selectors, see *Chapter 4, Providing Interactivity to Users: Selectors.*
The following diagram shows a panel stack and the selector that targets it, in Design Mode. The panel is the light gray area containing the text fields Region and Revenue. The title bar is the darker gray area at the top, labeled Panel1. The panel stack border is displayed as a thick black line; note that it surrounds the entire panel, including the panel and the title bar. The selector (labeled Elements Selector) is a separate control placed above the panel stack. The selector allows the user to choose the region to display.

The following diagram shows the same panel stack and selector in Interactive Mode. The panel, panel stack, and border appear the same, except that the text fields have been replaced by data. The selector is rendered as a drop-down list of the regions. The Central region has been selected, so its data is displayed in the panel.

Panel stacks and automatic target maintenance for selectors

Selectors allow a user to display different metrics or different elements of attributes, custom groups, or consolidations in a panel stack (the target of the selector). Targets can be automatically maintained in a layout. This means that when you add a panel stack, the panel stack automatically becomes the target of all selectors in the same panel or document section as the panel stack. For more information about automatically maintaining
targets for selectors, including instructions to enable and disable the functionality, see *Automatically maintaining targets for selectors, page 169.*

Selectors can also allow a user to flip through the panels in a panel stack. Targets are not automatically maintained for this type of selector; you always manually define the targets for panel selectors.

**Inserting and defining panels**

To insert and define panels, follow the high-level steps below:

1. Insert a panel stack (the holder for the panels). A single panel is automatically added to the panel stack. For instructions, see *Inserting a panel stack, page 76.*

2. By default, the title bar, which displays either the panel stack title or the panel name to help identify the panel stack, is displayed. The title bar also displays, by default, arrows to allow users to flip through the panels. For instructions to hide and display the title bar, and examples of a title bar, see *Displaying the title bar of a panel stack, page 77.* For instructions to hide and display the arrows, and an example of the arrows, see *Panel selector arrows on the title bar, page 79.* (If you hide the arrows or the title bar, you should add a selector to allow users to switch between panels, as described below.)

3. Insert as many additional panels as you need to hold the layers of data. For instructions, see *Inserting additional panels in a panel stack, page 82.*

4. Add controls to each panel, to display the data. You can add Grid/Graphs, text fields, shapes, images, and panel stacks, just as you can to a dashboard-style document. For a brief description of these controls, see *Chapter 1, Document Review*; for more detailed descriptions, including examples and procedures, see the *Report Services Document Creation Guide.*

   The default sort order for the data displayed on a panel depends on the data displayed on the panel, and the default sort for the displayed attributes. To change the sort order, see the *Report Services Document Creation Guide.*

5. Panels are displayed in the order in which they were added. If you want to display them in a different order, move the panels to reorder them. For an
example and instructions, see Changing the display order of panels, page 85.

6 Ensure that the correct panel will be displayed when the user initially views the dashboard-style document. For instructions, see Choosing the panel to display initially: the current panel, page 86.

7 Determine how to load panels in panel stacks when the dashboard-style document is viewed. All the panels can be pre-loaded, or only the first panel. For instructions, see Loading panels on demand, page 87.

   • When all the panels are pre-loaded, they display immediately when the user selects a different panel.

   • However, if the user is unlikely to access all the panels in a panel stack, or if you want to optimize the initial load time of the dashboard-style document, you can specify that the panels load only when a user changes to a different panel. Note that this on-demand panel loading only occurs when the dashboard-style document is executed with DHTML enabled.

8 Format the panel stack, panels, and title bar (if displayed). For examples and procedures, see Formatting panels and panel stacks, page 102.

9 (Optional) Add a selector to allow the user to switch between panels. See Chapter 4, Providing Interactivity to Users: Selectors.

   By default, the title bar displays arrows that allow users to move through the panels. If you choose to hide the arrows or hide the title bar, add a selector, such as a radio button or pull-down list, to allow users to switch between the different panels of a panel stack. A selector can also display the names of the different panels, so that a user can tell at a glance which panel he wants to view. The arrow selectors on the title bar do not display the panel names.

Inserting a panel stack

To create panels, you must first insert a panel stack (the holder for the collection of panels) into the dashboard-style document. A new panel stack already shows a single panel by default. After you insert a panel stack, you can add more panels to it.
The following procedure walks you through inserting a panel stack.

For instructions to add a filter panel to a dashboard-style document, see *Filtering a dashboard-style document: Filter panels, page 96*. A filter panel is a type of panel stack that contains only selectors.

---

**To insert a panel stack**

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.

2. If you used the Blank Dashboard template to create the document, only one section is displayed. If you used a different template:
   - Expand the section where you want the panel stack by clicking the plus sign next to the section name.
   - You cannot add a panel stack in the Details section. Since controls in the Details section are repeated once per row of the dataset, the panel stack would be repeated on each row.

3. From the **Insert** menu, select **Panel Stack**. When you move the cursor to the Layout area, the pointer becomes crosshairs.

4. Click in the desired location in the Layout area. If you click and drag in the Layout area, you can size the panel stack. The panel stack is added to the dashboard-style document, with a single panel.

   A title bar containing the name of the panel is displayed at the top of the panel stack by default. For steps to display or hide the title bar, see below.

   For steps to insert additional panels, see *Inserting additional panels in a panel stack, page 82*.

---

**Displaying the title bar of a panel stack**

You can determine whether to display or hide the title bar at the top of a panel stack. When you insert a panel stack into a dashboard-style document, the title bar is displayed at the top of the panel stack by default.

The title bar displays either:

- The title of the panel stack
• The name of the current panel, to help identify what the user is looking at (default)

In the image below, a panel stack is displayed in Design Mode in Web. A title bar containing the title Revenue by Product Category is displayed at the top of a panel stack.

The same panel stack is displayed in the image below, with its title bar hidden.

For a filter panel (a type of panel stack that contains only selectors), the title bar allows a user to clear all filters, and expand or collapse all the filters. For an example of a filter panel with a title bar, as well as steps to create a filter panel, see *Filtering a dashboard-style document: Filter panels, page 96*. 
Panel selector arrows on the title bar

By default, the title bar of a panel stack displays **Next** and **Previous** arrows to allow users to change panels, as shown below:

In Developer, the Next and Previous arrows are displayed as shown below:

The arrow on the left allows a user to display the previous panel in the panel stack. The arrow on the right is grayed out because this is the last panel in the panel stack.

You can hide the panel selector arrows from users by following the steps in *To hide the panel selector arrows on the title bar, page 81*. Hiding the arrows also disables changing panels in iPad documents by horizontal swiping. For background information on using selectors in iPad documents, see the *Mobile Design and Administration Guide*.

If you hide the arrows or the title bar that they display in, you should create a selector that targets the panel stack and allows users to change panels. For instructions, see *Methods to create a selector, page 129*.

The following procedures walk you through displaying or hiding the title bar, displaying or hiding the panel selector arrows, and specifying the height of
the title bar. The instructions apply to panel stacks and to filter panels, which are a type of panel stack that contains only selectors. For steps to create a filter panel, see *Filtering a dashboard-style document: Filter panels, page 96.*

**Prerequisite**

- These procedures continue where the previous procedure, *To insert a panel stack, page 77*, finished. They assume you have already created a panel stack and are still in Design or Editable Mode.

---

**To display the title bar if it has been hidden**

1. Right-click the panel stack in the Layout area, and select **Properties and Formatting**. The Properties and Formatting dialog box is displayed.

2. From the left, select **General**.

3. Select the **Show title bar** check box.

4. By default, the name of the panel currently displayed on the panel stack is shown in the title bar. Therefore, Current Panel Name is selected in the Title drop-down list. To display the title of the panel stack instead:
   - From the **Title** drop-down list, select **Custom Title**.
   - The title of the panel stack is blank by default. To change it, type the desired text into the **Custom Title** field.

5. Click **OK** to apply the changes and return to the dashboard-style document. A title bar is displayed on the panel stack.

---

**To hide the title bar**

For a filter panel (a type of panel stack that contains only selectors), the title bar allows a user to clear all filters, and expand or collapse all the filters. If you hide the title bar on a filter panel, a user cannot make those changes. For background information on filter panels, including examples and
instructions, see *Filtering a dashboard-style document: Filter panels, page 96.*

1. Right-click the panel stack to modify and select **Properties and Formatting.** The Properties and Formatting dialog box is displayed.

2. From the left, select **General.**

3. Clear the **Show title bar** check box.

4. Click **OK** to apply the changes and return to the dashboard-style document. The title bar is removed from the panel stack.

---

**To display the panel selector arrows on the title bar**

1. Right-click the panel stack to modify and select **Properties and Formatting.** The Properties and Formatting dialog box is displayed.

2. From the left, select **General.**

3. In the Panel Stack area, select the **Allow current panel to be changed without selector** check box.

   Displaying the arrows also enables changing panels in iPad documents by horizontal swiping. For background information on changing panels in iPad documents, see the *Mobile Design and Administration Guide.*

4. Click **OK** to apply the changes and return to the dashboard-style document.

---

**To hide the panel selector arrows on the title bar**

1. Right-click the panel stack to modify and select **Properties and Formatting.** The Properties and Formatting dialog box is displayed.

2. From the left, select **General.**

3. In the Panel Stack area, clear the **Allow current panel to be changed without selector** check box.

   Hiding the arrows also disables changing panels in iPad documents by horizontal swiping. For background information on
using selectors in iPad documents, see the Mobile Design and Administration Guide.

4 Click OK to apply the changes and return to the dashboard-style document.

---

**To specify the height of the title bar**

By default, the height of the title bar is .2 inches, but you can change it.

1 Right-click the panel stack to modify and select **Properties and Formatting**. The Properties and Formatting dialog box is displayed.

2 From the left, select **Layout**.

3 Specify the height of the title bar in the **Fixed at** field in the Title height area.

4 Click OK to apply the changes and return to the dashboard-style document.

---

**Inserting additional panels in a panel stack**

Insert as many additional panels as you need to hold the layers of data.

When you add a panel, it is added after the currently displayed panel. For example, a panel stack contains Panel1, Panel2, and Panel3, in that order. Panel2 is displayed. A new panel (Panel4) is added. The order of the panels is now Panel1, Panel2, Panel4, and Panel3. That order can be changed; see *Changing the display order of panels, page 85* for instructions.

The new panel is now displayed on the panel stack. To continue with the example above, Panel4 is displayed instead of Panel2. It is therefore the current panel, which is displayed when a user views the dashboard-style document in another view. For more information about the current panel, and how to change it, see *Choosing the panel to display initially: the current panel, page 86*.

By default, panels are named Panel1, Panel2, and so on, but you can rename them. You may want to give the panels more meaningful names since the panel name is shown in the selector (the button bar or other object that allows a user to switch panels) and can be displayed in the title bar.
The following procedures walk you through inserting and renaming a panel. These instructions apply to panel stacks and to filter panels, which are a type of panel stack that contains only selectors. For steps to create a filter panel, see *Filtering a dashboard-style document: Filter panels, page 96*.

**Prerequisites**

- These procedures continue where the previous procedure, *Inserting a panel stack, page 76* or *Displaying the title bar of a panel stack, page 77*, finished. They assume you have already created a panel stack and are still in Design or Editable Mode.

- The panel stack must have its title bar displayed. When you insert a panel stack into a dashboard-style document, the title bar of the panel stack is displayed by default. For steps to display the title bar if it has been hidden, see *To display the title bar if it has been hidden, page 80*.

**To insert an additional panel in a panel stack**

1. Select the panel stack and pass your cursor under its title bar. A toolbar of icons is displayed.

2. Click the **Add Panel** icon.

   The new panel is added to the panel stack, after the selected panel. The new panel is displayed on the panel stack, which means that the new panel is set as the current panel.

3. To add text, a shape, a report, grid or graph, a panel stack, an HTML container, a selector, or a widget to the panel stack, click the **Insert** icon. A drop-down list is displayed. Select the object to insert, then click the location on the panel stack where you want to insert it.

   Note the following:

   - The floating toolbar does not include the option to insert auto text codes. For instructions to insert auto text codes, including a list of available codes, see the *Report Services Document Creation Guide*.

   - For a filter panel, you can only add selectors to the panel.

4. You can do any of the following:

   - Add another panel
• Rename a panel (see page 84)
• Change the display order of the panels (see page 85)
• Choose the panel to display initially (see page 86)

**To copy an existing panel**

1. Select the panel stack and pass your cursor under its title bar. A toolbar of icons is displayed.

2. If the panel that you want to rename is not displayed, click the **Previous Panel **or **Next Panel **icon ‣ to set the previous or next panel as the current panel, respectively.

3. Click the **Duplicate Panel **icon  . The new panel is added to the panel stack, after the selected panel. The new panel is displayed on the panel stack, which means that it is set as the current panel.

4. You can do any of the following:
   • Add another panel
   • Rename a panel (see below)
   • Change the display order of the panels (see page 85)
   • Choose the panel to display initially (see page 86)

**To rename a panel**

1. Select the panel stack and pass your cursor under its title bar. A toolbar of icons is displayed.

2. If the panel that you want to rename is not displayed, click the **Previous Panel** ‣ or **Next Panel** icon ‣ to set the previous or next panel as the current panel, respectively.

3. Click the **Rename Panel** icon  . The Rename Panel dialog box is displayed.

4. Type the new name for the panel in the **Name** field.
Click OK to return to the dashboard-style document. The new name is displayed in the title bar of the panel.

### Changing the display order of panels

The order in which you add panels to a panel stack affects the order in which they are displayed in the selector (such as a row of buttons) attached to the panel stack. For example, a panel stack contains three panels. By default, the panels are named Panel1, Panel2, and Panel3, in the order they were added. The selector attached to the panel stack is a button array. It displays Panel1 on the left, Panel3 on the right, and Panel2 in the middle, as shown below.

![Panel 1, Panel 2, Panel 3]

<table>
<thead>
<tr>
<th>Employee</th>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bates</td>
<td>Michael</td>
<td>Southwest</td>
<td>$1,068,907</td>
<td>$163,911</td>
<td>$904,996</td>
</tr>
<tr>
<td>Becker</td>
<td>Kyle</td>
<td>Northwest</td>
<td>$508,234</td>
<td>$77,887</td>
<td>$430,346</td>
</tr>
<tr>
<td>Bell</td>
<td>Caitlin</td>
<td>Southwest</td>
<td>$1,040,481</td>
<td>$157,039</td>
<td>$683,441</td>
</tr>
<tr>
<td>Benner</td>
<td>Ian</td>
<td>Southeast</td>
<td>$520,737</td>
<td>$79,664</td>
<td>$441,073</td>
</tr>
<tr>
<td>Bernstein</td>
<td>Lawrence</td>
<td>Mid-Atlantic</td>
<td>$1,060,632</td>
<td>$158,930</td>
<td>$901,702</td>
</tr>
</tbody>
</table>

If this display order is incorrect, you can move the panels to change the order. See the procedure below for instructions.

These instructions apply to panel stacks and to filter panels, which are a type of panel stack that contains only selectors. For steps to create a filter panel, see *Filtering a dashboard-style document: Filter panels, page 96.*

---

**To change the display order of panels**

This procedure continues where the previous procedure, *To insert an additional panel in a panel stack, page 83,* finished.

1. Select the panel stack and pass your cursor under its title bar. A toolbar of icons is displayed.
2 If the panel that you want to move is not displayed, click the Previous Panel ▲ or Next Panel icon ▼ to set the previous or next panel as the current panel, respectively.

3 Once you have selected the panel to shift in the stack, do one of the following:

- To incrementally move the selected panel backward, click the Move Panel Backward icon ➞.
- To incrementally move the selected panel forward, click the Move Panel Forward icon ➘.

Next, you can specify the current panel, which is the panel that is initially displayed.

Choosing the panel to display initially: the current panel

You can choose which panel should be displayed on the panel stack when users view the dashboard-style document. This is referred to as the current panel.

The current panel is displayed when a user first opens the dashboard-style document, but the user can change to a different panel by using a selector. If DHTML is enabled and panels are defined to load on demand, only the current panel is downloaded when the dashboard-style document is executed; other panels are loaded when the user requests them. If the panel stack is defined to pre-load all the panels, all the panels are downloaded when the dashboard-style document is executed. For more information about loading panels, including instructions, see Loading panels on demand, page 87.

In Developer, when a user switches to PDF View, the current panel is the only one displayed as well as the only one that can be printed.

The panel displayed in Design Mode is set as the current panel. If you add a panel to a panel stack, the new panel becomes the current panel. To select a different panel for the current panel, follow the instructions below.

These instructions apply to panel stacks and to filter panels, which are a type of panel stack that contains only selectors. For steps to create a filter panel, see Filtering a dashboard-style document: Filter panels, page 96.
To choose the panel to display initially

This procedure continues where the previous procedure, *To change the display order of panels, page 85*, finished.

1. Select the panel stack and pass your cursor under its title bar. A toolbar of icons is displayed.

2. Click the **Previous Panel**  或 **Next Panel** icon  to set the previous or next panel as the current panel, respectively.

Next, you can format the panel stack, individual panels, and (if displayed) the title bar. For steps, see *Formatting panels and panel stacks, page 102*.

Deleting a panel from a panel stack

**To delete a panel from a panel stack**

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.

2. If the panel that you want to delete is not displayed, click the **Previous Panel**  or **Next Panel** icon  to set the previous or next panel as the current panel, respectively.

3. Click the **Delete Panel** icon  . The panel below the deleted panel becomes the new current panel, which is the panel that is currently displayed.

Loading panels on demand

All the panels of a panel stack can load when the dashboard-style document is executed, even though only one panel is displayed to the user. This ensures that these pre-loaded panels display immediately when the user selects a different panel. However, if the user is unlikely to access all the panels in a panel stack, or if you want to optimize the initial load time of the dashboard-style document, you can specify that the panels load on demand.
When panels are loaded on demand, only one panel is loaded when the dashboard-style document is executed. Other panels are loaded only when the user selects them. The dashboard-style document therefore opens faster, although panels loaded on demand will take some time to load when they are selected. After a panel is loaded, it remains cached on the client until the dashboard-style document is closed.

On-demand panel loading occurs when the dashboard-style document is executed with DHTML enabled. In Developer, only the current panel is displayed, selectors are not active, and therefore other panels are not available. On-demand panel loading does not occur in Flash View (Developer) or Flash Mode (MicroStrategy Web).

If your browser supports DHTML, DHTML is enabled by default. For more information on DHTML, and instructions to enable it, see the MicroStrategy Web Help.

You can define how panels are loaded at two levels:

- For all the panel stacks in the document (the document-level setting)
- For each panel stack

This allows you to easily set different panel load settings for different panel stacks. For example, a dashboard-style document contains multiple panel stacks. You want to pre-load all the panels of all the panel stacks, except for the panel stack that contains many panels. At the document level, define the default panel load setting to pre-load all panels. For the specific panel stack, specify that only the current panel is pre-loaded. Instructions for both levels follow.

---

To specify the default panel load setting for all panel stacks in a dashboard-style document

The document-level setting applies to all panel stacks that use the default panel load setting. You can change the panel load setting for specific panel stacks as well, as described in To specify how to load panels for a specific panel stack, page 89.

This setting applies to all layouts of a multi-layout document. For a brief description of multi-layout documents, see Multi-layout documents, page 21; for more details, including examples and procedures, see the Report Services Document Creation Guide.

1 In MicroStrategy Web, open the document in Design or Editable Mode.
2 From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.

3 On the left, select **Advanced**, under Document Properties.

4 Choose one of the **Pre-load** options:

   - To pre-load all panels when the dashboard-style document is executed, unless the panel load setting for a specific panel stack is defined differently, select **All Panels of All Panel Stacks**.
   - To load only the current panel of all the panel stacks in the dashboard-style document, select **Current Panel Only of All Panel Stacks**. Other panels are loaded when the user requests them.

   Panels are loaded on demand when DHTML is enabled. For steps to enable DHTML, see the **MicroStrategy Web Help**.

5 Click **OK** to return to the dashboard-style document.

---

**To specify how to load panels for a specific panel stack**

1 In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2 Right-click the panel stack to modify and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3 From the left, select **General**.

4 Select one of the following **Pre-load (DHTML only)** settings:

   - To use the document-level setting, select **Inherit from Document**.
   - To pre-load all panels when the dashboard-style document is executed, select **All Panels**.
   - To load only the current panel when the dashboard-style document is executed, select **Current Panel Only**.

   Panels are loaded on demand when DHTML is enabled. For instructions on enabling DHTML, see the **MicroStrategy Web Help**.

5 Click **OK** to return to the dashboard-style document.
Defining Information Windows

Information Windows let users view additional information about an object by clicking it in Express Mode or Flash Mode. A user can click:

- An attribute on a Grid/Graph displayed as either a grid or a graph
- A button
- An image
- An item in a selector
- A text field

For example, a user clicks the attribute element Northeast in the grid shown below. The Information Window pops up over the element, displaying an additional visualization, based on the element. The grid and Information Window below are shown in Express Mode:

In this example, the Region column in the grid is used as a selector. When a user clicks an element in the column, the Information Window appears.

The Information Window is displayed in Flash Mode as well. In other display modes, the Information Window is displayed as a panel stack in the location that you added it to the dashboard-style document, not as a tooltip over the
Grid/Graph. The Information Window is still interactive, controlled by the Grid/Graph.

For examples of Information Windows with images and selectors, see the placement options below.

You can select the placement of the Information Window. Your options are:

- **Automatic**: The Information Window is displayed in the best position.
- **Fixed**: The Information Window is displayed at the position of the panel stack.
- **Above**: The Information Window is displayed above the selected object (for example, the item in the selector or the attribute in the grid), as shown below. The user has clicked the Music item in the link bar selector.
- **Below**: The Information Window is displayed below the selected object, as shown below. The user has clicked the Movies item in the button bar selector.
• **Left**: The Information Window is displayed to the left of the selected object, as shown below. The user has clicked the Electronics item in the button bar selector.

![Image of Revenue Contribution by Subcategory]

• **Right**: The Information Window is displayed to the right of the selected object, as shown below. The user has clicked an image to display the Information Window.

![Image of Revenue Contribution by Subcategory]

The following are suggestions for controls to add to an Information Window:

- Images, such as corporate logos or buttons. For instructions to add images to a dashboard-style document, see the *Report Services Document Creation Guide*.

- Data fields to display information about attributes and metrics in the dashboard-style documents, or other details. For example, you can add the `{Store@Name}` data field to an Information Window. When the store location is selected in the widget, the Information Window displays the name of the store. For instructions to add data fields to a dashboard-style document, see the *Report Services Document Creation Guide*.
• Links to other reports, dashboard-style documents, or documents. For steps to add a link to a dashboard-style document, see the Report Services Document Creation Guide.

You can create an Information Window for:

• A text field, image, or button. For steps, see Defining an Information Window for a text field, image, or button, page 93.

• A Grid/Graph or selector. For steps, see Defining an Information Window for a Grid/Graph or a selector, page 94.

**Defining an Information Window for a text field, image, or button**

The Information Window is displayed in Express Mode and Flash Mode when a user clicks the text field, image, or button.

**Prerequisites**

The following procedure assumes that the dashboard-style document contains:

• A panel stack that will be used as the Information Window. For instructions to create a panel stack, see Inserting and defining panels, page 75.

• The text field, image, or button that will be used to control the Information Window. For instructions to add a text field or image, see the Report Services Document Creation Guide or Web Help. For steps to add a button, see the Mobile Design and Administration Guide.

---

**To define an Information Window for a text field or image**

1. Open a dashboard-style document in **Design** or **Editable Mode** in MicroStrategy Web.

2. Right-click the text field, image, or button to use to control the Information window, and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3. From the left, select **General**.
4 From the **Panel Stack** drop-down list, select the panel stack to use as the Information Window.

5 Click **OK** to return to the dashboard-style document.

6 Right-click the panel stack to use as the Information Window, and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

7 From the left, select **General**. Note that the **Use as Information Window** check box is automatically selected.

8 Select **Title of panel stack** from the **Title** drop-down list.

9 Type a title in the **Title** field. This text is used as the title of the Information Window.

10 From the **Placement** drop-down list, select the location of the Information Window. For examples of the placement options, see page 91.

11 Click **OK**.

12 Save the dashboard-style document.

**Defining an Information Window for a Grid/Graph or a selector**

The Information Window is displayed in Express Mode and Flash Mode when a user clicks an attribute element on a Grid/Graph or an item on a selector.

**Prerequisites**

The following procedure assumes that the dashboard-style document contains:

- A panel stack that will be used as the Information Window. The panel stack must contain data related to the Grid/Graph used as a selector. In the example on page 90, the panel stack contains a pie chart representation of yearly revenue by region. For instructions to create a panel stack, see *Inserting and defining panels, page 75*.

- Either of the following:
A Grid/Graph used as a selector. This control must target the panel stack and contain data related to the data in the panel stack. In the example on page 90, the Region attribute is used as the selector in the Grid/Graph, targeting the panel stack. For instructions to create a Grid/Graph, see the Report Services Document Creation Guide. For instructions to define the Grid/Graph as a selector, see Using Grid/Graphs as selectors to control other Grid/Graphs, page 219.

A selector that targets the panel stack and contains data related to the data in the panel stack. In the example on page 91, the Category attribute is used in the selector, which targets the panel stack. For instructions to create a selector, see Methods to create a selector, page 129.

To define an Information Window for a Grid/Graph or selector

1. Open a dashboard-style document in Design or Editable Mode in MicroStrategy Web.

2. Right-click the panel stack, and select Properties and Formatting. The Properties and Formatting dialog box opens.

3. From the left, select General.

4. Select the Use as Information Window check box.

5. Select Title of panel stack from the Title drop-down list.

6. Type a title in the Title field. This text is used as the title of the Information Window.

7. From the Placement drop-down list, select the location of the Information Window. For examples of the placement options, see page 91.

8. Click OK.

9. Save the dashboard-style document.
Filtering a dashboard-style document: Filter panels

A filter panel is a type of panel stack that contains only selectors, which users interact with to filter the data displayed in a dashboard-style document. For example, a dashboard-style document displays sales data by product category for the years 2007 to 2010. A user can filter the data to display sales data for only the books and movies categories, and only for 2010.

The filter panel in the following dashboard-style document, shown in Express Mode, contains selectors that target the grid report. The three selectors filter the grid report for region, employee, and revenue.

An analyst can use the selectors to filter the data on the grid report, as shown below.
• The analyst has selected Central, Mid-Atlantic, Northeast, and Northwest in the region selector. Notice that the title of the region selector indicates that four of the eight elements are selected.

• The analyst collapsed the employee selector, to focus on the selectors that she is using.

• The analyst has selected a revenue range of $933,237 to $1,845,606, which explains why only two regions of the selected four are displayed. (The other two regions do not have employee revenue that falls within the selected range.)

In Express Mode and Flash Mode, an analyst can:

• Filter the target by using the various selectors on the filter panel

• Expand and collapse each selector on the filter panel, using the Expand and Collapse icons on each selector

• Expand and collapse all the selectors on the filter panel, using the drop-down menu on the filter panel

• Clear a selector, using the Clear Selector icon on each selector

• Clear all the filters on the filter panel, using the Clear All Selectors icon on the filter panel
The drop-down menu on the filter panel is shown in Express Mode:

![Filter the report](Image)

By default, changes made to the selectors on the filter panel are automatically applied to the targets. You can change the automatic apply setting so that an Apply button is displayed on the filter panel. When a change is made to a selector on the filter panel, the Apply button is enabled. For a more detailed description, including examples, and instructions, see Controlling how data updates in a filter panel: Automatic apply, page 100.

On an iPad with MicroStrategy Mobile, an analyst can:

- Filter the target by using the various selectors on the filter panel
- Expand and collapse each selector on the filter panel
- Clear all the filters on the filter panel

### To insert a filter panel

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Expand the document section where you want the filter panel by clicking the plus sign next to the section name. You cannot add a filter panel to the Details section.
3. From the **Insert** menu, select **Filter Panel**.
4. Click in the desired section of the Layout area. The filter panel is added to the document, with a single panel.
5. By default, the filter panel displays a title bar, which allows the user to clear all filters, and expand or collapse all the filters. If you remove the title bar from a filter panel, a user cannot make those changes. For steps to remove the title bar, see To hide the title bar, page 80.
6. You can change the position or size of a filter panel, and format titles, borders, background color, and title bar. To do so, right-click the panel stack and select **Properties and Formatting**. The Properties and
Formatting dialog box is displayed. For steps to format the panel stack, see *Formatting panels and panel stacks, page 102*.

7 You can change the panel name, which can be displayed on the title bar or on a selector that allows users to switch between panels. For steps, see *To rename a panel, page 84*.

8 Add a selector to the filter panel by following the steps below:
   a Select the panel stack and pass your cursor under its title bar. A toolbar of icons is displayed.
   b Click the **Insert** icon.
   c From the drop-down list that opens, select a style of selector. (For examples of each selector style, see *Defining a selector, page 124*.)
   d Right-click the selector and choose **Properties and Formatting**. The Properties and Formatting dialog box opens.
   e From the left, choose **General**.
   f By default, a title bar is displayed for the selector. The title bar can help to identify what the user is looking at, and also allows the user to expand and collapse the selector in the filter panel. For element selectors, the number of selected elements is displayed in the title bar.
   g Type a title for the selector in the **Title** field. If you leave this field blank, the selector's name is displayed in the title bar by default.
   h From the left, choose **Selector**. Follow the steps in *Methods to create a selector, page 129*, to define the selector, including selecting the source, the metric qualification (value or rank), the action type, the targets, and so on.
   i Repeat these steps for each selector that you want to add to the filter panel.

9 The selectors in the filter panel are displayed vertically, in the order that they were added. To change the order, drag and drop a selector to its new position.

10 You can add more panels to the filter panel, as described in *Inserting additional panels in a panel stack, page 82*.

11 If the filter panel contains multiple panels, users can flip through the panels using the arrows on the title bar. You can also add a selector to allow change the displayed panel. For steps, see *Chapter 4, Providing Interactivity to Users: Selectors*. 
Panels are displayed in the order in which they were added. For steps to display them in a different order, see Changing the display order of panels, page 85.

To ensure that the correct panel will be displayed when the user first views the dashboard-style document, select the filter panel and pass your cursor near the top of it. A toolbar of icons is displayed. Then click the Display Previous Panel or Display Next Panel icon until the panel that you want to be the current panel is displayed.

Controlling how data updates in a filter panel: Automatic apply

By default, once a user chooses an item in selector on a filter panel, the target immediately and automatically updates without any additional user interaction. If a user selects multiple items, the target is automatically updated after each individual selection, which can take some time. Instead, you can disable automatic application of selector changes, allowing a user to select items in the selector, then choose when to apply the selections to the target. If changes are not made automatically, the Apply Now icon is displayed on the filter panel but is disabled; when a change is made to a selector on the filter panel, the Apply Now icon is enabled.

For example, the dashboard-style document shown below in Express Mode contains a Grid/Graph that is currently displaying all regions. Automatic application is disabled for the filter panel. A user has selected Northeast and Northwest in the Region selector on the filter panel, and the Apply Now icon is enabled. Once the user clicks the icon, the Grid/Graph will be updated to display only those two regions.
Filter panels are fully interactive in Express Mode and Flash Mode. In other modes, filter panels work as panel stacks with selectors; the drop-down menu to interact with the filter panel is not available. (The menu allows users to expand and collapse selectors, for example. For a complete list of actions, see *Filtering a dashboard-style document: Filter panels, page 96.*)

The **Automatically apply selector changes** setting for a filter panel applies in Express Mode and Flash Mode. The **Automatically apply selector changes** setting at the document level applies to selectors in a filter panel displayed in other modes. (For a description of the document level setting, see *Controlling how data updates: Automatically apply selector changes, page 182.*)

The dashboard-style document shown below in Interactive Mode has automatic application disabled at both the filter panel and document level. The dashboard-style document contains a selector that is not on a filter panel (the metric selector). All metrics are currently displayed, but the user has clicked Revenue in the metric selector. The Apply button displays in a floating toolbar; once the user clicks the button, the Grid/Graph will be updated to display only Revenue.

For instructions to enable the floating toolbar, see the *MicroStrategy Web Help.*

**Prerequisite**

- The following procedure assumes that the document contains a filter panel with selectors. For instructions to add a filter panel, see *To insert a filter panel, page 98.*
To enable or disable automatic target update for a filter panel

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Right-click the filter panel and select Properties and Formatting. The Properties and Formatting dialog box opens.
3. Select General in the list on the left.
4. Do one of the following to determine how targets are updated for the filter panel:
   • To enable automatic target update, select the Automatically apply selector changes check box.
   • To disable automatic target update, clear the Automatically apply selector changes check box.
5. Click OK to save your changes and return to the dashboard-style document.

Formatting panels and panel stacks

When you insert a panel stack into a document or dashboard-style document, its formatting is determined by the control default for panel stacks. Each control type (text field, selector, panel stack, and so on) has a control default, which contains a full set of formatting settings to specify the default format. For more information on control defaults, including how to apply them and how to change them, see the Report Services Document Creation Guide.

Formatting a filter panel, which is a type of panel stack that contains only selectors, is the same as formatting a panel stack.

You can change the formatting of each new panel stack as desired. You can use different interfaces to define the formatting. Which interface you use depends on your personal preference and what options you want to change. For more information on the different formatting interfaces, see Methods to format panels and panel stacks, page 104.

For panel stacks, you can apply different formats to different parts of the control (see Defining the parts of a panel stack, page 72 for detailed
The following table summarizes the formatting options available for each part of a panel stack.

<table>
<thead>
<tr>
<th>Panel Stack Part</th>
<th>Formatting Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Container</strong></td>
<td>• Borders, including 3D borders, drop shadows, and rounded corners (Flash only), as well as standard border options such as color and style</td>
</tr>
<tr>
<td>The object that holds the actual control</td>
<td>For steps, see <em>Formatting panel stack borders, page 106</em> and <em>Displaying rounded corners on panel stacks (Flash Mode only), page 107.</em></td>
</tr>
<tr>
<td><strong>Title bar</strong></td>
<td>• Font</td>
</tr>
<tr>
<td>(Optional) Displays a title to identify the panel</td>
<td>• Background color options, including gradients</td>
</tr>
<tr>
<td>For steps, see <em>Formatting the title bar of a panel stack, page 109.</em></td>
<td></td>
</tr>
<tr>
<td><strong>Individual panels</strong></td>
<td>• Background color options, including gradients</td>
</tr>
<tr>
<td>The different “pages” or layers of information in a panel stack</td>
<td>For steps, see <em>Formatting the background of a panel, page 110.</em></td>
</tr>
</tbody>
</table>

**Example: Formatting a panel stack**

The following images contain a selector as well as a panel stack. The panel stack (the holder for the panels) contains two panels, named Panel1 and Panel2, and a title bar. The selector, which is displayed as a button bar, allows you to switch between panels. The formatting of the selector is not discussed in this section; for information on formatting selectors, see *Formatting selectors, page 205.*

The panel stack container has a raised 3D effect, visible around the border of the panel stack, including the title bar. The title bar, which displays the text “Panel2” in the sample below, is formatted grey with italicized text.
In the image above, the panel named Panel2 is displayed, and its background is white. In the image below, Panel1 is displayed. Its background uses gradient colors, blending from black to grey.

Notice that the formatting of the border and the title bar do not change when different panels are displayed. Borders are applied to the panel stack and the title bar formatting is the same for all panels.

**Methods to format panels and panel stacks**

You can change the formatting and other properties for panels and panel stacks by using any of the following methods:

- For layout properties (such as name, position, and size) and properties specific to selectors such as action type and targets, use the Properties and Formatting dialog box. For panel stacks, these properties include position, size, and title bar information. For panels, these properties include the name. All other properties are defined for the panel stack as a whole.

- For the border style of the panel stack and the background fill of the current panel, use the Format options in the Properties dialog box. You can also set a gradient color, which is a gradual color change between two colors, for the current panel.

- For easy access to the following, use the Formatting toolbar:
  - Background fill for the current panel.
  - Line color for the current panel.
  - Borders of the panel stack.

- Right-click options for alignment, sizing, and ordering options.

The Formatting toolbar is the easiest to use, although it does not contain all of the available formatting options. The Properties dialog box provides all of the formatting options you can use to format panel stacks.
Useful formatting suggestions

The following list provides some additional formatting suggestions.

- Make the panel stack and all the panels in it appear three-dimensional, like a button, with the 3D effect. For an example on a panel stack, see Example: Formatting a panel stack, page 103; for steps, see Formatting panel stack borders, page 106.

- “Float” the panel stack and all the panels in it above the background by using a drop shadow. For steps, see Formatting panel stack borders, page 106.

- In Flash Mode, display rounded corners on the panel stack and all the panels in it. You can define the radius and select whether rounded corners are displayed for the top corners or all four corners. For an example and steps to display rounded corners, see Displaying rounded corners on panel stacks (Flash Mode only), page 107.

- Create a gradual color change by blending two colors using gradient colors. Each panel in a panel stack can have different gradient colors. For an example on a panel, see Example: Formatting a panel stack, page 103. For steps, see Formatting the background of a panel, page 110.

- Display pop-up text when a user positions the cursor over the panel stack with a tooltip. The tooltip can provide extra information, such as an expanded description of the panel stack. For steps to add a tooltip to a control, see the Report Services Document Creation Guide or the Web Help.

- Display information to other document designers in Design View while hiding it from users viewing the document in PDF View in Developer and Interactive Mode, Editable Mode, and Express Mode. To do this, you hide the control that contains the information by using the Visible option. For instance, you could include a graph with additional details about the data in a panel stack. For steps to hide a control, see the Report Services Document Creation Guide or the MicroStrategy Web Help.

- Enable a transition animation for Flash Mode. A transition animation is a visual transition that occurs when a panel is first displayed in Flash Mode. Examples are Blur, Fade, and Iris. For more information, see Enabling transition animations in Flash, page 61.

- You can determine how a panel stack is displayed when it is exported to Excel and PDF. You can specify whether or not to clip the contents of the panel stack if the contents of the panel stack are bigger than the panel stack itself. If the panel stack is clipped, you can determine whether to
export all the panels or only the current panel. For instructions and examples, see *Formatting a panel stack for export, page 112.*

**Formatting panel stack borders**

When you format the borders of a panel stack, the formatting applies to all panels in the panel stack. You can apply:

- A basic line border
- A 3D border to give the panel stack a three-dimensional appearance like a button
- Drop shadows, which float the panel stack on top of the background

You can also display rounded corners on the panel stack, in Flash Mode. For steps, see *Displaying rounded corners on panel stacks (Flash Mode only), page 107.*

**Prerequisite**

- The following procedure assumes that the dashboard-style document contains a panel stack or filter panel.

---

**To format the borders of a panel stack**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Right-click the panel stack to format and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
3. From the left, select **Color and Lines**.
4. From the first drop-down list at the top, select **Panel Stack**.
5. From the second drop-down list at the top, select **Body**.
6. To format basic borders:
   - To remove the entire border, click **None** in the Borders area.
   - To include all borders, click **All**. From the drop-down list, specify the line style to use as the border and then specify a color for the lines.
• To choose a border style, click **Custom**. From the drop-down lists, specify the line styles to use as the borders and then specify a color for each border.

7 To apply 3D borders:
   a From the left, select **Effects**.
   b Select the **Enable 3D Borders** check box.
   c From the **Effect** drop-down list, specify whether the 3D borders are **Sunken** (like a pushed button) or **Raised**.
   d Specify the thickness of the 3D borders in the **Weight** field.

8 To apply a drop shadow:
   a From the left, select **Effects**.
   b Select the **Enable Drop Shadows** check box.
   c Specify the distance between the panel stack and the drop shadow using the **Distance** slider.

9 Click **OK** to apply the formatting changes.

**Displaying rounded corners on panel stacks (Flash Mode only)**

A panel stack can have rounded corners instead of square, right-angle corners. Rounded corners are displayed in Flash Mode. In the following dashboard-style document sample, shown in Flash Mode, the panel stacks on the top have rounded corners, while the one on the bottom has straight corners.
The rounded corners settings apply to Flash Mode only. In PDF View in Developer or in other Web display modes, rounded corners display as square, right-angle corners.

You can control how rounded corners are displayed for panel stacks in Flash Mode by:

- Defining the radius, which sets how round the corners are. A larger radius produces a more rounded corner. The range is 1-20.
- Selecting whether rounded corners are displayed for all four corners or only for the top corners.

In the image above, notice that the corners of the panel stack on the upper right are more rounded than those on the upper left. The corner radius of the right panel stack is set to the maximum of 20, while the left panel stack has a radius of five. Notice also that the right panel stack has rounded corners on the top only, while all four corners of the left panel stack are rounded.

Rounded rectangles also use rounded corners. For information on rounded rectangles, see the Report Services Document Creation Guide.

**Prerequisite**

- The following procedure assumes that the dashboard-style document contains a panel stack.

---

**To display rounded corners for panel stacks in Flash Mode**

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.
2. Right-click the panel stack and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
3. From the left, select **Effects**.
4. Select the **Use rounded corners** check box.
5. Set the **Rounded corner radius** by using the slider. Higher numbers produce a more rounded corner, while lower numbers produce a straighter corner.
6 By default, all four corners are rounded. To round the top corners only, set Top corners only.

To view the effect, open the dashboard-style document in Flash Mode.

Formatting the title bar of a panel stack

You can format the background and height of the title bar of a panel stack.

Prerequisite

- The following procedure assumes that the dashboard-style document contains a panel stack or filter panel.

To format the title bar of a panel stack

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 Right-click the panel stack to format and select Properties and Formatting. The Properties and Formatting dialog box opens.

3 If the panel stack does not yet have a title bar, select General on the left. Then select the Show Title Bar check box.

4 To specify the height of the title bar:
   a From the left, select Layout.
   b Specify the height of the title bar in the Fixed at field in the Title height area.

5 To format the background fill of the title bar:
   a From the left, select Color and Lines.
   b From the first drop-down list, select Panel Stack.
   c From the second drop-down list, select Title.
   d Choose one of the following. As you make changes, the Sample area changes to show a preview of your selections.
To use a single color as the background, under Fill, select a color from the Color palette. Click More Colors to access additional colors.

To shade the title bar using gradient colors, which combine two colors, do the following:

a Under Fill, select Gradients from the Color palette. The Gradients dialog box opens.

b From the Color 1 and Color 2 drop-down lists, select the two colors to use for the gradient.

c Select a Shading Style to determine the direction in which the two colors are blended together.

d You can also select a Variant, which is the direction of the shading between the two colors. The Flash-only variant is a mirror-like gradient only displayed in Flash Mode.

e Click OK to save the gradients.

To allow what is behind the title bar to show through, set the Fill color to No Color.

6 Click OK to apply the changes and return to the dashboard-style document.

Formatting the background of a panel

All the panels in a panel stack can be the same color, or you can select a different color for each panel. Steps for each are provided below.

Prerequisite

- The following procedure assumes that the dashboard-style document contains a panel stack or filter panel.

To format the background of a panel

1 In MicroStrategy Web, open the document in Design or Editable Mode.
2 Select the panel stack and pass your cursor under its title bar. A toolbar of icons is displayed.

3 Use the **Previous Panel** ‹ and **Next Panel** › icons to select the panel to format.

4 Click the arrow to the right of the **Fill Color** icon ➤, and then do one of the following:
   - Select the background color from the drop-down list.
   - To access additional colors, do the following:
     a Select **More Colors** from the drop-down list. The Advanced Color Picker dialog box opens.
     b Select the background color.
     c Click **OK** to return to the document.
   - To apply a color gradient (a combination of two colors) to the panel, do the following:
     a Select **Gradients** from the drop-down list. The Gradients dialog box opens.
     b From the **Color 1** and **Color 2** drop-down lists, select the two colors to use for the gradient.
     c Select a **Shading Style** to determine the direction in which the two colors are blended together.
     d Select a **Variant**, which is the direction of the shading between the two colors. The Flash-only variant is a mirror-like gradient only displayed in Flash Mode.
     e Click **OK** to return to the document.
   - To allow the panel stack background color to show, set the **Fill color** to **No Color**.

---

**To format the background of all panels**

1 In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2 Right-click the panel stack to format and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
3 From the left, select **Color and Lines**.

4 From the first drop-down list, select one of the following:
   - To apply the background color only to panels that do not have a background color (that is, they are transparent), select **Panel Stack**.
   - To apply the background color to all panels, regardless of whether they have a background color, select **All Panels**.

5 From the second drop-down list, select **Body**.

6 Choose one of the following. As you make changes, the Sample area changes to show a preview of your selections.
   - To use a single color as the background, under Fill, select a color from the **Color** drop-down list. Click **More Colors** to access additional colors.
   - To shade the title bar using gradient colors, which combine two colors, do the following:
     a Under Fill, select **Gradients** from the **Color** drop-down list. The Gradients dialog box opens.
     b From the **Color 1** and **Color 2** drop-down lists, select the two colors to use for the gradient.
     c Select a **Shading Style** to determine the direction in which the two colors are blended together.
     d You can also select a **Variant**, which is the direction of the shading between the two colors. The Flash-only variant is a mirror-like gradient only displayed in Flash Mode.
     e Click **OK** to save the gradients.
   - To allow what is behind the title bar to show through, set the **Fill color** to **No Color**.

7 Click **OK** to apply the changes and return to the dashboard-style document.

**Formatting a panel stack for export**

You can determine how a panel stack is displayed when it is exported to Excel and PDF. First, you determine whether or not to clip the contents of
the panel stack if the contents of the panel stack are bigger than the panel stack itself (for example, a wide Grid/Graph).

- If the panel stack is clipped, the object in the panel stack is not fully displayed, since panel stacks cannot grow in size. The document below has been exported to PDF. The Grid/Graph is cut off on the right, but you can see the panel stack and the panel name in the title bar.

- If the panel stack is not clipped, the panel stack is essentially not exported, allowing the contents to be fully displayed. The PDF shown below is the same document as above, but with panel stack is no longer clipped. The full Grid/Graph is displayed, without the panel name or panel stack title bar.
If the panel stack is clipped, you can determine whether to export all the panels or only the current panel. The panels can be displayed vertically (from top to bottom) or horizontally (from left to right). The first example above exported only the current panel, although the panel stack contains three panels. The following PDF shows the three panels exported horizontally (page one is on the top, followed by page two):
If the panel is displayed vertically, you can select whether an individual panel can display across multiple pages. The PDF below is the same document, displayed vertically, with panels displayed on separate pages.

To format a panel stack for export

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2 Right-click the panel stack to format and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3 From the left, select **Advanced**.

4 Select whether or not to clip the panel stack:
   - To clip the panel stack, select the **Clip contents of panel stack when exporting** check box. If the contents of a panel stack are bigger than the panel stack itself (for example, a wide Grid/Graph), the object is clipped and not fully displayed when the document is exported, since panel stacks cannot grow in size.
   - To display all the contents of the panel stack, clear the **Clip contents of panel stack when exporting** check box. If the contents are bigger than the panel stack, the panel stack is essentially not exported, allowing the contents to be fully displayed.

   If you clear this check box, the remaining Export settings are not available. Click **OK** to save your changes and return to the document.

5 Define whether all panels are exported or only the current panel is exported. Select one of the following options from the **Expand panels** drop-down list:
   - To export only the current panel, select **None**. The current panel is the panel that is displayed.
   - To export all the panels and display them vertically, select **Vertical**.
   - To export all the panels and display them horizontally, select **Horizontal**.

6 If you selected Vertical or Horizontal, specify the amount of **Spacing** between the panels. The unit of measurement is inches.

7 If you selected Vertical, determine whether or not an individual panel can be split across pages:
   - To allow panels to display vertically across multiple pages, select the **Allow panels to split across pages** check box.
   - To specify that panels must display on a single page, clear the **Allow panels to split across pages** check box. The contents of the panels are clipped to fit on the page.

8 Click **OK** to save your changes and return to the document.
PROVIDING INTERACTIVITY TO USERS: SELECTORS

Introduction

Selectors provide dashboard-style documents with interactivity, allowing each user to change how he sees the data. When a user clicks a selector, a selector can change panels, the focus of a grid or graph report on the document, or dynamic text fields (a text field that is a reference to an object on a report) in a panel stack, as described below. For an in-depth explanation of dashboard-style documents, see What is a dashboard-style document?, page 26.

About selectors

Selectors allow a user, in Interactive Mode, Editable Mode, and Flash Mode, to change:

- Panels in a panel stack. For an example, see Creating a selector to change panels on a panel stack, page 134.
- The data displayed in a Grid/Graph, by displaying different metrics or different elements of attributes, custom groups, or consolidations; or by
filtering data based on a metric’s values. For examples, see Creating a selector for elements on a Grid/Graph, page 135, Creating a selector to choose the metric to display in a Grid/Graph, page 143, and Creating a selector that filters metric values, page 137.

• The contents of dynamic text fields (a text field that is a reference to an object on a dataset) in a panel stack. For an example, see Creating a selector that updates a dynamic text field on a panel stack, page 146.

• The contents of another selector. For example, a user can select a state from one selector, which updates a second selector to display the cities in the selected state. For a more detailed example, see Creating a selector that targets other selectors, page 150.

• Dataset results, allowing users to filter and view subsets of large amounts of data instead of loading and displaying all the data in a document at once. For an example and steps to create a selector that filters dataset results, see Creating a selector to filter dataset results, page 148.

You can use an attribute on a Grid/Graph as a selector that updates dataset results. For steps, see Enabling Grid/Graphs as selectors to update dataset results, page 226.

• Data displayed in a Transaction Services-enabled document:
  ▪ You can create a selector that restricts the options displayed in a List control in a Transaction Services-enabled document. For steps, see Creating a selector to filter List controls in a Transaction Services-enabled document, page 156.

  ▪ You can create a selector that allows users to submit, recalculate, or discard changes to data in the document. An example is included below, on page 119. For steps to create these selectors, and information on Transaction Services in general, see the Report Services Document Creation Guide.

For example, a Grid/Graph contains Region, Call Center, Year, and various metrics, as shown in the example below. This particular selector allows the user to select which regions to display on the Grid/Graph. The user can therefore slice or filter the Grid/Graph by the selected region or regions. Similarly, a selector can allow the user to select which metrics to display. All
regions and employees would be displayed, but with only the metrics chosen in the selector.

<table>
<thead>
<tr>
<th>Region</th>
<th>Cal Center</th>
<th>Year</th>
<th>Metrics</th>
<th>Profit</th>
<th>Profit Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td>Boston</td>
<td>2006</td>
<td>$62,469</td>
<td>15.35%</td>
<td></td>
</tr>
<tr>
<td>Northeast</td>
<td>Boston</td>
<td>2007</td>
<td>$76,011</td>
<td>14.97%</td>
<td></td>
</tr>
<tr>
<td>Northeast</td>
<td>New York</td>
<td>2006</td>
<td>$277,492</td>
<td>15.09%</td>
<td></td>
</tr>
<tr>
<td>Northeast</td>
<td>New York</td>
<td>2007</td>
<td>$359,690</td>
<td>15.23%</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>Atlanta</td>
<td>2006</td>
<td>$40,109</td>
<td>14.97%</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>Atlanta</td>
<td>2007</td>
<td>$56,668</td>
<td>15.01%</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>Miami</td>
<td>2006</td>
<td>$49,458</td>
<td>15.05%</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>Miami</td>
<td>2007</td>
<td>$57,230</td>
<td>14.97%</td>
<td></td>
</tr>
<tr>
<td>Central</td>
<td>Milwaukee</td>
<td>2006</td>
<td>$163,091</td>
<td>15.32%</td>
<td></td>
</tr>
<tr>
<td>Central</td>
<td>Milwaukee</td>
<td>2007</td>
<td>$209,937</td>
<td>15.26%</td>
<td></td>
</tr>
<tr>
<td>Central</td>
<td>Fargo</td>
<td>2006</td>
<td>$33,210</td>
<td>14.48%</td>
<td></td>
</tr>
<tr>
<td>Central</td>
<td>Fargo</td>
<td>2007</td>
<td>$44,533</td>
<td>15.30%</td>
<td></td>
</tr>
<tr>
<td>South</td>
<td>New Orleans</td>
<td>2006</td>
<td>$131,455</td>
<td>15.34%</td>
<td></td>
</tr>
</tbody>
</table>

A selector can submit, recalculate, or discard changes to data displayed in a Transaction Services-enabled document. (For details on Transaction Services documents, see the Report Services Document Creation Guide.) This type of selector can be either a button or a text link.

For example, in the image below, the grid contains sales data for several call centers.

A user can edit the name of a call center, then click the Submit button to update the underlying data, or edit the revenue for a call center and click the Recalculate Values link to reapply the number formatting applied to revenue values in the grid. For steps to create a selector button or link, see the Report Services Document Creation Guide.

An element selector or a metric condition slider selector can include or exclude the selected data. For example, the attributes that a user chooses in the selector can display in the target, or they can be hidden. For an example and instructions, see Determining whether the selector includes or excludes data: selection type, page 166.
A selector can target multiple objects. The same selector can control both a Grid/Graph and dynamic text fields on the same panel. A selector can target both a Grid/Graph and another selector.

A selector can either filter or slice the data. The selections made in a filtering selector are used to filter the underlying dataset before the metric values are aggregated at the level of the Grid/Graph that is displayed in the dashboard-style document. The selections made in a slicing selectors are used to determine which slices of data are combined and shown in the Grid/Graph. For more details on the differences, including examples, see *Applying selections as filters or slices, page 158.*

**Initial display of a selector**

For a selector that targets attribute elements on a Grid/Graph, whether a selector filters or slices data determines how the selector is first displayed:

- If it is a filtering selector, no items are selected in the selector. A drop-down list will have blank space, a button bar will not have any buttons selected, no radio buttons will be selected, and so on. This means that the target is unfiltered and therefore displays all of the available items.

  For example, a panel contains the dynamic text fields Region and Revenue from the Basic Report dataset. The selector allows the user to select which region to display on the panel. If the selector filters regions, when the dashboard-style document is first displayed, all the regions are displayed in the panel.

- If it is a slicing selector, the first item in the target is selected in the selector, and its target displays data for that item.

  If the selector instead slices regions, the data for the Central region is displayed when the dashboard-style document is first opened, since Central is the first attribute element. Central is selected in the selector.

These are the default settings, but you can change how a slicing selector is displayed. You can change the number of items displayed and whether they are the first or last elements. You can also opt to display all the items.

Once a user makes selections in the selector and saves the dashboard-style document, those selections are saved and displayed when the document is executed again.

For more information on these settings, including detailed examples, a description of how selectors with multiple targets use these settings, and
instructions, see *Determining how the target of a selector displays (current state), page 189.*

**How drilling and selectors work together**

When a user drills on a document that contains an element selector, the attribute, consolidation, or custom group used in the selector becomes the page-by element for the drilled-to report or document.

- If only one element is chosen in the selector, the drilled-to report displays that element.
- If multiple elements are chosen in the selector, the drilled-to report displays the first selected element.

For example, a document contains a Grid/Graph that displays revenue values by Category and Subcategory. The document also contains a selector on Year that targets the Grid/Graph. (Although Year is not displayed on the Grid/Graph, it is included in the dataset.) The document is displayed below
in Interactive Mode, after 2010 has been selected in the selector. Note that the revenue for the Art & Architecture subcategory is $158,651.

Drill to Item from Art & Architecture. On the drilled-to report, display subtotals (from the Data menu, select Show Totals). Notice that the report is
paged by Year (2010 only) and the revenue total for Art & Architecture is $158,651, the same as shown in the Grid/Graph in the document.

Return to the original document, which still has 2010 selected. Select 2011 in the selector as well. The revenue amount for Art & Architecture is now $365,872, as shown below. (Only a portion of the full document is shown in the sample.)

Once again drill to Item from Art & Architecture. On the drilled-to report, display subtotals. Notice that the report is paged by Year (2010 only, since it is the first year selected in the original report) and the revenue subtotal for
Art & Architecture is $158,651, the same as shown in the Grid/Graph in the document.

Defining a selector

When you add a selector to a dashboard-style document, you must define how it looks and what it controls. The following settings define a selector:

- **DHTML style** is how the items in the selector are displayed in Editable, Interactive, and Express Mode. (Items are the elements, metrics, or panels, as described in the examples above.) The DHTML style options are:
  - Button Bar (use to create tabs in your dashboard-style document)
  - Check Boxes

  - Cost
  - Profit
  - Revenue
Providing Interactivity to Users: Selectors

- Drop-down

- Link Bar (use to create tabs in your document):

- Listbox

- Qualification (available only for metric condition selectors; allows users to complete the metric qualification)

- Radio Buttons

- Search Box (available only for element selectors). This style allows users to search for an element. Unlike other selectors, a list of elements is not initially displayed. As the user types text, matches are
displayed for the user to choose from. This is particularly convenient if the element list is long.

You can determine whether the search is performed on the server or the client. To fetch elements directly from the data warehouse or Intelligent Cube as the user performs the search, select the Search on server check box in the Layout options on the Properties and Formatting dialog box.

- **Slider** (most effective selector for browsing data in a graph; also available for metric condition selectors)

  Place the graph slider under or above the graph it will control, then specify the graph as the target of the slider selector. Next, specify one of the attributes or metrics in the graph as the selector's source. This allows an analyst to drag the slider to view different sets of data in a graph and to adjust the size of the slider to view different ranges of values in the graph.

- **Flash Style** is how the selector is displayed in Flash Mode if it is an interactive Flash-only selector. The options are listed below:

  - **Automatic**: The default, which uses the DHTML Style (described above) for Flash Mode.

  - **Fish Eye Selector**: An interactive style of selector that is displayed only in Flash Mode. It magnifies an item when a user hovers the cursor over it. This style of selector is useful because it allows a user to choose from a large list of elements without having to see all of the elements displayed at one time. Any item that a user hovers over or selects remains magnified, while the remaining items are minimized and hidden from view.

  Since a Fish Eye Selector is displayed only in Flash Mode, determine how the selector is displayed in non-Flash modes by specifying a DHTML Style (described above).

  For more information about creating this type of selector, and an example, see *Creating a Fish Eye Selector, page 260*. 
- **Date Selection**: An interactive style of selector that is displayed only in Flash Mode. It is a calendar selector that allows you to select which dates you want to see data about in a dashboard-style document. You are able to see all of the dates of each month in the widget, which allows you to be able to select dates more easily.

Since a Date Selection widget is displayed only in Flash Mode, determine how the selector is displayed in non-Flash modes by specifying a [DHTML Style](#) (described above).

For more information about creating this type of selector, and an example, see *Creating a Date Selection widget, page 251*.

- **Action Type** determines whether the selector displays elements, metrics, metric conditions (such as “greater than $5,000”), or panels. For an action selector for a Transaction Services-enabled document, the Action Type determines whether the selector is used to submit, recalculate, or discard the changes to the data. For example, a user can edit the data displayed in a grid, then submit their changes to update the underlying data, or instead choose to recalculate derived metrics and subtotals displayed in the grid based on the changed data. For steps, see the *Report Services Document Creation Guide*.

For element selectors, you can select which forms are displayed in the selector, the order that they are displayed in, and how their elements are sorted. If multiple forms are displayed, you can choose which character separates the different forms. For an example and instructions to display and sort forms, see *Displaying and sorting forms in selectors, page 200*.

- **Source** is the attribute, custom group, or consolidation whose elements are displayed in the selector (for an element selector) or the metric whose values are qualified on (for a metric condition selector).

- **Selection Type** determines whether the selector includes or excludes the selected items from the target. It is available only for element selectors and metric condition slider selectors. For example, the attributes that a user chooses in the selector can display in the target, or they can be hidden. For instructions to specify the selection type, see *Determining whether the selector includes or excludes data: selection type, page 166*.

- **Qualify on** determines whether the selector filters metric values or rank, and is available only for metric condition selectors. The options are:
  - **Value** filters the metric's values.
  - **Rank Highest** ranks the metric’s values in descending order, and then filters by rank. For example, Rank Highest=2 displays the two highest values.
- **Rank Lowest** ranks the metric's values in ascending order, and then filters by rank. For example, Rank Lowest=2 displays the two lowest values.

- **Rank % Highest** ranks and filters by the number of metric values (or rows) in the target, in descending order. For example, if the target Grid/Graph contains eight items, the Rank % Highest =25 displays the two highest values.

- **Rank % Lowest** ranks and filters by the number of metric values (or rows) in the target, in ascending order. For example, if the target Grid/Graph contains eight items, the Rank % Lowest =25 displays the two lowest values.

If a title bar is displayed for the metric condition selector, a user can change this setting.

- **Target(s)** are the Grid/Graphs, panel stacks, List controls, datasets, and/or other selectors that the selector affects.

  - If targets are automatically maintained in the layout, attribute and metric selectors automatically target all Grid/Graphs and panel stacks that are in the same panel or document section as the selector.

  - If targets are not automatically maintained, you must manually select the targets when you create selectors.

  - You must always select the target for panel selectors, regardless of whether targets are automatically maintained.

  - To choose another selector as the target of this selector, you must disable automatic target maintenance and manually select the target. You can keep automatic target maintenance if you can place the target selector on a panel in the same document section as the source selector; the source selector will automatically target that panel stack.

For instructions to disable automatic target maintenance, as well as the advantages and disadvantages of automatic and manual target selection, see *Automatically maintaining targets for selectors, page 169*. 
## Methods to create a selector

The following table provides a brief overview of creating different types of selectors, as well as links to more detailed procedures.

<table>
<thead>
<tr>
<th>To Create a Selector...</th>
<th>Do This...</th>
</tr>
</thead>
<tbody>
<tr>
<td>That changes panels on a panel stack.</td>
<td>Right-click the panel stack and select <strong>Create Panel Stack Selector</strong>. For detailed steps, see <em>Creating a selector to change panels on a panel stack</em>, page 134.</td>
</tr>
<tr>
<td>That selects the elements to display on a Grid/Graph.</td>
<td>Right-click the attribute, custom group, or consolidation on the Grid/Graph and select <strong>Create Selector Control</strong>. For detailed steps, see <em>Creating a selector for elements on a Grid/Graph</em>, page 135.</td>
</tr>
</tbody>
</table>
| That filters a metric’s values. | 1 From the **Insert** menu, point to **Selector**, then select either **Metric Slider** or **Metric Qualification**.  
2 To target a specific Grid/Graph instead, right-click the metric on the Grid/Graph and select **Create Selector Control**. For detailed steps, see *Creating a selector that filters metric values*, page 137. |
| That selects the metric to display on a Grid/Graph. | Right-click the word **Metrics** on the Grid/Graph and select **Create Selector**. For detailed steps, see *Creating a selector to choose the metric to display in a Grid/Graph*, page 143. |
| That updates a dynamic text field on a panel stack. | 1 From the **Insert** menu, point to **Selector**, and then select the selector style.  
2 In the Properties and Formatting dialog box, select the attribute to use as the source, and the panel stack to use as the target. For detailed steps, see *Creating a selector that updates a dynamic text field on a panel stack*, page 146. |
| That is formatted differently in Flash Mode and becomes interactive when a user hovers the cursor over it. An example is the Fish Eye Selector, which magnifies the item that is hovered over, while the remaining items are minimized and displayed in the background of the selector. | See *Creating a Fish Eye Selector*, page 260 and *Creating a Date Selection widget*, page 251. |
### To Create a Selector... | Do This...
---|---
**That filters the data in a dataset.** | 1. From the **Insert** menu, point to **Selector**, and then select the selector style.  
2. In the Properties and Formatting dialog box, select the **Select datasets as target** check box.  
3. Select the dataset to be updated based on choices in the selector.  
For detailed steps, see *Creating a selector to filter dataset results*, page 148.

**That filters another selector.** | After creating the target selector (the one to be filtered by the source selector):  
1. Disable automatic target maintenance.  
2. From the **Insert** menu, point to **Selector**, and then choose the style from the list.  
3. In the Properties and Formatting dialog box, select the attribute to use as the source. For the target, select the target selector and either a Grid/Graph or panel stack.  
For detailed steps, see *Creating a selector that targets other selectors*, page 150.

**That filters a List control in a Transaction Services-enabled document.** | 1. Disable automatic target maintenance.  
2. From the **Insert** menu, point to **Selector**, and then choose the style from the list.  
3. In the Properties and Formatting dialog box, select the attribute to use as the source. For the target, select the List control.  
4. For detailed steps, see *Creating a selector to filter List controls in a Transaction Services-enabled document*, page 156.

**With a specific style.** | 1. Do one of the following:  
   - From the **Insert** menu, point to **Selector**, and then choose the style from the list.  
   - Click the arrow next to the **Selector** icon on the toolbar, and then choose the style from the list.  
2. In the Properties and Formatting dialog box, you can change the default action type from select elements to select metrics or panels.

**With the same style as the last selector you added.** | Click the **Selector** icon in the Controls toolbar.  
The default action type is select elements, although you can change it to select metrics or panels, in the Properties and Formatting dialog box.

**That uses an attribute on a Grid/Graph as a selector to target another panel stack or another Grid/Graph.** | 1. Right-click the header of an attribute in the Grid/Graph, and select **Use as Selector**.  
2. Select the panel stack or Grid/Graph to be updated based on the selected attribute element.  
For detailed steps, see *Using Grid/Graphs as selectors to control other Grid/Graphs*, page 219.
If targets are automatically maintained in the layout, element and metric selectors automatically target all Grid/Graphs and panel stacks that are in the same panel or document section as the selector. You do not need to manually select the targets. If automatic target maintenance is disabled, you must manually select the targets. See Selecting targets interactively (target selection mode), page 132 for steps.

You must always select targets for panel selectors, regardless of whether targets are automatically maintained.

To target another selector, automatic target maintenance must be disabled. Alternatively, you can keep automatic target maintenance if you can place the target selector on a panel in the same document section as the source selector; the source selector will automatically target that panel stack.

For more information on automatically maintaining targets, including how to enable and disable it, see Automatically maintaining targets for selectors, page 169.
Selecting targets interactively (target selection mode)

Target selection mode allows you to choose targets interactively. You can click the Grid/Graph, panel stack, or selector to use as the target of the selector.

Prerequisites

- The document contains a selector. For steps to add a selector, see Methods to create a selector, page 129.
- The document must contain at least one Grid/Graph, panel stack, or a second selector to use as the target of the selector.
- Automatic target maintenance must be disabled. If automatic target maintenance is enabled instead, target selection is not available, and attribute, metric, and metric condition selectors automatically target all Grid/Graphs and panel stacks that are in the same panel or document section as the selector. For more information about automatic target maintenance, including instructions to disable it, see Automatically maintaining targets for selectors, page 169.

To select targets for a selector

1 In MicroStrategy Web, open the document in Design or Editable Mode.

2 Right-click the selector and choose Select Targets. The Select Target dialog box is displayed.

3 Click the Grid/Graph, panel stack, List control, or selector to specify as the target. The sizing handles of the target are displayed. To select multiple targets, hold down the CTRL key while you click each control.

4 Do one of the following:
   - Click the OK icon . The selected controls are added as targets of the selector.
   - To cancel your changes and return to the document, click the Cancel icon .
Next steps after creating a selector

After you create a new selector, you can use the Properties and Formatting dialog box to change any settings, such as style or action type, of the selector. For example, the default DHTML style of a new selector is a drop-down list, which may not always suit your needs.

You can make the following changes to selectors:

- **Defining selectors to filter or slice targets, page 164.** A selector can either filter or slice data. The selections made in a filtering selector are used to filter the underlying dataset before the metric values are aggregated at the level of the Grid/Graph that is displayed in the document. The selections made in slicing selectors are used to determine which slices of data are combined and shown in the Grid/Graph.

- **Allowing users to select multiple items, page 181.** You can determine whether users can make multiple selections in Slider, Listbox, Link Bar, and Button Bar style selectors.

- **Controlling how data updates: Automatically apply selector changes, page 182.** You can determine whether the data is automatically updated when an item is selected in the selector.

- **Disabling simultaneous display of all items in a selector, page 183.**

- **Determining how the target of a selector displays when no data exists, page 185.** This scenario occurs if a target cannot display any data that meets the requirements of the choices made in the selector. By default, a message is displayed in the target, but you can choose to have the first item in the selector displayed instead.

- **Determining how the target of a selector displays (current state), page 189.** You can determine whether items are already chosen in the selector when it is first displayed.

- **Showing totals for selectors, page 197.**

- **Displaying and sorting forms in selectors, page 200.** For element selectors, you can select which forms are displayed in the selector, the order that they are displayed in, and how their elements are sorted. If multiple forms are displayed, you can choose which character separates the different forms.

- **Displaying title bars in selectors, page 202.** A title bar on a selector can help to identify the selector or provide instructions about using the selector. For metric slider and metric qualification selectors, which filter metric values, the title bar contains a drop-down menu that allows a user
to select whether to filter on the metric values or rank. For a metric slider selector, the drop-down menu in the title bar also allows a user to select whether to include or exclude the selected data.

- *Formatting selectors, page 205.*

### Creating a selector to change panels on a panel stack

A panel stack selector allows a user to flip through the panels in a panel stack. A panel stack is a collection of panels, which allow the user to see different predefined views of data in the same document.

For example, each panel can display a different Grid/Graph, and the selector allows the user to choose which panel, and thus which Grid/Graph, to view.

```
<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Northeast</td>
<td></td>
<td>$1,300,732</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$673,084</td>
</tr>
<tr>
<td>Southeast</td>
<td></td>
<td>$336,675</td>
</tr>
</tbody>
</table>
```

The items of the selector are the buttons across the top, and the target is the panel stack. For more information on panels, see *Chapter 3, Layering Data: Panels and Panel Stacks.*

### Prerequisite

The document contains a panel stack, to use as the target of the selector. For steps, see *Inserting a panel stack, page 76.*

---

**To create a selector for a panel stack**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. Right-click the panel stack to use as the target of the selector, and select **Create Panel Selector**. A selector is added just above the panel. The selected panel stack is the target and the Action Type is set to Select Panel.
To change the default selector style, which is a drop-down list, do the following:

a. Right-click the selector and click **Properties and Formatting**. The Properties and Formatting dialog box opens.

b. From the left, click **Layout**.

c. Select a style from the **DHTML Style** drop-down list.

You cannot use check boxes with a panel stack, since check boxes allow multiple selections and multiple panels cannot be displayed simultaneously.

d. Click **OK** to return to the document.

Now that you have created the selector, you can modify properties such as autosubmission and format the selector. For a list of tasks, see *Next steps after creating a selector, page 133*.

### Creating a selector for elements on a Grid/Graph

You can create a selector that allows a user to choose which elements to display in a Grid/Graph. These elements can be from an attribute, a custom group, or a consolidation on the Grid/Graph.

For example, a Grid/Graph contains Region, Call Center, Year, and various metrics, as shown in the example below. This particular selector allows the user to select which regions to display on the Grid/Graph. The user can therefore slice or filter the Grid/Graph by the selected region or regions.
In this example, the regions listed in the selector are the items of the selector; the target is the Grid/Graph.

You can choose to either include or exclude the selected elements from the target Grid/Graph by default. For examples, see *Determining whether the selector includes or excludes data: selection type, page 166*. Steps to define the default behavior are included below.

**Prerequisites**

- The document contains a Grid/Graph, to be used as the target of the selector. For steps, see the *Grid/Graphs* chapter of the *Report Services Document Creation Guide*. If targets are automatically maintained, and you add a Grid/Graph to the same document section or panel after creating the selector, the Grid/Graph is automatically added as a target.

- By default, targets are automatically maintained, so the element selector automatically targets all Grid/Graphs and panel stacks that are in the same panel or document section as the selected Grid/Graph. You can disable the maintenance for a layout. For steps, see *Disabling automatic target maintenance to allow manual target selection, page 177*.

---

**To create a selector for elements in a Grid/Graph**

1. In MicroStrategy Web, open a document in *Design* or *Editable Mode*.

2. Right-click the name of the attribute, consolidation or custom (not an element) in the Grid/Graph to use as the target of the selector, and select *Create Selector Control*. For example, to re-create the example shown above, right-click Region, not Northeast.

   A selector is created just above the Grid/Graph. The selected attribute is the source, the selected Grid/Graph is the target, and the Action Type is set to Select Element.

3. Right-click the new selector, then select *Properties and Formatting*. The Properties and Formatting dialog box is displayed.

4. To change the default selector style, which is a drop-down list, do the following:

   a. From the left, click *Layout*.

   b. Select a style from the *DHTML Style* drop-down list.
5 From the left, click **Selector.**

6 From the **Selection Type** drop-down list, select one of the following:
   - To use the selector to include data for selected values, select **Include.**
   - To use the selector to exclude data for selected values, select **Exclude.**

7 Click **OK** to return to the document.

Now that you have created the selector, you can modify properties, such as multiple selections and simultaneous display of selector items, and format the selector. For a list of tasks, see *Next steps after creating a selector, page 133.*

### Creating a selector that filters metric values

You can create a selector that allows a user to filter on a metric's values, ranks, or percent ranks. The selector can be either a slider or a qualification.

#### Metric slider

A slider allows the user to select the minimum and maximum values to display. For example, a dashboard-style document contains a Grid/Graph with Region and the Revenue, Cost, and Profit metrics. A selector displays the range of revenue values, including the minimum and maximum values (in the example below, $1,761,187.19 and $8,554,414.55). A user can move the slider to select a new minimum and maximum revenue to display. In this example, the selector is filtering the Revenue metric to display only those regions with Revenue values between $3,343,953 and $7,983,672.

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td></td>
<td>$5,020,366</td>
<td>$4,265,043</td>
<td>$764,323</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$4,452,615</td>
<td>$3,779,531</td>
<td>$673,084</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$5,389,280</td>
<td>$4,582,324</td>
<td>$806,956</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td>$3,694,132</td>
<td>$3,132,800</td>
<td>$561,331</td>
</tr>
<tr>
<td>Web</td>
<td></td>
<td>$3,902,762</td>
<td>$3,319,225</td>
<td>$583,538</td>
</tr>
</tbody>
</table>

Select the range of Revenue values to display

Between 3,343,953.49 and 7,983,672.10

1,761,187.19 $6,554,414.55
A user can also specify the beginning or end of the selected range in the slider, by hovering his cursor over one of the endpoints of the slider (called a thumb), clicking on the tooltip, and then typing a number in the field.

You can choose to either include or exclude the values from the target. This means that the values that a user chooses in the selector can display in the target, or they can be hidden. For examples, see Determining whether the selector includes or excludes data: selection type, page 166.

In addition, if the selector title bar is displayed, a user can change whether the selector filters on metric values, ranks, or percent ranks. See Choosing the filtering criterion, page 139.

**Metric qualification**

A user can complete the qualification to filter the metric's values. This type of metric condition selector allows a user to:

- Select whether to filter on the metric values or ranking
- Select the operator (equals, greater than, and so on)
- Type the value to filter on

For example, given the same regional revenue Grid/Graph described above, a user could display only the revenue values greater than $5,000,000 (as shown in the example below) or only the top-ranking 5 regions in term of revenue. After the user completes the qualification, he clicks the check mark to apply the qualification.
To change whether the selector filters on metric values, ranks, or percent ranks, the user clicks the down arrow in the title bar to open the drop-down list, as shown below:

In addition, if the selector title bar is displayed, a user can change whether the selector filters on metric values, ranks, or percent ranks. See Choosing the filtering criterion, page 139.

Choosing the filtering criterion

For either a slider selector or a qualification selector, the title bar contains a drop-down list to select whether to filter on metric values, ranks, or percent ranks, as described below. If the title bar is hidden, the option chosen when the selector was defined is used. For instructions to display the title bar, see Displaying title bars in selectors, page 202.

- **Value** filters the target by the metric's values.
- **Rank Highest** ranks the metric's values in descending order, and then filters by rank. For example, Rank Highest=2 displays the two highest values.
- **Rank Lowest** ranks the metric's values in ascending order, and then filters by rank. For example, Rank Lowest=2 displays the two lowest values.
- **Rank % Highest** ranks and filters by the number of metric values (or rows) in the target, in descending order. For example, if the target Grid/Graph contains eight items, the Rank % Highest =25 displays the two highest values.
• **Rank % Lowest** ranks and filters by the number of metric values (or rows) in the target, in ascending order. For example, if the target Grid/Graph contains eight items, the Rank % Lowest = 25 displays the two lowest values.

**Creating a metric filtering selector**

If you want to create a metric filtering selector for a specific Grid/Graph, you can quickly and easily complete the task by following the steps in *To create a selector that filters a metric's values on a Grid/Graph, page 140.*

If you want to create a metric filtering selector that targets a panel stack or multiple Grid/Graphs, follow the steps in *To create a selector that filters a metric's values, page 142.*

**Prerequisites**

- The document must contain a Grid/Graph or panel stack, to use as the target of the selector. For steps, see the Grid/Graphs chapter of the *Report Services Document Creation Guide* or *Inserting and defining panels, page 75.* If targets are automatically maintained, and you add a Grid/Graph or panel stack to the same document section or panel after creating the selector, the Grid/Graph or panel stack is automatically added as a target.

- By default, targets are automatically maintained, so the metric filtering selector automatically targets all Grid/Graphs and panel stacks that are in the same panel or document section as the selector. You can disable the maintenance for a layout. For steps, see *Disabling automatic target maintenance to allow manual target selection, page 177.*

---

**To create a selector that filters a metric's values on a Grid/Graph**

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.

2. Right-click the metric in the Grid/Graph to use as the target of the selector, and select **Create Selector Control**.

A metric slider selector is created just above the Grid/Graph. The selected metric is the source, the selected Grid/Graph is the target, and the Action Type is set to Metric Condition.
3 Right-click the new selector and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

4 To change the selector to a metric qualification, complete the following:
   a From the left, click **Layout**.
   b From the DHTML Style drop-down list, select **Metric Qualification**.

5 From the left, click **Selector**.

6 From the **Selection Type** drop-down list, select one of the following:
   - To use the selector to include data for selected values, select **Include**.
   - To use the selector to exclude data for selected values, select **Exclude**.

   If the selector's title bar is not displayed, then this setting is used. If the selector's title bar is displayed, this is the default and a user can change between including or excluding the selections.

7 From the **Qualify On** drop-down list, select one of the following:
   - To filter on the metric's values, select **Value**.
   - To rank the metric's value, where 1 is the highest value, and then filter by rank, select **Rank Highest**.
   - To rank the metric's value, where 1 is the lowest value, and then filter by rank, select **Rank Lowest**.
   - To filter the data to display the top x% of items in the target, select **Rank % Highest**. For example, if the target Grid/Graph contains eight items, Rank % Highest = 25 displays the top two items.
   - To filter the data to display the bottom x% of items in the target, select **Rank % Lowest**. For example, if the target Grid/Graph contains eight items, Rank % Lowest = 25 displays the bottom two items.

8 Click **OK** to return to the document.

Now that you have created the selector, you can modify properties, such as multiple selections and simultaneous display of selector items, and format the selector. For a list of tasks, see **Next steps after creating a selector**, page 133.
To create a selector that filters a metric's values

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.

2. From the **Insert** menu, point to **Selector**, then select one of the following:
   - To create a slider, select **Metric Slider**.
   - To create a qualification, select **Metric Qualification**.

3. Click the section of the Layout area in which to place the selector. If you click and drag in the section, you can size the selector.

4. If the targets are not automatically maintained, you must manually specify the target of the selector, as described in *Selecting targets interactively (target selection mode), page 132*.

5. Right-click the new selector and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

6. From the left, click **Selector**.

7. From the **Source** drop-down list, select the metric to qualify on.

8. From the **Selection Type** drop-down list, select one of the following:
   - To use the selector to include data for selected values, select **Include**.
   - To use the selector to exclude data for selected values, select **Exclude**.
   
   If the selector's title bar is not displayed, then this setting is used. If the selector's title bar is displayed, this is the default and a user can change between including or excluding the selections.

9. From the **Qualify On** drop-down list, select one of the following:
   - To filter on the metric's values, select **Value**.
   - To rank the metric's value, where 1 is the highest value, and then filter by rank, select **Rank Highest**.
   - To rank the metric's value, where 1 is the lowest value, and then filter by rank, select **Rank Lowest**.
   - To filter the data to display the top x% of items in the target, select **Rank % Highest**. For example, if the target Grid/Graph contains eight items, Rank % Highest = 25 displays the top two items.
• To filter the data to display the bottom x% of items in the target, select **Rank % Lowest**. For example, if the target Grid/Graph contains eight items, Rank % Lowest = 25 displays the bottom two items.

10 Click OK to return to the document.

Now that you have created the selector, you can modify properties, such as multiple selections and simultaneous display of selector items, and format the selector. For a list of tasks, see *Next steps after creating a selector*, page 133.

### Creating a selector to choose the metric to display in a Grid/Graph

A selector can allow the user to select which metrics to display.

For example, a Grid/Graph contains the Revenue, Cost, and Profit metrics and various attributes. The selector allows the user to select which metric to display on the Grid/Graph. In the following example, all the metrics are selected, and displayed on the document.
The user clears the selections for Revenue and Cost. All regions and employees are still displayed, but with the Profit metric, as chosen in the selector.

In this example, the metrics listed in the selector are the items of the selector; the target is the Grid/Graph.

### Determining the order of items in the selector

The metrics in a metric selector display in the same order in which they have been added to the Grid/Graph that the selector updates (called the target). For example, if the Revenue, Cost, and Profit metrics have been added to a Grid/Graph in that order, the metric selector displays Revenue, Cost, and Profit in that order.

If the metric selector targets more than one Grid/Graph, the selector displays the metrics in the first target, followed by the metrics in additional targets in the order that they were selected as targets for the selector. For example, in the image below, the metric selector's first target is the Grid/Graph labeled Regional Revenue, Cost, and Profit. The metrics in the first Grid/Graph (Revenue, Cost, and Profit) are displayed in the metric selector.
The metric selector's second target is the Grid/Graph labeled Regional Profit Breakdown. The metrics in the second Grid/Graph (Profit per Employee and Profit Margin) are displayed after Revenue, Cost, and Profit. Because the Profit metric is already included in the first target, it is only displayed once in the metric selector.

Creating a selector to choose a Grid/Graph's metrics

A selector can allow the user to select which metrics to display.

Prerequisites

- The document must contain a Grid/Graph, so it can be used as the target of the selector. For steps, see the Grid/Graphs chapter of the Report Services Document Creation Guide. If targets are automatically maintained, and you add a Grid/Graph to the same document section or panel after creating the selector, the Grid/Graph is automatically added as a target.

- By default, targets are automatically maintained, so the element selector automatically targets all Grid/Graphs and panel stacks that are in the same panel or document section as the selected Grid/Graph. You can disable the automatic target maintenance for a layout. For steps, see Disabling automatic target maintenance to allow manual target selection, page 177.

To create a selector to choose the metric to display in a Grid/Graph

1. In MicroStrategy Web, open a document in Design or Editable Mode.

2. Right-click the word Metrics on the Grid/Graph to use as the target of the selector, and select Create Selector Control.
A selector is created just above the Grid/Graph. The selected Grid/Graph is the target, and the Action Type is set to Select Metric.

3 Right-click the new selector, then select Properties and Formatting. The Properties and Formatting dialog box is displayed.

4 To change the default selector style, which is a drop-down list, do the following:
   a From the left, click Layout.
   b Select a style from the DHTML Style drop-down list.

5 Click OK to return to the document.

Now that you have created the selector, you can modify properties, such as multiple selections and simultaneous display of selector items, and format the selector. For a list of tasks, see Next steps after creating a selector, page 133.

Creating a selector that updates a dynamic text field on a panel stack

You can create a selector that displays different elements of attributes, custom groups, or consolidations in a panel stack. The selector updates a dynamic text field on the panel stack. A dynamic text field is a text field populated by the dataset; it is essentially a reference to an object on a dataset. For a more detailed description of dynamic text fields, including examples, as well as instructions to add them to a dashboard-style document, see the Report Services Document Creation Guide.

For example, a panel contains the dynamic text fields Region and Revenue from the Basic Report dataset. The image below shows the panel in Design View; the dynamic text fields are indicated by braces { }.

The selector allows the user to select which region to display on the panel. The following image shows the same selector and panel in Interactive Mode.
Mid-Atlantic has been selected from the drop-down list of the selector. Mid-Atlantic replaces {Region}, and the revenue amount for the Mid-Atlantic region replaces {Revenue}.

In this example, the regions listed in the drop-down list are the items of the selector; the target is the panel stack.

**Prerequisites**

- The document contains a panel stack, to use as the target of the selector. For steps, see *Inserting and defining panels, page 75*. If targets are automatically maintained, and you add a panel stack to the same document section or panel after creating the selector, the panel stack is automatically added as a target.

- By default, targets are automatically maintained, so the selector automatically targets all Grid/Graphs and panel stacks that are in the same panel or document section as the selected Grid/Graph. You can disable the maintenance for a layout. For steps, see *Disabling automatic target maintenance to allow manual target selection, page 177*.

**To create a selector that updates a dynamic text field on a panel stack**

1. In MicroStrategy Web, open a document in Design or Editable Mode.

2. Click the arrow next to the **Selector Control** icon on the Controls toolbar, and then choose how to display the selector from the drop-down list. For an example of each style of selector, see *Defining a selector, page 124*. When you move the mouse to the layout area, the pointer becomes crosshairs.

3. Click the section of the Layout area in which to place the selector. If you click and drag in the section, you can size the selector.

4. If the targets are not automatically maintained, you must manually specify the target of the selector, as described in *Selecting targets interactively (target selection mode), page 132*. 
5 Right-click the selector and select Properties and Formatting. The Properties and Formatting dialog box opens.

6 From the left, choose Selector.

7 Select an attribute, custom group, or consolidation in the Source field. The elements of the source are displayed as items in the selector.

8 Click OK to return to the document.

Now that you have created the selector, you can modify properties, such as multiple selections and simultaneous display of selector items, and format the selector. For a list of tasks, see Next steps after creating a selector, page 133.

Creating a selector to filter dataset results

You can create a selector that filters the data in a dataset, allowing users to view subsets of large amounts of data instead of loading and displaying all the data at once. For example, if you want to create a document that allows users to view a list of all orders submitted by a specific customer, including information on the items in each order, you can create a dashboard-style document with a list of Customers displayed in a selector. The selector targets a grid that displays Order and Item information. In this example, the selector contains data from a dataset containing each Customer, and the grid contains data from another dataset containing Order and Item information.

You can enable users to select a customer in the selector to update the dataset results displayed in the grid. Each time the user selects a different customer, MicroStrategy re-executes the SQL used to retrieve the Order and Item data, then uses the results to display Order and Item information for the appropriate customer.

You can create a similar dashboard-style document using an attribute element selector that updates the contents of a grid, rather than a dataset. In order to do so, however, you must provide a single dataset that contains all relevant Customer, Order, and Item information, which can easily add up to a million rows of data or more. As a result, the dashboard-style document will require time to retrieve all the dataset results when the dashboard-style document is opened.

In contrast, if you use a selector to filter the dataset results, only the data for the selected customer is retrieved when the dashboard-style document is executed, requiring less time to open the dashboard-style document.
However, because the SQL used to retrieve the dataset results is executed against the data source each time a selection is made, more time is required to display data when users make subsequent selections.

For steps to create an attribute element selector, see *Creating a selector for elements on a Grid/Graph, page 135.*

You can select which attribute forms are displayed in the selector, the order that they are displayed in, and how their elements are sorted. If multiple forms are displayed, you can choose which character separates the different forms. For an example and steps to display and sort forms, see *Displaying and sorting forms in selectors, page 200.*

You can determine whether items are already chosen in the selector when it is first displayed, using the Current State option. For detailed information on the options available, see *Current State setting with a filtering selector, page 191.* For steps to define whether items are chosen in the selector when it is first displayed, see *Defining the Current State of a selector, page 195.*

**Prerequisite**

- The steps below assume that you have created a document that contains at least one control, such as a panel stack or a Grid/Graph, to use as the target of the selector. This control should display data from the dataset that you want to filter. For steps to create a panel stack, see *Inserting a panel stack, page 76.* For steps to create a Grid/Graph, see the *Report Services Document Creation Guide.*

For steps to enable the filtering of datasets based on Freeform SQL reports, see the *Custom SQL Queries: Freeform SQL and Query Builder* chapter in the *Advanced Reporting Guide.*

**To use a selector to filter dataset results**

1. In Web, open the document in Design Mode.
2. From the **Insert** menu, point to **Selector**, then choose the type of selector to add to the document.
3. Click the location in the layout area to add the selector to. The selector is automatically created and added to the document.
4 Right-click the selector, then select **Properties and Formatting**. The Properties and Formatting dialog box opens.

5 From the left, click **Selector**.

6 From the **Action Type** drop-down list, choose **Select Attribute Element**.

7 From the **Source** drop-down list, select the attribute that contains the elements to display as items in the selector.

8 Under **Targets**, select the **Select datasets as target** check box.
   - If the check box is not available, select the **click here** link displayed below the Available list.

9 From the **Available** list, select the datasets to have automatically updated when users choose an item in the selector, then click **>** to add the datasets to the **Selected** list. You can select multiple datasets at once by pressing **CTRL** and clicking each dataset to select it.
   SQL reports and MDX reports, as well as Freeform SQL reports that contain one or more Freeform SQL conditions, are displayed as options in the Available list.

10 You can determine whether users can display data for all elements in the selector at once. To display all the elements, a user chooses the All option in the selector. Whether displaying all is enabled or disabled, users can select one item at a time to display. Do one of the following:
    - To allow users to display data for all elements in the selector at once, select the **Show option for All** check box.
    - To disable simultaneous display of all elements, clear the **Show option for All** check box.

11 By default, the All option is labeled (All) in the selector. You can rename the All option by typing text into the **Alias** field. You can rename the All option only if the Show option for All check box is selected above.

12 Click **OK** to apply your changes.

### Creating a selector that targets other selectors

You can create a selector that targets another selector. In essence, the source selector filters the target selector.
For example, a dashboard-style document contains a Grid/Graph with Subcategory and Item, filtered to display only the Books category. The dashboard-style document also includes two selectors. One selector displays the subcategories in the Books category (the Subcategory selector), while the other selector contains a list of individual books (the Item category). Both selectors target the Grid/Graph, to display data for the selected Subcategory and Item. The Subcategory selector targets the Item selector, filtering the Item selector to display only the books in the subcategory chosen in the Subcategory selector. If a user selects Literature from the Subcategory selector, the Item selector is updated to display only books that fall under the Literature subcategory, instead of displaying a long list of every available book. This is shown below:

![Subcategory and Item selectors](image)

**Determining whether and how selections in the target selector are updated**

When a user selects or clears items in the source selector, the target selector is updated to display only those items selected in the source selector, as shown in the examples above. If the selector is a filtering selector, you can also determine whether and how the target selector are updated when the source selector is updated:

- You can determine which items are selected or cleared in the target selector.
- You can determine which items are displayed in the target selector’s target.

For example, a document contains the following:

- A Grid/Graph that displays region, call center, employee, and the revenue metric.
- A selector that displays call centers and targets the Grid/Graph.
• A selector that displays regions and targets the Call Center selector.

Select Atlanta and Milwaukee in the Call Center selector. The Grid/Graph is updated to display the data for those call centers only, as shown below:

Select only Central in the Region selector. The Call Center selector is filtered to display only those call centers in the Central region. Milwaukee is selected in the Call Center selector, since it was already selected. The Grid/Graph does not change; it is still filtered by the previous selections (Atlanta and Milwaukee) made in the Call Center selector.

This is the default behavior, when no change is made to which items are selected or cleared in the target selector. The target of the target selector remains filtered by the selector; only those items selected in the target selector are displayed.
You can specify that the target of the target selector is no longer filtered by the selector and therefore displays all items. You can then determine whether all the items in the target selector are cleared or selected, as described below.

If updates to the Region selector change the status of the Call Center selector to unset, when you selected Central in the Region selector, the Call Center selector would be filtered to display only those call centers in the Central region. All items in the Call Center selector would be cleared. The Grid/Graph would no longer be filtered by the selector, so the Grid/Graph would display all the call centers, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Call Center</th>
<th>Employee</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Milwaukee</td>
<td>Gale</td>
<td>$1,669,250</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>Mary</td>
<td>$1,690,350</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$822,500</td>
</tr>
<tr>
<td></td>
<td>Fargo</td>
<td>Ellerkamp</td>
<td>$847,227</td>
</tr>
<tr>
<td></td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Washington, DC</td>
<td>Folks</td>
<td>$1,047,776</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$1,026,874</td>
</tr>
<tr>
<td></td>
<td>Charleston</td>
<td>Brown</td>
<td>$331,735</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Vernon</td>
<td>$325,147</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Corcoran</td>
<td>$229,439</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ingles</td>
<td>$221,379</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Smith</td>
<td>$209,634</td>
</tr>
<tr>
<td>Northeast</td>
<td>Boston</td>
<td>De Le Torre</td>
<td>$607,895</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Kieferson</td>
<td>$584,933</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sonder</td>
<td>$295,108</td>
</tr>
<tr>
<td></td>
<td>New York</td>
<td>Kelly</td>
<td>$2,350,720</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sawyer</td>
<td>$2,411,912</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Yager</td>
<td>$2,303,847</td>
</tr>
<tr>
<td>Northwest</td>
<td>San Francisco</td>
<td>Becker</td>
<td>$508,234</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hall</td>
<td>$513,213</td>
</tr>
<tr>
<td></td>
<td>Seattle</td>
<td>gedot</td>
<td>$739,741</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Conner</td>
<td>$1,650,742</td>
</tr>
</tbody>
</table>

If updates to the Region selector change the status of the Call Center selector to all, when you selected Central in the Region selector, the Call Center selector would be filtered to display only those call centers in the Central region. All items in the Call Center selector would be selected. The Grid/
Graph would no longer be filtered by the selector, so the Grid/Graph would display all the call centers, as shown below:

This behavior is controlled by the **Update target filters when current selection changes** setting. Steps to change it are included in the following procedure.

**Creating a selector to target another selector**

**Prerequisites**

This procedure assumes that:

- The document contains a Grid/Graph or panel stack. For steps, see the *Grid/Graphs* chapter of the *Report Services Document Creation Guide* or *Inserting and defining panels, page 75.*
• The document contains a selector that targets the Grid/Graph or panel stack. This will be the target selector.

• Automatic target maintenance is disabled. For steps, see *Disabling automatic target maintenance to allow manual target selection, page 177.*

  ▪ If you want to keep automatic target maintenance, place the target selector on a panel stack in the same document section as the source selector instead. The source selector will automatically target the panel stack, and update the target selector.

---

**To create a selector that targets another selector**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. On the **Insert** menu, point to **Selector**, then choose the selector style to use to display the selector. When you move the cursor to the Layout area, the pointer becomes crosshairs.

3. Click in the section of the Layout area in which you want to place the selector. If you click and drag in the section, you can size the selector.

4. Right-click the selector and choose **Properties and Formatting**. The Properties and Formatting dialog box opens.

5. From the left, click **Selector**.

6. From the **Action type** drop-down list, choose **Select Attribute element**.

7. The Source list contains all of the attributes in all of the datasets in the document. From the **Source** drop-down list, select the attribute to use as the source of the selector. The elements of this attribute will be displayed as items in the selector.

8. From the list of **Available** targets on the left, choose the target selector and click > to add it to the list of **Selected** targets.

9. Select the Grid/Graph or panel stack and click > to add it to the list of **Selected** targets. You can also add other Grid/Graphs and panel stacks as targets as well.

   If you did not disable automatic target maintenance, the Available targets and Selected targets lists are not available. To disable it, click the link to change to manual control and select **OK** at the
prompt to continue. The lists are now available. You can remove any Grid/Graphs and panel stacks that were added as Selected targets when automatic target maintenance was enabled. To do this, select them in the **Selected targets** list and click `<.`

10 You can determine which items are selected or cleared in the target selector, and what items are displayed in the target selector’s target, when this selector is updated. No matter which option is chosen, any changes made in this selector determine which items are displayed in the target selector. For examples of the options, see *Determining whether and how selections in the target selector are updated, page 151*.

To do this, select **Apply selections as a filter**. Select one of the following options from the **Update target filters when current selection changes** drop-down list:

- To keep the current selections in the target selector and continue filtering its target, select **Do not update**. This is the default.

- If the All item is shown in the target selector, you can specify that all items and the All item are displayed in the target selector, all items in its target are displayed, and the target selector’s status is changed to unset. Select **Unset**.

- If the All item is not shown in the target selector, you can specify that all items in the target selector are cleared, all items are displayed in its target, and the target selector’s status is changed to unset. Select **Unset**.

- To specify that all items are displayed in the target selector and in the target, select **All**.

11 Click **OK** to return to the document.

Now that you have created the selector, you can modify properties, such as multiple selections and simultaneous display of selector items, and format the selector. For a list of tasks, see *Next steps after creating a selector, page 133*.

### Creating a selector to filter List controls in a Transaction Services-enabled document

You can create a selector that filters the choices available in a List control displayed in a Transaction Services-enabled document.
For example, you create a document that allows you to approve time off requests for employees selected from a list. If the company is large, viewing the full list of employees may be unwieldy. Instead, you can create a selector that contains each team in your department, then restrict the employees in the list to those from a single team.

**Prerequisites**

This procedure assumes that:

- You have created a Transaction Services-enabled document that contains the List control to update when an item is chosen in the selector. The List control must display attribute elements from a selected dataset as items in the control (this is called a data-driven input control). For steps to create a Transaction Services-enabled document, as well as steps to create a List control, see the Report Services Document Creation Guide.

- Automatic target maintenance is disabled. For steps, see Disabling automatic target maintenance to allow manual target selection, page 177.

**To create a selector that filters a List control**

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. On the Insert menu, point to Selector, then choose the display style for the selector. When you move the cursor to the Layout area, the pointer becomes crosshairs.

3. Click in the section of the Layout area in which you want to place the selector. If you click and drag in the section, you can size the selector.

4. Right-click the selector and choose Properties and Formatting. The Properties and Formatting dialog box opens.

5. From the left, click Selector.

6. From the Action type drop-down list, choose Select Attribute Element.

7. The Source list contains all of the attributes in all of the datasets in the document. From the Source drop-down list, select the attribute to use as the source of the selector. The elements of this attribute will be displayed as items in the selector.
8 From the list of **Available** targets on the left, choose the List control and click > to add it to the list of **Selected** targets. The name used to identify each List control varies depending on whether the List control was created based on a text field or dataset object on a Grid/Graph:

- If the List control was created based on a text field, it is listed using the name of the text field.
- If the List control was created based on a metric in a Grid/Graph, it is listed as \textit{GridGraph:Metric}, where \textit{GridGraph} is the name of the Grid/Graph and \textit{Metric} is the name of the metric.
- If the List control was created based on an attribute in a Grid/Graph, it is listed as \textit{GridGraph:Attribute@AttributeForm}, where \textit{GridGraph} is the name of the Grid/Graph, \textit{Attribute} is the name of the attribute, and \textit{AttributeForm} is the name of the attribute form.

If you did not disable automatic target maintenance, the Available targets and Selected targets lists are not available. To disable it, click the link to change to manual control and select \textbf{OK} at the prompt to continue. The lists are now available. You can remove any Grid/Graphs, panel stacks, and so on that were added as Selected targets when automatic target maintenance was enabled. To do this, select them in the **Selected targets** list and click <.

9 Click \textbf{OK} to return to the document.

Now that you have created the selector, you can modify properties, such as multiple selections and simultaneous display of selector items, and format the selector. For a list of tasks, see \textit{Next steps after creating a selector, page 133}.

### Applying selections as filters or slices

The selections a user makes in a selector affects how data is calculated and displayed in the selector’s target. You can define the selector to either filter or slice the target:

- **Filtering** means that the data for the current selection is calculated only when it is requested by the user. The selections are used to filter the underlying dataset before the metric values are aggregated at the level of the Grid/Graph that is displayed in the dashboard-style document. If the source attribute is not included in the Grid/Graph, the metric values from
all the selected elements are aggregated and shown at the level specified in the Grid/Graph.

All metric condition selectors, which filter metric values or ranks, and selectors that target other selectors are filtering selectors. You cannot change them to slicing selectors.

- **Slicing** means that the data for each available item in the selector is calculated in advance when the document is first displayed. The selections are used to determine which slices of data are combined and shown in the Grid/Graph. Even if the source attribute is not included in the Grid/Graph, the data is still sliced at the level of the source attribute, and therefore the metric values from multiple selected items are not added together. Instead, the data for each selected element is shown separately in the Grid/Graph, the same as if the source attribute had been included in the Grid/Graph.

For example, the dataset of a dashboard-style document contains Region, Year, and the Revenue metric. A Grid/Graph displays Year and Revenue only, and is targeted by a selector with Region as its source. The selector is defined to slice the data. When Central is selected, three rows, one for each year, are displayed, as shown below:

If you select Mid-Atlantic as well as Central, six rows are displayed, two for each year, as shown below:
This occurs because the selector slices the data by region before the user selections are made, and cannot aggregate the slices for multiple regions.

If you change the selector to filter rather than slice the data, the yearly revenue is aggregated across the selected regions. The yearly revenue is calculated by adding the Central and Mid-Atlantic values for each year, and only one row for each year is displayed in the Grid/Graph, as shown below:

Other important differences between filtering and slicing selectors are described below:

- Slicing allows the total to be displayed as an item in the selector. A filtering selector does not display the total as a selector item. (For background information on selector totals, see *Showing totals for selectors*, page 197.)

- Slicing allows you to specify that the selector automatically uses a default selection when other changes in the dashboard-style document cause the selection made by the user to return no data. Default selections are not available for filtering selectors. (For background information on default selections, see *Determining how the target of a selector displays when no data exists*, page 185.)

- Slicing is performed on Intelligence Server in Express Mode and on the client in Flash Mode. Filtering is performed on the Intelligence Server in both modes. This means that when a user chooses different items in a selector, a call is made to the web server to update the document, except when a slicing selector is used in Flash Mode. In that case, the web server is not called, which can make the document run faster as users change selections. In contrast, a filtering selector can speed up the initial load time of a document in Flash Mode, since all the slices do not need to be initially downloaded to the client. However, when a filtering selector targets a panel stack, all static content, dynamic text fields, and links in the target panel are copied and sent to the client for every new slice of data. To maximize performance, MicroStrategy recommends removing...
all content that is either static or independent of the selector out of the target panel.

- If a selector is sliced, you can define the current state, which determines how the target is displayed when the dashboard-style document is executed. The target can display all the selector items, a specific number of the first items, or a specific number of the last items. If a selector is filtered, you can define the current state as unset only, which displays all the selector items. For more information on the different states, see *Determining how the target of a selector displays (current state)*, page 189.

- If a dashboard-style document contains multiple datasets, a slicing selector shows only the items available in the target. A filtering selector shows all the items available in all the datasets. For example, a selector on Category targets a Grid/Graph that displays only Books and Movies. A second dataset on the document is filtered for Books and Music, but is not used on the Grid/Graph. If the selector is filtered, the selector displays Books, Movies, and Music (all the categories available in all the datasets). If the selector is sliced, the selector displays Books and Movies (only the categories available on the target). For a more detailed example, see *Selectors in a dashboard-style document with multiple datasets* below.

### Selectors in a dashboard-style document with multiple datasets

If a dashboard-style document contains multiple datasets, which items are displayed in a selector depends on the selector type:

- A slicing selector shows only the items available on the target.
- A filtering selector shows all the items available in all the datasets.

For example, a dashboard-style document contains the following datasets:

- Profit by Category, which contains Category and Profit, and is filtered for Books, Electronics, and Movies
- Revenue by Category, which contains Category and Revenue, and is filtered for Movies and Music

A Grid/Graph is created using the Profit by Category dataset as the data source. A slicing selector is created to target the Grid/Graph. The selector
displays Books, Electronics, and Movies as selector items, based on the elements available in the target. This is shown below:

If the selector is changed to be a filtering selector, the selector displays Books, Electronics, Movies, and Music as selector items, based on the categories available in all the datasets on the dashboard-style document. Because the Profit by Category data source does not contain data on Music, Music cannot be displayed on the Grid/Graph.

If the Grid/Graph used the Revenue by Category dataset as the data source instead, a filtering selector still displays all the categories. Even when the All item is selected, the Grid/Graph displays only Movies and Music, since those are the only categories available on the Grid/Graph’s data source.
Change the selector to slice the target, and only the categories in the data source's filter are shown in the selector:

![Selector screenshot](image)

For steps to add multiple datasets and to create Grid/Graphs, see the *Report Services Document Creation Guide*.

**Selectors in a dashboard-style document that is viewed off-line**

When a dashboard-style document is viewed off-line (exported to Flash, in a subscription, or in MicroStrategy Office):

- If a selector is applied using filtering, only the data for the current selections are included in the dashboard-style document. An off-line user cannot change the selector and update the target.

- If a selector is applied using slicing, all the slices, and therefore all the data, are included in the dashboard-style document. An off-line user can change the selector and update the target.

For example, the dataset of a dashboard-style document contains Region, Year, and the Revenue metric. A Grid/Graph displays Year and Revenue only, and is targeted by a selector with Region as its source. The selector is applied as a filter. Only Central is selected, and the dashboard-style document is exported to a Flash file to be used off-line, without using MicroStrategy. The Flash file contains only the data for Central, and no other selections can be made.

If the selector is applied as a slice instead, all the data is sliced and included in the Flash file. Even if only the Central region is selected when the
dashboard-style document is exported, you can use the selector in the Flash file and display other regions.

For instructions to export a dashboard-style document to Flash, see Exporting dashboard-style documents to Flash for stand-alone use, page 60.

Defining selectors to filter or slice targets

You can define whether:

- A specific selector slices or filters the data. See To apply selections as filters or slices for a specific selector, page 165 for instructions.

  All metric condition selectors, which filter metric values or ranks, and selectors that target other selectors are filtering selectors. You cannot change them to slicing selectors.

- A specific target is sliced or filtered by a selector, allowing you to filter one target and slice another using the same selector. See To apply selections as filters or slices for a specific target, page 165.

- Selectors in the entire dashboard-style document slice or filter the data. This document-level setting is used to define the behavior of new selector targets, except when the target being added is already the target of another selector that uses the same source. In that case, the target uses the behavior defined in the other selector. For instructions, see To apply selections as filters or slices (document-level), page 166.

For example, at the document level, selectors are defined as filters.

- Selector1 targets Grid/Graph1 as a filter, using Region as the source.

- Selector2 targets Grid/Graph2 as a slice, using the same attribute, Region, as the source.

- The dashboard-style document also contains a third Grid/Graph, which is not the target of any selectors.

Open Selector1 and add Grid/Graph2 as a target. It is automatically defined as a slice, because Grid/Graph2 is already the target of Selector2 (a slicing selector), and both selectors use the same attribute, Region.

Add Grid/Graph3 as a target to Selector1. It is automatically defined as a filter, because Grid/Graph3 is not already the target of another selector.
**Prerequisites**

The following procedures assume that you have already created a selector. The selector must not be a metric condition selector or a selector that targets another selector. For steps, see *Methods to create a selector, page 129.*

---

**To apply selections as filters or slices for a specific selector**

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.
2. Right-click the selector to update, and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
3. From the left, click **Selector**.
4. To define how the selector is applied to all targets, do one of the following:
   - To apply the selections as a filter, select the **Apply selections as a filter** check box.
   - To apply the selections as a slice, clear the **Apply selections as a filter** check box.

   **If** **Apply selections as a filter** **is unavailable**, the selector is applied as both a filter and a slice for different targets.

5. Click **OK** to return to the dashboard-style document.

---

**To apply selections as filters or slices for a specific target**

You use Developer to change the type for a specific target.

1. Open the dashboard-style document in Design View in the Document Editor.
2. Right-click the selector to update, and select **Properties**. The Properties dialog box opens.
3. Click the **Selector** tab.
4. In the **Selected targets** list, select the **Type** for the target that you want to change.
5 Click OK to return to the dashboard-style document.

---

**To apply selections as filters or slices (document-level)**

This document-level setting is applied to all new selectors that do not have a target, except when the new target is already the target of another selector that uses the same source.

1 In MicroStrategy Web, open the dashboard-style document in **Design** or **Editable Mode**.

2 From the **Tools** menu, select **Document Properties**. The Document Properties dialog box opens.

3 From the left, select **Document**, under Document Properties.

4 Do one of the following:
   - To apply the selections as a filter, select the **Apply selections as a filter for all new targets** check box.
   - To apply the selections as a slice, clear the **Apply selections as a filter for all new targets** check box.

5 Click **OK** to return to the dashboard-style document.

---

**Determining whether the selector includes or excludes data: selection type**

You can specify whether an element selector or a metric condition slider selector includes or excludes the selected data, by defining the Selection Type option. (An element selector displays different elements of attributes, custom groups, or consolidations; a metric condition slider displays a slider to filter metric values or rank.)

For example, a dashboard-style document contains an element selector that displays regions and targets a Grid/Graph. A user can select regions and by
default they are displayed rather than hidden in the Grid/Graph, as shown below.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$158,930</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>Vernon</td>
<td>$331,735</td>
<td>$280,504</td>
<td>$51,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
<td>$888,702</td>
<td>$159,074</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$1,026,874</td>
<td>$871,679</td>
<td>$155,195</td>
</tr>
<tr>
<td></td>
<td>Ingles</td>
<td>Walter</td>
<td>$229,439</td>
<td>$194,651</td>
<td>$34,588</td>
</tr>
<tr>
<td></td>
<td>Smith</td>
<td>Thomas</td>
<td>$221,379</td>
<td>$188,010</td>
<td>$33,368</td>
</tr>
<tr>
<td></td>
<td>Young</td>
<td>Sarah</td>
<td>$209,634</td>
<td>$178,331</td>
<td>$31,303</td>
</tr>
<tr>
<td></td>
<td>De Le Torre</td>
<td>Sandra</td>
<td>$607,895</td>
<td>$514,795</td>
<td>$93,100</td>
</tr>
<tr>
<td></td>
<td>Kelly</td>
<td>Laura</td>
<td>$2,350,720</td>
<td>$1,992,726</td>
<td>$357,994</td>
</tr>
<tr>
<td></td>
<td>Kieferson</td>
<td>Jack</td>
<td>$564,933</td>
<td>$497,463</td>
<td>$67,470</td>
</tr>
<tr>
<td></td>
<td>Sawyer</td>
<td>Leanne</td>
<td>$2,411,912</td>
<td>$2,043,693</td>
<td>$368,219</td>
</tr>
<tr>
<td></td>
<td>Sonder</td>
<td>Melanie</td>
<td>$295,108</td>
<td>$251,183</td>
<td>$43,925</td>
</tr>
<tr>
<td></td>
<td>Yager</td>
<td>Beth</td>
<td>$2,303,847</td>
<td>$1,953,823</td>
<td>$350,024</td>
</tr>
</tbody>
</table>

Change the selection type to exclude items, and update the text displayed in the title bar to reflect that change. When the dashboard-style document is executed again, and the user selects Mid-Atlantic and Northeast, all regions
except Mid-Atlantic and Northeast are displayed. Notice that Mid-Atlantic and Northeast are still selected, but are also crossed out, in the selector.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp Nancy</td>
<td></td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale Loren</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Torrison Mary</td>
<td>$1,690,350</td>
<td>$1,430,855</td>
<td>$259,485</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zemlicka George</td>
<td>$822,500</td>
<td>$667,693</td>
<td>$124,807</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Becker Kyle</td>
<td>$508,234</td>
<td>$430,346</td>
<td>$77,887</td>
<td></td>
</tr>
<tr>
<td>Northwest</td>
<td>Gedot Harriet</td>
<td>$739,741</td>
<td>$629,986</td>
<td>$110,655</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hal David</td>
<td>$513,213</td>
<td>$434,770</td>
<td>$76,443</td>
<td></td>
</tr>
<tr>
<td>South</td>
<td>Conner Beatrice</td>
<td>$1,650,742</td>
<td>$1,397,270</td>
<td>$253,472</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Nelson Arthur</td>
<td>$1,654,297</td>
<td>$1,402,779</td>
<td>$251,519</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pierce Charles</td>
<td>$2,084,241</td>
<td>$1,782,276</td>
<td>$301,966</td>
<td></td>
</tr>
<tr>
<td>Southeast</td>
<td>Benner Ian</td>
<td>$520,737</td>
<td>$441,073</td>
<td>$79,664</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Lynch Sam</td>
<td>$592,471</td>
<td>$503,833</td>
<td>$86,639</td>
<td></td>
</tr>
<tr>
<td></td>
<td>McClain Sean</td>
<td>$531,371</td>
<td>$453,072</td>
<td>$78,299</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stromm Fred</td>
<td>$595,372</td>
<td>$505,298</td>
<td>$90,074</td>
<td></td>
</tr>
<tr>
<td>Southwest</td>
<td>Bates Michael</td>
<td>$1,068,907</td>
<td>$964,996</td>
<td>$163,911</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bel Caitlin</td>
<td>$1,040,481</td>
<td>$883,441</td>
<td>$157,039</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hunt Matthew</td>
<td>$731,413</td>
<td>$619,634</td>
<td>$111,779</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Johnson Andrew</td>
<td>$445,052</td>
<td>$378,221</td>
<td>$66,831</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Schafer Rose</td>
<td>$408,280</td>
<td>$346,508</td>
<td>$61,772</td>
<td></td>
</tr>
</tbody>
</table>

The following procedure assumes you have already created an element selector or a metric condition slider selector. For instructions, see Methods to create a selector, page 129.

**Prerequisite**

The document contains either:

- An element selector, which displays different elements of attributes, custom groups, or consolidations. For steps to create it, see Creating a selector for elements on a Grid/Graph, page 135 or Creating a selector that updates a dynamic text field on a panel stack, page 146,

- A metric condition slider selector, which displays a slider to filter metric values or rank. For steps to create it, see Creating a selector that filters metric values, page 137.

**To define the selection type**

1 In MicroStrategy Web, open a document in **Design** or **Editable Mode**.
2 Right-click the selector to update, and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3 From the left, click **Selector**.

4 From the **Selection Type** drop-down list, select one of the following:
   - To have a user's selection include data, select **Include**. The target displays the items that the user chooses.
   - To have a user's selection exclude data, select **Exclude**. The target hides the items that the user chooses.

5 Click **OK** to return to the dashboard-style document.

### Automatically maintaining targets for selectors

If targets are enabled to be automatically maintained:

- All attribute, metric, and metric condition selectors automatically target all Grid/Graphs and panel stacks that are in the same panel or document section as the selector.

- You cannot change the target of an attribute, metric, or metric condition selector, except by moving controls to different document sections, or using the panel stack technique described below.

- You cannot choose a selector as the target of another selector. You can, however, place the target selector on a panel in the same document as the source selector. The target selector is the selector updated by the source selector. With automatic target maintenance, the source selector will automatically target that panel stack.

- Any new Grid/Graph or panel stack is automatically added as the target of all attribute, metric, and metric condition selectors in the same panel or document section.

- Targets are not automatically maintained for panel selectors; you always manually define the targets for panel selectors. For instructions, see *Methods to create a selector, page 129*.

Target maintenance is defined for each layout in a dashboard-style document. You can use manual targets in one layout, while allowing automatic target maintenance in another layout.
For example, a layout in a dashboard-style document has automatic target maintenance enabled. The document contains the following objects, as shown in Design View below:

- Grid/Graph 1 in the Document Header section
- Grid/Graph 2 in the Detail Header section
- Panel stack 1, which displays region, in the Detail Header

Insert a selector (Selector 1) into the Document Header, and another (Selector 2) into the Detail Header.

- Selector 1 automatically targets Grid/Graph 1, as shown in the Property List below, since they are both in the same document section.
- Selector 2 automatically targets Grid/Graph 2 and Panel Stack 1, as shown in the Properties dialog box below, since all three objects are in the same document section. Grid/Graph 1 is not a target of Selector 2. (You can tell that automatic target maintenance is enabled, because the Available targets list and arrow buttons are grayed out, and the Manual Targets button is available.)

```
- Detail Header
  - Element 1
  - Grid/Graph 2
  - Region

Available targets:  Selected targets:

<table>
<thead>
<tr>
<th>Target</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid/Graph 1</td>
<td></td>
</tr>
<tr>
<td>PanelStack1</td>
<td>Slice</td>
</tr>
<tr>
<td>Grid/Graph 2</td>
<td>Slice</td>
</tr>
</tbody>
</table>

This layout is configured to automatically maintain targets. If you would like manual control, click the button below.

Manual Targets
```

The selectors are not completely defined by the automatic target maintenance. They do not have a Source, as shown in the Property List image above. For both selectors, define the Source as Region. Open the dashboard-style document in Interactive Mode. Select Mid-Atlantic in Selector 1 (the selector above Grid/Graph 1), and Central in Selector 2 (the
selector above Grid/Graph 2). The dashboard-style document displays as shown below:

- Grid/Graph 1 displays data for the region chosen in Selector 1 (Mid-Atlantic).
- Grid/Graph 2 displays data for the region chosen in Selector 2 (Central).
- Panel Stack 1 will display the region name chosen in Selector 2 (Central).

Insert a second panel stack (Panel Stack 2) in the Detail Header section. The new panel stack is automatically added as a target of Selector 2. Add the Region attribute to Panel Stack 2. When you view the dashboard-style document in Interactive Mode, Panel Stack 2 displays the region name
chosen in Selector 2, which is Central in the dashboard-style document sample shown below:

Insert a panel stack selector for Panel Stack 1 (right-click the panel stack and select **Insert Panel Stack Selector**). The new selector's target is defined as Panel Stack 1, and the selector will change which panel is displayed in the target. A panel stack selector automatically targets the panel stack that it is created for; targets are not automatically maintained for panel stack selectors. If the automatic target maintenance applied to panel stack selectors, both Panel Stack 1 and Panel Stack 2 would be targeted, since both panel stacks are in the same document section as the selector. When you view the dashboard-style document in Interactive Mode, Panel Stack 1 displays the panel chosen in the panel stack selector. In the following
example, the panel stack selector has been used to select Panel 2. Note that Panel Stack 1 now displays Panel 2, rather than a region name.

An attribute on a Grid/Graph can be used as a selector that targets a panel stack or another Grid/Graph. If a user clicks an attribute on the first Grid/Graph, the target changes to display information for only that attribute. Automatic selector maintenance applies to these types of selectors, as well. All the Grid/Graphs and panel stacks in the same document section or panel as the selected Grid/Graph are automatically chosen as targets. For more information, see Using Grid/Graphs as selectors to control other Grid/Graphs, page 219.

**Controlling targets when targets are automatically maintained**

When targets are automatically maintained in a layout, you can still control what target is chosen for a selector, by placing controls in different document sections. For example, a dashboard-style document should have a selector that targets Grid/Graph 1 but not Grid/Graph 2. Simply place Selector 1 and Grid/Graph 1 in one document section, where they are automatically linked. Place Grid/Graph 2 in another document section, and the Grid/Graph is not
targeted by Selector 1. (You can insert additional document sections as necessary; see the Developer Help (formerly the Desktop Help) for instructions.)

If an object is moved between panels or document sections, selector targets are updated to automatically maintain the targets. For example, Selector 1 targets Panel Stack 1, located in the Document Header section. The Detail Header section contains Selector 2, which targets Panel Stack 2 and Grid/Graph 1 which are also in the Detail Header section. If you move Panel Stack 2 from the Detail Header to the Document Header:

- Selector 1 now automatically targets Panel Stack 2, as well as Panel Stack 1.
- Selector 2 now automatically targets only Grid/Graph 1.

If you cannot move controls, you can place them in different panel stacks in the same document section. Make the panel stack invisible by using a transparent background and no borders, and hiding the title bar.

For example, a dashboard-style document contains two Grid/Graphs, 01 Basic Report and Region-Category Inventory, in the Detail Header, as shown in Design View below.

![Design View](image)

You need a selector in the Detail Header that targets only the Basic Report. When a user selects a different region, the Basic Report should change, but never the Inventory report. Automatic target maintenance is enabled in the layout, because you want targets in other parts of the layout to continue to be automatically updated when you add new panel stacks and Grid/Graphs.

If you add the selector in the Detail Header, it will target both the Basic Report and the Inventory report. Instead, create a panel stack in the Detail Header, and format it to be invisible (a transparent background, no borders,
and hidden title bar). Move the Basic Report into the panel stack. Add a selector to the panel stack. The selector targets the Basic Report, because they are on the same panel stack. The selector does not target the Inventory report, because the Inventory Report, although in the same document section as the selector, is not on the same panel stack. The following image of the Selector tab of the Properties dialog box for the selector shows that:

1 Automatic target maintenance is enabled (the Available targets and Selected targets lists are unavailable)

2 Only the Basic Report is selected as a target

The dashboard-style document is shown below, in Interactive View. Notice that you do not see the panel stack at all.
Click the Southeast button on the selector to display data for only Southeast in the Basic Report. The Inventory report does not change, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>(All)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Canada</td>
<td>Ian Benner</td>
<td>$520,737</td>
</tr>
<tr>
<td>Central</td>
<td>Lynch Sam</td>
<td>$592,471</td>
</tr>
<tr>
<td>England</td>
<td>McCain Sean</td>
<td>$531,371</td>
</tr>
<tr>
<td></td>
<td>Strome Fred</td>
<td>$595,372</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Category</th>
<th>Begin on Hand</th>
<th>On Hand</th>
<th>Qty</th>
</tr>
</thead>
<tbody>
<tr>
<td>Canada</td>
<td>Books</td>
<td>6,910</td>
<td>911</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Electronics</td>
<td>1,610</td>
<td>2,526</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Movies</td>
<td>2,810</td>
<td>11,075</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Music</td>
<td>7,520</td>
<td>14,064</td>
<td></td>
</tr>
<tr>
<td>Central</td>
<td>Books</td>
<td>6,910</td>
<td>911</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Electronics</td>
<td>1,610</td>
<td>2,526</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Movies</td>
<td>2,810</td>
<td>11,075</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Music</td>
<td>7,520</td>
<td>14,064</td>
<td></td>
</tr>
<tr>
<td>England</td>
<td>Books</td>
<td>6,910</td>
<td>911</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Electronics</td>
<td>1,610</td>
<td>2,526</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Movies</td>
<td>2,810</td>
<td>11,075</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Music</td>
<td>7,520</td>
<td>14,064</td>
<td></td>
</tr>
<tr>
<td>France</td>
<td>Books</td>
<td>6,910</td>
<td>911</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Electronics</td>
<td>1,610</td>
<td>2,526</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Movies</td>
<td>2,810</td>
<td>11,075</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Music</td>
<td>7,520</td>
<td>14,064</td>
<td></td>
</tr>
<tr>
<td>Germany</td>
<td>Books</td>
<td>6,910</td>
<td>911</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Electronics</td>
<td>1,610</td>
<td>2,526</td>
<td></td>
</tr>
</tbody>
</table>

Disabling automatic target maintenance to allow manual target selection

You may want to manually select the targets for attribute, metric, and metric condition selectors in a layout. For example, you may want a selector to target a Grid/Graph or panel stack that is not in the same document section or panel as the selector. You may want a selector to target another selector.

To allow this, disable automatic target maintenance. Targets that were automatically maintained are saved; no targets are deleted or changed. You can now define new targets, including other selectors, for existing attribute, metric, and metric condition selectors. If you create any new selectors, you must manually select the targets for them.

Using manual target selection, you can:

- Create a selector that targets a Grid/Graph or panel stack that is not in the same document section or panel as the selector
- Create a selector that targets another selector
For example, a dashboard-style document has automatic target maintenance enabled. The dashboard-style document contains the following objects:

- In the Document Header section:
  - Grid/Graph 1
  - Selector 1, which targets Grid/Graph 1 to display data about the selected Region

- In the Detail Header section:
  - Grid/Graph 2
  - Panel Stack 1
  - Selector 2, which targets Grid/Graph 2, to display data about the selected region, and Panel Stack 1, to display the selected region name
  - Panel Stack Selector, which targets Panel Stack 1 to switch panels

Disable automatic target maintenance. The selector targets remain the same, but you can now modify them manually, as shown in the Properties dialog box below:

Add another selector to the Detail Header section. No targets are automatically defined, so you must manually define the targets.

---

**To disable automatic target maintenance while editing a selector**

This procedure assumes that you are editing the settings of a selector.

1. On the Selector page of the Properties and Formatting dialog box, click the link to change to manual control. A warning message opens, indicating that you will need to manually maintain targets if you disable automatic target maintenance.
2 Click **OK**. You are returned to the Properties and Formatting dialog box. Automatic target maintenance has been disabled for all selectors in the layout.

---

**To disable automatic target maintenance**

1 In MicroStrategy Web, open a document in **Design** or **Editable Mode**.

2 From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.

3 Click **Layout** on the left, under **Layout Properties**.

4 Clear the **Automatically maintain targets for all selectors in this Layout** check box.

5 Click **OK** to return to the dashboard-style document.

---

**Enabling automatic target maintenance**

When you enable automatic target maintenance on a layout, the targets of all existing attribute, metric, and metric condition selectors are replaced with all the Grid/Graphs and panel stacks that are in the same panel or document section as the selector. However, if a selector is the target of another selector, it is not replaced.

For example, a dashboard-style document has automatic target maintenance disabled. The dashboard-style document contains the following objects:

- In the Document Header section:
  - Grid/Graph 1
  - Selector 1, which targets Grid/Graph 1 and Grid/Graph 2 to display data about the selected Region
- In the Detail Header section:
  - Grid/Graph 2
  - Panel Stack 1
  - Selector 2, which targets Panel Stack 1 to display the selected region name
Panel Stack Selector, which targets Panel Stack 1 to switch panels

Notice that Selector 1 targets Grid/Graph 2, which is not in the same document section as the selector.

Enable automatic target maintenance. The targets of all existing selectors are redefined to those Grid/Graphs and panel stacks in the same document section as the selector. Now the dashboard-style document contains the following objects:

- In the Document Header section:
  - Grid/Graph 1
  - Selector 1, which targets Grid/Graph 1 to display data about the selected Region (Grid/Graph 2 has been removed from the target list)

- In the Detail Header section:
  - Grid/Graph 2
  - Panel Stack 1
  - Selector 2, which targets Grid/Graph 2 to display data about the selected Region, and Panel Stack 1 to display the selected region name (Grid/Graph 2 has been added to the target list)
  - Panel Stack Selector, which targets Panel Stack 1 to switch panels (panel stack selectors are not affected by automatic target maintenance)

---

**To enable automatic target maintenance**

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.
2. From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.
3. Click **Layout** on the left, under Layout Properties.
4. Select the **Automatically maintain targets for all selectors in this layout** check box.
5. Click **OK** to return to the dashboard-style document.
Allowing users to select multiple items

Recall that items in a selector are the elements, metrics, metric values, or panels that are listed in the selector. The user selects an item to change the panel, Grid/Graph, or other selector. If the style of a selector is one of those listed below, the user can choose more than one item in the selector:

- Slider (except for metric condition selectors)
- Search Box
- Listbox
- Link Bar
- Button Bar
- Check Boxes

Use the **Allow multiple selections** option to determine whether users can select more than one item in a selector. For all other styles, this option is unavailable, since those styles do not support multiple selections.

The Check Boxes style always allows multiple selections; you cannot change the **Allow multiple selections** option.

To allow multiple selections in a selector

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.
2. Right-click the selector to modify, and select **Properties and Formatting**. The Properties and Formatting dialog box opens.
3. From the left, choose **Selector**.
4. Select the **Allow multiple selections** check box.
5. Click **OK** to return to the dashboard-style document.
To disable multiple selections in a selector

1. Open the dashboard-style document using the Document Editor in Design View.

2. From the Format menu, select Properties. The Properties dialog box opens.

3. On the Selector tab, clear the Allow multiple selections check box.

4. Click OK to return to the dashboard-style document.

Controlling how data updates: Automatically apply selector changes

Once a user chooses an item in the selector, the target immediately updates without any additional user interaction. This is referred to as automatic submission. If multiple items are selected, the target is automatically updated after each individual selection, which can take some time. Therefore, if multiple items are allowed, disable the Automatically apply selector changes option, allowing the user to choose when to update the target. The user can pick either a single item or multiple items, and then click Apply to update the target.

For metric condition selectors that use a qualification, the user must click the check mark ✓ to apply the qualification to the target.

The Automatically apply selector changes option is set for an entire dashboard-style document, not for an individual selector. Selectors on a filter panel (a type of panel stack that contains only selectors) are controlled by a similar setting for filter panels, which applies in Express Mode and Flash Mode. The document level setting applies to selectors in a filter panel displayed in other modes. For details on how the filter panel setting works, see Controlling how data updates in a filter panel: Automatic apply, page 100.

The Apply button is displayed only if the Automatically apply selector changes option is disabled and the user clears or selects an item in the selector.
To disable automatic submission for a dashboard-style document

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.
2. From the **Tools** menu, select **Document Properties**. The Properties dialog box opens.
4. Clear the **Automatically apply selector changes** check box.
5. Click **OK** to return to the dashboard-style document.

Disabling simultaneous display of all items in a selector

The dashboard-style document in the following image is shown in Editable Mode. It contains a Grid/Graph with a link bar selector. The items of the selector are the regions from the Grid/Graph. The user has clicked (All) in the selector, so all the regions are displayed on the Grid/Graph.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>Mary</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
<tr>
<td></td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$158,930</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>Vernon</td>
<td>$331,735</td>
<td>$280,504</td>
<td>$51,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
<td>$886,702</td>
<td>$151,074</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$1,026,874</td>
<td>$871,679</td>
<td>$155,195</td>
</tr>
</tbody>
</table>
The All option is displayed by default in a selector, but you can remove it by disabling the Show option All setting. The same dashboard-style document, with this setting disabled, looks like the following:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp Nancy</td>
<td></td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale Loren</td>
<td></td>
<td>$1,659,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrison Mary</td>
<td></td>
<td>$1,690,350</td>
<td>$1,430,065</td>
<td>$259,465</td>
</tr>
<tr>
<td></td>
<td>Zemlicka George</td>
<td></td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
</tbody>
</table>

Now a user can only display each region separately; he cannot display all regions simultaneously.

The All option is not available when the target of the selector is a panel stack, since you cannot display multiple panels simultaneously. It is also unavailable for metric condition selectors.

### To disable simultaneous display of all items

1. In MicroStrategy Web, open a document in Design or Editable Mode.
2. Right-click the selector to modify, and select Properties and Formatting. The Properties and Formatting dialog box opens.
3. From the left, choose Selector.
4. Clear the Show option for All check box.
5. Click OK to apply the changes.

### Renaming the All option of a selector

The All option allows a user to display all the items in the selector. For example, a Grid/Graph displays metrics for employees and regions. The user can choose which regions to display by using a selector. If the user clicks the (All) item, all the regions are displayed in the Grid/Graph. This example is shown in Disabling simultaneous display of all items in a selector, page 183.
By default, this item is displayed as (All), but you can replace the text of the item. To continue with the example, replace (All) with All Regions to provide an explicit description of the item. This is shown below.

<table>
<thead>
<tr>
<th>All Regions</th>
<th>Central</th>
<th>Mid-Atlantic</th>
<th>Northeast</th>
<th>Northwest</th>
<th>South</th>
<th>Southeast</th>
<th>Southwest</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,659,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>Mary</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$158,930</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>Vernon</td>
<td>$331,735</td>
<td>$280,504</td>
<td>$51,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
<td>$888,702</td>
<td>$159,074</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>Robert</td>
<td>$1,026,874</td>
<td>$871,679</td>
<td>$155,195</td>
</tr>
</tbody>
</table>

To rename the All option of a selector

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.
2. Right-click the selector to modify and select **Properties and Formatting**. The Properties and Formatting dialog opens.
3. From the left, choose **Selector**.
4. Select the **Show option for All** check box.
5. Enter the new name of the item in the **Alias** field.
6. Click **OK** to apply the changes.

Determining how the target of a selector displays when no data exists

A panel displays a Grid/Graph with Call Center and Region as the attributes. The panel also contains a selector that lists Call Centers and targets the Grid/Graph. Outside of the panel stack, another selector lists Regions. Its target is the panel stack and therefore the selector on that panel as well. Refer to these
selectors as the regional selector and the call center selector. This dashboard-style document is shown below in Design View.

In Interactive Mode, choose **Central** in the regional selector. The first Call Center, Milwaukee, is displayed in the Grid/Graph, as shown below in Interactive Mode. Notice that the call center selector automatically shows Milwaukee as selected.

Select **Fargo** in the call center selector, and the Grid/Graph is updated, as shown below.
Click **Central** in the region selector to clear it. Since no regions, and therefore no call centers, are selected, the Grid/Graph cannot display any data. A message is displayed that no data exists, as shown below:

Select **Northwest** in the regional selector. The Grid/Graph displays a message that no data is returned, and no call center is selected in the call center selector. The Grid/Graph tries to return data that is both Region = Northwest and Call Center = Fargo, but no such data exists, as shown below.

To automatically display the first Call Center in the new Region instead, allow the call center selector to be automatically updated. If you follow the same path as before, when you select **Northwest** in the regional selector, the Grid/Graph is updated to display San Francisco, as shown below. Notice that the call center selector shows San Francisco as selected.
Prerequisites

Before you can allow a selector to be automatically updated, the following requirements must be met:

- The selector that you want to be automatically updated must be both:
  - On a panel.
  - A slicing selector, not a filtering selector. For a comparison of filtering and slicing selectors, see Applying selections as filters or slices, page 158.
- The selector that updates the automatically updated selector must target the panel stack.

You can create cascading selectors, where one selector updates another, and the second updates a third. To ensure that a selection in one selector affects all its targets, you must define the selectors in the order of the attributes’ hierarchy. For an example, see Using Grid/Graphs as selectors to control other Grid/Graphs, page 219.

To determine how the target of a selector displays when no data exists

1. In MicroStrategy Web, open a document in Design or Editable Mode.
2. Right-click the selector to modify and select Properties and Formatting. The Properties and Formatting dialog box opens.
3. From the left, choose Selector.
4. The Automatically update when there is no data for the current selection check box determines how the target displays when no data exists:
   - To display a message that no data is returned, clear the check box.
   - To display an item, select the check box.
5. Click OK to apply the changes.
Determining how the target of a selector displays (current state)

By default, when a filtering selector is first displayed, none of the selector items are selected, so the selector's target displays all of the available items (all the regions, for instance, if the selector's source is Region). If the selector slices rather than filters the data, by default the first item in the target is selected in the selector, and its target displays data for that item (for example, Central, if the source is Region).

Selector items are the elements that are listed in the selector. The user selects an item to update the target panel, Grid/Graph, or other selector.

A user can make selections in the selector, which updates the target. If the user does not save the dashboard-style document, when the dashboard-style document is re-executed, the selector and target are displayed according to the default (all data for a filtering selector, the first item for a slicing selector). If the user saves the dashboard-style document with his selections, when the document is re-executed, the selector and target are displayed according to those selections.

You can change these defaults by using the Current State setting to define how a slicing selector and its target are first displayed. You can define the Current State to display all items in the target or only a specific number of items. When a user saves the dashboard-style document after selecting items in the selector, the Current State setting is Set to Specific Elements (the ones that the user specified).

A filtering selector always displays as unset (all items are displayed) until a user saves the dashboard-style document after selecting items, when the Current State setting is Set to Specific Elements (user-specified).

For both slicing and filtering selectors, you cannot set the Current State to Set to Specific Elements; this state only occurs when a user saves the dashboard-style document with updated selections.

You can define the Current State only for selectors that target attribute elements on Grid/Graphs or panel stacks (See Methods to create a selector, page 129 for descriptions).

This section contains the following information on setting the Current State:

- For a more detailed description of the various Current State options, see Defining the Current State of a selector, page 195.
• For examples of the Current State setting in a slicing selector, see *Current State setting with a slicing selector, page 190.*

• For examples of the Current State setting in a filtering selector, see *Current State setting with a filtering selector, page 191.*

Slicing selectors and filtering selectors are discussed separately because they have different Current State options.

• For examples of the Current State settings used with multiple targets, see *Current State settings and multiple targets, page 193.*

• For a procedure to define the current state setting, see *To determine how the target of a selector displays, page 196.*

### Current State setting with a slicing selector

For example, a dashboard-style document contains a Grid/Graph and a slicing selector that targets the Grid/Graph. The Region attribute is the source of the target. By default, the selector’s current state is defined to display the first selector item.

When the dashboard-style document is executed, the check box for the first region, Central, is selected in the selector, so the target Grid/Graph displays data only for the Central region, as shown below:

In the selector, a user selects the Mid-Atlantic and Northeast check boxes, and clears the Central check box. Now only Mid-Atlantic and Northeast are displayed in the Grid/Graph. The user closes the dashboard-style document without saving it, then re-executes the dashboard-style document. As defined by the selector’s Current State setting, Central is once again selected in the selector and displayed in the target.

As before, the user selects the Mid-Atlantic and Northeast check boxes, and clears the Central check box in the selector. Mid-Atlantic and Northeast are displayed in the Grid/Graph. This time, the user saves the dashboard-style document before closing it, then re-executes it. The Grid/Graph displays the
Mid-Atlantic and Northeast data, with Mid-Atlantic and Northeast checked in the selector, as shown below:

```
[ ] (All) [ ] Central [ ] Mid-Atlantic [ ] Northeast [ ] Northwest [ ] South [ ] Southeast [ ] Southwest [ ] Web
```

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$159,930</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>Vernon</td>
<td>$331,735</td>
<td>$230,504</td>
<td>$51,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>Peter</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Foks</td>
<td>Adrienne</td>
<td>$1,047,776</td>
<td>$888,702</td>
<td>$159,074</td>
</tr>
<tr>
<td>Hollywood</td>
<td>Robert</td>
<td></td>
<td>$1,026,874</td>
<td>$871,879</td>
<td>$155,195</td>
</tr>
<tr>
<td></td>
<td>Ingles</td>
<td>Walter</td>
<td>$228,439</td>
<td>$194,851</td>
<td>$33,588</td>
</tr>
<tr>
<td></td>
<td>Smith</td>
<td>Thomas</td>
<td>$221,379</td>
<td>$186,010</td>
<td>$33,368</td>
</tr>
<tr>
<td></td>
<td>Young</td>
<td>Sarah</td>
<td>$206,624</td>
<td>$178,331</td>
<td>$31,303</td>
</tr>
<tr>
<td>Northeast</td>
<td>De Le Torre</td>
<td>Sandra</td>
<td>$607,895</td>
<td>$514,795</td>
<td>$93,100</td>
</tr>
<tr>
<td></td>
<td>Kelly</td>
<td>Laura</td>
<td>$2,350,720</td>
<td>$1,992,726</td>
<td>$357,994</td>
</tr>
<tr>
<td></td>
<td>Kieferson</td>
<td>Jack</td>
<td>$584,933</td>
<td>$497,463</td>
<td>$87,470</td>
</tr>
<tr>
<td></td>
<td>Sawyer</td>
<td>Lianne</td>
<td>$2,411,012</td>
<td>$2,043,693</td>
<td>$368,219</td>
</tr>
<tr>
<td></td>
<td>Sonders</td>
<td>Melanie</td>
<td>$295,108</td>
<td>$251,183</td>
<td>$43,925</td>
</tr>
<tr>
<td></td>
<td>Yager</td>
<td>Beth</td>
<td>$2,303,847</td>
<td>$1,953,823</td>
<td>$350,024</td>
</tr>
</tbody>
</table>

When the user saved the dashboard-style document, the selector's state was saved and therefore it automatically changed the Current State setting to **Set to specific elements**. This allows the user's saved selector choices to be displayed when the dashboard-style document is re-executed.

If desired, you can reset the Current State setting of the selector, so that it once again automatically displays the first region when the dashboard-style document is executed. To do this, define Current State as **Use first**, and set **Number of Elements** to one.

You can enter any number of elements. You can also define the Current State to display all the elements or to display the last number elements, then specify the number of elements to display.

**Current State setting with a filtering selector**

A dashboard-style document contains a Grid/Graph and a filtering selector that targets the Grid/Graph. The Region attribute is the source of the target, and the selector filters the target. By default, the selector's Current State is defined as **Unset**. This means that the target Grid/Graph is unfiltered and therefore displays all the regions.
When a user executes the dashboard-style document, all of the regions are displayed in the target Grid/Graph, as shown below. Notice that none of the check boxes in the selector are selected, since the selector state is unset.

The user selects Central in the selector. The Grid/Graph updates to display the data for the Central region only.

The user closes the dashboard-style document without saving it, and then re-executes it. The selector's Current State is still set to the default setting of Unset, which means that all the regions are displayed in the target Grid/Graph.

The user then selects the Central check box again, so that the data for the Central region is displayed in the Grid/Graph. This time, the user saves the dashboard-style document before closing it. When the user re-executes it,
the Grid/Graph displays the Central data, with Central checked in the selector, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp, Nancy</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td>Gae</td>
<td>Loren</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td>Tamson</td>
<td>Mary</td>
<td>$1,690,250</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td>Zetticka</td>
<td>George</td>
<td>$822,500</td>
<td>$697,053</td>
<td>$124,867</td>
</tr>
</tbody>
</table>

This time, because the user saved the dashboard-style document, the selector's state was saved and therefore it automatically changed the Current State setting to **Set to specific elements**. This allows the user's saved selector choices to be displayed when the dashboard-style document is re-executed.

### Current State settings and multiple targets

If a selector has multiple targets, the selector display is affected by whether all the targets contain the same elements. If they do not, the Current State settings are applied differently.

One way that target Grid/Graphs can contain different elements is if one Grid/Graph has a view filter. For example, a dashboard-style document contains two Grid/Graphs. The Employee Revenue Grid/Graph contains the Region attribute, Employee attribute, and Revenue metric. The Regional Revenue Grid/Graph contains the Region attribute and Revenue metric. Both Grid/Graphs are targeted by a selector. Both Grid/Graphs contain the same elements. A view filter is applied to the Regional Revenue Grid/Graph, to exclude Central. Now the Grid/Graphs contain different elements, since Employee Revenue includes the Central region and Regional Revenue does not.

For a slicing selector, the default Current State displays the first element in the targets, with the first element selected in the selector. Both Grid/Graphs display data for the Central region. If the targets contain different elements, the first element for each target is displayed: Central in the Employee Revenue Grid/Graph and Mid-Atlantic in the Regional Revenue Grid/Graph.
Because the displayed elements are different, no item is selected in the selector, as shown below:

![Selector dashboard with examples](image)

For a filtering selector, the default Current State displays all the elements in the targets, with no element selected in the selector. Both Grid/Graphs display data for all the regions. If the targets contain different elements, each target still displays all its elements, but the Regional Revenue Grid/Graph does not contain Central, as shown below:

![Grid/Graph comparison](image)
Defining the Current State of a selector

The state of a selector is controlled by the Current state and Number of Elements settings, as described below:

- For a slicing selector, the following scenarios are possible:
  - The target displays the first Number of Elements, where Number of Elements is selector items. For example, if the selector source is Region and Number of Elements is defined as two, the first two regions (Central and Mid-Atlantic) are displayed.
    
    To do this, set Current State to Use first and specify the Number of Elements.
  
  - The target displays the last Number of Elements, where Number of Elements is selector items. For example, if the selector source is Region and Number of Elements is defined as one, the last region (Web) is displayed.
    
    To do this, set Current State to Use last and specify the Number of Elements.
  
  - When a user chooses items in the selector, the target displays the selected items. When the user saves the dashboard-style document with his selections, Current State is automatically switched to Set to specific elements.

    Current State is automatically defined as Set to specific elements; you cannot select this option.

- For a filtering selector, the following scenarios are possible:
  - The target is not filtered and therefore displays data for all items in the selector. In the selector, none of the selector items is selected. A drop-down list will have blank space, a button bar will not have any buttons selected, no radio buttons will be selected, and so on.

    To do this, set Current State to Unset (no filter).
  
  - When a user chooses items in the selector, the target displays the selected items. When the user saves the dashboard-style document with his selections, Current State is automatically switched to Set to specific elements.
**Current State** is automatically defined as **Set to specific elements**; you cannot select this option.

For the differences between slicing and filtering selectors, see *Applying selections as filters or slices, page 158*.

**Prerequisites**

The following procedure assumes that the dashboard-style document contains:

- A selector that targets attribute elements on a Grid/Graph. For instructions to create a selector, see *Methods to create a selector, page 129*.

- A Grid/Graph that is used as the target of the selector. For instructions to add a Grid/Graph to a dashboard-style document, see the *Report Services Document Creation Guide*.

---

**To determine how the target of a selector displays**

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.

2. Right-click the selector to modify and choose **Properties and Formatting**. The Properties and Formatting dialog box opens.

3. From the left, click **Selector**.

4. Select one of the following options from the **Current State** drop-down list:

   - If **Apply selections as a filter** is cleared (which means that the selector slices data):
     
     - To display the first **Number of Elements**, select **Use first**. For example, if the selector source is Region and Number of Elements is defined as two, the first two regions (Central and Mid-Atlantic) are displayed.

     - To display the last **Number of Elements**, select **Use last**. For example, if the selector source is Region and Number of Elements is defined as one, the last region (Web) is displayed.
• If **Apply selections as a filter** is selected:
  
  • To display data for all items in the selector, select **Unset (no filter)**.

When a user has chosen items in the selector, **Set to specific elements** is selected automatically. The target displays the items that the user chose in the selector. This option is shown only when a user has chosen selector items, and is available for both filtering and slicing selectors.

5 If **Current state** is set to either **Use first** or **Use last**, type the number of elements to display in the **Number of elements** field. For example, if the selector source is Region, **Use last** is selected, and **Number of elements** is defined as one, the last region (Web) is displayed.

6 Click **OK** to return to the dashboard-style document.

### Showing totals for selectors

Selectors that contain attribute, custom group, or consolidation elements as selector items can also include an option to display totals. The total is calculated for all the selector items. A user can choose whether to display specific elements, all of the elements at the same time, or the totals.

For example, a dashboard-style document contains a Grid/Graph with Region and several metrics. A selector (the check boxes on the left) targets the Grid/Graph and displays all the regions, as well as the Total option, as selector items. In the following sample, all the regions are selected, and the total is displayed:

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Profit Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td></td>
<td>$5,029,366</td>
<td>$764,323</td>
<td>15.20%</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$4,452,615</td>
<td>$673,084</td>
<td>15.12%</td>
</tr>
<tr>
<td>Northeast</td>
<td></td>
<td>$8,554,415</td>
<td>$1,300,732</td>
<td>15.21%</td>
</tr>
<tr>
<td>Northwest</td>
<td></td>
<td>$1,761,187</td>
<td>$266,986</td>
<td>15.16%</td>
</tr>
<tr>
<td>South</td>
<td></td>
<td>$5,389,280</td>
<td>$806,956</td>
<td>14.97%</td>
</tr>
<tr>
<td>Southeast</td>
<td></td>
<td>$2,239,951</td>
<td>$336,675</td>
<td>15.03%</td>
</tr>
<tr>
<td>Southwest</td>
<td></td>
<td>$3,694,132</td>
<td>$561,331</td>
<td>15.20%</td>
</tr>
<tr>
<td>Web</td>
<td></td>
<td>$3,902,762</td>
<td>$583,538</td>
<td>14.95%</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td></td>
<td>$35,023,708</td>
<td>$5,293,624</td>
<td>15.11%</td>
</tr>
</tbody>
</table>
The All option does not have to be selected for the total to be displayed. For example, only Central, Mid-Atlantic, and Total are selected in the following sample:

<table>
<thead>
<tr>
<th>Region</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Profit Margin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td></td>
<td>$3,029,366</td>
<td>$764,323</td>
<td>15.20%</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td></td>
<td>$4,452,615</td>
<td>$673,084</td>
<td>15.12%</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>$35,023,708</td>
<td>$5,293,624</td>
<td>15.11%</td>
</tr>
</tbody>
</table>

Notice that the values in the Total line remain the same as in the previous sample—the total is always calculated using all the selector items (in this instance, all the regions).

The following example shows a drop-down selector that targets an attribute on a panel stack. When Total is chosen in the selector, the total revenue of all the regions is displayed.

Conditional formatting on selector totals

Conditional formatting allows you to format specified data in your dashboard-style document depending on predefined criteria. If the selector’s target is a Grid/Graph, you can choose whether to apply conditional formatting to metrics only, to metrics and their corresponding selector totals, or to the subtotals only. In MicroStrategy Web, if the target is a text field, you can select whether to apply conditional formatting to metrics only, or to metrics and their corresponding selector totals. When you create a conditional format in Developer, if the target is a text field, the conditional format is not applied to the total, but rather to the metric values only.
For example, a dashboard-style document contains the Region attribute and the Revenue metric on a panel stack. The panel stack is targeted by a selector, which allows a user to choose the region to display in the panel stack. The selector includes the option to display the total, which is calculated for all the regions. The conditional formatting on the Revenue metric displays low revenue in red and high revenue in green. The conditional formatting can be applied to the regional revenue values only, or to both the regional revenue values and the total value.

To select metrics or metrics and totals, use the Advanced Conditional Formatting in MicroStrategy Web. When you apply a conditional format in Developer, the conditional format is applied to the metric values only. For steps to apply conditional formatting in Web, see the Formatting Documents chapter of the Report Services Document Creation Guide. For steps to apply conditional formatting in Developer, see the Developer Help (formerly the Desktop Help).

**Showing totals in a selector**

**To show totals in a selector**

1. In MicroStrategy Web, open a document in Design or Editable Mode.
2. Right-click the selector and select Properties and Formatting. The Properties and Formatting dialog box opens.
3. On the left, click Selector.
4. Select the Show option for Total check box.
   
   Note the following:
   
   - If the Action type is defined as Select metric or Select panel, the Show option for Total check box is not available.
   
   - If Apply selections as a filter is selected, the Show option for Total check box is not available. For a comparison of filtering and slicing selectors, see Applying selections as filters or slices, page 158.
5. Click OK.
Displaying and sorting forms in selectors

For element selectors, you can select which forms are displayed in the selector, the order that they are displayed in, and how their elements are sorted. If multiple forms are displayed, you can choose which character separates the different forms.

For example, a document contains the Customer attribute. By default, the selector displays the customer last name and first name, separated by a colon. The customers are sorted in alphabetical order, as shown below:
By defining the attribute forms to display, the same selector can display the customers by last name and then ID, separated by a comma and a space. The customers are now sorted in reverse alphabetical order, as shown below:

To select and sort forms for a selector

1. In MicroStrategy Web, open a document in Design or Editable Mode.

2. Right-click the selector to modify and select Properties and Formatting. The Properties and Formatting dialog box opens.

3. From the left, click Selector.

4. By default, Display Forms is set to Automatic, which means that the default forms are displayed. To select the forms to display, perform the following steps:
   
   a. From the Display Forms drop-down list, select Custom. The Attribute Forms dialog box opens.

   b. In the Available list, select the form to display and click the Add arrow to move it to the Selected list. You can select multiple forms.

   c. To change the order that the forms are displayed, select a form in the Selected list and click the Move Up or Move Down arrow.

   d. Click OK to close the Attribute Forms dialog box.
5 To sort the form, complete the following steps:
   a Click the Sort button . The Sort dialog box opens.
   b Select an attribute from the drop-down list, then select either Ascending or Descending.
   c Click OK to close the Sort dialog box.

6 If you have chosen multiple forms, you can select the character that separates the different forms when they are displayed in the selector. Select a character from the Form Separator drop-down list, or choose Other in the list and type the characters in the box.

   You can use up to three characters as the separator if you choose Other.

7 Click OK to return to the dashboard-style document.

Displaying title bars in selectors

A title bar on a selector can help to identify the selector or provide instructions about using the selector. For example, the title bar can indicate which Grid/Graph or panel stack the selector targets. In the sample shown below, the title bars are used to provide instructions, as well as to identify that the top selector uses Region to update the grid and the graph, while the bottom selector filters just the grid on the Revenue values. Notice that the Revenue total for Northeast in the grid is $7,066,478, while the Revenue amount for Northeast in the graph is $8,554,415. This discrepancy occurs because the grid is not displaying employee revenue values below $209,634,
as indicated by the slider selector, while the graph is including all revenue values for Northeast.

For metric slider and metric qualification selectors, which filter metric values, the title bar contains a drop-down menu that allows a user to select whether to filter on the metric values or rank, as shown in the metric qualification selector below. For descriptions of the different options, see Creating a selector that filters metric values, page 137.

For a metric slider selector, the drop-down menu in the title bar also allows a user to select whether to include or exclude the selected data. For example, in the image below, cost values greater than or equal to $2,724,912 are selected in the slider. When Include is selected from the title bar drop-down menu, data for all regions with cost values greater than or equal to $2,724,912 is
displayed. Note that the drop-down menu also includes the options to select whether to filter on the metric values or rank.

![Image of selector with title bar]

**Prerequisite**

- The dashboard-style document contains a selector. For steps to create a selector, see *Defining a selector, page 124.*

---

**To display the title bar**

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.
2. Right-click the selector and choose **Properties and Formatting**. The Properties and Formatting dialog box opens.
3. From the left, select **General**.
4. Select the **Show title bar** check box.
5. Type the text to display in the title bar in the **Title** field.
   
   If you leave this field blank, the selector's Name is displayed in the title bar, unless the selector is an element selector or metric condition selector. In those cases, the source of the target (such as Region or Revenue) is displayed.

6. To specify the height of the title bar, do the following:
   a. From the left, click **Layout**.
   b. Type the new height in the **Title Height** field.
7. Click **OK** to return to the dashboard-style document. The title bar is displayed on the selector in the Layout area.
For steps to format the title bar, see *Formatting the title bar of a selector*, page 215.

**Formatting selectors**

As with any other control, when you insert a selector into a dashboard-style document, its formatting is determined by the control default. However, you can change any of the formatting options, such as background and border colors. For a list of formatting options, and which interface to use, see *Methods to format a selector*, page 206 and *Useful formatting suggestions for selectors*, page 207.

You can format the selector body and the title bar separately, as described in *Formatting the selector body vs. title bar* below.

**Formatting the selector body vs. title bar**

A selector can have a title bar, which displays above the selector items. For instructions to display the title bar, and an example, see *Displaying title bars in selectors*, page 202. You can format the body (which displays the selector items) differently than the title bar. For example, if you apply a background color to the body of a selector, the title bar is not displayed in that color.

The following table lists the various formatting options available for a body and for a title bar.

<table>
<thead>
<tr>
<th>Object</th>
<th>Formatting Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selector body</td>
<td>Alignment (horizontal and vertical)</td>
</tr>
<tr>
<td></td>
<td>Background, including:</td>
</tr>
<tr>
<td></td>
<td>• Transparency</td>
</tr>
<tr>
<td></td>
<td>• Gradient colors</td>
</tr>
<tr>
<td></td>
<td>• Selection color (background color for cells selected by a selector)</td>
</tr>
<tr>
<td></td>
<td>Border</td>
</tr>
<tr>
<td></td>
<td>Effects, including:</td>
</tr>
<tr>
<td></td>
<td>• 3D borders</td>
</tr>
<tr>
<td></td>
<td>• Drop shadow</td>
</tr>
<tr>
<td>Font</td>
<td></td>
</tr>
</tbody>
</table>
For steps to format a selector, see:

- *Specifying proportional or fixed width for selector items, page 208*
- *Formatting the text of a selector’s items, page 210*
- *Formatting the background of a selector, page 211*
- *Defining the background color for selected items in Flash Mode, page 213*
- *Formatting the title bar of a selector, page 215*
- *Selector display in Flash Mode, page 216*
- *Selector display when exported to PDF, page 217*

## Methods to format a selector

You can change the formatting and other settings of selectors by using any of the following methods:

- For all formatting options, including alignment, effects, and colors, use the Format options in the Properties and Formatting dialog box.
- For easy access to basic formatting options, use the Formatting toolbar.
- For easy access to alignment, sizing, and ordering options, use the right-click menu.
- For layout properties (such as name, position, and size) and properties specific to selectors such as action type and targets, use the Properties and Formatting dialog box.

The Formatting toolbar is the easiest to use, but does not contain other formatting options available in the Properties and Formatting dialog box.
Useful formatting suggestions for selectors

The following list provides some useful formatting suggestions. For information on basic options such as formatting fonts and borders, and examples and instructions for all the formatting listed below, see the Developer Help (formerly the Desktop Help).

- Make the selector body appear three-dimensional, like a button, with the 3D effect.

  3D effects do not apply to Search Box selectors.

- Let the content behind the selector show through by setting the backstyle to transparent. You can also allow a fill color to cover what is behind the selector by setting the backstyle to opaque.

- Float the selector above the background by using a drop shadow.

  Drop shadows do not apply to Search Box selectors.

- Create a gradual color change in the selector’s background by blending two colors using gradient colors on the selector.

- By default, the background for selected items is automatically chosen to provide contrast with the selector’s background. You can define the background color for items selected in Drop-down, Listbox, and Link Bar selectors. The color is displayed in Flash Mode. In all other modes, only Link Bar selectors use the selection color. For an example and procedure, see Defining the background color for selected items in Flash Mode, page 213.

  Selected item color does not apply to Search Box selectors.

- Display pop-up text when a user positions the cursor over the control with a tooltip. The tooltip can provide extra information, such as an expanded description of the control.

- Display a selector to other document designers in Design View while hiding it from users viewing the document in PDF View (Developer or Web), and Interactive Mode, Editable Mode, and Express Mode. To do this, you hide the control that contains the information by using the Visible setting. For instance, you could prevent a user from changing panels in a panel stack by hiding the panel stack’s selector.

- Control the sizing behavior of the selector items with the Make all items the same width setting, which can be set to proportional (the default) or fixed (same width for all items). The items are the buttons or check boxes,
for example, of the selector. For an example, see *Specifying proportional or fixed width for selector items, page 208*.

Item width does not apply to Search Box selectors.

- Format the font of the text for the items in the selector, including style, size, and color. For an example, see *Formatting the text of a selector’s items, page 210*.

These formatting options apply to all selector types, but to a Fish Eye selector only when it is displayed in non-Flash modes. In non-Flash modes, a Fish Eye selector is displayed according to its DHTML style. For information on creating a Fish Eye selector, see *Creating a Fish Eye Selector, page 260*; for information on formatting a Fish Eye selector for display in Flash Mode, see *Formatting a Fish Eye Selector, page 394*.

**Specifying proportional or fixed width for selector items**

You can control the sizing behavior of the selector items with the **Make all items the same width** option. The items are the buttons or check boxes, for example, of a selector.

By default, items are sized proportionally, which means that the width of each item is proportional to the length of the text inside the item. This allows the complete text of each item to be displayed, with little wasted space. To use the same width for all the items, specify a fixed item size.

In the example below, the width of the selector items (the links above the Grid/Graph) are sized proportionally—Northwest is longer than (All), for example. This is the default behavior.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$158,930</td>
</tr>
<tr>
<td></td>
<td>Brown</td>
<td>$331,735</td>
<td>$260,504</td>
<td>$71,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Folks</td>
<td>$1,047,775</td>
<td>$888,702</td>
<td>$159,074</td>
</tr>
<tr>
<td></td>
<td>Hollywood</td>
<td>$1,028,874</td>
<td>$871,679</td>
<td>$157,195</td>
</tr>
</tbody>
</table>
If the **Make all items the same width** option is selected, the width of each selector item is the same size as the others, as shown below. In this case, the (All) item has extra space, while Northwest is cut off, displaying as Northwe instead.

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp Nancy</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale Loren</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Morrison Mary</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka George</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Bernstein Lawrence</td>
<td>$1,060,632</td>
<td>$901,702</td>
<td>$158,930</td>
</tr>
<tr>
<td></td>
<td>Brown Vernon</td>
<td>$331,735</td>
<td>$280,504</td>
<td>$51,231</td>
</tr>
<tr>
<td></td>
<td>Corcoran Peter</td>
<td>$325,147</td>
<td>$275,752</td>
<td>$49,395</td>
</tr>
<tr>
<td></td>
<td>Folks Adrienne</td>
<td>$1,047,776</td>
<td>$888,702</td>
<td>$159,074</td>
</tr>
<tr>
<td></td>
<td>Hollywood Robert</td>
<td>$1,026,874</td>
<td>$871,679</td>
<td>$155,195</td>
</tr>
</tbody>
</table>

Item width does not apply to Search Box selectors.

**To specify proportional or fixed width for selector items**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. Right-click the selector to modify and select **Properties and Formatting**. The Properties and Formatting dialog opens.
3. From the left, choose **Layout**.
4. Do one of the following:
   - To specify proportional width for selector items: Clear the **Make all items the same width** check box.
   - To specify selector item width as fixed: Select the **Make all items the same width** check box.
5. Click **OK** to apply the changes.
Formatting the text of a selector’s items

You can format the font of the text for the items in a selector. The items of a selector are the elements, metrics, or panels that are listed in the selector. The user selects an item to change the display of the panel or Grid/Graph. Font formatting options for selector items include style, size, and color. You can also align text horizontally and vertically.

The following dashboard-style document sample shows a button bar. The size of the selector, as well as the font and alignment of the item’s text, has not been changed from the default appearance. The orientation of the button bar has been changed from vertical to horizontal.

In the following dashboard-style document sample, the same selector has been formatted. The button bar has been expanded to the width of the panel stack. The item’s text is now centered vertically and horizontally within each button. The font type, size, and color have changed, and the text is italicized.

To format the text of a selector’s items

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Right-click the selector to modify and select Properties and Formatting. The Properties and Formatting dialog box opens.
3 You can align the text vertically and horizontally within each item:
   a From the left, select **Alignment**.
   b From the **Horizontal** drop-down list, select the horizontal alignment (Left, Right, or Center).
   c From the **Vertical** drop-down list, select the vertical alignment (Top, Bottom, or Center).

   Items are displayed vertically aligned in Flash Mode only.

4 From the left, select **Font**.

5 In the second drop-down list, select **Body**.

6 Format the text of the selector items, including the font name, size, and color; whether the font is bold, underlined, or italicized; and whether to underline or strike out the text.

7 Click **OK** to return to the dashboard-style document.

### Formatting the background of a selector

The background of a selector can be:

- A single color
- A gradient, which is a combination of two colors
- Transparent, to allow what is behind the selector to show through (default)

Items that are selected in a selector are highlighted with a different background color, to indicate that they are selected. By default, this background is automatically chosen to provide contrast with the background of the selector. You can specify the color of selected items in Drop-down, Listbox, and Link Bar selectors. For Drop-down and Listbox selectors, the selection color is displayed in Flash Mode. For the Link Bar, the selection color is displayed in all modes except Design Mode. For steps and an example, see *Defining the background color for selected items in Flash Mode, page 213.*
Prerequisite

The following procedure assumes that you have created a selector.

To format the background of a selector

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. Right-click the selector and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3. From the left, select **Color and Lines**.

4. In the second drop-down list, select **Body**.

5. From the **Color** palette, select the background color of the selector by doing one of the following:
   
   - To apply the default background color (transparent), click **No Fill**.
   
   - To apply a solid background color, select the background color from the palette. You can access additional colors by clicking **More Colors**.
   
   - To apply a color gradient to the selector, click **Gradients**. The Gradients dialog box opens.
     
     a. From the **Color 1** palette, select the first color to use for the gradient.
     
     b. From the **Color 2** palette, select the second color to use for the gradient.
     
     c. Select the **Horizontal** or **Vertical** option to determine the direction in which two colors are blended together.
     
     d. You can also select a **Variant**, which is the direction of the shading between the two colors. The Flash-only variant is a mirror-like gradient only displayed in Flash Mode.
     
     e. Click **OK** to return to the Properties and Formatting dialog box.

6. Click **OK** to return to the document.
Defining the background color for selected items in Flash Mode

By default, the background for selected items is automatically chosen to provide contrast with the selector's background. For Drop-down, Listbox, and Link Bar selectors, you can specify the color for selected items. The color is displayed in Flash Mode. In all other modes, only Link Bar selectors use the selection color. (For details on the different types of selectors, see Defining a selector, page 124.)

For example, a dashboard-style document contains a Link Bar selector that targets a Grid/Graph. The selector's background is set to light gray, and the background for selected items is set to automatic. In Flash Mode, the background is automatically displayed in light gray, with the selected item (Central) automatically displayed in a lighter gray to provide contrast, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>Nancy</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>Loren</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>Mary</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>George</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
</tbody>
</table>

The same document in Interactive Mode displays with a light gray background for the selector, as specified, with the selected item (Central) is automatically displayed in a blue background to provide contrast, as shown below:
Change the selected item’s background to dark red. In Flash Mode, the selected item’s background is dark red, as specified, and the selector’s background is still displayed in light gray, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Employee</th>
<th>Revenue</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Ellerkamp</td>
<td>$847,227</td>
<td>$720,449</td>
<td>$126,778</td>
</tr>
<tr>
<td></td>
<td>Gale</td>
<td>$1,669,290</td>
<td>$1,416,036</td>
<td>$253,254</td>
</tr>
<tr>
<td></td>
<td>Torrison</td>
<td>$1,690,350</td>
<td>$1,430,865</td>
<td>$259,485</td>
</tr>
<tr>
<td></td>
<td>Zemlicka</td>
<td>$822,500</td>
<td>$697,693</td>
<td>$124,807</td>
</tr>
</tbody>
</table>

In all modes, an item that the cursor is pointed at is displayed in a lighter shade of the selected item’s background. In the Flash Mode example above, Mid-Atlantic is displayed with a pink background, while the Interactive Mode example displays Northwest in a light blue.

**Prerequisite**

- The following procedure assumes you have added a Drop-down, Link Bar, or Listbox selector to the dashboard-style document.

---

**To format the background of selected items**

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Right-click the selector and select Properties and Formatting. The Properties and Formatting dialog box opens.
3. From the left, select Color and Lines.
4. In the second drop-down list, select Body.
5. By default, Selection Color is set to Automatic, which means that the color of the selected items are automatically set to contrast with the selector’s background. To change the background color of selected items, do one of the following:
• To apply the default background color (transparent), click **No Fill**.

• To apply a solid background color, select the background color from the palette. You can access additional colors by clicking **More Colors**.

  The **Selection color** is applied in Flash Mode. In all other modes, the **Selection color** is applied only to Link Bar selectors.

6 Click **OK** to save your changes and return to the dashboard-style document.

---

**Formatting the title bar of a selector**

You can format the background color and the text of the title bar.

**Prerequisites**

• You have added a selector to the document.

• The selector’s title bar is displayed. For steps, see *Displaying title bars in selectors*, page 202.

---

**To format the title bar of a selector**

1 In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2 Right-click the selector and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

**Format the background**

3 From the left, click **Colors and Lines**.

4 From the second drop-down list, select **Title**.

5 From the **Color** palette, select the background color of the title bar by doing one of the following:

  • To apply the default background color (transparent), click **No Fill**.

  • To apply a solid background color, select the background color from the palette. You can access additional colors by clicking **More Colors**.
• To apply a color gradient, click **Gradients**. The Gradients dialog box opens.
  a From the **Color 1** palette, select the first color to use for the gradient.
  b From the **Color 2** palette, select the second color to use for the gradient.
  c Select the **Horizontal** or **Vertical** option to determine the direction in which two colors are blended together.
  d You can also select a **Variant**, which is the direction of the shading between the two colors. The Flash-only variant is a mirror-like gradient only displayed in Flash Mode.
  e Click **OK** to return to the Properties and Formatting dialog box.

**Format the text**

6 From the left, click **Font**.

7 From the second drop-down list, select **Title**.

8 Format the text of the selector items, including the font name, size, and color; whether the font is bold, underlined, or italicized; and whether to underline or strike out the text.

9 Click **OK** to save your changes and return to the document.

**Selector display in Flash Mode**

You can define how a selector displays in Flash Mode. This allows you to override the rendering of the selector with a custom widget selector style that you created. For more information on creating widgets, see the MicroStrategy Developer Library (MSDL) provided with MicroStrategy SDK. To apply the custom widget to a selector, follow the steps below.

**Prerequisite**

This procedure assumes you have already created:

• A selector in the document
• A custom widget with the MicroStrategy SDK
To specify a custom widget for a selector

1. In MicroStrategy Web, open a document in Design or Editable Mode.
2. Right-click the selector to edit and select Properties and Formatting. The Properties and Formatting dialog box opens.
3. From the left, select Flash.
4. From the Selected Widget drop-down list, choose the custom widget that will be used to display the selector in Flash Mode.
5. Click OK to apply the changes.

Selector display when exported to PDF

When a dashboard-style document containing a Button Bar, Check Boxes, Link Bar, or Radio Button selector is exported to PDF, you can determine whether the selector is exported to a PDF file as shown in MicroStrategy Web or whether it is exported with only the selected items displayed. If it is exported as shown in Web, the check boxes or radio buttons are displayed in the PDF, as well as all the selector items, whether or not they are selected. The setting also applies to PDF View in Developer.

For example, a dashboard-style document contains a Grid/Graph targeted by:

- A Radio Button selector for Category, defined to export to PDF as shown in Web
- A Check Boxes selector for Subcategory, defined to export only the selected items to PDF
A user selects the Books category and the Literature and Books - Miscellaneous subcategories in the selectors, as shown below in Express Mode:

The dashboard-style document is exported to PDF, as shown below. The Category selector displays with the radio buttons and all categories, since the selector is defined to export as shown in Web. The Subcategory selector displays only Literature and Books - Miscellaneous, without check boxes, since the selector is defined to export only the selected items.
Prerequisites

The following procedure assumes that the dashboard-style document already contains a Button Bar, Check Boxes, Link Bar, or Radio Buttons selector. For instructions to create a selector, see Methods to create a selector, page 129.

To define selector display for PDF export

1. **In MicroStrategy Web, open the dashboard-style document in Design or Editable Mode.**

2. **Right-click the selector and choose Properties and Formatting.** The Properties and Formatting dialog box opens.

3. **In the list on the left, select Layout.**

4. **To define the selector display when exported to PDF, do one of the following:**
   - To export the selector as shown on the screen (with all selector items and the check boxes, radio buttons, button bar, or link bar), select the Export selector to PDF as shown on screen check box.
   - To export only the selected items (without check boxes, radio buttons, button bar, or link bar), clear the Export selector to PDF as shown on screen check box.

   - **The Export selector to PDF as shown on screen check box is available only when the selector’s DHTML style is Button Bar, Check Boxes, Link Bar, or Radio Buttons.**

5. **Click OK to save your changes and return to the dashboard-style document.**

Using Grid/Graphs as selectors to control other Grid/Graphs

Two Grid/Graphs are shown in the following image. The grid on the left shows revenue by region. The graph on the right shows revenue by quarter...
and region. Notice that the two Grid/Graphs share a particular attribute (Region) and that Region in the grid is underlined, indicating a link.

Click a specific region, such as Mid-Atlantic, in the grid. The graph changes to display information for that region only, as shown below:

The grid report on the left is controlling the graph report on the right. In other words, this scenario uses one Grid/Graph as a selector targeting another Grid/Graph. The first Grid/Graph does not become a selector, but performs in a manner similar to a selector. A panel stack, rather than another Grid/Graph, can be the target of a Grid/Graph.
Notice that Region, as the attribute header, is underlined, indicating a link. If you click Region, all the regions are displayed in the graph. By default, the “All Elements” option is not available for a user. You can allow users to display all the elements in the target at one time by selecting Show option for All when you enable the Grid/Graph as a selector.

For steps to enable a Grid/Graph as a selector, see *Enabling a Grid/Graph as a selector, page 223*.

By default, the background for items selected in the Grid/Graph is automatically chosen to provide contrast with the Grid/Graph’s background, as shown above. For Flash Mode and Express Mode, you can specify the color for the selected items. For an example and instructions, see *Formatting the background of selected items in Grid/Graphs used as selectors, page 224*.

**Cascading selectors**

You can use Grid/Graphs as cascading selectors, where one Grid/Graph updates another Grid/Graph, and the second updates a third. For example, a dashboard-style document contains the following:

- A Grid/Graph containing the Revenue metric
- A Grid/Graph containing the Call Center attribute, targeting the Revenue Grid/Graph
- A Grid/Graph containing the Region attribute, targeting both the Call Center and Revenue Grid/Graphs
- A Grid/Graph containing the Country attribute, targeting the Region, Call Center, and Revenue Grid/Graphs

This dashboard-style document is shown below. USA is selected for Country, Southeast for Region, and Atlanta for Call Center. The Revenue metric
displays the value for Atlanta. If you select Miami instead, the Revenue value changes accordingly.

<table>
<thead>
<tr>
<th>Country</th>
<th>Region</th>
<th>Call Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>Central</td>
<td>Atlanta</td>
</tr>
<tr>
<td>Web</td>
<td>Mid-Atlantic</td>
<td>Miami</td>
</tr>
<tr>
<td></td>
<td>Northeast</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Northwest</td>
<td></td>
</tr>
<tr>
<td></td>
<td>South</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southeast</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southwest</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$35,023,708</td>
</tr>
</tbody>
</table>

To ensure that a selection in one Grid/Graph affects its targets, especially the Revenue Grid/Graph, you must define the Grid/Graphs in the order of the attributes’ hierarchy. In this case, define the Grid/Graph for Country, then another for Region, and finally the last for Call Center. If you define Call Center first, then Region, and then Country, the targets are not updated or return no data.

### Widgets used as selectors

The grid report for a Microcharts widget often consists of several attributes in the row headers and the elements of those attributes in the rows. You can enable these attributes and elements as selectors. This allows an analyst to select an attribute or an element and view specific data related to it in other Grid/Graphs in the document.

When an analyst hovers the cursor over an attribute element that is enabled as a selector, it becomes a hand pointer to indicate that a link exists. When the link is clicked, all target Grid/Graphs on the document are updated with a set of data related to the attribute element that was clicked. For example, if you click Southeast, all data related to the Southeast region is displayed in the target Grid/Graphs on the document. Only Grid/Graphs that are assigned as targets of the widget are updated when you choose an option from a selector.
Enabling a Grid/Graph as a selector

**Prerequisites**

- This procedure assumes that a Grid/Graph has been created to use as the selector. For steps, see the *Report Services Document Creation Guide*.

- A panel stack or Grid/Graph must also be created to use as the target. For steps to create a panel stack, see *Inserting a panel stack, page 76*. For steps to create a Grid/Graph, see the *Report Services Document Creation Guide*.

- The selector and target must have an attribute in common.

- If targets are automatically maintained, and you add a Grid/Graph or panel stack to the same document section or panel after defining this selector, the Grid/Graph or panel stack that is added automatically becomes a target. For more information about automatic target maintenance, including instructions to disable it, see *Automatically maintaining targets for selectors, page 169*.

**To enable a Grid/Graph as a selector**

1. In MicroStrategy Web, open a document in **Design** or **Editable Mode**.

2. On a Grid/Graph, right-click the attribute header to use as the selector, and choose **Use as Selector**.

3. Depending on whether or not targets are automatically maintained in the layout, do one of the following:

   - If targets are automatically maintained in the layout, you cannot select targets. All Grid/Graphs and panel stacks in the same document section or panel as the selected Grid/Graph are chosen as targets.

   - If targets are manually maintained in the layout, the Configure Selector dialog box opens. Select the target Grid/Graph or panel stack in the list of available controls on the left, and click > to add it to the list of selected targets. You can select multiple targets.

     ![Disclaimer]
     
     You can disable automatic targets for all targets in the layout. For steps, and the effects of disabling automatic target maintenance, see *Disabling automatic target maintenance to allow manual target selection, page 177*.
4 The All option in a selector allows the user to display all the elements in the target at one time. To enable the All option, select the **Show option for All** check box in the Configure Selector dialog box.

5 Click **OK** to return to the dashboard-style document.

**Disabling a Grid/Graph used as a selector**

If you no longer want the Grid/Graph to be used as a selector targeting other Grid/Graphs and panel stacks, you can disable it.

---

**To disable a Grid/Graph used as a selector**

1 In MicroStrategy Web, open a document in **Design** or **Editable Mode**.

2 On the Grid/Graph, right-click the attribute to disable, and choose **Remove Selector**.

**Formatting the background of selected items in Grid/Graphs used as selectors**

By default, the background for items selected in the Grid/Graph is automatically chosen to provide contrast with the Grid/Graph’s background, but you can specify the color for the selected items. The color is displayed in Flash Mode and Express Mode.

For example, a dashboard-style document contains two Grid/Graphs. The one on the left, which is displayed as a grid, shows revenue by region. Region is used as a selector, targeting the Grid/Graph on the right, which is displayed as a graph. The graph shows revenue by category and region. When a region is selected in the grid, the graph is updated to display data for that region only.

By default, the grid's background is set to transparent, and the background for selected items is set to automatic. In Flash Mode, the grid is displayed automatically with a white background (transparent to the section's
background, which is white). The selected item (Central) is displayed in blue to provide contrast, as shown below:

<table>
<thead>
<tr>
<th>Region Metrics</th>
<th>Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>$5,029,366</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>$4,452,615</td>
</tr>
<tr>
<td>Northeast</td>
<td>$8,554,615</td>
</tr>
<tr>
<td>Northwest</td>
<td>$1,761,187</td>
</tr>
<tr>
<td>South</td>
<td>$6,389,280</td>
</tr>
<tr>
<td>Southeast</td>
<td>$2,239,951</td>
</tr>
<tr>
<td>Southwest</td>
<td>$3,694,132</td>
</tr>
<tr>
<td>vWeb</td>
<td>$3,902,762</td>
</tr>
</tbody>
</table>

Change the grid's background for selected items to dark gray. In Flash Mode, the selected item's background is dark gray, as specified, and the grid's background is still automatically displayed in white, as shown below:

In all other modes except Express Mode, the background of the selected item is automatically defined, so it appears in blue, as shown in the first example above.
To format the background of selected items

This procedure assumes that the dashboard-style document contains a Grid/Graph used as a selector. For instructions on adding Grid/Graphs, see the Developer Help (formerly the Desktop Help). For instructions to enable the Grid/Graph as a selector, see Using Grid/Graphs as selectors to control other Grid/Graphs, page 219.

1. Open the dashboard-style document to be formatted in the Document Editor in Design View.

2. Select the Grid/Graph to format.

3. From the Format menu, select Format. The Format Objects dialog box opens.

4. Select Container in the Format list on the left.

5. Click the Background tab.

6. Define the Selection color, which is the background color for items that are selected in the Grid/Graph.
   - If you want to specify a color, click Selection color, and choose a color from the color palette.
   - If you want the color to be automatically set to contrast with the Grid/Graph's background, choose Automatic from the Selection color drop-down list.

   The Selection color is applied in Flash Mode and Express Mode.

7. Click OK to return to the dashboard-style document.

Enabling Grid/Graphs as selectors to update dataset results

You can enable Grid/Graphs as report condition selectors to filter the data in a dataset, allowing users to view subsets of large amounts of data, rather than loading and displaying all the data at once. For example, if you want to create a document that allows users to view a list of all orders submitted by a
specific customer, including information on the items in each order, you can
create a dashboard-style document with a list of Customers displayed in a
grid on the left side of the dashboard-style document, and a grid containing
Order and Item information on the right side of the dashboard-style
document. In this example, the left grid is populated with data from a dataset
containing each Customer, and the right grid is populated with data from a
dataset containing Order and Item information.

You can enable users to select a customer in the left grid to update the
dataset results displayed in the right grid. Each time the user selects a
different customer, MicroStrategy re-executes the SQL used to retrieve the
Order and Item data, then uses the results to display Order and Item
information for the appropriate customer.

You can create a similar dashboard-style document using Grid/Graphs that
control other Grid/Graphs. In order to do so, however, you must provide a
single dataset that contains all relevant Customer, Order, and Item
information, which can easily add up to a million rows of data or more. As a
result, the dashboard-style document will require time to retrieve all the
dataset results when the dashboard-style document is opened.

In contrast, if you use a Grid/Graph to filter the dataset results, only the data
for the selected customer is retrieved when the dashboard-style document is
executed, requiring less time to open the dashboard-style document.
However, because the SQL used to retrieve the dataset results is executed
against the data source each time a selection is made, more time is required
to display data when users make subsequent selections.

For steps to use Grid/Graphs to control other Grid/Graphs, see Using Grid/
Graphs as selectors to control other Grid/Graphs, page 219.

Prerequisites

• The steps below assume that you have created a document that contains
  the following:

  □ The Grid/Graph that you want to use as a selector. This Grid/Graph
  should contain the attribute whose elements users will select to
  update the dataset results. For steps, see the Report Services
  Document Creation Guide.

  □ At least one control, such as a panel stack or a second Grid/Graph, to
  use as the target of the Grid/Graph described above. This control
  should display data from the dataset that you want to filter. For steps
to create a panel stack, see Inserting a panel stack, page 76. For steps
to create a Grid/Graph, see the Report Services Document Creation Guide.

- For steps to enable the filtering of datasets based on Freeform SQL reports, see the Custom SQL Queries: Freeform SQL and Query Builder chapter in the Advanced Reporting Guide.

---

**To use a Grid/Graph as a selector to update dataset results**

1. In Web, open the document in **Design Mode**.

2. Right-click the header of the attribute in the Grid/Graph to use as the selector, and choose **Use as Selector**.

3. Depending on whether or not targets are automatically maintained in the layout, do one of the following:
   - If targets are automatically maintained in the layout, the attribute is automatically enabled as a document selector. To change this, again right-click the attribute header, and choose **Edit Selector**. The Configure Selector dialog box opens.
   - If targets are manually maintained in the layout, the Configure Selector dialog box opens.

   You can disable automatic targets for all targets in the layout. For steps, and the effects of disabling automatic target maintenance, see **Disabling automatic target maintenance to allow manual target selection, page 177**.

4. From the **Target Type** drop-down list, select **Dataset**.

5. From the Available list, select the datasets that you want to have automatically updated when users choose an item in the selector, then click > to add the datasets to the Selected list. You can select multiple datasets at once by pressing **CTRL** and clicking each dataset that you want to select.

   SQL reports and MDX reports, as well as Freeform SQL reports that contain one or more Freeform SQL conditions, are displayed as options in the Available list.

6. You can determine whether users can display data for all elements in the selector at once. To display all the elements, a user clicks the header of the attribute used as the selector when the document is run. Whether
displaying all is enabled or disabled, users can select one item at a time to display. Do one of the following:

- To allow users to display data for all elements in the selector at once, select the **Show option for All** check box.
- To disable simultaneous display of all elements, clear the **Show option for All** check box.

7 Click **Create** to apply your changes.

### Enabling Grid/Graphs as selectors in a Transaction Services-enabled document

You can enable a Grid/Graph as a selector to filter the items displayed in a List control in a Transaction Services-enabled document. When you enable the Grid/Graph as a selector, you choose an attribute on the Grid/Graph. A user selects an element of that attribute to filter the choices available in the List control.

**Prerequisites**

This procedure assumes that:

- The Transaction Services-enabled document contains the List control to update when an item is chosen in the selector. The List control must display attribute elements from a selected dataset as items in the control (this is called a data-driven input control). For steps to create a Transaction Services-enabled document, as well as steps to create a List control, see the *Report Services Document Creation Guide*.
- The document contains a Grid/Graph to use as the selector. For steps to create a Grid/Graph, see the *Report Services Document Creation Guide*.
- Automatic target maintenance is disabled. For steps, see *Disabling automatic target maintenance to allow manual target selection, page 177*.

**To enable a Grid/Graph as a selector to filter a List control**

1 In MicroStrategy Web, open a document in **Design** or **Editable Mode**.
2 On the Grid/Graph, right-click the header of the attribute to use as the selector, and choose **Use as Selector**. The Configure Selector dialog box opens.

3 From the list of **Available Targets** on the left, choose the List control and click > to add it to the list of **Selected Targets**. The name used to identify each List control varies depending on whether the List control was created based on a text field or a dataset object on a Grid/Graph:

   • If the List control was created based on a text field, it is listed using the name of the text field.

   • If the List control was created based on a metric in a Grid/Graph, it is listed as `GridGraph:Metric`, where `GridGraph` is the name of the Grid/Graph and `Metric` is the name of the metric.

   • If the List control was created based on an attribute in a Grid/Graph, it is listed as `GridGraph:Attribute@AttributeForm`, where `GridGraph` is the name of the Grid/Graph, `Attribute` is the name of the attribute, and `AttributeForm` is the name of the attribute form.

4 The All option in a selector allows the user to display all the elements in the target at one time. To enable the All option, select the **Show option for All** check box in the Configure Selector dialog box.

5 Click **OK** to return to the document.

---

### Creating a selector that updates the view filter in a grid or graph

You can allow users to dynamically update the qualifications in the view filter of a grid or graph by choosing items in a selector. To do so, you define a dynamic condition in the view filter of the grid or graph, then create a selector that targets the dynamic condition.

For example, you create a grid that contains sales data for various product categories, then create a selector that contains each product category. This selector targets a dynamic condition in the grid’s view filter. A user can select the Books and Music categories in the selector. The grid is then filtered to display data only for Books and Movies.
For an overview of view filters and steps to create a dynamic condition, see the Document Creation Guide.

**Prerequisite**

- This procedure assumes that you have already created a document with at least one grid or graph report. The view filter of the grid or graph must contain a dynamic condition.

---

**To create a selector that updates the view filter in a Grid/Graph**

1. From the Insert menu, point to Selector, then select the type of selector to add to the document.

2. Click the location in the layout area to add the selector to. The selector is automatically created and added to the document.

3. Right-click the selector, then select Properties and Formatting. The Properties and Formatting dialog box opens.

4. From the left, click Selector.

5. From the Action Type drop-down list, choose Select Attribute Element.

6. From the Source drop-down list, select the attribute that contains the elements to display as items in the selector.

7. The dynamic condition appears in the Available list as **GridGraphName:ConditionName**, where **GridGraphName** is the name of the grid or graph whose view filter contains the dynamic condition, and **ConditionName** is the name of the dynamic condition. From the Available list, select the dynamic condition, then click > to add the dynamic condition to the Selected list.

   - If the Available targets and Selected targets lists are not available, click the link to change to manual control and select OK at the prompt to continue. The lists are now available.

8. Click OK to apply your changes.
Updating the image on a panel using a selector

You can allow users to update the image displayed on a panel in a panel stack by choosing items in a selector. For example, a document displays a selector containing the names of several retail stores and a panel stack containing the image of a single store. A user can choose the names of different stores in the selector to update the store image. The image is automatically sized and displayed to fit in the panel.

Prerequisites

- The following procedure assumes that you have already created the document to display the image in. The document must contain a dataset report containing the following attributes:
  - An attribute that contains the location of each image to display (for example, http://yourserver.com/example.jpg).
  - An attribute that contains the ID of each image to display. Users can select from elements of this attribute in the selector to determine which image is displayed in the panel stack.

To dynamically update an image displayed in a panel using a selector

1. Open the document in Design Mode.
2. From the Insert menu, point to Selector, then choose the type of selector to add to the document.
3. Click the location in the layout area to add the selector to. The selector is automatically created and added to the document.
4. From the Dataset Objects panel, click and drag the attribute that contains the image IDs onto the selector that you just created. The name of the attribute appears in the selector.
5. From the Insert menu, select Panel Stack. Click the location in the layout area to add the panel stack to. The panel stack is automatically created and added to the document.
6. From the Insert menu, select Image. Click and drag a rectangle shape over the area on the panel stack to display the image in. When a user chooses an item in the selector to update the image, the image will be
automatically resized to fit this shape. The Properties and Formatting dialog box opens.

7 In the **Source** field, type the name of the attribute that contains the image locations, surrounded by brackets `{ }`. For example, if the attribute is called Image Source, type `{Image_Source}` in the field.

8 Click **OK** to apply your changes.
PROVIDING FLASH ANALYSIS AND INTERACTIVITY: WIDGETS

Introduction

A widget is a Flash-based display of the results of a dataset, allowing users to visualize data in different ways than traditional reports displayed as a grid report or graph report do. Widgets are sophisticated visualization techniques that can combine with rich interactivity to enable users to understand their data more effectively. You can use a variety of widget types, such as Gauge, Heat Map, and Stacked Area widgets, in dashboard-style documents. Although each type of widget looks different and is used in a unique way, the main purpose of all widgets remains the same: to provide analysts with a visual and interactive look into their data.

For example, the Interactive Bubble Graph widget below allows analysts to drill into each bubble in the graph by clicking it. Analysts can also use the
time animation toolbar at the top of the widget to watch the bubbles appear on the graph in chronological order.

For more information on Bubble Graph widgets in particular, including a detailed description of the data structure and a procedure to enable drilling, see Creating an Interactive Bubble Graph widget, page 295.

This chapter helps you choose the right widget and describes each type of widget, its purpose, how to create it, and how a dashboard-style document analyst can use it to analyze a specific set of data.

Choosing the right widget

This section briefly summarizes each type of widget that you can use in a dashboard-style document, and provides a quick reference table to determine how a widget will display, whether the widget is interactive, and whether users can save their changes, based on which view/mode your users will use.

A dashboard-style document designer creates widgets in Design Mode or Editable Mode in MicroStrategy Web, or in Design View in Developer. The
designer and other users can interact with widgets in MicroStrategy Web, Developer, and MicroStrategy Mobile devices, as shown in the table below.

<table>
<thead>
<tr>
<th>View or Mode</th>
<th>Widget Can Display As</th>
<th>Interact with Widget?</th>
<th>Save Widget Changes?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MicroStrategy Developer</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design View</td>
<td>Empty Grid/Graph (no data)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Flash View</td>
<td>• Widget *</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>• Grid/Graph</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HTML View</td>
<td>• Grid/Graph</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>• Placeholder</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hidden</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PDF View</td>
<td>• Grid/Graph</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>• Placeholder</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hidden</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MicroStrategy Web</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design Mode</td>
<td>Empty Grid/Graph (no data)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Editable Mode</td>
<td>Grid/Graph</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Express Mode</td>
<td>• Widget **</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>• Grid/Graph</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Placeholder</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hidden</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flash Mode</td>
<td>• Widget</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>• Grid/Graph</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interactive Mode</td>
<td>• Widget **</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>• Grid/Graph</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Placeholder</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hidden</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MicroStrategy Mobile</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Android</td>
<td>Android widgets:</td>
<td>Yes (Android widgets only)</td>
<td>No</td>
</tr>
<tr>
<td>Must define in MicroStrategy Web</td>
<td>• Widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Grid/Graph</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>All other widgets are displayed as Grid/Graphs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>iPad</td>
<td>iPad widgets:</td>
<td>Yes (iPad widgets only)</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>• Widget</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Grid/Graph</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>All other widgets are displayed as Grid/Graphs</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Choosing the right widget

The following list briefly summarizes each type of widget that you can use in a dashboard-style document.


- **Bubble Grid**: Bubbles of different colors and sizes representing the values of two metrics. It can help identify important trends or anomalies in data, relative to the total contribution of accompanying data. See Creating a Bubble Grid widget, page 244 for steps and an example.

- **Cylinder**: A simple status indicator that displays a vertical cylinder with fluid in it. The level of the fluid within the cylinder is a visual representation of a single metric value. See Creating a Cylinder widget, page 247 for steps and an example.
• **Data Cloud**: A list of attribute elements displayed in various sizes to depict the differences in metric values between the elements. The varying sizes allow a user to quickly identify the most significant, positive, or negative contributions. See *Creating a Data Cloud widget, page 249* for steps and an example.

• **Date Selection**: A calendar selector that allows you to select which dates you want to see data about in a dashboard-style document. You are able to see all of the dates of each month in the widget, which makes selecting dates easier. See *Creating a Date Selection widget, page 251* for steps and an example.

• **Fish Eye Selector**: An interactive selector that magnifies an item when you hover the cursor over it. It allows a user to choose from a list of attribute elements, metrics, or images without having to see all of the elements, metrics, or images. Any item that a user hovers over or selects remains magnified, while the remaining items are minimized and hidden from view. This can be especially helpful when the user has to browse through a lengthy list. See *Creating a Fish Eye Selector, page 260* for steps and an example.

• **Funnel**: A variation of a stacked bar graph that displays data that adds up to 100%. It allows a user to visualize the percent contribution of a metric to the whole. See *Creating a Funnel widget, page 274* for steps and an example.

• **Gauge**: A simple status indicator that displays a needle that moves within a range of numbers displayed on its outside edges. An example of a gauge is a car’s speedometer. See *Creating a Gauge widget, page 276* for steps and an example.

• **Graph Matrix (deprecated)**: A group of area graphs that display actual values and line graphs that display forecasted values. It allows a user to quickly analyze various trends across several metric dimensions. See *Creating a Graph Matrix (deprecated) widget, page 278* for steps and an example.

• **Graph Matrix**: The Graph Matrix widget allows you to display your data using a variety of graph styles, such as the line graph, bubble graph, or grid, then customize it to suit users’ needs. See *Creating a Graph Matrix widget, page 281* for steps and an example.

• **Heat Map**: A combination of colored rectangles, each representing an attribute element, that allow you to quickly grasp the state and impact of a large number of variables at the same time. See *Creating a Heat Map widget, page 283* for steps and an example.
• **Image Layout**: You can display your data using an image overlaid with colored areas or bubble markers to allow users to quickly grasp relationships between different locations, such as the foot traffic of aisles in a store or sales data for regions on a map. See *Creating an Image Layout widget, page 287* for steps and an example.

• **Interactive Bubble Graph**: A conventional bubble plot that allows you to visualize the trends of three different metrics for a set of attribute elements. See *Creating an Interactive Bubble Graph widget, page 295* for steps and an example.

• **Interactive Stacked Graph**: A combination of a check box list and area graph. The graph allows a user to see the contribution of various metric series to the change in value of a larger set of data. See *Creating an Interactive Stacked Graph widget, page 301* for steps and an example.

• **Map**: Locations displayed as image markers or bubble markers on a map, along with additional data for those locations, such as attribute and metric data. See *Creating a Map widget, page 303* for steps and an example.

• **Media**: Video, audio, images, or website content. One of the primary purposes of the Media widget is to present supplemental information about the data on a dashboard-style document. It can also be used for instructional content or HTML content from a website. See *Creating a Media widget, page 314* for steps and an example.

• **Microcharts**: One or more compact representations of data that allow analysts to quickly visualize trends. Use a Microcharts widget to quickly visualize the trend of a metric at a glance without having to know many additional details. The bar, sparkline, and bullet microcharts used in the Microcharts widget convey information that an analyst can understand just by looking at the graph once. See *Creating a Microcharts widget, page 320* for steps and an example.

• **Network**: Data is displayed as nodes in the widget, with lines (called edges) drawn between the nodes to represent relationships between data elements. Once the widget is created, users can visualize characteristics of the nodes and the relationships between them, using display options such as node size, edge thickness, and edge color. The Network widget allows you to quickly and easily identify relationships between related items and clusters. See *Creating a Network widget, page 332* for steps and an example.

• **RSS Reader**: RSS (Really Simple Syndication) is a data format used to display updated Web content when you click a URL. An RSS document is called a feed, and it contains either a summary of the content from an associated website or the full text. The RSS Reader widget can help
provide context to your business data. Use RSS Reader widgets on a dashboard-style document to view and update RSS feeds as a user analyzes grids, graphs, and other objects in the same dashboard-style document. See *Creating an RSS Reader widget, page 335* for steps and an example.

- **Survey:** An interactive survey displayed in a Transaction Services-enabled document. Users can submit their answers, which are then stored in your data source. See *Creating a Survey widget, page 339* for steps and an example.

- **Thermometer:** A simple status indicator that displays a thermometer set to a certain temperature level. The temperature level within the thermometer is a visual representation of a single metric value. See *Creating a Thermometer widget, page 358* for steps and an example.

- **Time Series Slider:** An area graph that allows an analyst to choose which section of the graph to view at a time. See *Creating a Time Series Slider widget, page 360* for steps and an example.

- **Waterfall:** A group of clustered bars displayed from left to right. It highlights the increments and decrements of the values of metrics over time. The widget can help identify what is contributing to fluctuations in the metric values and can be used for “what-if” analyses. See *Creating a Waterfall widget, page 363* for steps and an example.

- **Weighted List Viewer:** A combination of the data visualization techniques of thresholds and graphical weighting in a single visualization. This enables the analyst to assess the performance of a group of items. See *Creating a Weighted List Viewer widget, page 366* for steps and an example.

**Widgets for mobile devices**

You can define a Grid/Graph to display as a widget on a document when the document is executed on a mobile device that has the MicroStrategy Mobile
application. For examples of the widgets available for mobile devices, and steps to create them, see the Mobile Design and Administration Guide.

SDK widgets

The following customized widgets are available. See the MicroStrategy Developer Library (MSDL), part of the MicroStrategy SDK, for information to customize and use these widgets. With the MicroStrategy SDK, you can access additional MicroStrategy widgets, add third-party widgets, and create and use custom widgets.

- **Google Graph**: A simple chart of data. The widget is created using the Google API.

- **Image Map**: Displays a map with regions that appear in different colors, depending on the conditions defined. You can specify the type of map displayed, such as a world map, regions or states in a country, or departments in a retail store.

- **Line Chart**: Uses line charts to visualize trends in your data. You can examine specific points of data in a line chart, or examine subsets of data.

- **Store Layout**: A layout image of a retail store. Different departments in the store are displayed in different colors, depending on the conditions defined. For example, departments whose profit is less than 75% of their profit goal are displayed in red.

- **Table**: A simple tabular layout.

- **Timeline**: A timeline that displays a series of events. The timeline can be examined at the yearly, monthly, and weekly level as a series of bands. This lets users quickly spot trends, such as the times when call congestion is most likely to affect a call center.

- **USA Map**: A map of the United States, which acts as a selector to determine the data displayed in another control. For example, a user can click a region in the United States, such as Central, to display revenue data for the Central region in a target Grid/Graph.

- **WhatIf Control**: Allows you to perform a "What if?" analysis on your data. For example, you can explore what happens to net income values if revenue doubles in the next year.
Formatting widgets

By default, most types of widgets automatically inherit some of the formatting of the underlying grid or graph reports on which they are based. For example, a widget can be displayed using the font colors and types defined for its underlying graph report.

A widget also has additional formatting specific to the type of widget. For example, you can change the number format of the metric values in a Bubble Grid widget, Cylinder widget, or Gauge widget. For an Interactive Stacked Graph widget, you can change the font of the text that appears in the graph and the color of the check boxes on the left side of the graph. For descriptions of the types of formatting that are available for each type of widget, as well as steps to format widgets, see Chapter 6, Formatting Widgets.

Widgets and automatic target maintenance for selectors

Selectors allow a user to control what is displayed in a widget or Grid/Graph (the target of the selector). Targets can be automatically maintained in a layout. This means that when you add a Grid/Graph or widget, the Grid/Graph or widget automatically becomes the target of all selectors in the same panel or document section as the Grid/Graph or widget. For background information on selectors, see Chapter 4, Providing Interactivity to Users: Selectors. For more information about automatically maintaining targets for selectors, including instructions to enable and disable the functionality, see Automatically maintaining targets for selectors, page 169.

Creating widgets

Prerequisites for creating widgets

- To test the widgets you have created and to view and interact with widgets, Flash Player is required. See the MicroStrategy Readme for the latest version support information.

- To successfully create a useful widget that can be used to analyze data, you must have the appropriate attributes and metrics (or other objects) to define the widget. The report objects and their placement on the Grid/Graph determine whether the widget can be successfully generated and display data. For example, a Grid/Graph that you want to display as a
Gauge widget must have one attribute on the rows and one metric on the columns. These data requirements are detailed in the steps for creating each widget.

- You can add objects from multiple datasets to the Grid/Graph, if you have the correct privileges and the project has been set up to allow Grid/Graphs to use multiple datasets. For steps to allow Grid/Graphs to use multiple datasets, see the Adding Text and Data chapter of the Document Creation Guide.

- Unlike other widgets, the RSS Reader and Media widgets do not require attributes or metrics on their Grid/Graphs, unless the widget is a target of an attribute selector in the dashboard-style document. For instructions on how to create a RSS Reader widget, see Creating an RSS Reader widget, page 335. For instructions on how to create a Media widget, see Creating a Media widget, page 314.

## Creating a Bubble Grid widget

The Bubble Grid widget conveys information to help an analyst identify important trends or anomalies in data, relative to the total contribution of accompanying data. In the widget, metric values are plotted as bubbles of different colors and sizes; the colors and sizes of the bubbles represent the values of two distinct metrics on the Grid/Graph that contains the widget. Each bubble is generated at the intersection of two different attribute elements. For example, in the widget below, a single bubble depicts the profit
and revenue for books (an element of the Category attribute) in the South region (an element of the Region attribute).

The Bubble Grid widget is most beneficial when it is used to perform analyses involving key business ratios, such as the number of customers in a store vs. the revenue generated per customer. For example, the widget can help analysts investigate questions such as “Does the number of customers that visit a certain store correlate to the amount of money each customer spends?” Analysts can use the widget to answer these types of questions in the context of business attributes, such as different stores, regions, and times of the day or year. Positive correlations in the data show that stores with a large number of customers generate a large amount of revenue, and negative correlations show the opposite. When analysts detect negative correlations for stores in specific regions, they can investigate reasons for the issue and recommend changes such as adding more sales personnel to the stores.

A Bubble Grid widget does not need a separate selector to allow a user to interact with it. However, you can use a Bubble Grid widget as a selector. For an example and more information, see Using a Bubble Grid widget as a selector, page 443.
To create and add a Bubble Grid widget to a document

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Bubble Grid**.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.

To add objects to the Grid/Graph that contains the widget

5. From the **Dataset Objects** panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

   a. Place two attributes, custom groups, or consolidations on the Grid/Graph’s rows. Bubbles are generated at the intersections of the elements from these objects.

      - Elements from the first (left-most) object are displayed on the X-axis of the widget. This object represents one of the business areas that can be analyzed in the widget.

      - To analyze data along the X-axis relative to time, use a time-based attribute such as Hour, Day, or Month. If you use an Hour or Day attribute, apply a view filter to the Grid/Graph to limit the number of hours or days displayed in the widget at the same time. For details on how view filters affect Grid/Graphs, and instructions to add them, see the *Report Services Document Creation Guide*.

      - Elements from the second attribute are displayed on the Y-axis of the widget. This attribute represents the other business area that can be analyzed in the widget.

   b. At least two metrics on the columns. The values of these two metrics produce the bubbles in the widget, as described below:

      - The first (left-most) metric determines the size of the bubbles. The smaller metric values produce the smaller bubbles in the widget; the larger metric values produce the larger bubbles.
- The second metric determines the color of the bubbles. For example, if Profit is the second metric on the columns, the colors of the bubbles depict the range of profit values. You can determine which colors are used for minimum and maximum metric values, as described in *Formatting a Bubble Grid widget, page 387*. This range of colors is depicted in the legend at the bottom of the widget, if the legend is enabled.

- Any additional metrics are displayed in tooltips when an analyst hovers the cursor over a bubble in MicroStrategy Web. These metrics do not have an effect on the size or color of the bubbles in the widget.

**To enable the widget to be displayed**

6 View and test your results in one of two ways:

- Select **Flash Mode** from the **Home** menu.
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 61*.

- Select **Interactive Mode** from the **Home** menu.
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 369*.

**Creating a Cylinder widget**

A Cylinder widget is a simple status indicator that displays a vertical cylinder with fluid in it. The level of the fluid within the cylinder is a visual representation of a single metric value. Like the Gauge and Thermometer widgets, this type of widget is designed to display the value of a single metric.

The Cylinder widget is most useful when combined with a selector because this allows users to choose specific metric values to display in the cylinder.
In the image below, the liquid level in the cylinder represents the amount of revenue generated (the Revenue metric).

![Cylinder widget](image)

**To create and add a Cylinder widget to a document**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Cylinder**.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.

**To add objects to the Grid/Graph that contains the widget**

5. To allow users to change the metric value displayed in the widget with a selector, complete the following substeps:
   
a. Insert a selector next to the Cylinder widget, then select an attribute as its source. Users choose attribute elements from this selector to change the display in the Cylinder widget. For steps to insert a selector and choose a source for it, see *Methods to create a selector, page 129*. 
b Set the Cylinder Grid/Graph as the target of the selector. For steps to select an object as the target of a selector, see *Creating a selector to change panels on a panel stack, page 134.*

6 It can be useful to drag the dataset from the **Dataset Objects** panel and place it beneath the selector. This allows users to see the dataset’s values as they select different attribute elements from the selector and see how their choices change the appearance of the widget.

**To enable the widget to be displayed**

7 View and test your results by selecting **Flash Mode** from the **Home** menu.

- If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 61.*

---

**Creating a Data Cloud widget**

A Data Cloud widget displays attribute elements in various sizes to depict the differences in metric values between the elements. This widget is similar to a Heat Map widget in that they both allow an analyst to quickly identify the most significant positive or negative contributions.

A Data Cloud widget is a list of attribute elements. The font size of each attribute element represents a metric value for that element. A bigger font for an element indicates a larger metric value. In the Data Cloud widget shown below, the size of each attribute element from the Subcategory attribute represents the amount of revenue generated by each type of book. Any additional metrics are displayed when a user hovers over a subcategory.

![Data Cloud widget example](image)

A Data Cloud widget does not need a separate selector to allow a user to interact with it. However, you can use a Data Cloud widget as a selector. For
an example and more information, see *Using a Data Cloud widget as a selector, page 443.*

---

**To create and add a Data Cloud widget to a document**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Data Cloud**.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.
4. If desired, resize the widget by clicking and then dragging its handles.

**To add objects to the Grid/Graph that contains the widget**

5. From the **Dataset Objects** panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:
   a. Place at least one attribute on the Grid/Graph’s rows.
      - The elements of the left-most attribute are displayed in the widget. For example, if the attribute is Year, a list of years is displayed in the widget.
      - If you include additional attributes to the right of the first attribute, elements from all of the attributes are combined and displayed in the widget. For example, if Year is the first attribute and Quarter is the second attribute, every combination of year and quarter is displayed in the widget, such as 2007 Q4 and 2007 Q3.
   b. Place at least one metric on the Grid/Graph’s columns.
      - The first (left-most) metric on the columns determines the size of the font of the attribute elements in the widget.
      - If you include additional metrics to the right of the first metric, the additional metrics are displayed in the tooltips. When a user hovers the cursor over an attribute element in MicroStrategy Web, a tooltip is displayed. The tooltip lists the attribute element and metric values for that attribute element.
To enable the widget to be displayed

6 View and test your results in one of two ways:

- Select **Flash Mode** from the **Home** menu.
  
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 61*.

- Select **Interactive Mode** from the **Home** menu.
  
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 369*.

You may want to place the corresponding Grid/Graph below the Data Cloud widget to display the exact metric values for the attribute elements displayed in the widget. For instructions to insert a Grid/Graph, see the Report Services Document Creation Guide.

You can add links to a Data Cloud widget. Linking allows users to connect from a widget in a dashboard-style document (the source) and open a document or report (the target). If you add a link to a Data Cloud widget, the Links menu is displayed when a MicroStrategy Web user hovers the cursor over an attribute element in the widget. The user can click a link in the Links menu to open the target. See *Linking in widgets, page 379* for instructions and examples.

Creating a Date Selection widget

A Date Selection widget is a calendar selector that allows users to select dates for which they want to see related data. You are able to see all of the dates of each month in the widget, which allows you to select dates more easily.

For example, the Date Selection widget is useful if you are working with a dashboard-style document that displays data from Q4 2007 and you want to view data from a date before that. You can select the date that you want to see
and the data for that date will display on the dashboard-style document, as shown below:

<table>
<thead>
<tr>
<th>Day Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Profit Margin</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/6/2007</td>
<td>$22,501</td>
<td>$3,939</td>
<td>17.51%</td>
<td>550</td>
</tr>
</tbody>
</table>

The same dashboard-style document is shown below in Interactive Mode. The Date Selection widget is defined to not display as a widget in DHTML. The Date Selection widget was created as a widget (as opposed to creating it as a selector), so the selector is now displayed as a Grid/Graph. Notice the scroll bar at the right: all the dates are not shown in this sample, because the list is so long. Because the list is so long, dates even further down the list do not appear in the same screen as the graph, which is why the Date Selection widget is so useful.
On a mobile device with MicroStrategy Mobile, the Date Selection widget can display as an interactive event calendar, which users can view in Day, Week, or Month view. For steps to create and format a Date Selection widget for display on a mobile device, see the *Mobile Design and Administration Guide*.

If the Date Selection widget was created as a selector rather than a widget, in Interactive Mode the dashboard-style document looks like the sample shown below. You can set the style of the selector, which in this example is left as the default, Listbox. Again, all the dates are not shown, because the list is so long. The scroll bar allows the user to view and select dates further down in the list.

<table>
<thead>
<tr>
<th>Date</th>
<th>Metrics</th>
<th>Revenue</th>
<th>Profit</th>
<th>Profit Margin</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/6/2007</td>
<td></td>
<td>$22,501</td>
<td>$3,939</td>
<td>17.51%</td>
<td>560</td>
</tr>
</tbody>
</table>

A panel stack can also be the target of a Date Selection widget. However, a Date Selection widget created as a widget cannot switch panels on a panel stack.

The table below summarizes the differences between a Date Selection widget created as a widget and as a selector.

<table>
<thead>
<tr>
<th></th>
<th>Created as a Widget</th>
<th>Created as a Selector</th>
</tr>
</thead>
<tbody>
<tr>
<td>Targets panel stacks and Grid/Graphs</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Switches panels on a panel stack</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
For steps to create a Date Selection widget as a widget, see "Creating a Date Selection widget as a widget, page 254." For steps to create a Date Selection widget as a selector, see "Creating a Date Selection widget as a selector, page 257."

**Creating a Date Selection widget as a widget**

A Date Selection widget is an interactive style of widget.

When created as a widget and displayed in Flash Mode, a Date Selection widget displays as a Date Selection widget.

When created as a widget and displayed in non-Flash modes, a Date Selection widget can be displayed as any of the following:

- Date Selection widget
- Grid/Graph used as a selector
- Empty Grid/Graph placeholder
- Hidden

A Date Selection widget created as a widget can target Grid/Graphs and panel stacks, but cannot switch panels on a panel stack. (For more information on Grid/Graphs controlling panel stacks or other Grid/Graphs, see "Using Grid/Graphs as selectors to control other Grid/Graphs, page 219.") If you want the Date Selection widget to display as a standard selector such as a listbox or button bar in non-Flash modes, or to allow multiple selections, create it as a selector instead. For steps, see "Creating a Date Selection widget as a selector, page 257."

---

**To create and add a Date Selection widget as widget to a document**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
To create the target

2 Create the Grid/Graph or panel stack to be used as the target, if it is not already in the document. For instructions, see the *MicroStrategy Web Help*.

To create the selector widget

3 From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Date Selection**.

4 Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

5 If desired, resize the widget by clicking and then dragging its handles.

6 From the Dataset Objects panel on the left, select one attribute and drag it on top of the Grid/Graph’s rows. The attribute must be of a date type (examples in the MicroStrategy Tutorial project include Day and Ship Date).

   If targets are automatically maintained and you place the selector widget and target in the same document section or panel, you will not need to disable automatic target maintenance to select the target. For information on the effects of disabling it, see *Disabling automatic target maintenance to allow manual target selection*, page 177.

To connect the selector to the target

7 Right-click the attribute to use as the selector, and choose **Use As Selector**. The Configure Selector dialog box opens.

8 Do one of the following:

   • If targets are automatically maintained and you added the widget and target to the same document section or panel, the target Grid/Graph or panel stack is automatically added as a target to this selector. Click **Create** to finish adding the target.

   • If targets are automatically maintained but the widget and target are not in the same document section or panel, you must disable
automatic target maintenance and then manually select the target, as described below:

a  Click Click here. A warning message opens, indicating that you will need to manually maintain targets if you disable automatic target maintenance. For the effects of disabling automatic target maintenance, see Disabling automatic target maintenance to allow manual target selection, page 177.

b  Click OK. You are returned to the Selector dialog box. Automatic target maintenance has been disabled for all selectors in the layout.

c  Select the target in the Available Targets list, and click the Add to selections arrow to move it to the Selected Targets list.

d  Click Create.

•  If targets are not automatically maintained, you must manually specify the target of the selector, as described below:

a  Select the target in the Available Targets list, and click the Add to selections arrow to move it to the Selected Targets list.

b  Click Create.

9  Right-click the widget and select Properties and Formatting. The Properties and Formatting dialog box opens.

10  From the left, click Widget.

11  You can change the Alternative Display option, which determines how the widget looks in non-Flash modes. The widget can display as a placeholder or as a Grid/Graph, or can be hidden. For more information, see Defining how a widget is displayed in different views and modes, page 369.

12  By default, the Date Selection widget is displayed as a widget in Flash. To display it as a grid or graph report instead, clear the Flash check box in the Display Widget As column.

13  By default, the Date Selection widget is displayed as a widget in DHTML (Express Mode and Interactive Mode in MicroStrategy Web). To use the Alternative Display option instead, clear the DHTML check box in the Display Widget As column.
14 Click OK to apply your changes.

To enable the widget to be displayed

15 View and test your results in one of two ways:

• Select Flash Mode from the Home menu.
  – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 61.

• Select Interactive Mode from the Home menu.
  – To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see Defining how a widget is displayed in different views and modes, page 369.

A Date Selection widget created as a widget can be displayed as a widget using Flash in DHTML interactive documents.

Creating a Date Selection widget as a selector

In Flash Mode, a Date Selection widget created as a selector displays as a standard Date Selection selector.

In non-Flash modes, a Date Selection widget created as a selector can be displayed as a standard selector such as a listbox or button bar. To display the Date Selection widget as a Grid/Graph, or to hide it completely, create it as a widget instead. For instructions, see Creating a Date Selection widget as a widget, page 254. A Date Selection widget created as a selector allows multiple selections, unlike a Date Selection widget created as a widget.

You can create a Date Selection widget from scratch or by applying its style to an existing selector. The following procedure creates it from scratch.

To apply the style to an existing selector, set the Flash style option (found in the Property List or the Properties dialog box) to Date Selection.

To create and add a Date Selection widget as selector to a document

1 In MicroStrategy Web, open the document in Design Mode or Editable Mode.
To create the target

2 Create the Grid/Graph or panel stack to be used as the target, if it is not already in the document. The target must contain a date attribute, such as Day or Quarter. For steps, see Inserting a panel stack, page 76.

To create the selector

3 From the Insert menu, scroll to Selector, then select Date Selection. When you move the cursor to the Layout area, the cursor becomes crosshairs.

4 Click the location on your document where you want to place the selector. The Grid/Graph containing the selector is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of selector you have added to the document.

5 If desired, resize the selector by clicking and then dragging its handles.

To define the selector

6 Right-click the new selector and select Properties and Formatting. The Properties and Formatting dialog box opens.

7 On the left, click Selector.

8 Choose Select attribute element from the Action Type drop-down list.

9 Select a date attribute from the Source drop-down list. (In the MicroStrategy Tutorial project, Day and Ship Date are examples of date attributes.)

The Source drop-down list contains all of the attributes in all of the datasets in the document. The source attribute that you choose becomes the attribute whose elements are displayed in the selector for a user to choose from.

To connect the selector to the target

10 You can select one or multiple Grid/Graphs or panel stacks, or any combination of Grid/Graphs and panel stacks, as the target. The target Grid/Graph or panel stack displays the data from the date that the user chooses in the Date Selection widget.

• If targets are automatically maintained and you added the selector and target to the same document section or panel, the target Grid/Graph or panel stack is automatically added as a target to this selector.
• If targets are automatically maintained but the selector and target are not in the same document section or panel, you must disable automatic target maintenance before selecting targets, as described below:

  a Click **Click here**. A warning message opens, indicating that you will need to manually maintain targets if you disable automatic target maintenance. For the effects of disabling automatic target maintenance, see *Disabling automatic target maintenance to allow manual target selection, page 177.*

  b Click **OK**. You are returned to the Properties and Formatting dialog box. Automatic target maintenance has been disabled for all selectors in the layout.

• If targets are not automatically maintained or you disabled automatic maintenance, you must manually specify the target of the selector. Select the target in the Available Targets list, and click the **Add to selections** arrow to move it to the Selected Targets list.

**To set a default selector style for non-Flash modes/views**

11 From the list on the left, click **Layout**.

12 In Flash Mode, the Date Selection widget is viewable as designed above. In non-Flash modes, the Date Selection widget is displayed by default as a Listbox style selector. To change the default selector style (for non-Flash Mode display), select a different **DHTML style**.

13 For Slider, Radio Buttons, Check Boxes, and Button Bar selector styles, you can use the **Orientation** option to display the selector horizontally (on a single line from left to right) or vertically (in a single column).

14 The user must select an item in a selector to change the target of the selector. For the List Box selector style, you can allow a user to select an item by hovering the cursor over it, without clicking, if you select the **Change selection on mouseover** check box. If the user points the cursor away from the selector without clicking an item, the target reverts to its previous state.

The mouseover option is applied only in Flash Mode.

**To allow multiple selections and define the All option for users**

15 By default, users can only select one item from the following selector styles: Slider, Listbox, Link Bar, and Button Bar. To allow users to make multiple selections for these selector styles, select the **Allow multiple**
Selections check box. This check box is cleared by default. This option is unavailable for other selector styles (except for Check Boxes) because those styles do not support multiple selections.

16 From the list on the left, click **Selector**.

17 By default, the user can display all attribute elements in the target at one time, by selecting the All option. To disable the All option, clear the **Show option for All** check box.

   The Show option for All check box is not available if the DHTML style is set to **Slider** and the **Allow multiple selections** check box is selected.

18 By default, the All option is labeled (All) in the selector. You can rename the All option by typing text into the **Alias for All** field. You can rename the All option only if the Show option for All check box is selected above.

19 Click **OK** to return to the document.

20 Save the document.

**To enable the selector to be displayed**

21 View and test your results by selecting **Flash Mode** from the **Home** menu.

   • If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 61.*

**Creating a Fish Eye Selector**

The Fish Eye Selector magnifies an item when a user hovers the cursor over it in Flash Mode, Interactive Mode, or Express Mode. Any item that a user hovers over or selects remains magnified, while the remaining items are minimized and displayed in the background of the selector. A Fish Eye
Selector is shown below in Flash Mode, targeting a graph, which changes as the selection on the left changes.

You can create a Fish Eye Selector as either a widget or a selector. Which you choose depends on how you want to display the Fish Eye Selector in different modes. In general, a Fish Eye Selector created as a widget can display as a Fish Eye Selector, a grid or graph, a placeholder, or hidden. A Fish Eye Selector created as a selector can display as a Fish Eye Selector or any standard selector, such as list box or slider. For a complete list of how Fish Eye Selectors are displayed in MicroStrategy Web modes and Developer views, see *Fish Eye Selector: Widget vs. selector, page 265*. Also, a Fish Eye Selector created as a widget cannot switch panels on a panel stack, unlike a Fish Eye Selector created as a selector.

For example, you can choose to display a Fish Eye Selector as a grid, instead of a widget. The same dashboard-style document shown above in Flash Mode is shown below in Interactive Mode. The widget, which is displayed as a Fish Eye Selector in Flash Mode, is displayed as a grid in Interactive Mode. The
grid functions as a selector, targeting and changing the graph, just as the Fish Eye Selector did in the previous example.

<table>
<thead>
<tr>
<th>Employee</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Michael</td>
<td>Bates</td>
</tr>
<tr>
<td>Kyle</td>
<td>Becker</td>
</tr>
<tr>
<td>Caitlin</td>
<td>Bell</td>
</tr>
<tr>
<td>Ian</td>
<td>Benner</td>
</tr>
<tr>
<td>Lawrence</td>
<td>Bernstein</td>
</tr>
<tr>
<td>Vernon</td>
<td>Brown</td>
</tr>
<tr>
<td>Beatrice</td>
<td>Conner</td>
</tr>
<tr>
<td>Peter</td>
<td>Carcoran</td>
</tr>
<tr>
<td>Sandra</td>
<td>De Le Torre</td>
</tr>
<tr>
<td>Nancy</td>
<td>Ellerkamp</td>
</tr>
<tr>
<td>Adrienne</td>
<td>Folks</td>
</tr>
<tr>
<td>Loren</td>
<td>Gale</td>
</tr>
<tr>
<td>Harriet</td>
<td>Gedot</td>
</tr>
<tr>
<td>David</td>
<td>Hall</td>
</tr>
<tr>
<td>Robert</td>
<td>Hollywood</td>
</tr>
<tr>
<td>Matthew</td>
<td>Hunt</td>
</tr>
<tr>
<td>Walter</td>
<td>Ingles</td>
</tr>
<tr>
<td>Andrew</td>
<td>Johnson</td>
</tr>
<tr>
<td>Laura</td>
<td>Kelly</td>
</tr>
<tr>
<td>Jack</td>
<td>Kieferson</td>
</tr>
<tr>
<td>Sam</td>
<td>Lynch</td>
</tr>
</tbody>
</table>

All the employees are not shown in this sample, because the list is so long. Notice that the previous selection, Jack Kieferson, is far down the list. Because the list is so long, names even further down the list may not appear in the same screen as the graph, which is why the Fish Eye Selector is so useful.

The Fish Eye Selector in the previous example was created as a widget, which is why it can be displayed as grid. If the Fish Eye Selector was created as a selector instead, you can choose the selector style for display in non-Flash modes. For example, the Fish Eye Selector can display as a button bar, as
shown in the Interactive Mode example shown below. The button bar targets and changes the graph.

<table>
<thead>
<tr>
<th>Bates: Michael</th>
<th>( \text{Average} )</th>
</tr>
</thead>
<tbody>
<tr>
<td>Becker: Kyle</td>
<td>( \text{Profit} )</td>
</tr>
<tr>
<td>Bell: Caitlin</td>
<td>( \text{Profit} )</td>
</tr>
<tr>
<td>Benner: Ian</td>
<td>( \text{Profit} )</td>
</tr>
<tr>
<td>Bernstein: Lawrence</td>
<td>( \text{Profit} )</td>
</tr>
<tr>
<td>Brown: Vernon</td>
<td>( \text{Profit} )</td>
</tr>
<tr>
<td>Conner: Beatrice</td>
<td>( \text{Profit} )</td>
</tr>
<tr>
<td>Corcoran: Peter</td>
<td>( \text{Profit} )</td>
</tr>
<tr>
<td>De Le Torre: Sandra</td>
<td>( \text{Profit} )</td>
</tr>
<tr>
<td>Ellerkamp: Nancy</td>
<td>( \text{Profit} )</td>
</tr>
<tr>
<td>Folks: Adrienne</td>
<td>( \text{Profit} )</td>
</tr>
<tr>
<td>Gale: Loren</td>
<td>( \text{Profit} )</td>
</tr>
<tr>
<td>Gedot: Harriet</td>
<td>( \text{Profit} )</td>
</tr>
</tbody>
</table>

Again, all the employees are not shown, because the list is so long. Notice that the selection shown in Flash Mode, Jack Kieferson, is not even shown in this image, because he is so far down the list.

For more examples of displaying a widget in different modes, see Defining how a widget is displayed in different views and modes, page 369.

**Fish Eye Selector targeting a panel stack**

A Fish Eye Selector can target a panel stack, updating the dynamic text fields on a panel. For example, the Fish Eye Selector in the following dashboard-style document, shown in Flash Mode, changes which employee
is displayed on the panel. The other data fields (region, revenue, and profit) also change to reflect that employee’s information.

If the Fish Eye Selector is created as a selector, it can switch panels on a panel stack, as shown below:
A Fish Eye Selector created as a widget cannot switch panels on a panel stack, although it can update dynamic text fields on a panel.

**Fish Eye Selector: Widget vs. selector**

The table below summarizes the differences in functionality between a Fish Eye Selector created as a widget and as a selector.

<table>
<thead>
<tr>
<th>Created as a Widget</th>
<th>Created as a Selector</th>
</tr>
</thead>
<tbody>
<tr>
<td>Targets Grid/Graphs and dynamic fields on panel stacks</td>
<td>Yes</td>
</tr>
<tr>
<td>Switches panels on a panel stack</td>
<td>No</td>
</tr>
<tr>
<td>Replaces selector item text with images</td>
<td>Yes</td>
</tr>
<tr>
<td>Can be the target of another selector</td>
<td>Yes</td>
</tr>
</tbody>
</table>

For steps to create a Fish Eye Selector as a widget, see *Creating a Fish Eye Selector as a widget, page 266*. For steps to create a Fish Eye Selector as a selector, see *Creating a Fish Eye Selector as a selector, page 269*.

How a Fish Eye Selector is created affects how it can be displayed in various Web modes and Developer views, as shown in the following table.

<table>
<thead>
<tr>
<th>View or Mode</th>
<th>Fish Eye Selector Created as a Widget</th>
<th>Fish Eye Selector Created as a Selector</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MicroStrategy Web</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Editable Mode</td>
<td>• Grid or graph</td>
<td>• Standard selector</td>
</tr>
<tr>
<td>Express Mode</td>
<td>• Widget</td>
<td>• Standard selector</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Placeholder</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hidden</td>
<td></td>
</tr>
<tr>
<td>Flash Mode</td>
<td>• Widget</td>
<td>• Widget</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph</td>
<td></td>
</tr>
<tr>
<td>Interactive Mode</td>
<td>• Widget</td>
<td>• Standard selector</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Placeholder</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Hidden</td>
<td></td>
</tr>
<tr>
<td><strong>MicroStrategy Developer</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Creating a Fish Eye Selector as a widget

The Fish Eye Selector is an interactive style of widget.

When created as a widget and displayed in Flash Mode, a Fish Eye Selector displays as a Fish Eye Selector.

When created as a widget and displayed in non-Flash modes, a Fish Eye Selector can be displayed as any of the following:

- Fish Eye Selector
- Grid/Graph used as a selector
- Empty Grid/Graph placeholder
- Hidden

A Fish Eye Selector created as a widget can target Grid/Graphs and dynamic text fields on panel stacks, but cannot switch panels on a panel stack. (For more information on Grid/Graphs controlling panel stacks or other Grid/
Graphs, see *Using Grid/Graphs as selectors to control other Grid/Graphs, page 219.* If you want the Fish Eye Selector to switch panels or display as a standard selector such as a listbox or button bar in non-Flash modes, create it as a selector instead. For instructions, see *Creating a Fish Eye Selector as a selector, page 269.*

---

**To create a Fish Eye Selector as a widget**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

   **To create the target**

2. Create the Grid/Graph or panel stack to be used as the target, if it is not already in the document. For steps, see the *Grid/Graphs* chapter of the *Report Services Document Creation Guide* or *Inserting and defining panels, page 75.*

   **To create the selector widget**

3. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Fish Eye**.

4. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

5. If desired, resize the widget by clicking and then dragging its handles.

6. From the Dataset Objects panel on the left, select an attribute or metric and drag it on top of the Grid/Graph’s rows. The attribute elements or metric values will be displayed in the selector.

   The selector and target must have an attribute or metric in common. If targets are automatically maintained and you place the selector and target in the same document section or panel, you will not need to disable automatic target maintenance to select the target. For information on the effects of disabling it, see *Disabling automatic target maintenance to allow manual target selection, page 177.*

   **To connect the selector to the target**

7. Right-click the attribute or metric to use as the selector, and choose **Use As Selector**. The Configure Selector dialog box opens.
8 Do one of the following:

- If targets are automatically maintained and you added the selector Grid/Graph and target to the same document section or panel, the target Grid/Graph or panel stack is automatically added as a target to this selector. Click **Create** to finish adding the target.

- If targets are automatically maintained but the widget and target are not in the same document section or panel, you must disable automatic target maintenance and then manually select the target, as described below:
  a. Click **Click here**. A warning message opens, indicating that you will need to manually maintain targets if you disable automatic target maintenance. For the effects of disabling automatic target maintenance, see *Disabling automatic target maintenance to allow manual target selection, page 177*.
  b. Click **OK**. You are returned to the Selector dialog box. Automatic target maintenance has been disabled for all selectors in the layout.
  c. Select the target in the Available Targets list, and click the **Add to selections** arrow to move it to the Selected Targets list.
  d. Click **Create**.

- If targets are not automatically maintained, you must manually specify the target of the selector, as described below:
  a. Select the target in the Available Targets list, and click the **Add to selections** arrow to move it to the Selected Targets list.
  b. Click **Create**.

**To specify the widget display**

9 Right-click the widget and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

10 From the left, click **Widget**.

11 You can change the **Alternative Display** option, which determines how the widget looks in non-Flash modes. The widget can display as a placeholder or as a Grid/Graph, or can be hidden. For more information, see *Defining how a widget is displayed in different views and modes, page 369*. 
12 By default, the Fish Eye Selector is displayed as a widget in Flash. To display it as a grid or graph report instead, clear the Flash check box in the Display Widget As column.

13 By default, the Fish Eye Selector is displayed as a widget in DHTML (Express Mode and Interactive Mode in MicroStrategy Web). To use the Alternative Display option instead, clear the DHTML check box in the Display Widget As column.

14 Click OK to apply your changes.

To enable the widget to be displayed

15 View and test your results in one of two ways:

- Select Flash Mode from the Home menu.
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 61.

- Select Interactive Mode from the Home menu.
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see Defining how a widget is displayed in different views and modes, page 369.

The Fish Eye Selector can display a list of images from which analysts can select. These images replace any attribute element, metric, or panel names in the selector. When an image is selected, any target panel stacks or Grid/Graphs are updated with related data. For steps to have images displayed in place of element, metric, or panel names, see Formatting a Fish Eye Selector, page 394.

Creating a Fish Eye Selector as a selector

When created as a selector and displayed in Flash Mode, a Fish Eye Selector displays as a Fish Eye Selector.

When created as a selector and displayed in non-Flash modes, a Fish Eye Selector can be displayed as a standard selector such as a listbox or button bar.

A Fish Eye Selector created as a selector can target Grid/Graphs and dynamic text fields on panel stacks. It can also switch the panels of a panel
stack. If you want the Fish Eye Selector to display as a Grid/Graph, display as a widget, or hide it completely in non-Flash modes, create it as a widget instead. For instructions, see Creating a Fish Eye Selector as a widget, page 266.

You can create a new Fish Eye Selector or apply the Fish Eye style to an existing selector. The following procedure creates a new Fish Eye Selector. To apply the style to an existing selector, set the Flash style option (found in the Properties and Formatting dialog box) to Fish Eye.

To create and add a Fish Eye Selector as selector to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

   **To create the target**

2. Create the Grid/Graph or panel stack to be used as the target, if it is not already in the document. For steps, see the Grid/Graphs chapter of the Report Services Document Creation Guide or Inserting and defining panels, page 75.

   **To create the selector**

3. From the Insert menu, point to Selector, and select Fish Eye. When you move the cursor to the Layout area, the cursor appears as a crosshair.

4. Click the location on your document where you want to place the selector.

5. If desired, resize the selector by clicking and then dragging its handles.

   **To define the action type**

6. Right-click the new selector and select Properties and Formatting. The Properties and Formatting dialog box opens.

7. From the left, click Selector.

8. From the Action Type drop-down list, select one of the following:
   - To display attribute elements in the selector, choose Select attribute element. Users will choose from this list of elements to update target panel stacks and Grid/Graphs in the document. Later in this procedure, you specify the attribute whose elements users will choose from.
• To display metric names in the selector, choose **Select Metric**. Users will choose from this list to update target Grid/Graphs in the document. Later in this procedure, you specify the target Grid/Graph or panel stack whose metrics users will choose from.

  Metrics in text fields within the target are not listed when the document is displayed. For example, a panel stack is selected as a target and contains a metric in a text field. That metric is not shown as an item in the selector.

• To display panels in the selector, choose **Select Panel**. Users will choose from this list to update target panel stacks in the document. Later in this procedure, you specify the target panel stack whose panels users will choose from.

  – If DHTML style is set to Checkboxes, the Select Panel option is not available, since check boxes allow multiple selections and you cannot display multiple panels simultaneously. To make the Select Panel option available, select a different DHTML style.

9 If you chose Select attribute element from the Action Type drop-down list above, specify an attribute from the **Source** drop-down list.

  The Source drop-down list contains all of the attributes in all of the datasets in the document. The source attribute that you choose becomes the attribute whose elements are displayed in the selector for a user to choose from.

**To connect the selector to the target**

10 If you choose Select panel as the Action Type, from the **Panel Stack** drop-down list, select the panel stack that the selector will change.

  The Panel Stack drop-down list contains all of the panel stacks in the document. The selector displays the panels of the panel stack selected in this option.

11 If users will be selecting attribute elements or metrics (in other words, if you set the Action Type above to either Select attribute element or Select metric), you can select one or multiple Grid/Graphs or panel stacks, and any combination of Grid/Graphs and panel stacks. The target Grid/Graph or panel stack displays the attribute elements or metrics that the user chooses from the Fish Eye Selector.

• If targets are automatically maintained and you added the selector and target to the same document section or panel, the target Grid/Graph or panel stack is automatically added as a target to this selector.
• If targets are automatically maintained but the selector and target are not in the same document section or panel, you must disable automatic target maintenance before selecting targets, as described below:

  a  Click Click here. A warning message opens, indicating that you will need to manually maintain targets if you disable automatic target maintenance. For the effects of disabling automatic target maintenance, see Disabling automatic target maintenance to allow manual target selection, page 177.

  b  Click OK. You are returned to the Properties and Formatting dialog box. Automatic target maintenance has been disabled for all selectors in the layout.

• If targets are not automatically maintained or you disabled automatic maintenance, you must manually specify the target of the selector. Select the target in the Available Targets list, and click the Add to selections arrow to move it to the Selected Targets list.

To set a default selector style for non-Flash modes/views

12 From the list on the left, click Layout.

13 In Flash Mode, the Fish Eye Selector is displayed as designed above. In non-Flash modes, the Fish Eye Selector is displayed by default as a Listbox style selector. To change the default selector style (for non-Flash Mode display), select a different DHTML style.

14 For Slider, Radio Buttons, Check Boxes, and Button Bar selector styles, you can use the Orientation option to display the selector horizontally (on a single line from left to right) or vertically (in a single column).

15 The user must select an item in a selector to change the target of the selector. For the List Box selector style, you can allow a user to select an item by hovering the cursor over it, without clicking, if you select the Change selection on mouseover check box. If the user points the cursor away from the selector without clicking an item, the target reverts to its previous state.

The mouseover option is applied only in Flash Mode.

To allow multiple selections and define the All option for users

16 By default, users can only select one item from the following selector styles: Slider, Listbox, Link Bar, and Button Bar. To allow users to make multiple selections for these selector styles, select the Allow multiple
selections check box. This check box is cleared by default. This option is unavailable for other selector styles (except for Check Boxes) because those styles do not support multiple selections.

17 From the list on the left, click Selector.

18 By default, the user can display all attribute elements or metrics in the target at one time, by selecting the All option. To disable the All option, clear the Show option for All check box.

   The Show option for All check box is not available if either of the following is true:

   • The Action Type is set to Select Panel.
   • The DHTML style is set to Slider and the Allow multiple selections check box is selected.

19 By default, the All option is labeled (All) in the selector. You can rename the All option by typing text into the Alias field. You can rename the All option only if the Show option for All check box is selected above.

20 Click OK to return to the document.

21 Save the document.

To enable the selector to be displayed

22 View and test your results by selecting Flash Mode from the Home menu.

   • If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 61.

The Fish Eye Selector can display a list of images from which analysts can select. These images replace any attribute element, metric, or panel names in the selector. When an image is selected, any target panel stacks or Grid/Graphs are updated with related data. For steps to have images displayed in place of element, metric, or panel names, see Formatting a Fish Eye Selector, page 394.
Creating a Funnel widget

A Funnel widget allows you to quickly analyze various trends across several metric values. It can be used for a wide variety of business purposes, including application management, click management, pipeline analyses for sales forecasts, and sales process analysis.

The widget is a variation of a stacked percent bar graph that displays data that adds up to 100%. Therefore, it can allow analysts to visualize the percent contribution of sales data. It can also show the stages in a sales process and reveal the amount of potential revenue for each stage. When the widget is used to analyze a sales process, analysts can use the widget to drill down to key metrics such as deal size, profit potential, and probability of closing. The widget can also help identify potential problem areas in an organization’s sales processes.

For example, the following Funnel widget displays the percent contribution of revenue data by region. Each section of the funnel is a different region, and the size of each section is proportional to the amount of revenue that the region contributed.
To create and add a Funnel widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select Funnel.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.

To add objects to the Grid/Graph that contains the widget

5. From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:
   a. Place at least one attribute on the Grid/Graph’s rows. The attributes are displayed as separate cross-sections of the funnel.
   b. Place at least one metric on the Grid/Graph’s columns. The size of each section of the widget is determined by the values of the metric.

To enable the widget to be displayed

6. View and test your results in one of two ways:
   - Select Flash Mode from the Home menu.
     - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 61.
   - Select Interactive Mode from the Home menu.
     - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see Defining how a widget is displayed in different views and modes, page 369.

A Funnel widget does not need a separate selector to allow a user to interact with it.
Creating a Gauge widget

A Gauge widget is a simple status indicator that displays a needle that moves within a range of numbers displayed on its outside edges. A real-world example of a gauge is a car’s speedometer. Like the Cylinder and Thermometer widgets, this type of widget is designed to display the value of a single metric. The needle within the gauge is a visual representation of that single metric value.

The Gauge widget is most useful when combined with a selector because this allows users to choose specific metric values to display in the gauge. In the image below, the location of the needle in the gauge represents the amount of revenue generated (the Revenue metric).

![Gauge widget example](image)

To create and add a Gauge widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. From the Insert menu, point to Widgets, then Flash, and select Gauge.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.
4. If desired, resize the widget by clicking and then dragging its handles.
To add objects to the Grid/Graph that contains the widget

5 From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

a  Place at least one attribute on the Grid/Graph’s rows.

b  Place at least one metric on the Grid/Graph’s columns. The metric values determine the location of the needle on the gauge.

6 To allow users to change the metric value displayed in the widget with a selector:

a  Insert a selector next to the Gauge widget, then select an attribute as its source. Users choose attribute elements from this selector to change the display in the Gauge widget. For steps to insert a selector and select a source for it, see Methods to create a selector, page 129.

b  Set the Gauge widget as the target of the selector. For steps to select an object as the target of a selector, see Creating a selector to change panels on a panel stack, page 134.

7 It can be useful to drag the dataset from the Dataset Objects panel and place it beneath the selector. This allows users to see the dataset’s values as they select different attribute elements from the selector and see how their choices change the appearance of the widget.

To enable the widget to be displayed

8 View and test your results in one of two ways:

• Select Flash Mode from the Home menu.
  – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 61.

• Select Interactive Mode from the Home menu.
  – To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see Defining how a widget is displayed in different views and modes, page 369.
Creating a Graph Matrix (deprecated) widget

A Graph Matrix (deprecated) widget allows you to quickly analyze various trends across several metric dimensions. You can use the widget to assess questions such as “How are sales comparing vs. forecast, by time and region?”.

The Graph Matrix (deprecated) widget consists of several area graphs that display current values. Each area graph also has a line graph above it to show forecasted values. One graph is displayed for every combination of elements from the attributes on the rows and columns of the Grid/Graph that contains the widget. For example, in the widget below, the rows of the report contain the Category attribute elements and the columns contain the Region attribute elements. Twelve graphs are displayed because data exists for four regions and three categories of products.

<table>
<thead>
<tr>
<th>Category</th>
<th>Northeast</th>
<th>Mid-Atlantic</th>
<th>South</th>
<th>Southeast</th>
</tr>
</thead>
<tbody>
<tr>
<td>Books</td>
<td>$240,000</td>
<td>$180,000</td>
<td>$120,000</td>
<td>$120,000</td>
</tr>
<tr>
<td></td>
<td>$180,000</td>
<td>$120,000</td>
<td>$60,000</td>
<td>$60,000</td>
</tr>
<tr>
<td></td>
<td>$120,000</td>
<td>$60,000</td>
<td>$0</td>
<td>$0</td>
</tr>
<tr>
<td>Electronics</td>
<td>$1,000,000</td>
<td>$400,000</td>
<td>$200,000</td>
<td>$100,000</td>
</tr>
<tr>
<td></td>
<td>$500,000</td>
<td>$200,000</td>
<td>$100,000</td>
<td>$50,000</td>
</tr>
<tr>
<td></td>
<td>$200,000</td>
<td>$100,000</td>
<td>$50,000</td>
<td>$0</td>
</tr>
<tr>
<td>Movies</td>
<td>$300,000</td>
<td>$50,000</td>
<td>$0</td>
<td>$0</td>
</tr>
<tr>
<td></td>
<td>$200,000</td>
<td>$30,000</td>
<td>$0</td>
<td>$0</td>
</tr>
<tr>
<td></td>
<td>$100,000</td>
<td>$10,000</td>
<td>$0</td>
<td>$0</td>
</tr>
</tbody>
</table>

A separate area graph is produced for each combination of region and product category. For example, one area graph focuses solely on electronics product figures in the Northeast region. Values in that graph are plotted across quarter (on the X-axis) and revenue (on the Y-axis). The line graph at the top of the area graph represents revenue forecast metric values, or the amount of revenue the company predicted it would generate.
You can maximize a specific area graph by double-clicking it. The graph opens in a new window, as shown below.

Each area graph in a Graph Matrix (deprecated) widget has the following characteristics, as shown above.

- The X-axis provides the time scale. For example, the X-axis can represent weeks, quarters, or years.
- The Y-axis provides the metric values. For example, the Y-axis can represent revenue, profit, or units sold.
- The area graph shows the current values, allowing you to see how values changed over time. The area graph represents the values of the first metric on the Grid/Graph that contains the widget.
- The line graph at the top of the area graph shows the predicted, or forecasted, values. The line graph represents the values of any additional metrics on the Grid/Graph.
- The black reference line in the area graph (not displayed above) shows the average for only the specific graph you are looking at.
- The red reference line in the area graph (not displayed above) shows the average metric value for all of the graphs in the same row of the Graph Matrix (deprecated) widget. This allows you to easily compare one graph in the widget to another.
To create and add a Graph Matrix (deprecated) widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select Graph Matrix (deprecated).

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.

To add objects to the Grid/Graph that contains the widget

5. From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

- You must place either two attributes on the Grid/Graph’s rows, one attribute on the columns, and one metric on the columns; or you must place three attributes on the rows and one metric on the columns:
  - Place at least two attributes on the rows. The first (left-most) attribute on the rows (and the second, third, fourth, and so on) provide the row headers in the widget. The last (right-most) attribute on the rows provides the X-axis of the graphs. This attribute, which is generally time-based, is used to drive the time series of the graphs.
  - If there are fewer than three attributes on the rows, place at least one attribute on the columns. The first (left-most) attribute on the columns provides the column headers in the widget. These values are used to slice the data by grouping it based on the column attributes. Additional attributes on the columns produce separate line graphs within each area graph in the widget.
  - Place at least one metric on the Grid/Graph’s columns. (If there is an attribute on the columns, place the metric the right of, or below, the attribute.) The value of this metric is graphed on the Y-axis. The first metric on the columns is depicted as the colored series in the area graphs. Any additional metrics are depicted as the forecast lines in each area graph.
To enable the widget to be displayed

6  View and test your results in one of two ways:

• Select **Flash Mode** from the **Home** menu.
  – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 61*.

• Select **Interactive Mode** from the **Home** menu.
  – To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 369*.

A Graph Matrix (deprecated) widget does not need a separate selector to allow a user to interact with it. However, you can use a Graph Matrix (deprecated) widget as a selector. For an example and more information, see *Using a Graph Matrix (deprecated) widget as a selector, page 443*.

Creating a Graph Matrix widget

The Graph Matrix widget allows you to quickly analyze various trends across several metric dimensions. The widget consists of a matrix of graphs that allow users to analyze and compare trends in metric data.
An example of the Graph Matrix widget is shown in the image below.

![Graph Matrix widget example](image)

You can access the following additional options by creating the Graph Matrix widget as a visualization:

- Organize the data displayed in the graph based on a specific attribute. For example, a bar graph contains units sold data for several regions. You can choose to display a different bar for each individual store within each region.

- Color graph elements (such as bubbles, lines, or bar risers) by an attribute or a metric. For example, you can choose to display a different color for each element in an attribute. You can choose to have graph elements automatically colored based on the value of a metric, with the darkest colors being displayed for the largest metric values.

- Automatically size graph elements based on the value of a metric, with the largest elements being displayed for the largest metric values.

- Slice your data, by displaying a graph for each combination of attribute elements in the rows and columns of the Graph Matrix visualization. For example, you can display the revenue data for each Region as a separate line graph, or display a bar graph containing store sales for each year.

To access these options, you must first create a Graph Matrix visualization in a Visual Insight dashboard, then convert the dashboard into a Report Services document. For instructions to create a dashboard, see the MicroStrategy Web Help.
**Prerequisites**

For a report to be displayed as a Graph Matrix widget, it must meet the following requirements:

- At least one attribute, either on the row or the columns.
- At least one metric on the columns, below all attributes that are on the columns.

---

**To create a Graph Matrix widget**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Graph Matrix**.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. If desired, resize the widget by clicking and then dragging its handles.
4. From the Dataset Objects panel on the left, select attributes and metrics, and drag them on to the Grid/Graph, as described in the prerequisites above.

---

**Creating a Heat Map widget**

A Heat Map widget presents a combination of colored rectangles, each representing an attribute element, that allow you to quickly grasp the state and impact of a large number of variables. Heat Maps are often used in the financial services industry to review the status of a portfolio.

The rectangles contain a variety and shadings of colors, which emphasize the status of the various components. In a Heat Map:

- The size of each rectangle represents its relative weight.
- The color represents the relative change in value of that rectangle.
- You can hover over each rectangle to see which attribute element the rectangle represents and its metric values.
Each part of the example below is explained in the following list:

- The large areas (such as the Large Blend area in the image above) represent different categories of mutual funds. These areas are generated by the first attribute on the rows of the Grid/Graph that contains the widget. In this case, the first attribute is Mutual Fund Category. Notice that the name of each category is displayed in the headers of each of these areas. You can change the aggregation function used to calculate the size of these areas. For steps, see *Formatting a Heat Map widget, page 404*. This aggregation function is also displayed in a tooltip when the user hovers the cursor over an area.

![Image of a Heat Map widget with various mutual fund categories and values]
• The colored rectangles (colored shades of red and blue in the image above) represent different mutual funds. These rectangles, such as the Vanguard Small Cap Index and Legg Mason Value Prim rectangles above, are generated by any additional attributes on the rows. In this case, a second attribute, Mutual Fund, is on the rows of the Grid/Graph.

• The size of each rectangle represents its relative weight. This is determined by the first metric on the columns of the Grid/Graph. This widget shows that Large Blend funds are weighted more heavily than Mid-Cap Blend funds in regard to net assets. In this case, the first metric on the columns of the Grid/Graph is Net Assets.

• The colors displayed in the widget represent different ranges of return year-to-date percentages generated by the mutual funds. (In the image above, blue denotes higher percentages, while red and purple denote lower percentages.) The colors applied to each rectangle are generated by the second metric on the Grid/Graph. (In the image above, the second metric on the report is Return YTD %.) You can define the colors used to denote these values. For steps, see Analyzing data in a Heat Map widget in the MicroStrategy Web Help.

You can create a dynamic heat map that an analyst can control using a selector. This type of heat map is considered dynamic because a user can use the selector, such as a drop-down list, to choose a different attribute element to view on the heat map. Steps to create both a static and a dynamic Heat Map widget are included below.

To create and add a Heat Map widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select Heat Map.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.
To add objects to the Grid/Graph that contains the widget

5 From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

a Place at least one attribute on the rows. This attribute is used to create the large rectangles whose names are displayed in the widget.

b You can place additional attributes on the Grid/Graph:

– To group each element of the first attribute inside the larger area, place a second attribute to the right of the first. For example, the Region attribute contains the element South and the Call Center attribute contains the elements New Orleans and Memphis. If Region is placed to the left of Call Center, a large area called South is displayed in the widget, with smaller rectangles New Orleans and Memphis inside.

– You can add additional attributes to further group the rectangles in the Heat Map. Attributes that have a parent-child relationship work best, because they are nested within one another in the Heat Map.

c Place at least two metrics on the columns:

– The first metric on the columns determines the size of the small rectangles within each large rectangle. Items with lower values are represented by smaller rectangles.

– The second metric on the columns must be placed at the bottom of the columns. It determines the color of each rectangle. It must include values in the range of -1 to 1. This range is used to provide different shadings of color.

– If more than two metrics are placed on the Grid/Graph, the additional metrics are displayed in a tooltip when the user hovers the cursor over the area.

6 If you are creating a dynamic Heat Map widget, perform the following:

a Insert a selector, such as a Drop-down list, next to the widget. Users choose attribute elements from this selector to change the display in the widget. For steps to insert a selector, see Methods to create a selector, page 129.

b Choose an attribute from the dataset that is not already in the Grid/Graph and set this attribute as the Source of the selector. Do not include this attribute in the Grid/Graph. It is used to populate the selector.
c Set the Grid/Graph as the target of the selector.

**To enable the widget to be displayed**

7 View and test your results in one of two ways:

- Select **Flash Mode** from the **Home** menu.
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 61*.

- Select **Interactive Mode** from the **Home** menu.
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 369*.

You can use a Heat Map widget as a selector. For an example and more information, see *Using a Heat Map widget as a selector, page 445*.

You can add links to a Heat Map widget. Linking allows users to connect from a widget in a dashboard-style document (the source) and open a document or report (the target). You can design the links and targets to simulate drilling. If you add a link to a Heat Map widget, a Links menu is displayed when a MicroStrategy Web user hovers the cursor over an attribute element in the widget. The user can click a link in the Links menu to open the target. See *Linking in widgets, page 379* for instructions and examples.

### Creating an Image Layout widget

You can add an Image Layout widget to a document to display an image overlaid with colored areas or bubble markers. For example, you can display a map of the United States, with a bubble marker displayed over each state. You can have states with a high number of stores displayed using large bubble markers, and states with a low number of stores displayed using small bubble markers. As another example, you can display the layout of a store in the widget, with each aisle displayed as a separate region, then have Web color each aisle based on the number of visits each aisle receives. The image below shows an Image Layout widget with a map of the United States, in which each state is displayed as a separate colored region. For steps to
create and add an Image Layout widget to a document, see *To create and add an Image Layout widget to a document, page 292.*

Displaying shape files in an Image Layout widget

A shape file is an HTML file that contains the widget’s background image, as well as the location of each area or bubble marker you want to display on top of the image. You can display a single shape file in the widget, or multiple shape files at the same time, as shown in the image below.

If you create an Image Layout widget with multiple shape files, you can allow users to select which image map is displayed in the widget, as shown in the image below. To do so, create an attribute selector based on the attribute that provides the location of each shape file in the widget. This selector should
target the widget’s Grid/Graph. For steps to create the selector, see *Creating a selector for elements on a Grid/Graph*, page 135.

To create and display an Image Layout widget, you must place attributes and metrics that meet the widget’s data requirements on the widget’s Grid/Graph. To display a widget with a single shape file, you must provide the following:

- An attribute with the name of each location that you want to display in the widget
- One or more metrics to use to size or color items in the widget

The image below is an example of the Grid/Graph of an Image Layout widget that displays a single shape file.

<table>
<thead>
<tr>
<th>Customer State</th>
<th>Cost</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alabama</td>
<td>$988,670</td>
<td>$174,460</td>
</tr>
<tr>
<td>Arizona</td>
<td>$379,391</td>
<td>$64,679</td>
</tr>
<tr>
<td>Arkansas</td>
<td>$221,958</td>
<td>$39,703</td>
</tr>
<tr>
<td>California</td>
<td>$3,259,846</td>
<td>$583,886</td>
</tr>
<tr>
<td>Colorado</td>
<td>$429,181</td>
<td>$76,899</td>
</tr>
<tr>
<td>Connecticut</td>
<td>$950,756</td>
<td>$170,938</td>
</tr>
<tr>
<td>Delaware</td>
<td>$51,120</td>
<td>$9,105</td>
</tr>
<tr>
<td>Florida</td>
<td>$1,256,851</td>
<td>$223,699</td>
</tr>
</tbody>
</table>
To display multiple shape files in a single widget, you must provide the following:

- An attribute with the following attribute forms:
  - **DESC**: This attribute form contains the title of each shape file displayed in the widget.
  - **SHAPEFILE**: This attribute form contains the file path of each shape file to display in the widget. For example, if you want to display maps of France and Italy in the widget, the attribute should contain elements such as `VisFramework/map/FranceImageMapCoords.html` and `VisFramework/map/ItalyImageMapCoords.html`. Each shape file must be defined and stored in the `VisFramework/map` folder. For steps to define and store shape files, see the *MicroStrategy Web Help*.

- An attribute with the name of each location that you want to display in the widget.

- One or more metrics to use to size or color items in the widget.

The image below is an example of the Grid/Graph of an Image Layout widget that displays multiple shape files.

<table>
<thead>
<tr>
<th>IL Subcategory DESC</th>
<th>SHAPEFILE</th>
<th>Item DESC</th>
<th>Cost</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Art &amp; Architecture</td>
<td>VisFramework/map/Products/11.html</td>
<td>100 Places to Go While Still Young at Heart</td>
<td>$50,216</td>
<td>1,526</td>
</tr>
<tr>
<td></td>
<td>VisFramework/map/Products/11.html</td>
<td>Architecture: Form, Space, &amp; Order</td>
<td>$31,303</td>
<td>1,524</td>
</tr>
<tr>
<td></td>
<td>VisFramework/map/Products/11.html</td>
<td>50 Favorite Rooms</td>
<td>$20,253</td>
<td>1,517</td>
</tr>
<tr>
<td></td>
<td>VisFramework/map/Products/11.html</td>
<td>500 Best Vacation Home Plans</td>
<td>$14,049</td>
<td>2,280</td>
</tr>
<tr>
<td></td>
<td>VisFramework/map/Products/11.html</td>
<td>Building With Stone</td>
<td>$17,589</td>
<td>1,557</td>
</tr>
<tr>
<td></td>
<td>VisFramework/map/Products/11.html</td>
<td>Voyaging Under Power</td>
<td>$16,341</td>
<td>2,273</td>
</tr>
<tr>
<td>Business</td>
<td>VisFramework/map/Products/12.html</td>
<td>Working With Emotional Intelligence</td>
<td>$20,819</td>
<td>1,448</td>
</tr>
<tr>
<td></td>
<td>VisFramework/map/Products/12.html</td>
<td>The Wisdom of Teams</td>
<td>$13,670</td>
<td>1,479</td>
</tr>
<tr>
<td></td>
<td>VisFramework/map/Products/12.html</td>
<td>The Power to Get in</td>
<td>$21,093</td>
<td>2,282</td>
</tr>
<tr>
<td></td>
<td>VisFramework/map/Products/12.html</td>
<td>Don’t Sweat the Small Stuff</td>
<td>$16,578</td>
<td>2,306</td>
</tr>
<tr>
<td></td>
<td>VisFramework/map/Products/12.html</td>
<td>Jump Start Your Brain</td>
<td>$12,209</td>
<td>1,488</td>
</tr>
<tr>
<td></td>
<td>VisFramework/map/Products/12.html</td>
<td>Smart Choices</td>
<td>$19,447</td>
<td>1,578</td>
</tr>
</tbody>
</table>

For detailed steps to create an Image Layout widget, see *To create and add an Image Layout widget to a document, page 292*.

**Performing actions by selecting an area or bubble marker**
You can allow users to perform an action by selecting an area or bubble marker in Web, or on a mobile device with MicroStrategy Mobile. To do this, you must assign the action to the attribute on the widget’s Grid/Graph that provides each area or bubble marker on the map. For example, if several customer regions are displayed in an Image Layout widget, you can allow users to tap on a region to update the data displayed in a grid in the document. In Web, you can use the Image Layout widget as a selector, add links to open a report or document, or both.

On an iPad, you can enable the following actions for an item in the widget:

- Display additional information about the item in a pop-up Information Window. For background information and steps to define an Information Window, see the *Layering Data: Panels and Panel Stacks* chapter in the *Dashboards and Widgets Creation Guide*.

- Use the widget as a selector. To use the widget as a selector, you must define the attribute that provides each area or bubble marker on the map as a selector on the widget’s Grid/Graph. For steps, see the *MicroStrategy Web Help*.

- Open a link to a report or document. For steps to define a link in a widget using the Links Editor, see the *Providing Flash Analysis and Interactivity: Widgets* chapter in the *Dashboards and Widgets Creation Guide*.

You can enable multiple actions for a widget displayed on an iPad. Opening a link to a report or document is a lower priority action than the others. If you have also enabled the widget to display an Information Window, use the widget as a selector, or both, MicroStrategy will perform the higher priority action(s) instead. To allow iPad users to open links by tapping areas or markers in the widget, ensure that the link is the only action enabled for the item.

For background information on widgets for mobile devices, see the *Mobile Design and Administration Guide*.

**Prerequisites**

This procedure assumes that an administrator has already created the following:

- The shape file to display in the widget. A shape file is an HTML file that contains the image that you want to display in the widget, as well as the location of each bubble marker or area you want to display on top of the image. Web provides several default shape files for you to choose from,
including a map of countries of the world and a map of states in the United States. You can define your own shape file for use in the widget. For steps, see the MicroStrategy Web Help.

- An attribute with the name of each location that you want to display in the widget. Each element of this attribute should contain the name of a location defined in the shape file described above, as listed in the ALT parameter for the location. For example, if the shape file defines a bubble marker for Washington state as follows: `<AREA SHAPE="triangle" HREF="#" ALT="Washington" COORDS="69,30" />`, the attribute should contain an element named Washington.

Web uses this attribute to determine the default shape file to display in the widget. If a geo role, such as City, State, or Country, has been assigned to this attribute, the widget will automatically display the first shape file with the same geo role as the attribute. For example, if the attribute’s geo role is State, the States of USA shape file will be displayed in the widget by default. The attribute can also be used to display a specific shape file by assigning it a shape key. A shape key is a unique identifier given to each shape file. If a shape key has been assigned to the attribute, the widget will automatically display the shape file with the same shape key. You can assign a geo role or shape key to an attribute during the Data Import process, or when editing an attribute in Developer. For steps to assign a geo role or shape key while importing data, see the MicroStrategy Web Help.

- To display multiple shape files in the widget at the same time, you must provide an attribute with the following attribute forms:
  - **DESC**: This attribute form contains the title of each shape file displayed in the widget.
  - **SHAPEFILE**: This attribute form contains the file path of each shape file to display in the widget. For example, if you want to display maps of France and Italy in the widget, the attribute should contain elements such as `VisFramework/map/ FranceImageMapCoords.html` and `VisFramework/map/ ItalyImageMapCoords.html`. Each shape file must be defined and stored in the `VisFramework/map` folder. For steps, see the MicroStrategy Web Help.

---

**To create and add an Image Layout widget to a document**

1. Open the document in **Design** or **Editable Mode**.
2 From the **Insert** menu, point to **Widget**, then **Flash**. Select **Image Layout**.

3 Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget that you have added to the document.

4 If desired, resize the widget by clicking and then dragging its handles.

5 Right-click the widget, then select **Properties and Formatting**. The Properties and Formatting dialog box opens.

6 From the left, select **Widget**, then click the **Widget Properties** icon. The Image Layout dialog box opens.

7 You can determine whether the widget displays areas or bubble markers. From the **Display Mode** drop-down list, select one of the following:

   - To allow MicroStrategy to decide whether to show areas or bubble markers, select **Automatic** (default). If no metrics are placed on the widget’s Grid/Graph, the widget displays areas or bubbles based on whether the shape file displayed in the widget is designed to display areas or bubble markers by default. Otherwise, the widget is displayed with bubble markers. For details to define a shape file and determine whether it displays areas or bubble markers by default, see the **MicroStrategy Web Help**.
   
   - To display areas, select **Area**.
   
   - To display bubble markers, select **Bubble**.

8 You can select the shape file to use to display the widget. From the **Shape File** drop-down list, select the name of the shape file to display in the widget.

9 Click **OK** to apply your changes.

10 From the Dataset Objects panel on the left, select attributes and drag them on top of the widget’s Grid/Graph, based on the following requirements for this widget:
• To specify the areas or bubble markers to display in the widget, place one attribute on the rows of the widget’s Grid/Graph. This attribute must contain the name of each location that you want to display in the widget, as described in the prerequisites above.

• To display multiple shape files in the widget at the same time, place the attribute containing the location of each shape file on the rows of the widget’s Grid/Graph, to the left of the attribute that you just added in the step above.

11 From the Dataset Objects panel on the left, select metrics and drag them on top of the widget’s Grid/Graph, based on the following requirements for this widget:

• To display areas in the widget, place at least one metric on the columns of the Grid/Graph. To have areas colored based on the value of this metric, define a threshold on the metric, as described in the step below.

Any additional metrics on the columns will be displayed in a pop-up tooltip when the user hovers the cursor over a location in the widget.

• To display bubble markers in the widget, perform the following steps:

  a Place at least one metric on the columns of the Grid/Graph. This metric is used to size bubble markers in the widget, with higher metric values represented by larger bubble markers.

  b To color bubble markers or replace bubble markers with images based on the value of a metric, do one of the following:

    – To color bubble markers based on the metric you just placed on the Grid/Graph, define a threshold on the metric, as described in the step below.

    – To color bubble markers based on a second metric, place the second metric on the columns of the Grid/Graph, to the right of the first. Select the appropriate options to define a threshold on this metric, as described in the step below.

Any additional metrics placed on the columns will be displayed in a pop-up tooltip when the user hovers the cursor over a location in the widget.

12 To color areas or bubble markers, or have bubble markers replaced with images based on the value of a metric, you must define a threshold on the metric.
For example, bubble markers in an Image Layout widget are sized using the absolute value of the metric values that they represent. This means that bubble markers representing $10,000 are displayed in the same size as bubble markers representing -$10,000. To differentiate the two values, you can define a threshold to display negative values in red and positive values in blue.

To define a threshold on a metric, right-click the metric on the widget’s columns, point to Conditional Formatting, then select Visual. The Visual Conditional Formatting Editor opens. Select the appropriate options to define threshold conditions and specify the colors you want to have applied to the areas or bubbles, or the images you want to use to replace the bubble markers. To change the color in which an area or bubble is displayed, you must format the background color (fill color) used to display the appropriate metric values in the widget’s Grid/Graph. For background information and steps to define a threshold, see the Formatting Documents chapter in the Report Services Document Creation Guide.

13 View and test your results by selecting Flash Mode from the Home menu.

- If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 61.

**Creating an Interactive Bubble Graph widget**

An Interactive Bubble Graph widget is a conventional bubble plot that allows you to visualize the trends of three different metrics for a set of attribute elements. The data structure for an interactive bubble graph is very specific. At minimum, one attribute and three metrics are required. In the bubble graph:

- One bubble is displayed for each attribute element.
- Each bubble’s position on the X-axis represents the value of the first metric.
- Each bubble’s position on the Y-axis represents the value of the second metric.
• The size of each bubble represents the value of the third metric.

The Interactive Bubble Graph is interactive, unlike a standard bubble graph report. For example:

• Analysts can change which metric is displayed on which axis, if a designer adds this functionality. For example, in the widget shown above, the Profit Margin is displayed on the X-axis (the horizontal axis) and the Minimum Revenue per Customer on the Y-axis (the vertical axis). An analyst can switch the metrics, so that the Profit Margin is shown on the Y-axis and the Minimum Revenue per Customer on the X-axis.

• Analysts can zoom into a section of the widget to enlarge it, if a designer adds this functionality. For example, the user can draw a selection box (or lasso) around a cluster of bubbles and enlarge that area of the widget to focus on information for those cities.

• Analysts can drill into the components of a bubble to see the underlying data within that bubble’s data, if a designer adds this functionality. For example, an analyst can click on any Region bubble (the parent attribute) to drill down to bubbles that represent different cities (child attributes) within that region.

• Analysts can see a time-series animation that plots the bubble values through time, if a designer adds this functionality. To see the animation, an analyst moves the time slider or clicks the animation’s Play button.
For steps to enable or disable any of the features described above, see *Formatting an Interactive Bubble Graph widget, page 408*.

**Supporting drilling in an Interactive Bubble Graph widget**

If you want to support drilling in an Interactive Bubble Graph widget, the objects on the widget must be structured in a specific way. There are two easy methods to structure the objects so that drilling is supported: using a custom group on the widget, or using subtotals on the widget. Both methods are described below. This information is presented before the steps to create the widget, so that you can perform any necessary object creation described below, before you begin creating the widget.

**Supporting drilling using a custom group**

The structure required for drilling can be created with a custom group. The child attribute must be structured in a specific way. For an introduction to custom groups, see the *Advanced Reporting Guide*.

The data for the child attribute must be displayed so that the total for the child attribute is in the top row of data, followed by the data for (the elements of) the child attribute. An example in grid form is shown in the image below. In the custom group, notice that the first element within the Northeast region is Northeast. This is followed by the two child attribute elements, Boston and New York.

In the metric data, the first row represents the total (Average for the first two metrics, Sum for the third) of the other two rows. The first row must include totals for drilling to work properly.

<table>
<thead>
<tr>
<th>Year</th>
<th>Region</th>
<th>Call Center Custom Group</th>
<th>Metrics</th>
<th>Profit per Employee</th>
<th>Revenue per Employee</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>2005</td>
<td>Central</td>
<td>Milwaukee</td>
<td>$71,272</td>
<td>$455,929</td>
<td>32,736</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fargo</td>
<td>$77,672</td>
<td>$499,411</td>
<td>27,254</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Northeast</td>
<td>Northeast</td>
<td>$85,772</td>
<td>$493,013</td>
<td>52,462</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Boston</td>
<td>$30,908</td>
<td>$175,468</td>
<td>9,794</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>New York</td>
<td>$140,636</td>
<td>$806,530</td>
<td>42,560</td>
<td></td>
</tr>
<tr>
<td>2006</td>
<td>Central</td>
<td>Milwaukee</td>
<td>$86,290</td>
<td>$545,558</td>
<td>39,256</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fargo</td>
<td>$96,194</td>
<td>$608,032</td>
<td>32,004</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Northeast</td>
<td>Northeast</td>
<td>$109,159</td>
<td>$611,461</td>
<td>65,347</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Boston</td>
<td>$39,617</td>
<td>$220,527</td>
<td>11,396</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>New York</td>
<td>$178,721</td>
<td>$1,002,955</td>
<td>53,951</td>
<td></td>
</tr>
</tbody>
</table>
The structure requirements for the child attribute are as follows:

- The child attribute must group attribute elements together at the level of the parent attribute. For example, elements in the Call Center Custom Group above are sorted by Region.

- The child attribute must contain attribute elements that represent totals across each group. For example, the Northeast element above represents all of the call centers in the Northeast Region.

- The elements that represent totals must be displayed at the top of each group. For example, the Northeast element is immediately followed by the call centers in the Northeast region, Boston and New York. Directly below is the Central element, followed by each call center in the Central region.

**Supporting drilling using subtotals**

As an alternative to creating a custom group, you can add subtotals, without grand totals, when you create the original report. The subtotals must be calculated by row, across the level of the child attribute, and must be displayed at the top of each level. This ensures that the total for the second attribute is displayed in the top row of data, followed by the data for that attribute. Be sure to add the Grid/Graph to the dashboard-style document with formatting, so that this structure is used.

For example, the following report is subtotaled across the level of Call Center, which is the child attribute of Region. The subtotals are displayed at the top of each region.

<table>
<thead>
<tr>
<th>Region</th>
<th>Call Center</th>
<th>Metrics</th>
<th>Profit per Employee</th>
<th>Revenue per Employee</th>
<th>Units Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central</td>
<td>Total</td>
<td></td>
<td>$487,910</td>
<td>$3,083,808</td>
<td>122,302</td>
</tr>
<tr>
<td></td>
<td>Milwaukee</td>
<td></td>
<td>$301,205</td>
<td>$1,914,563</td>
<td>101,659</td>
</tr>
<tr>
<td></td>
<td>Fargo</td>
<td></td>
<td>$181,705</td>
<td>$1,169,245</td>
<td>20,643</td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td></td>
<td>$1,176,476</td>
<td>$6,005,901</td>
<td>104,809</td>
</tr>
<tr>
<td>Mid-Atlantic</td>
<td>Washington, DC</td>
<td></td>
<td>$937,403</td>
<td>$5,425,540</td>
<td>73,269</td>
</tr>
<tr>
<td></td>
<td>Charleston</td>
<td></td>
<td>$239,076</td>
<td>$1,300,441</td>
<td>31,510</td>
</tr>
<tr>
<td>Northeast</td>
<td>Total</td>
<td></td>
<td>$669,913</td>
<td>$3,791,804</td>
<td>202,163</td>
</tr>
<tr>
<td></td>
<td>Boston</td>
<td></td>
<td>$119,441</td>
<td>$675,703</td>
<td>35,661</td>
</tr>
<tr>
<td></td>
<td>New York</td>
<td></td>
<td>$550,472</td>
<td>$3,116,101</td>
<td>166,202</td>
</tr>
</tbody>
</table>

For steps to add a Grid/Graph with formatting, see the *Report Services Document Creation Guide*. For steps to display subtotals, see the *Basic Reporting Guide*. 
Creating and adding an Interactive Bubble Graph widget to a document

To create and add an Interactive Bubble Graph widget to a document

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Interactive Bubble Graph**.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.

To add objects to the Grid/Graph that contains the widget

5. From the **Dataset Objects** panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

   a. Place at least one attribute on the rows. You can add additional attributes, as described below:

      - To support drilling on the bubble graph, add one additional attribute to the right of the attribute in the rows. This attribute must be a child attribute of the attribute already on the rows. For example, City is a child attribute of the State attribute. For details on methods to structure objects to support drilling, see *Supporting drilling in an Interactive Bubble Graph widget*, page 297.

      - To support time series animation, add a time-based attribute on the left-most side of the rows.

      - To enable both drilling and time series animation, you must have at least three attributes on the rows. The left-most attribute must be associated with time; the second and third attributes must be children of the left-most attribute (the parent attribute).

      - To ensure that different groups of attribute elements are displayed as different colored bubbles, you can add a fourth attribute above the first three metrics on the columns.
Once the widget is created, if you provided objects to support drilling or time series animation, you must enable these features. For steps to enable drilling or time series animation in the widget, see *Formatting an Interactive Bubble Graph widget*, page 408.

b Place at least three metrics on the columns. The first three metrics are displayed along the X-axis, the Y-axis, and the Z-axis, in order from left to right, by default. For example, the first metric is displayed on the X-axis. The Z-axis value determines the size of the bubbles. (You can enable or disable the ability for an analyst to change which metric displays along each axis. For steps, see *Creating an Interactive Bubble Graph widget*, page 295.)

**To enable the widget to be displayed**

6 View and test your results in one of two ways:

- Select **Flash Mode** from the **Home** menu.
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in*, page 61.

- Select **Interactive Mode** from the **Home** menu.
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes*, page 369.

Once the widget is created, if you provided objects to support drilling or time series animation, you must enable these features. For steps to enable drilling or time series animation in the widget, see *Formatting an Interactive Bubble Graph widget*, page 408.

An Interactive Bubble Graph widget does not need a separate selector to allow a user to interact with it. However, you can use an Interactive Bubble Graph widget as a selector. For an example and more information, see *Using an Interactive Bubble Graph widget as a selector*, page 446.

You can add links to an Interactive Bubble Graph widget. Linking allows users to connect from a widget in a dashboard-style document (the source) and open a document or report (the target). If you add a link to an Interactive Bubble Graph widget, a Links menu is displayed when a MicroStrategy Web user hovers the cursor over an bubble in the widget. The user can click a link in the Links menu to open the target. See *Linking in widgets*, page 379 for instructions and examples.
Creating an Interactive Stacked Graph widget

An Interactive Stacked Graph widget presents a combination of a check box list and an area graph. The graph allows a user to see the contribution of various metric series to the change in value of a larger set of data.

- By selecting individual attribute elements (for example, a list of years) using the check boxes, analysts determine what data is displayed on the area graph on the right. When all check boxes are selected, the area graph is at its maximum size because it is representing contributions from each individual element.

- This widget allows you to visualize total metric values as one large stacked area, and the individual pieces of that total as smaller stacked areas within the large stacked area. You can quickly analyze how the individual parts make up the whole, which is useful when making percent-to-total comparisons. To see how the individual parts make up the whole, click the name of the attribute element on the left; you can select multiple items by holding **CTRL** and selecting elements.

The image below shows a sample Interactive Stacked Graph widget:
To create and add an Interactive Stacked Graph widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. From the Insert menu, point to Widgets, then Flash, and select Interactive Stacked Graph.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.
4. If desired, resize the widget by clicking and then dragging its handles.

To add objects to the Grid/Graph that contains the widget

5. From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:
   a. Place at least two attributes, one on the rows and one on the columns, as described below:
      - The attribute placed on the rows is displayed on the graph’s X-axis, at the bottom of the area graph in the widget. For example, if you place a Region attribute in the rows and then switch to Flash Mode, the regions are listed on the X-axis (horizontal graph line) at the bottom of the area graph.
      - Attributes placed on the columns must appear above (or to the left of) the metric on the columns. Attributes placed on the columns appear as a list of check boxes on the left side of the widget. For example, if you place a Category attribute on the columns and then switch to Flash Mode, the list of categories is displayed on the left as check boxes. The user can select each check box to show or hide that specific data on the area graph.
   b. Place only one metric on the columns. The metric values are displayed on the Y-axis of the graph. The metric must appear below (or to the right of) any attributes on the columns.
To enable the widget to be displayed

6 View and test your results by selecting Flash Mode from the Home menu.

   – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 61.

An Interactive Stacked Graph widget does not need a separate selector to allow a user to interact with it. However, you can use an Interactive Stacked Graph widget as a selector. For an example and more information, see Using an Interactive Stacked Graph widget as a selector, page 449.

Creating a Map widget

You can display your data as markers or areas on an interactive map using the Map widget. For example, you can create a Map widget that displays how customer households are clustered in different parts of the country using a density map, or display retail locations as a series of map markers that users can click to view additional information about stores in their area.

This section contains details and information to use the out-of-the-box Map widget that MicroStrategy provides. For steps to create a custom Map widget, see the MicroStrategy GIS Integration Help.

For steps to enable the Map widget, see Enabling the Map widget, page 305. For steps to create and display a Map widget, see one of the following:

• To display a report as a Map widget, page 306
To create and add a Map widget to a dashboard-style document, page 309

You can display data in a Map widget in the following ways:

• Image markers use colors and image styles to help users analyze data displayed on a map. MicroStrategy provides a variety of out-of-the-box image styles to choose from, and you can create your own custom images. The markers are fixed size images. You can determine whether or not to replace the static image markers in the widget with a different image based on the value of a metric. To do so, you define an image-based threshold on the metric in the widget’s grid. If you use Quick Symbols for thresholding, the following symbols display in Flash Mode: Square, Circle, Star, and Diamond.

• Bubble markers provide two visual cues to help users analyze data displayed on a map: size and color. If you choose to display bubble markers, the size of each bubble marker is automatically determined based on the values of the metric used to display the markers, with the largest bubbles being displayed for the largest metric values. You can also color bubble markers based on the value of a metric. To do so, you define a threshold that determines the fill color used to display metric values in the widget’s grid.

• A density map is color-coded based on the population density of locations on the map. For example, you can display locations with a high concentration of stores in red, and locations with a low concentration of stores in blue. The density map is available for a Map widget displayed in a document in Flash Mode.

• Map areas represent geographical regions, such as countries, states, and counties. You can color-code areas based on the values of a metric. To do so, you define a threshold that determines the fill color used to display metric values in the widget’s grid. Map areas are available for a Map widget displayed in a document in Flash Mode.

You can apply different threshold formatting to different metrics in the widget; when users select a metric to use to display data in the widget, the appropriate formatting is applied. For steps to define thresholds, see the Formatting Documents chapter in the Document Creation Guide.

In addition, you can add the following to a Map widget:

• You can allow users to open a link to a report or document by selecting image markers, bubble markers, or map areas in the widget. To do so, you must add the link to the attribute used to display locations in the widget.
For steps to add links to a widget, see _Creating links in widgets, page 382_.

- You can allow users to click on locations in the widget to filter the display of grids, graphs, panel stacks, and other widgets. To do so, you use the Map widget as a selector. For steps, see _To use a widget as a selector, page 458_. (Available for a Map widget added to a document.)

- You can limit both the points and the areas that are visible to a user. To do this, you apply security filters to a mapped attribute to limit the data that is passed to the Map widget. For details on security filters, see the _System Administration Guide_.

By default, the map displayed in the out-of-the-box Map widget contains highway-level data for the world and street-level data for North America, Europe, Southern Africa, parts of the Middle East, Asia, and so on. The map also contains detailed boundary data for the United States and Puerto Rico.

In addition to the out-of-the-box Map widget described in this section, you can create the following custom Map widgets:

- Map widget integrated with Google Maps
- Map widget with custom maps retrieved from the ESRI cloud
- Map widget with custom maps retrieved from a local ESRI server

For requirements and steps to enable and create widgets using each of these methods, see the _MicroStrategy GIS Integration Help_.

**Enabling the Map widget**

Enabling the Map widget involves modifying configuration files that are provided with MicroStrategy Web. Subsequent upgrades can overwrite these files. To minimize the impact of upgrades and avoid losing your customizations, create duplicates of your files to make sure you have access to them even if the copy provided as part of MicroStrategy Web is overwritten.

Keep a copy of the esriConfig.xml file in case you make an error in modifying the file. For detailed background information on customizing MicroStrategy Web, including general best practices to follow when modifying configuration files, upgrading MicroStrategy Web, creating customization plug-ins, and so on, see the _MicroStrategy Developer Library (MSDL)_.
Prerequisites

• The following procedure assumes that you have already obtained a MicroStrategy Map key. To obtain a key, contact MicroStrategy Technical Support.

To enable the Map widget

1. Navigate to the config folder in the Web folder. The default location for this folder is `C:\Program Files\MicroStrategy\Web ASPx\WEB-INF\xml\config`.

2. Open the esriConfig.xml file.

3. Replace `<apps></apps>` with `<apps><key>yourMicroStrategykeyhere</key></apps>`, and replace `yourMicroStrategykeyhere` with the MicroStrategy Map key that you got from Technical Support.

4. Save the esriConfig.xml file.

5. Restart the Web server to apply your changes.

To display a report as a Map widget

Prerequisites

• The Custom Visualizations Editor must be enabled. For more information, contact your Web administrator.

• The Map widget must be enabled. For steps, see Enabling the Map widget, page 305.

• The report must meet the following requirements:
  • Contains an attribute on the rows. This attribute provides the latitude and longitude of each map marker in the widget using separate attribute forms. For example, you can provide an attribute that has been assigned the Country, State, Zip Code, City, or Location geo roles.
- Contains at least one metric on the columns.

1. In MicroStrategy Web, click the name of the report to run it.

2. The latitude and longitude attribute forms of the attribute that contains the location of each map marker in the widget must be displayed on the grid. If the attribute forms are not displayed, right-click the attribute and point to **Attribute Forms**, then select the attribute form to display. Repeat this step for each attribute form to display in the grid.
   - If the forms you want to display do not appear in the list, select **More**. In the Attribute Forms dialog box, select each attribute form and click the right arrow to move the form to the Selected Forms list. Select the **Show on Grid** check box next to each attribute form and click **OK** to apply your changes.

3. From the **Tools** menu, select **Report Options**. The Report Options dialog box opens.

4. Click the **General** tab. In the Headers area, under Rows and Columns, clear the **Merge** check boxes. Click **OK** to apply your changes.

5. From the **Tools** menu, select **Custom Visualizations**. The Custom Visualizations Editor opens.

6. Select the **Enable this report to use Custom Visualizations** check box.

7. In the Available list, under Flash, select **Map** and click the right arrow to move it to the Selected list.

8. Ensure that the **Set view mode to Custom Visualization** check box is selected.

9. Click **Visualization Properties**. In the Map dialog box, do one of the following:
   - To display image markers in the map, select the **Show Markers** check box, then perform the following steps below:
     a. Select **Use image markers**.
     b. From the **Attribute** drop-down list, select the attribute that contains the latitude and longitude of each map marker to display in the widget.
     c. From the **Select latitude** drop-down list, select the attribute form that supplies the latitude value.
d From the **Select longitude** drop-down list, select the attribute form that supplies the longitude value.

e You can determine whether or not to replace the static image markers in the widget with a different image based on the value of a metric. To do so, you must define an image-based threshold on the metric in the widget’s grid. Do one of the following:

- To replace image markers based on the value of a metric, select the **Apply color formatting to the map** check box.

- To display map markers without replacing image markers, clear the **Apply color formatting to the map** check box.

For steps to define thresholds, see the *Formatting Documents* chapter in the *Document Creation Guide*.

- To display bubble markers in the map, select the **Show Markers** check box, then perform the following steps below:

  
a Select **Use bubble markers**.

  
b In the **Maximum bubble size** field, type a value between 7 and 100 that represents the maximum diameter, in pixels, to use to display bubble markers in the map. The default value is 100.

  
c From the **Negative values are represented as** drop-down list, specify whether to display negative values as absolute numbers or as bubbles sized as 7 pixels. For example, if you choose Absolute numbers, a bubble representing a metric value of -2,500 will be displayed as the same size as a bubble representing 2,500.

  
d From the **Attribute** drop-down list, select the attribute that contains the latitude and longitude of each map marker to display in the widget.

  
e From the **Select latitude** drop-down list, select the attribute form that supplies the latitude value.

  
f From the **Select longitude** drop-down list, select the attribute form that supplies the longitude value.

  
g You can determine whether or not to override the default color of bubble markers in the map based on the value of a metric. To do so, you must define a threshold to change the color of the metric’s values in the widget’s grid. Do one of the following:

- To format the color of bubble markers on the map based on the value of a metric, select the **Apply color formatting to the map** check box. If you do not define a threshold to change the
To create and add a Map widget to a dashboard-style document

Prerequisites

You have enabled the Map widget. For steps, see Enabling the Map widget, page 305.

The dashboard must contain a dataset that meets the following requirements:

- To display image markers, bubble markers, or density markers in the widget, the dataset must include one or more attributes to provide the latitude and longitude of each location in the widget. You can provide this information using either of the following:
  - One attribute on the rows. This attribute must provide the latitude and longitude of each location in the widget using separate attribute forms. For example, you can provide an attribute that has been assigned the Country, State, Zip Code, City, or Location geo roles.
  - Two attributes on the rows, one to provide the latitude and one to provide the longitude of each location in the widget. For example, you can provide one attribute that has been assigned the Latitude geo role and one attribute that has been assigned the Longitude geo role.

- To display map areas in the widget, the dataset must include one attribute whose values include the names of each area to display, as color of bubble markers in the widget, the fill color used to display metric values in the grid is used as the color of the bubble markers. The fill color is white by default.

  - To display map markers using their default color (orange), clear the Apply color formatting to the map check box.

For steps to define thresholds, see the Formatting Documents chapter in the Document Creation Guide.

10 Click OK to apply your changes.

11 Click OK. The report is displayed as a Map widget.

12 To save the report, from the Home menu, select Save.
provided by the base map for the widget, which you select in the steps below. The base map is a map that contains the shape of each area that can be displayed in the widget.

For example, the base map for Countries of the World contains the shape information required to display each country on a world map. You want to display a map that contains a colored area for each country in which your company has sales representatives. Create an attribute called Country, which contains the names of these countries. Use the Country attribute to provide location information in a widget that uses the Countries of the World base map.

- At least one metric on the columns.

1. In MicroStrategy Web, open the dashboard in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select Map.

3. Click the location on your dashboard where you want to place the widget. The Grid/Graph containing the widget is displayed.

4. If desired, resize the widget by clicking and then dragging its handles.

5. From the Dataset Objects panel on the left, select attributes and metrics, and drag them on to the Grid/Graph, as follows:
   - Place the attribute or attributes that provide location information for the widget onto the rows of the grid. Depending on the type of Map widget, the widget can require latitude or longitude information, or the name of map areas to display, as described in the prerequisites above.
   - Place at least one metric on the columns.

6. If you are providing locations in the widget using a single attribute that contains latitude and longitude values, the attribute’s latitude and longitude forms must be displayed on the grid. If the attribute forms are not displayed, right-click the attribute and point to Attribute Forms, then select the attribute form to display. Repeat this step for each attribute form to display in the grid.
   - If the forms you want to display do not appear in the list, select More. In the Attribute Forms dialog box, select each attribute form and click the right arrow to move the form to the Selected Forms list. Select the Show on Grid check box next to each attribute form and click OK to apply your changes.
7 Right-click the widget’s grid and select **Properties and Formatting**. The Properties and Formatting dialog opens.

8 From the left, select **Grid**. In the Headers area, under Rows and Columns, clear the **Merge** check boxes. Click **Apply** to apply your changes.

9 From the left, select **Widget**.

10 By default, the Map widget is displayed in Express Mode and Interactive Mode as a placeholder with a message. To display the Map widget as a grid or graph in Express Mode and Interactive Mode, under Display widget in, clear the **DHTML** check box.

11 Click the **Widget Properties** icon. In the Map dialog box, do one of the following:

   • To display image markers in the map, select the **Show Markers** check box, then perform the following steps below:

      a Select **Use image markers**.

      b From the **Use Attribute or Form** drop-down list, select one of the following:

         – To provide locations in the map using separate attributes, select **Use Attribute**.

         – To provide locations in the map using attribute forms, select **Use Attribute Form**. From the **Select Attribute** drop-down list, select the attribute that contains the latitude and longitude of each location to display in the widget.

      c From the **Select latitude** drop-down list, select the attribute or attribute form that supplies the latitude value.

      d From the **Select longitude** drop-down list, select the attribute or attribute form that supplies the longitude value.

      e From the **Selection display attribute/form** drop-down list, select the attribute or attribute form to show in the pop-up tooltip displayed when a user hovers the cursor over a location in the widget.

      f You can determine whether or not to replace the static image markers in the widget with a different image based on the value of
a metric. To do so, you must define an image-based threshold on
the metric in the widget’s grid. Do one of the following:

– To replace image markers based on the value of a metric, select
the **Apply color formatting to the map** check box.

– To display map markers without replacing image markers,
clear the **Apply color formatting to the map** check box.

For steps to define thresholds, see the *Formatting Documents*
chapter in the *Document Creation Guide*.

• To display bubble markers in the map, select the **Show Markers**
check box, then perform the following steps below:

  a Select **Use bubble markers**.

  b In the **Maximum bubble size** field, type a value between 7 and
100 that represents the maximum diameter, in pixels, to use to
display bubble markers in the map. The default value is 100.

  c From the **Negative values are represented as** drop-down list,
specify whether to display negative values as absolute numbers or
as bubbles sized as 7 pixels. For example, if you choose Absolute
numbers, a bubble representing a metric value of -2,500 will be
displayed as the same size as a bubble representing 2,500.

  d From the **Use Attribute or Form** drop-down list, select one of the
following:

    – To provide locations in the map using separate attributes,
select **Use Attribute**.

    – To provide locations in the map using attribute forms, select
**Use Attribute Form**. From the **Select Attribute** drop-down
list, select the attribute that contains the latitude and longitude
of each location to display in the widget.

  e From the **Select latitude** drop-down list, select the attribute or
attribute form that supplies the latitude value.

  f From the **Select longitude** drop-down list, select the attribute or
attribute form that supplies the longitude value.

  g You can determine whether or not to override the default color of
bubble markers in the map based on the value of a metric. To do
so, you must define a threshold to change the color of the metric’s
values in the widget’s grid. Do one of the following:
– To format the color of bubble markers on the map based on the value of a metric, select the **Apply color formatting to the map** check box. If you do not define a threshold to change the color of bubble markers in the widget, the fill color used to display metric values in the grid is used as the color of the bubble markers. The fill color is white by default.

– To display map markers using their default color (orange), clear the **Apply color formatting to the map** check box.

For steps to define thresholds, see the *Formatting Documents* chapter in the *Document Creation Guide*.

• To display a density map, select the **Show Markers** check box, then perform the following steps below:

  a. Select **Use density maps**. From the drop-down list, select the display theme to use to display the density map. A preview of the display theme is displayed to the right.

  b. From the **Use Attribute or Form** drop-down list, select one of the following:

     – To provide locations in the map using separate attributes, select **Use Attribute**.

     – To provide locations in the map using attribute forms, select **Use Attribute Form**. From the **Select Attribute** drop-down list, select the attribute that contains the latitude and longitude of each location to display in the widget.

  c. From the **Select latitude** drop-down list, select the attribute or attribute form that supplies the latitude value.

  d. From the **Select longitude** drop-down list, select the attribute or attribute form that supplies the longitude value.

  e. From the **Selection display attribute/form** drop-down list, select the attribute or attribute form to show in the pop-up tooltip displayed when a user hovers the cursor over a location in the widget.

• To display map areas, ensure that the **Show Markers** check box is cleared, then perform the following steps below:

  a. Select the **Show Areas** check box.

  b. From the **Attribute** drop-down list, select the attribute that contains the name of each area to display in the map.
c From the **Shape File** drop-down list, select the name of the base map to use to display areas in the widget. The base map is a map that contains the widget's background image, as well as the shape of each area that can be displayed in the widget. For example, the base map for Countries of the World contains the shape information required to display each country on a world map.

12 Click **OK** to return to the Properties and Formatting dialog box.

13 Click **OK** again to apply your changes.

14 To save the document, from the **Home** menu, select **Save**.

**Creating a Media widget**

The Media widget allows you to present a variety of media such as video, audio, images, or website content on your dashboard-style document. You can include media in the widget to provide background information about data, or instructions on how to use the dashboard-style document. You can also use the Media widget to enhance the look and feel of a dashboard-style document. In the following dashboard-style document, the Media widget in
the top left corner shows a company’s CEO addressing his employees on important trends in the latest figures.

One of the primary purposes of the Media widget is to present supplemental information about the data on a dashboard-style document. For example, a regional manager can record a video that summarizes quarterly sales and discusses the significance of the data in a dashboard-style document that contains sales information. Analysts can then view the dashboard-style document in the context of this additional information and commentary.

The media file used in the widget can come from an online source, be stored locally on your machine, or be stored remotely on your corporate network.

The Media widget can be used for instructional purposes. For instance, a dashboard-style document designer can include audio or video files that explain how to use a dashboard-style document. Analysts can use this information to focus on key data and take advantage of the dashboard-style document’s interactive features, allowing them to work with the dashboard-style document more efficiently.

You can display HTML content from a website in the widget. For example, you can display a section of your internal corporate website that contains a
business presentation. Website content that is refreshed frequently, such as numeric indicators on system usage, can also be useful media to present in the widget.

You can configure the Media widget to play a media file based on the attribute, dashboard-style document, or dataset selected in the dashboard-style document. For example, select a quarter in the dashboard-style document, and a manager’s video about the revenue for that quarter is displayed. Similarly, you can choose a region to play a video about the performance of the stores in that particular region.

You can export a dashboard-style document containing a Media widget into a Flash file, so that users can view the widget and interact with it off-line, without a connection to Intelligence Server or your web server.

Prerequisites for the Media widget

- If your machine is running Microsoft Windows 2003 SP2 (R2) and Microsoft Internet Information Services (IIS) 6, you must add .flv files to the Multipurpose Internet Mail Extension (MIME) types in IIS Manager:
  a. From the Start menu, select Control Panel, then Administrative Tools.
  b. Double-click Internet Information Services (IIS) Manager.
  c. Expand the (local computer) folder, expand Web Sites, then expand Default Web Site.
  d. Right-click MicroStrategy and select Properties.
  e. On the HTTP Headers tab click MIME Types. Then click New.
  f. In the Extension field, type flv.
  g. In the MIME Type field, type video/x-flv.
  h. Click OK until the MicroStrategy Properties window closes.
  i. Restart IIS.

- To ensure that the Media widget can play the media file off-line, the file name for the media file must be specified without a path. The media file must be stored in the same folder as the Flash file. When specified this way, the media file is not accessible when the dashboard-style document is viewed online. For background information about Flash files and how
To export dashboard-style documents, see the *Document and Dashboard Analysis Guide* or the *Web Help*.

- To use a graphic, video, or audio clip that is available on your network, ensure that the file has the required view or access privileges.
- The Media widget can play and display the file formats listed in the following table.

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video</td>
<td>.swf, .flv</td>
</tr>
<tr>
<td>Audio</td>
<td>.mp3</td>
</tr>
<tr>
<td>Graphic</td>
<td>.gif, .jpg, .png, .svg</td>
</tr>
</tbody>
</table>

- The Media widget handles HTML tags in the following ways. Use the lists below to confirm the tags you plan to use will display as expected:

<table>
<thead>
<tr>
<th>Tags and Content Supported</th>
<th>Tags Not Rendered, But Content in Tags Displayed</th>
<th>Tags and Content Not Displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;A&gt;</td>
<td>&lt;TABLE&gt;</td>
<td>&lt;SCRIPT&gt;</td>
</tr>
<tr>
<td>&lt;B&gt;</td>
<td>&lt;TR&gt;</td>
<td>&lt;STYLE&gt;</td>
</tr>
<tr>
<td>&lt;BR&gt;</td>
<td>&lt;TD&gt;</td>
<td>&lt;SPAN&gt;</td>
</tr>
<tr>
<td>&lt;IMG&gt;</td>
<td>&lt;DIV&gt;</td>
<td></td>
</tr>
<tr>
<td>&lt;I&gt;</td>
<td>&lt;FONT&gt;  *</td>
<td></td>
</tr>
<tr>
<td>&lt;LI&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;P&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;U&gt;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* The &lt;FONT&gt; tag may be removed if it contains a CLASS attribute within it, for example, &lt;font class="header">Welcome &lt;/font&gt;.
To create and add a Media widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. From the Insert menu, point to Widgets, then Flash, and select Media.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.
4. If desired, resize the widget by clicking and then dragging its handles.

To enable the widget to be displayed

5. Perform one of the following to enable the widget to be viewed:
   - Select Flash Mode from the Home menu.
     - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 61.
   - Select Interactive Mode from the Home menu.
     - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see Defining how a widget is displayed in different views and modes, page 369.

To specify the media content to display in the widget

6. Right-click the widget and select Properties. The Properties dialog box opens.
7. On the General tab, from the Content Type drop-down list, choose the type of media to present by selecting Video, Audio, Web Content, or Image. See Prerequisites for the Media widget, page 316 for supported file formats.
8. Specify the location of the content in the Default Feed field according to the following:
   - If the media is stored on a network location or website, specify the network location of the file or website's URL using the following format: http://www.mycompany.com/SalesVideos/
South.swf. Folder paths in the form of `\computer_name\videos\South.swf` cannot be used.

- To define the widget as a target of an attribute, dashboard-style document, or dataset selector in the dashboard-style document:
  - Specify a dynamic path that includes the name of the object, for example: `http://www.example.com/videos/{[Region]}.swf`. For a document, use the format `{{#name of document#}}`. For a dataset, use the format `{{#name of dataset#}}`.
  - Use a `+` character to include a space between words, for example: `http://www.mycompany.com/videos/Books+Electronics+Music+Movies`.

- If the Media widget will be exported to a Flash file in a dashboard-style document so users can view and interact with it off-line, perform the following:
  - Specify only the file name, without a path, for example, `South.swf`.
  - Add the `.mht` file to the list of Adobe Flash Player trusted files on the client machine. To do this, on the Macromedia Support Site, from the `Edit locations` drop-down list, select `Add location`. Type the location of the `.mht` file, then click `Confirm`. Close and reopen the dashboard-style document.

9 If you selected `Web Content` above and the web content is located on a different web domain than the one used for MicroStrategy Web, select the `Use Proxy` check box.

10 If you want to display a tooltip, enter text in the `Tooltip Text` field. For details on tooltips, see the `Report Services Document Creation Guide`.

11 Select the background color from the `Background color` drop-down list.

12 If you want to display the media content when a user clicks a button in the widget, rather than automatically when the widget is executed, select the `Popup content when clicked` check box, then perform the following:
   a To determine how the content is displayed when the user clicks the button, from the `Display Window` drop-down list select `Inline` or `New Window`.
   b Enter text for the button in the `Button Text` field.

13 Determine the following video play options on the Play Frequency tab:
• To display the Play button in the widget, select the Show play button control check box. If the Play button is not displayed, the media cannot be controlled by the user.

• To play the media file automatically when the dashboard-style document is executed, select the Auto Play on Start check box.

• To play the video continuously in a loop, select Continuous Play (Loop).

• To play the video only once, select Play Once.

14 Click OK to save changes and display the widget.

Creating a Microcharts widget

The Microcharts widget consists of compact representations of data that allow analysts to quickly visualize trends in data. Microcharts convey information so that a user can, at a glance, determine the trend of a metric over time or how a metric is performing compared to forecasted figures. The Microcharts widget is useful for this purpose because individual microcharts can display attribute and metric data in a small graph that would otherwise be displayed as a single value in a grid report cell.

![Microcharts widget example](image)

Use a Microcharts widget to quickly visualize the trend of a metric at a glance without having to know many additional details. The bar, sparkline, and bullet microcharts used in the Microcharts widget convey information that an analyst can understand by looking at the graph once.
Each of the microcharts provides a unique way to visualize your data, as described below:

<table>
<thead>
<tr>
<th>Microchart</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bar chart</strong></td>
<td>Bar microcharts plot a metric with respect to time using a single bar, displaying a metric's current value and historical data to visualize the shape of the trend.</td>
</tr>
</tbody>
</table>
| **Sparklines** | Sparkline microcharts plot a metric with respect to time using a line graph, displaying a metric's current value and historical data to visualize the shape of the trend. Sparkline microcharts consist of the following:  
  • A line graph that depicts the metric's value over time.  
  • A horizontal reference line, which provides a comparison point between the actual values and the reference values. |
| **Bullet chart** | Bullet microcharts compare the value of one metric against other metrics, typically representing a target value. One common example is comparing the year-to-date value of a metric to the annual target or the forecast of the metric. Bullet charts consist of the following:  
  • A horizontal performance measure bar. This represents the actual metric value.  
  • A vertical reference line, which is typically the target value for the metric.  
  • Colored reference bands (Band 1, Band 2, and Band 3) that indicate a numeric range in which the metric's values exist. |

One, two, or three microcharts can be displayed in the Microcharts widget, depending on the number of metrics used on the Grid/Graph that contains the widget. For example, bar and sparkline microcharts are included on the left side of the widget shown above. These microcharts convey the trend of a metric over time, from left to right. On the right side of the widget, bullet microcharts reveal the percentage of cases that were closed, in correlation with the goals for the regions, which are represented by the vertical lines within the bullet microcharts.

**About operation modes**

The Microcharts widget is displayed by default in Grid mode, which displays simple rows of data, as shown in the image above. Other operation modes are available, described in this section. Steps to set up and enable each operation mode are included in *To create and add a Microcharts widget to a document, page 323.*
You can display Grid mode in Tree mode, which groups the rows in the widget logically. Users can collapse and expand the rows as needed to see more detailed data. For steps to enable Tree mode, see *To enable Tree mode, page 329.*

Vertical Scroll mode displays data one row at a time, scrolling vertically.

Ticker mode displays one row at a time, scrolling side to side. A ticker can display text as well as report data. The text can be both static and variable; the values for the variables are displayed at run time. For example, a variable can alert users when profits dip below a specified target. The following example uses variables to define the text that appears. The text in braces contains the variables for a microchart, attribute, and metric.

```
{&sparkline} The {Region} Region has NOT reached its profit target of {{Profit Target}} {&bullet}
```

The resulting ticker is displayed below. When you click the text, a larger version of the ticker is displayed.

You can display the Microcharts widget on a mobile device with MicroStrategy Mobile (Ticker mode, Vertical Scroll mode, and Grid mode with indented rows are not available on mobile devices). When the widget is displayed on the mobile device, users can tap the metric column to toggle between different metrics on the columns of the widget. For instructions to create a Microcharts widget for mobile devices, see the *Mobile Design and Administration Guide.*
Creating a Microcharts widget

To create and add a Microcharts widget to a document

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.

2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Microcharts**.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.

To add objects to the Grid/Graph that contains the widget

The steps below ensure that the widget can display all three microcharts (bar, sparkline, and bullet), but steps are also below to display or hide any of the microchart types.

5. To add attributes, from the **Dataset Objects** panel on the left select attributes and drag them on top of the widget, based on the following requirements:

   - If KPI List mode will not be used, place at least two attributes on the rows, based on the following:
     - The elements of the first attribute are displayed as text in the first column of the widget. The number of rows in the widget represents the number of elements from the first attribute on the rows. For example, the widget above has seven rows of regional data because the Region attribute on the rows has seven different elements, or regions.
     - The last (right-most) attribute on the rows determines the X-axis values in the bar microcharts and sparkline microcharts.
     - If the rows contain at least three attributes, each attribute (except the last, right-most attribute) is combined and displayed as a row in the widget. If you want to indent these rows so users can collapse or expand them in groups, display the widget in Grid mode with indented rows; steps are included in this procedure.
• If you want to display rows as a list of KPIs, place only one attribute on the rows. Use a time-based attribute such as Month or Year since the attribute controls the time series of the bar and sparklines charts.

6 To add metrics, from the Dataset Objects panel on the left select metrics and drag them on top of the widget, based on the following requirements:

• To display all three microchart types, place at least seven metrics on the columns, as follows:
  – The first (left-most) metric determines the height of the bars in the bar microcharts and the peak points in the sparkline microcharts.
  – The second metric creates the horizontal reference lines that are displayed in the sparkline microcharts.
  – The third metric determines the length of the performance measure bar in the bullet microcharts. The bar represents the actual metric value.
  – The fourth metric determines the maximum possible values in the bullet microcharts.
  – The fifth metric determines the right-most boundary of the first color band, Band 1, in the bullet microcharts.
  – The sixth metric determines the right-most boundary of the second color band, Band 2, in the bullet microcharts.
  – The seventh metric determines the value of the vertical reference line in the bullet microcharts, which is typically the target value for the metric.
  – Any additional metrics are displayed in the columns of the widget, after the microcharts and their associated metrics.

• If you want to display the widget in ticker mode, add metrics with the following information in mind. One of two tickers is displayed, depending on the values, as described below:
  – Ticker 1 is displayed when the third metrics’ (the performance metric) values are equal to or greater than the target values represented by the seventh metric.
  – Ticker 2 is displayed when the third metric’s values are less than the target values represented by the seventh metric.
• If you want to display rows as a list of KPIs:
  – Place at least one metric on the columns. By default, each metric is calculated and displayed as an individual row in the widget.
  – To display all three microcharts types, place at least seven metrics on the columns as described above.

**To enable the widget to be displayed**

7 View and test your results in one of two ways:

• Select **Flash Mode** from the **Home** menu.
  – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 61*.  

• Select **Interactive Mode** from the **Home** menu.
  – To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 369*.  

**To show or hide a microchart type**

8 From the **Home** menu, select **Flash Mode**.

9 Right-click the widget and select **Properties**. From the drop-down list, select **Options**.

• To show or hide bar microcharts, click the **Bar** tab and select or clear the **Show bar graph** check box.

• To show or hide sparkline microcharts, click the **Sparkline** tab and select or clear the **Show sparkline graph** check box.

• To show or hide bullet microcharts, click the **Bullet** tab and select or clear the **Show bullet graph** check box.

10 By default, Grid mode is displayed for a Microcharts widget. Grid mode displays all the rows of microcharts at the same time. To use an alternative operation mode, follow the steps below to display the widget in Vertical Scroll mode, Ticker mode, KPI List mode, or Grid mode with indented rows for easier grouping.
Enabling an operation mode to view and work with the Microcharts widget

Once you have followed the steps above to create and add a Microcharts widget to a document, you can use the steps below to display the widget in a different mode. By default, a Microcharts widget displays in Grid mode, which is a list of all rows of data displayed at the same time.

To enable Vertical Scroll mode

In Vertical Scroll mode, one row is displayed at a time, and the rows automatically scroll from top to bottom. Users can also manually move from one row to the next using the Previous and Next buttons on the right side of the widget, as shown below:

<table>
<thead>
<tr>
<th>Region</th>
<th>Last 12 months</th>
<th>Revenue</th>
<th>Profit Region Level</th>
<th>Profit Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mid-Atlantic</td>
<td><img src="image" alt="Graph" /></td>
<td>$2,563,395</td>
<td>$4,007,500</td>
<td>34,120,793</td>
</tr>
</tbody>
</table>

1. To display the widget in Vertical Scroll mode, from the Home menu select **Flash Mode**, then right-click the widget and select **Properties**.
2. From the drop-down list at the top left, select **Mode**.
3. On the Mode tab, from the **Operation Mode** drop-down list, select **Vertical Scroll**.
4. To enable manual scrolling, on the Vertical Scroll tab, select the **Previous/Next buttons** check box.
5. To define the speed of the vertical scrolling, select an option from the **Motion** drop-down list.
6. Click **OK**.
To enable Ticker mode

In Ticker mode, microcharts and supplemental text are displayed in a scrolling ticker that moves from right to left, as shown below:

1. To display the widget in Ticker mode, from the Home menu select Flash Mode, then right-click the widget and select Properties.

2. From the drop-down list at the top left, select Mode.

3. On the Mode tab, from the Operation Mode drop-down list, select Ticker.

4. On the Ticker tab, type a name for the ticker in the Title field. This name appears above the ticker.

5. To allow users to manually scroll from row to row, select the Previous/Next buttons check box.

6. Select or clear the Enable detail view check box to allow users to click the text to display or hide a larger, detailed view of each row.

7. Define the speed of the scrolling ticker by selecting an option from the Motion drop-down list.

8. To define the text that appears in the tickers, type values for Ticker 1 and Ticker 2. Define values based on the following:

   - **Microcharts**: Type one of the following to display specific types of dynamic microcharts at run time: {&bullet} for bullet microcharts, {&bar} for bar microcharts, or {&sparkline} for sparkline microcharts.
• **Attributes and metrics**: To display dynamic attributes and metrics at run time, type attributes and metrics in braces, for example, `{Revenue}`. For objects with spaces in the name, use brackets inside the braces, for example `{{Revenue Forecast}}`.

9 From the **Ticker 1 color** and **Ticker 2 color** drop-down lists, select a font color for each ticker.

10 Click **OK** to apply the changes to the widget.

---

**To enable KPI List mode**

In KPI List mode, each KPI is represented by its own row of microcharts. Because all data for a KPI is presented in one row of the Microchart widget, trends are easier to spot, as shown below:

<table>
<thead>
<tr>
<th>Metric</th>
<th>Last 12 months trend</th>
<th>Last 12 months trend</th>
<th>This Quarter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>min: $3,800,750</td>
<td>max: $7,081,712</td>
<td>$7,581,619</td>
</tr>
<tr>
<td>Profit</td>
<td>min: $702,700</td>
<td>max: $1,219,422</td>
<td>$1,117,821</td>
</tr>
<tr>
<td>Cost</td>
<td>min: $101,233</td>
<td>max: $16,903,098</td>
<td>$6,463,698</td>
</tr>
</tbody>
</table>

1 To display the widget in KPI List mode, from the **Home** menu select **Flash Mode**, then right-click the widget and select **Properties**.

2 From the drop-down list at the top left, select **Mode**.

3 On the Mode tab, from the **Operation Mode** drop-down list, select **Grid** or **Vertical Scroll**. (You cannot display KPIs in Ticker mode.)

4 Specify the number of metrics to use to generate the rows of microcharts for the KPIs, using the following guidelines:

- If one metric is used per KPI, only sparkline and bar charts and their metrics are displayed. The horizontal reference line is not displayed in the sparklines.

- If two metrics are used per KPI, sparkline and bar charts and their metrics are displayed. The horizontal reference line is displayed.

- If three to six metrics are used per KPI, sparkline and bar charts and their metrics are displayed. Additional metrics are displayed to the right of the sparkline and bar charts and their metrics.
• If seven or more metrics are used per KPI, sparkline, bar, and bullet charts are all displayed. Additional metrics are displayed to the right of the sparkline and bar charts.

5 You can provide a name for the column that displays the metric associated with the sparklines or bullet charts; this is the last data point within the sparklines and bullet charts. The example below shows “This Quarter” as a label:

<table>
<thead>
<tr>
<th>Metric</th>
<th>Last 12 months trend</th>
<th>Last 12 months trend</th>
<th>This Quarter</th>
<th>TM vs target</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>min $3,866,706</td>
<td>max $7,581,519</td>
<td>$1,007,989</td>
<td>20,570</td>
</tr>
<tr>
<td>Profit</td>
<td>min $702,290</td>
<td>max $1,219,423</td>
<td>$164,103</td>
<td>3,506</td>
</tr>
<tr>
<td>Cost</td>
<td>min $3,102,633</td>
<td>max $6,483,888</td>
<td>$43,896</td>
<td>17,054</td>
</tr>
</tbody>
</table>

To add a label, from the drop-down list at the top left, select **Labels**.

• On the Sparkline tab, in the **Associated Metric** field, type a name for the column that contains the metric values associated with the sparklines.

• On the Bullet tab, in the **Associated Metric** field, type a name for the column that contains the metric values associated with the bullet charts.

6 Click **OK** to apply changes to the widget.

**To enable Tree mode**

You can enable Tree mode to group rows in the widget. Groups of rows can be collapsed or expanded to show different levels of detail, with each level representing a different attribute, as shown below in Web:
Tree mode can be viewed in Flash Mode, and on an iPad or Android device with MicroStrategy Mobile. To display the widget in Tree mode on a mobile device, you must create and add the following subtotals to the widget:

- A subtotal grouped by the first attribute on the rows, then the time attribute (the last attribute on the rows).
- A subtotal grouped by the first attribute on the rows, the second attribute on the rows, then the time attribute.
- And so on, up to but not including the last attribute on the rows before the time attribute.

For example, if you have placed the attributes Category, Subcategory, Item, and Year on the rows of the widget’s grid, you must create and add the following subtotals to the widget:

- A subtotal grouped by Category and Year.
- A subtotal grouped by Category, Subcategory, and Year.

Since Item is the lowest-level attribute before Year, it does not need to be included in any of the subtotals. An example image is below.
To create the subtotals for displaying Tree mode on a mobile device

If the widget is going to be displayed on a mobile device, follow the steps below to create subtotals. If it is going to be displayed in Web, skip to To enable Tree mode below.

1. In Developer, open the document that contains the Microcharts widget in Design View.
2. Right-click the widget’s grid, then select Edit Grid.
3. On the toolbar, click the Subtotals icon. The Subtotals dialog box opens.
4. Click Advanced. The Advanced Subtotals Editor opens.
5. Under Applied levels, click the Group By option.
6. For each subtotal, perform the following steps:
   a. Click Add. The Group By Selection dialog box opens.
   b. Select the check box next to each attribute to include in the subtotal. For example, in the sample above, you would select Category and Year for the first subtotal. For the second subtotal, you would select Category, Subcategory, and Year.
   c. Click OK to create the subtotal.
7. Click OK to return to the Subtotals dialog box.
8. Click OK to apply your changes and return to the document.
9. From the toolbar, click the Save and Close icon to save your changes.

To enable Tree mode

Follow the steps below to enable Tree mode for Web and mobile devices.

10. In Web, open the document in Flash Mode.
11. Right-click the widget and select Properties.
12. From the drop-down list at the top left, select Mode.
13. On the Mode tab, from the Operation Mode drop-down list, select Grid.
14. Select the Tree display check box.
15 You can determine how totals for the grouped rows are displayed in Web. To do this, select an Aggregation function from the drop-down list.

16 Click OK to apply your changes to the widget.

A Microcharts widget does not need a separate selector to allow a user to interact with it. However, you can use a Microcharts widget as a selector. For an example and more information, see Using a Microcharts widget as a selector, page 451.

You can add links to a Microcharts widget. Linking allows users to connect from a widget in a dashboard-style document (the source) to a document or report (the target). If you add a link to a Microcharts widget, a Links menu is displayed when a MicroStrategy Web user hovers the cursor over a bar chart or sparkline graph in the widget. The user can click a link in the Links menu to open the target. See Linking in widgets, page 379 for instructions and examples.

Creating a Network widget

The Network widget allows you to quickly and easily identify relationships between related items and clusters, such as when visualizing a social network or displaying a market basket analysis. Attribute elements are displayed as nodes in the widget, with lines (called edges) drawn between the nodes to represent relationships between elements. Once the widget is created, users can visualize characteristics of the nodes and the relationships between them, using display options such as node size, edge thickness, and edge color. For example, if a node is displayed for each store in a country, you can
have the widget automatically display a connection between two nodes using a thicker line if the two stores share a large number of customers.

For more information on analyzing data in a Network widget, see the MicroStrategy Web Help. You can display the Network widget on a mobile device with MicroStrategy Mobile. For background information on widgets for mobile devices, see the Mobile Design and Administration Guide.

**Prerequisite**

- This procedure assumes that you have already created the document to which you want to add the Network widget.

**To create and add a Network widget to a document**

1. In MicroStrategy Web, open the document in **Design Mode**.

2. From the Insert menu, point to **Widgets**, then **Flash**. Select **Network**. Click the location on your document where you want to place the widget. If desired, resize the widget’s Grid/Graph by clicking and dragging its handles.

3. From the **Dataset Objects** panel on the left, select attributes and metrics and drag them on top of the grid, as described below.
• In order to display edges between nodes in the widget, you must place attributes on the Grid/Graph to provide the starting and ending nodes for each edge you want to display. Each row of data in the Grid/Graph corresponds to a separate edge in the widget. Place two attributes on the Grid/Graph’s rows, as follows:

  – The elements of the first attribute are displayed as nodes that serve as the starting location for each edge in the widget.
  
  – The elements of the second attribute are displayed as nodes that serve as the ending location for each edge in the widget.

4 Place three metrics on the Grid/Graph’s columns, as follows:

• The first metric is used to automatically size edges in the widget, with larger metric values represented by thicker edges.

• The second metric is used to automatically color edges in the widget. To do this, you must define a threshold to change the color in which the data in the Grid/Graph is displayed based on the value of the metric. For background information and steps to create a threshold, see the *Report Services Document Creation Guide*.

• The third metric is used to automatically size nodes in the widget, with larger metric values represented by larger nodes.

5 You can have MicroStrategy display an Information Window when a user clicks the node for a specific attribute element in the widget. To do so, you must define the Information Window for the attribute that contains the element on the widget’s Grid/Graph.

You can choose to display an Information Window for attribute elements that serve as the starting location for an edge, the ending location for an edge, or both. If an element is included in both attributes on the widget’s Grid/Graph, and you have enabled separate Information Windows to display for each attribute, the first Information Window that you defined is displayed.

For steps to define an Information Window for an attribute, see *Defining an Information Window for a Grid/Graph or a selector, page 94*.

6 View and test your results by selecting **Flash Mode** from the **Home** menu.

  – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 61*. 
Creating an RSS Reader widget

RSS (Really Simple Syndication) is a data format used to display updated web content when you click a URL. An RSS document is called a feed, and it contains either a summary of the content from an associated website or the full text.

The RSS Reader widget helps provide a 360-degree view of your business by allowing you to compare and contrast data in your dashboard-style document with information from external news feed sources.

The RSS Reader widget in the example above retrieves news from an RSS news feed, which can be displayed alongside the other components of your dashboard-style document. The RSS feed is automatically reloaded to display the most up-to-date news about a variety of topics that you specify. When an analyst selects a news item from the list, the beginning of the article is displayed in the details section at the top. Clicking the article’s text opens the full article in a new window.

An analyst can refresh the list of news articles by clicking the Refresh icon at the top left of the widget. He can also navigate to and from different pages of news articles by using the arrows at the bottom.

Analysts can use RSS Reader widgets on a dashboard-style document to view and update their favorite RSS news feeds as they analyze grids, graphs, and other objects in the dashboard-style document.
For example, you are viewing a dashboard-style document with sales figures for some of your local customers. You can configure the RSS Reader widget to display up-to-the-minute news about those customers. This allows you to view both sales data and news information about the same customers in one place. In another example, one of your reports provides sales figures for a group of stores in northern California. Using an RSS feed, you can display local industry news for that specific region, which can provide valuable background information about those sales figures.

To extend this relationship between your business data and recent news, you can configure an RSS feed to be connected to specific attributes in your dashboard-style document. For example, you can click a customer’s name on a report to view updated RSS news information about that customer. Steps for this are included in the procedure below to create the widget.

On a mobile device with MicroStrategy Mobile, the RSS Reader widget can display updated web content when the user taps a URL. For steps to create and format an RSS Reader widget for display on a mobile device, see the Mobile Design and Administration Guide.

**Prerequisites**

- The RSS Reader widget supports RSS 1.0 and RSS 2.0 formats. See the MicroStrategy Readme for the latest version support information.

- If enabling the RSS Reader widget to display content when used offline, be aware that the third-party products discussed below are manufactured by vendors independent of MicroStrategy, and the information provided is subject to change. Refer to the appropriate third-party vendor documentation for updated Flash Player support information.

---

**To create and add an RSS Reader widget to a document**

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select RSS Reader.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.
If desired, resize the widget by clicking and then dragging its handles.

To enable the widget to be displayed

View and test your results in one of two ways:

- Select **Flash Mode** from the **Home** menu.
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 61.*

- Select **Interactive Mode** from the **Home** menu.
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 369.*

To specify the RSS feed to display in the widget

Right-click the widget and select **Properties**. The Properties dialog box opens.

On the **General** tab, type a title in the **RSS reader title** field. The title appears at the top of the widget.

In the **Default RSS Field**, type the URL for one of the following types of RSS feeds (you can only use one RSS feed):

- **Static RSS feeds** display a default set of news about a general topic, such as business or technology. Their URLs are configured to display information on the general topic. For static feeds, type the RSS feed’s URL. For example, to view news from the Yahoo! Business News RSS feed, enter the following: http://rss.news.yahoo.com/rss/business

- **Dynamic RSS feeds** are modified to display information about a specific topic. For details about the parameters and syntax to use in the RSS feed’s URL, consult your RSS news provider’s website. For dynamic RSS feeds, specify the base URL, language/country settings, and one of the following:

  - To display news about a specific topic, insert the topic into the URL’s query parameter. If you are required to specify a UTF-related parameter, use UTF-8 encoding. If parameter words have a space between them, use a + character in place of each space.
– To display news related to an attribute, document, or dataset, insert an auto code for the object in the URL’s query parameter. For example, http://news.search.yahoo.com/news/rss?p={[Customer State]}&ei=UTF-8&fl=0&x=wrt. For a document, use {{#name of document#}}, for a dataset, use {{#name of dataset#}}.

– To display news about an attribute element, use a dynamic RSS feed URL in the widget, for example: http://news.search.yahoo.com/news/rss?p={[Category]}&ei=UTF-8&fl=0&x=wrt. The RSS widget’s template must contain the attribute, the attribute must be enabled as a selector, and the RSS widget must be set as a target of the attribute. For details about using a widget as a selector, see Chapter 7, Viewing Data Related to Widgets: Using Widgets as Selectors.

9 Specify the rate at which news items are automatically refreshed. Enter this value in seconds in the **Default refresh frequency (Sec)** field.

10 Specify the maximum number of news items that a user sees at a time by typing a number in the **Items shown at a time** field. The default value is 10.

11 Determine whether a news article is opened in a new window when it is selected in the widget. To do this, select or clear the **Open full article when clicked** check box.

12 If the RSS feed is accessed through a proxy server, select the **Use Proxy** check box.

13 Click **OK** to save your changes.

**To enable RSS content to display when used offline**

If users will access the RSS content offline, use the steps below to add the .mht file to the list of Adobe Flash Player trusted files on the client machine. The .mht file contains all data required to make a widget display and operate properly after it has been exported.


15 From the **Edit locations** drop-down menu on the right, select Add location.
16 Type the location of the .mht file in the field.

17 Click Confirm.

18 Close and reopen the document that contains the widget.

Creating a Survey widget

The Survey widget allows you to create a survey in a database or on a third-party survey creation website, then display your survey in a Transaction Services-enabled document. Users can view the document to interact with the survey and submit their answers, which are then stored in your data source. The Survey widget can be displayed in Express Mode in MicroStrategy Web and on the iPad.

The Survey widget provides an easy way to dynamically generate and maintain surveys. If you want to modify the survey after its creation (for example, by adding or editing survey questions), you can update the survey information provided by the attributes and metrics placed on the widget’s grid. These changes will automatically be reflected and displayed in the widget, without requiring any additional configuration changes to the widget in the document.
To create and add a Survey widget to a document, you must perform the following basic steps:

- Import the appropriate information to use to create and display your survey, such as the survey title and the questions and answers to include in the survey, into MicroStrategy attributes and metrics. Once you have added the widget to the document, the widget will automatically be displayed based on the data in these attributes and metrics.

- Create a Transaction Services report to link to your Survey widget’s grid. This report should contain the input objects required to submit survey answers to your data source, as described in the links below.

- Create the document to which you want to add the widget. The document’s dataset should contain each of the attributes and metrics that you want to use to create and display your survey.

- Create the Survey widget, placing the appropriate attributes and metrics onto the widget’s grid.

- Configure the widget as a Transaction Services-enabled grid.

- Add an action selector button (or link) to the document to allow users to submit their data.

For detailed steps to create and add a Survey widget to a document, see Creating and adding a Survey widget to a document, page 350. For more information on creating a specific type of survey, including example images, the attributes and metrics that you must provide in order to display the survey, and the input objects required for the Transaction Services report, see the appropriate link below:

- Creating a survey with simple survey questions, page 341
- Creating a survey with question sections enabled, page 344
- Creating a survey with question sections and question groups enabled, page 345
- Creating a survey with question sections, question groups, and question tables enabled, page 347
- Showing or hiding follow-up questions in your survey, page 349
- Verifying the format of the survey’s answers, page 350
Creating a survey with simple survey questions

The Survey widget offers a variety of survey question types that users can interact with to submit their answers. The simplest type of survey consists of a list of questions, with no separate question sections, groups, or tables.

The table below contains a list of survey question types you can use to create a simple survey, and a description of each.

<table>
<thead>
<tr>
<th>Question Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text field</td>
<td>First name</td>
<td>A field consisting of one line in which users can enter text. Text fields are suited for questions in which users provide a single line of text, such as an email address. Text fields are represented by a Question Type value of 1.</td>
</tr>
<tr>
<td>Text area</td>
<td>Other</td>
<td>A field in which users can type multiple lines of text. Text areas are suited for comments sections in which users provide multiple lines of written content. Text areas are represented by a Question Type value of 2.</td>
</tr>
<tr>
<td>Radio button</td>
<td>Driving</td>
<td>A list of radio buttons. Users can select one radio button at a time. Radio buttons are represented by a Question Type value of 3.</td>
</tr>
<tr>
<td>Check box</td>
<td>Insurance</td>
<td>A list of check boxes. Users can select more than one check box at the same time. Check boxes are represented by a Question Type value of 4.</td>
</tr>
<tr>
<td>Drop-down list</td>
<td>Slightly</td>
<td>A drop-down list contains a list of options. Users can select one option from the drop-down list at a time. Drop-down lists are represented by a Question Type value of 5.</td>
</tr>
<tr>
<td>Likert scale</td>
<td>Scale</td>
<td>A series of radio buttons that users can choose from to rate an item on a numeric scale. For example, users can choose 1 to strongly disagree with a statement, or 5 to strongly agree. Likert scale questions are represented by a Question Type value of 6.</td>
</tr>
</tbody>
</table>
In order to create and add a Survey widget with simple survey questions to a document, your document’s dataset must include attributes and metrics to provide data for the following survey options:

For a list and descriptions of all survey options available, see *Specifying display options for a Survey widget, page 356.*

- Survey ID
- Question ID
- Question Title
- Question Type
- Answer ID
- Answer Title

<table>
<thead>
<tr>
<th>Question Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Please rank the following</td>
<td>Drag and drop ranking</td>
<td>A list containing options that users can click and drag to rank them from highest to lowest. Drag and drop ranking questions are represented by a Question Type value of 9.</td>
</tr>
<tr>
<td></td>
<td>Star ranking</td>
<td>A row of stars that users can use to submit a specific star rating out of five stars (such as four out of five stars). Star rating questions are represented by a Question Type value of 10.</td>
</tr>
<tr>
<td></td>
<td>Group question</td>
<td>When you display questions in a question group or table, the question with a Question Type value of 11 is treated as the main question. For example, in the question table displayed to the left, Rate the Cars has a Question Type of 11, and is displayed as a header above the rest of the questions, including Performance, Safety, Price, and My Next Car Will Be. For more information on question groups, see <em>Creating a survey with question sections and question groups enabled, page 345.</em> For more information on question tables, see <em>Creating a survey with question sections, question groups, and question tables enabled, page 347.</em></td>
</tr>
</tbody>
</table>
• **Answer Value**

• **Current Answer**

Each attribute or metric that you want to use to display the survey must be placed on the widget’s grid. An example grid is shown in the image below. In the example, the survey contains:

• Four separate text field questions, one each for the user’s First Name, Last Name, Email, and Address.

• A question called Your Driving Experience, which presents the user with four radio buttons to select from. The radio button options are Less than 1 year, 1-3 years, 4-10 years, and More than 10 years.

• A question called The Companies You Have Insured Your Car With, which presents the user with a series of check boxes, each corresponding to an insurance company.

• A question called Other Comments?, which provides the user with a text area in which to type additional comments.

You can specify the following optional survey information for simple surveys:

• **Customer ID**

• **Survey Title**

• **Survey Description**

• **Survey Status**

• **Question Number**

• **Question Description**
• Required

The Transaction Services report that you link to the Survey widget’s grid must contain the following input objects:

• Customer ID (optional)
• Survey ID
• Question ID
• Answer ID
• Answer Value

For full steps to create a Transaction Services report, see the Custom SQL Queries: Freeform SQL and Query Builder chapter in the Advanced Reporting Guide. For detailed steps to create and add a Survey widget to a document, see Creating and adding a Survey widget to a document, page 350.

Creating a survey with question sections enabled

You can create a survey with questions divided up into multiple sections. Each section is displayed on a separate page in the survey, and users can skip to a specific section by selecting the section’s title from a drop-down list, as shown in the image below.

In addition to the survey information required to create a survey with simple questions, you must provide report objects on the widget’s grid to define the following survey options:

For a list and descriptions of all survey options available, see Specifying display options for a Survey widget, page 356.
• Section ID
• Section Title

The following are survey options you can specify in addition to the optional survey information that you can provide for simple surveys:

• Section Description

The Transaction Services report that you link to the Survey widget’s grid must contain the following input objects:

• Customer ID (optional)
• Survey ID
• Question ID
• Answer ID
• Answer Value

For full steps to create a Transaction Services report, see the Custom SQL Queries: Freeform SQL and Query Builder chapter in the Advanced Reporting Guide. For detailed steps to create and add a Survey widget to a document, see Creating and adding a Survey widget to a document, page 350.

**Creating a survey with question sections and question groups enabled**

In addition to simple surveys containing text fields and radio buttons, you can create surveys that contain groups of survey questions, such as a group of
fields in which users can enter their first name, last name, and address. The table below contains a list of question group types and a description of each.

<table>
<thead>
<tr>
<th>Group Type</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Personal Info *</td>
<td>Custom grouping</td>
<td>A group of survey questions. For example, you can display a group of text fields containing related information, such as the multiple lines of a mailing address. You can mix and match question types to customize your question group. The custom grouping is represented by a Group Style value of 1.</td>
</tr>
</tbody>
</table>

In addition to the survey information required to create a survey with simple questions, you must provide report objects on the widget’s grid to define the following survey options:

- Section ID
- Section Title
- Question Number
- Group Style

The following are survey options you can specify in addition to the optional survey information that you can provide for simple surveys:

- Section Description
- Question Order
- Group Break

The Transaction Services report that you link to the Survey widget’s grid must contain the following input objects:

- Customer ID (optional)
- Survey ID
- Question ID
• Answer ID

• Answer Value

For full steps to create a Transaction Services report, see the *Custom SQL Queries: Freeform SQL and Query Builder* chapter in the *Advanced Reporting Guide*. For detailed steps to create and add a Survey widget to a document, see *Creating and adding a Survey widget to a document, page 350*.

**Creating a survey with question sections, question groups, and question tables enabled**

You can enable a survey to display tables of questions. For example, you can display car manufacturers across several columns, then allow users to rate each manufacturer on the performance, safety, and price of their cars, as shown in the image below. Each question (in this example, Performance, Safety, Price, and My Next Car Will Be) is displayed in a separate row.

![Survey Example](image)

In addition to the survey information required to create a survey with simple questions, you must provide report objects on the widget’s grid to define the following survey options:

For a list and descriptions of all survey options available, see *Specifying display options for a Survey widget, page 356*.

• Section ID

• Section Title

• Question Number

• Group Style. The question table is represented by a Group Style value of 3.
• **Group Answer ID**

The Question Number is the unique ID of the question group (or table) to which a question belongs. Each question that belongs to a question group or table will share the same Question Number value. In the example above, the Performance, Safety, Price, and My Next Car Will Be questions are all part of a single question table. They are all represented by a Question Number value of 3 in the widget’s grid, as shown in the image below.

The Group Answer ID is the unique ID of each column of answers within a question table. For example, in the image above, the Rate the Cars question contains four answer columns, each representing a different car manufacturer. As shown in the image below, each answer column is represented by a different Answer ID (Audi corresponds to a value of 5, VW corresponds to a value of 6, and so on).

In the first row of the question table, a star rating control is displayed for each manufacturer, and users can select stars to rate each manufacturer on their performance. In the widget’s grid, the star rating control for Audi is represented by a Group Answer ID of 5 (corresponding to Audi’s Answer ID), the star rating control for VW is represented by a Group Answer ID of 6, and so on.

<table>
<thead>
<tr>
<th>QuestionNum</th>
<th>QuestionID</th>
<th>QuestionTitle</th>
<th>QuestionType</th>
<th>QuestionOrder</th>
<th>GroupAnswerID</th>
<th>GroupStyle</th>
<th>AnswerID</th>
<th>AnswerTitle</th>
<th>AnswerValue</th>
<th>AnswerOrder</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Rate the cars</td>
<td>11</td>
<td>9</td>
<td>3</td>
<td>5</td>
<td>3</td>
<td>8</td>
<td>Audi</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td>Performance</td>
<td>10</td>
<td>1</td>
<td>3</td>
<td>6</td>
<td>3</td>
<td>7</td>
<td>VW</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>9</td>
<td>Safety</td>
<td>10</td>
<td>2</td>
<td>3</td>
<td>6</td>
<td>3</td>
<td>8</td>
<td>None</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>10</td>
<td>Price</td>
<td>10</td>
<td>3</td>
<td>3</td>
<td>6</td>
<td>3</td>
<td>7</td>
<td>None</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>

The following are survey options you can specify in addition to the optional survey information that you can provide for simple surveys:

- **Section Description**
- **Question Order**
- **Group Break**

The Transaction Services report that you link to the Survey widget’s grid must contain the following input objects:

- **Customer ID (optional)**
• Survey ID
• Question ID
• Group Answer ID
• Answer ID
• Answer Value

For full steps to create a Transaction Services report, see the Custom SQL Queries: Freeform SQL and Query Builder chapter in the Advanced Reporting Guide. For detailed steps to create and add a Survey widget to a document, see Creating and adding a Survey widget to a document, page 350.

**Showing or hiding follow-up questions in your survey**

You can configure questions in your survey to be shown or hidden, depending on your respondents’ answers. For example, you can display a follow-up question if the answer to one of your survey questions needs additional comments or clarification.

To show or hide questions in your survey, in addition to the information required to create a survey with simple questions, you must provide a Condition Statement object on the widget’s grid.

For each follow-up question, the Condition Statement checks the answer to an earlier question on the survey and determines whether the question is displayed. For example, Question 8 is a follow-up question that can be displayed only if the answer to Question 5 is yes.

The Condition Statement must be in the following format:

```
SectionID;QuestionID;QuestionNumber;GroupAnswerID=^CheckAnswerID
```

The variables in italics are described below:

• The following variables determine the survey question to check:
  • `SectionID`: If applicable, the Section ID of the question.
  • `QuestionID`: The Question ID.
  • `QuestionNumber`: If applicable, the Question Number.
• **GroupAnswerID**: If applicable, the Group Answer ID for the question.

• **CheckAnswerID**: The Answer ID to compare to the answer for the survey question. If the answers match, the follow-up question is shown.

**Example**: For Question 5, the conditional statement is 1:2;;=^B. This means that if the Answer ID for Section 1, Question 2 is B, Question 5 is displayed on the survey. For any other answer to Question 2, the question is not displayed.

### Verifying the format of the survey’s answers

You can check the text in your respondents’ answers to ensure that they meet certain criteria, such as ensuring that phone numbers follow a specific format. To check an answer, you use a regular expression, which searches for and matches patterns in the text.

For an introduction to regular expressions, see the following W3Schools reference: [http://www.w3schools.com/jsref/jsref_obj_regexp.asp](http://www.w3schools.com/jsref/jsref_obj_regexp.asp).

To check the text in your survey’s answers, in addition to the information required to create a survey with simple questions, you must provide a Restriction object on the widget’s grid.

For survey answers that are text fields or text areas, the Restriction object defines the expected format of the answer. You define your restrictions using regular expressions. Some examples of regular expressions that you can use include:

• To require that phone numbers use the format 123-123-1234, use the expression `\d{3}-\d{3}-\d{4}`.

• To require that respondents answer the question with only A, B, or C, use the expression `(A|B|C)`.

### Creating and adding a Survey widget to a document

#### Prerequisites

• You must have the Web Configure Transaction privilege.

• This procedure assumes that the Transaction Services report that you want to link to the widget’s grid has already been created. This report
must contain the input objects required to submit user answers to your data source. For steps to create a Transaction Services report, see the Advanced Reporting Guide. For a list of the input objects required for each type of Survey widget, see the appropriate link below:

- Creating a survey with simple survey questions, page 341
- Creating a survey with question sections enabled, page 344
- Creating a survey with question sections and question groups enabled, page 345
- Creating a survey with question sections, question groups, and question tables enabled, page 347
- Showing or hiding follow-up questions in your survey, page 349
- Verifying the format of the survey’s answers, page 350

- This procedure assumes that you have already created the document to which you want to add the Survey widget. This document must have a dataset containing each attribute or metric that you want to use to create and display your survey. For details on the report objects required for each type of survey, see the appropriate link above.

To create and add a Survey widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, select Grid.

3. Click the location on your document where you want to place the grid. The grid is automatically added to your document and displayed. If desired, resize the grid by clicking and then dragging its handles.

To define the Survey widget

4. From the Dataset Objects panel on the left, select attributes and metrics and drag them on top of the grid to provide information about how to display the Survey widget, such as the questions and answers to display in the survey. Be sure to sort values in the grid in ascending order, first by Question ID, then by Answer ID. For a list of the report objects required to display a survey containing simple questions, sections, question groups, or question tables, see the appropriate link below:

- Creating a survey with simple survey questions, page 341
• Creating a survey with question sections enabled, page 344
• Creating a survey with question sections and question groups enabled, page 345
• Creating a survey with question sections, question groups, and question tables enabled, page 347
• Showing or hiding follow-up questions in your survey, page 349
• Verifying the format of the survey’s answers, page 350

5 Right-click the grid and select Properties and Formatting. The Properties and Formatting dialog box opens.

6 From the left, click Grid. Clear the Enable incremental fetch in Grid check box, then click Apply to apply your changes.

7 From the left, click Widget. From the Widget drop-down list, point to DHTML, then select Survey.

8 Click the Widget Properties icon. The Survey dialog box opens.

9 You can determine whether to show the title of the survey in the widget. Do one of the following:
   • To show the title of the survey, select the Show survey title check box.
   • To display the widget without a title, clear the Show survey title check box.

10 From the Color scheme drop-down list, select a color scheme to use when displaying the survey.

11 You can choose whether to display sections of questions in the widget. Do one of the following:
   • To allow question sections, select the Enable sections check box.
   • To display the survey without any question sections, clear the Enable sections check box.

12 You can choose to display groups of questions in the survey, such as a group of fields in which users can enter their first name, last name, and address. Do one of the following:
   • To allow question groups, select the Support question group check box.
• To display the survey without question groups, clear the **Support question group** check box.

13 You can choose to display tables of questions in the survey. This option is available if the Support question group option is selected. Do one of the following:

• To allow question tables, select the **Support question table** check box.

• To display the survey without question tables, clear the **Support question table** check box.

14 The survey options that you can use to customize the widget are displayed in the table at the bottom of the Survey dialog box. Do one of the following:

• To display only the survey options that you must provide an attribute or metric for in order to display the widget, select the **Show only required field** check box.

• To display all options available regardless of whether an attribute or metric is required, clear the **Show only required field** check box.

15 The table at the bottom of the Survey dialog box displays a list of all options you can configure for the survey, such as the title of the survey, the possible answers for each question, and whether an answer is required for each question. Each option is listed as a row in the table.

For each row that contains an option that you want to configure, from the drop-down list for the option under Template Units, select the attribute or metric that you want to use to provide data for the option. An example
image is shown below. For a list of available survey options, see
*Specifying display options for a Survey widget, page 356.*

<table>
<thead>
<tr>
<th>Survey Elements</th>
<th>Required</th>
<th>Template Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey ID</td>
<td>yes</td>
<td>SurveyID</td>
</tr>
<tr>
<td>Question ID</td>
<td>yes</td>
<td>QuestionID</td>
</tr>
<tr>
<td>Question Title</td>
<td>yes</td>
<td>QuestionTitle</td>
</tr>
<tr>
<td>Question Type</td>
<td>yes</td>
<td>QuestionType</td>
</tr>
<tr>
<td>Answer ID</td>
<td>yes</td>
<td>AnswerID</td>
</tr>
<tr>
<td>Answer Title</td>
<td>yes</td>
<td>AnswerTitle</td>
</tr>
<tr>
<td>Answer Value</td>
<td>yes</td>
<td>AnswerValue</td>
</tr>
<tr>
<td>Current Answer</td>
<td>yes</td>
<td>UserInput</td>
</tr>
</tbody>
</table>

16 When you are finished selecting attributes and metrics, click **OK** to return to the Properties and Formatting dialog box.

17 Click **OK** to apply your changes and return to the document.

**Configure the widget as a Transaction Services-enabled grid**

18 Right-click the widget’s Grid/Graph and select **Configure Transaction.** The Configure Transaction dialog box opens.

19 Click the browse button (...). Navigate to and select the Transaction Services report that you created to link to the widget.

20 A list of each input object in the Transaction Services report is displayed in the Transaction Input column. For each input object, from the **Grid Object** drop-down list, select the attribute form or metric to link to the input object, as shown in the image below.
You must map the input object for the current answer to the same report object that you used to provide the current answer information in the Survey dialog box in the steps above.

21 Select the **Mark rows for selection (tabular grids only)** check box.

22 Clear the **Submit unchanged records** check box.

23 Select any additional options that you want to use to configure your Transaction Services-enabled grid, then click **OK** to apply your changes. For full steps, see the *Report Services Document Creation Guide*.

**Add a submit button to the document**

24 From the **Insert** menu, point to **Selector**, then select **Action Selector Button**. Click the location on your document that you want to add the submit button to. The button is automatically created and added to the document.

25 Right-click the button or link that you added above and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

26 From the left, click **Selector**.

27 From the **Action Type** drop-down list, select **Submit**.

28 Select any additional options that you want to use to format the button, then click **OK** to apply your changes. You can also add an action selector
link for users to click to submit their survey answers instead of a button. For full steps to create an action selector button or link, see the Report Services Document Creation Guide.

**Specifying display options for a Survey widget**

The table below lists the survey options that you can provide values for when creating and displaying a Survey widget, and a description of each survey option.

<table>
<thead>
<tr>
<th>Survey Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer ID</td>
<td>The unique ID of the survey designer.</td>
</tr>
<tr>
<td>Survey ID</td>
<td>The unique ID of the survey.</td>
</tr>
<tr>
<td>Survey Title</td>
<td>The title of the survey.</td>
</tr>
<tr>
<td>Survey Description</td>
<td>The description of the survey.</td>
</tr>
<tr>
<td>Survey Status</td>
<td>Whether the survey is still being designed and tested (a value of 0), open for survey participants (a value of 1), or closed to participants (a value of 2).</td>
</tr>
<tr>
<td>Section ID</td>
<td>The unique ID of each section of questions. This option is available if sections are enabled.</td>
</tr>
<tr>
<td>Section Title</td>
<td>The title used to identify the section. You can select the title of a section in the widget to skip to a specific section in the survey. This option is available if sections are enabled.</td>
</tr>
<tr>
<td>Section Description</td>
<td>The description of the section. This option is available if sections are enabled.</td>
</tr>
<tr>
<td>Question Number</td>
<td>The unique ID of the question group or table to which a question belongs. This survey option is available if question groups are enabled.</td>
</tr>
<tr>
<td>Question ID</td>
<td>The unique ID of the survey question or question group.</td>
</tr>
<tr>
<td>Question Title</td>
<td>The title of the question, question group, or question table, such as “Please rate the service you received”. Generally, the title of a question is displayed above or beside the question, depending on the question type.</td>
</tr>
<tr>
<td>Question Description</td>
<td>The description of the question.</td>
</tr>
</tbody>
</table>
### Survey Option | Description
--- | ---
**Question Type** | The type of survey question users are presented with, such as radio buttons or a drop-down list. The following survey question types are available:
- Text field, represented by a value of 1.
- Text area, represented by a value of 2.
- Radio button, represented by a value of 3.
- Check box, represented by a value of 4.
- Drop-down list, represented by a value of 5.
- Likert scale, represented by a value of 6.
- Ranking, represented by a value of 9.
- Star rating, represented by a value of 10.
- Group question, represented by a value of 11.
For example images of each survey question type available, see *Creating a survey with simple survey questions, page 341.*

**Required** | Whether the user must answer the question in order to submit their survey answers. Required questions are represented by a value of 1 and optional questions are represented by a value of 0.

**Question Order** | The order in which to display the questions in the survey. If question groups are enabled, this option represents the order in which to display questions in each question group.

**Group Answer ID** | The unique ID of each column of answers within a question table. For an example, see *Creating a survey with question sections, question groups, and question tables enabled, page 347.*

**Group Break** | Whether to start a new line in the question group after the current question. For example, you can choose to display fields for the user’s first name and last name on the first line of a question group, followed by a field for their address on the second line. A value of 1 represents a new line and a value of 0 represents no new line.

**Group Style** | The style in which the question group or table is displayed, such as a group of fields in which to enter contact information. The group styles are:
- Custom grouping, represented by a value of 1.
- Question table, represented by a value of 3. For more information on question tables, see *Creating a survey with question sections, question groups, and question tables enabled, page 347.*
For example images of each type of question group available, see *Creating a survey with question sections and question groups enabled, page 345.*

**Answer ID** | The unique ID of the survey answer.

**Answer Title** | The title of the answer, such as "Less than one year" or "One to three years".

**Answer Value** | The value of the survey answer as represented in your data source.

**Current Answer** | The currently selected survey answer. The report object used to provide survey answers must be of the string data type.
Creating a Thermometer widget

A Thermometer widget is a simple status indicator that displays a thermometer set to a certain temperature level. The temperature level within the thermometer is a visual representation of a single metric value. This type of widget is ideal for tracking progress toward a goal. Like the Gauge and Cylinder widgets, this type of widget is designed to display the value of a single metric.

The Thermometer widget is most useful when combined with a selector because this allows users to selectively choose specific metric values to display in the thermometer. In the image below, the thermometer level represents the number of units sold, based on the Units Sold metric.
To create and add a Thermometer widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select Thermometer.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.

To add objects to the Grid/Graph that contains the widget

5. From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:
   a. Place one attribute on the rows. The attribute elements are displayed in the selector, to allow users to display different data in the widget.
   b. Place one metric on the columns. The metric values determine the temperature level displayed in the thermometer.

6. To allow users to use a selector to change the metric value displayed in the widget:
   a. Insert a selector next to the widget. For steps to insert a selector, see Methods to create a selector, page 129.
   b. Choose an attribute from the dataset that is not already in the Grid/Graph and set this attribute as the Source of the selector. Do not include this attribute in the Grid/Graph. It is used to populate the selector.
   c. Set the Grid/Graph as the target of the selector.

7. It can be useful to drag the dataset from the Dataset Objects panel and place it beneath the selector. This allows users to see the dataset’s values as they select different attribute elements from the selector and see how their choices change the appearance of the widget.
By default, the values on the side of the Thermometer widget range from 1 to 100. If metric values on your report are larger than 100 or less than 0:

a. Right-click the widget and select Properties to open the Thermometer dialog box.

b. In the Max Value field, enter a number larger than the largest metric value on the report. For example, if the metric values on the report range from 60,000 to 1,000,000, enter a number such as 1,100,000 to accommodate larger values in the data.

c. In the Min Value field, enter a number that is less than the smallest metric value on the report. For example, if the metric values on the report range from -20,000 to 1,000,000, enter a number such as -30,000 to accommodate smaller values in the data.

d. Click OK to save your changes.

To enable the widget to be displayed

View and test your results by selecting Flash Mode from the Home menu.

– If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 61.

Creating a Time Series Slider widget

A Time Series Slider widget is an area graph that allows an analyst to choose which section of the graph to view at a time. The widget consists of two related graphs, one positioned above the other. The top graph is the controller, and contains a slider. The bottom graph is the primary graph. You use the slider on the controller to select some portion of the controller, which determines the range of data visible in the primary graph.

Time series datasets are often long and require analysis from both a macro and micro view. Therefore, the time series slider widget requires only one attribute, preferably one with many values. This attribute is normally time-based, but it does not have to be. The widget also requires only one metric. In the graph:

• The X-axis represents the attribute. In the image below, this is the Month attribute.
• The Y-axis represents the metric. In the image below, this is the Revenue metric.

To create and add a Time Series Slider widget to a document

1. In MicroStrategy Web, open the document in Design or Editable Mode.

2. From the Insert menu, point to Widgets, then Flash, and select Time Series Slider.

3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.

4. If desired, resize the widget by clicking and then dragging its handles.
To add objects to the Grid/Graph that contains the widget

5 From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

a Place at least one attribute on the rows. The first attribute is typically time-based, such as a Day or Quarter attribute. Its elements are displayed on the X-axis.

b Place at least one metric on the columns. The metric values are displayed on the graph report’s Y-axis.
   – If you include two metrics, a line graph and an area graph are displayed together.

6 To allow users to use a selector to change the metric value displayed in the widget:

a Insert a selector next to the widget. For steps to insert a selector, see Methods to create a selector, page 129.

b Choose an attribute from the dataset that is not already in the Grid/Graph and set this attribute as the Source of the selector. Do not include this attribute in the Grid/Graph. It is used to populate the selector.

c Set the Grid/Graph as the target of the selector.

7 It can be useful to drag the dataset from the Dataset Objects panel and place it beneath the selector. This allows users to see the dataset's values as they select different attribute elements from the selector and see how their choices change the appearance of the widget.

To enable the widget to be displayed

8 View and test your results by selecting Flash Mode from the Home menu.

   – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 61.

A Time Series Slider widget can be used as a selector. For an example and more information, see Using a Time Series Slider widget as a selector, page 453.
Creating a Waterfall widget

A Waterfall widget highlights the increments and decrements of the values of metrics over time. Analysts can use the widget to identify aspects of their business that are contributing to the fluctuations in the values. The widget can also be used to perform “what-if” analyses.

The widget consists of a group of clustered bars displayed from left to right. The X-axis contains either attribute elements or metrics, depending on where the attributes and metrics are placed on the widget’s template. The Y-axis displays a range of values based on the metrics on the widget’s template.

In the example shown below, metrics are displayed along the X-axis. The first bar represents the amount of sales revenue generated in 2006. The remaining bars in the widget represent the other metrics on the X-axis, including the Depreciation and Tax Expense metrics. These bars depict the business factors that diminished revenue and one factor (the Other Gains and Losses metric) that increased revenue. As a group, these bars highlight the contributions of various aspects of the business on total revenue from sales. This final value is represented by the last bar on the right, which represents Net Income for 2006.
The increments and decrements in a Waterfall widget can be calculated and displayed in either of the following ways:

- Increments and decrements are calculated and displayed in the widget based on the metrics that are included on the Grid/Graph and the order of those metrics.
  - It is recommended that you use this method when the metrics are on the rows of the Grid/Graph and the attributes are on the columns of the Grid/Graph. This allows you to place the metrics along the X-axis in a specific order and view the increment and decrement bars in that order.
  - To ensure that the metrics determine how increments and decrements are calculated and displayed, select the **Increments/Decrements Provided** check box. This is included in the steps below to create the widget.

- Increments and decrements are automatically determined by the widget when it is displayed in MicroStrategy Web. They are calculated according to the metrics included on the Grid/Graph.
  - It is recommended that you use this method when the metrics are on the columns of the Grid/Graph and the attributes are on the rows of the Grid/Graph. Using this method requires that you have placed metrics on the columns that depict the total value for each unit of time.
  - To ensure that the widget automatically determines the increments and decrements, clear the **Increments/Decrements Provided** check box. This is included in the steps below to create the widget.

---

**To create and add a Waterfall widget to a document**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Waterfall**.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.
4. If desired, resize the widget by clicking and then dragging its handles.
To add objects to the Grid/Graph that contains the widget

5 From the Dataset Objects panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:

   a Place at least one metric on the rows or columns. Any number of metrics and attributes can be placed on the rows and columns.

      – To ensure that metrics generate the increment and decrement bars in the widget, place the metrics on the rows.

      – Attributes or metrics that are placed on the rows are displayed on the X-axis of the widget. If the rows contain both attributes and metrics, a combination of those objects is displayed.

      – Attributes and metrics that are placed on the columns are displayed in the legend. If the columns contain both attributes and metrics, a combination of those objects is displayed.

To enable the widget to be displayed

6 View and test your results in one of two ways:

   • Select Flash Mode from the Home menu.

      – If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see Determining the display modes users can choose to work in, page 61.

   • Select Interactive Mode from the Home menu.

      – To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see Defining how a widget is displayed in different views and modes, page 369.

To specify whether the metrics should generate the increment and decrement bars

7 Right-click the widget and select Properties. The Properties dialog box opens.

8 Click the Data tab, then do one of the following:

   • To ensure that increments and decrements bars are displayed in the widget in the same order of the metrics on the Grid/Graph, select the Increments/Decrements Provided check box.
To ensure that the increments and decrements bars in the widget are generated automatically, clear the **Increments/Decrementes Provided** check box. It is recommended that you use this method when the metrics are placed on the columns of the Grid/Graph and the attributes are placed on the rows.

9. On the Data tab, use the **Text for Last Entry** field to specify a name or label for the bar on the far right of the widget. For example, you can create a label for the bar called Final Value or End of 2008.

10. Click **OK**.

A Waterfall widget does not need a separate selector to allow a user to interact with it. However, you can use a Waterfall widget as a selector. For an example and more information, see *Using a Time Series Slider widget as a selector, page 453*.

**Creating a Weighted List Viewer widget**

A Weighted List Viewer widget combines the data visualization techniques of thresholds and graphical weighting into a single visualization. This enables the analyst to assess the performance of a group of items.

Thresholds in the widget highlight rows based on the value of the first metric on the Grid/Graph that contains the widget. Specifically, rows are highlighted according to the range of values from the first metric on the Grid/Graph’s columns. The rows are also ordered automatically so that metrics that are performing well are at the top and metrics that are
performing poorly are at the bottom. A stacked bar graph is included next to the grid; it indicates the relative contribution, or weight, of each row.

In summary, the Weighted List Viewer widget has the following characteristics:

- A grid that provides attribute and metric values with threshold colors applied to the values from top to bottom. The color bands on the grid reflect the range of values of the first metric on the Grid/Graph that contains the widget.
  - In the example above, the top rows are green and represent the maximum value of the Order Count metric. The next rows are black, denoting neutral metric values, and gradually change into the red of the bottom rows. Red represents the minimum range of values of the Order Count metric.
  - The light-to-dark color gradient is automatically generated by the widget.
  - You can specify whether to divide the metric values into two or three threshold color bands. (For the steps, see Formatting a Weighted List Viewer widget, page 439.)
- A stacked contribution bar graph on the left that depicts the relative contribution or percent-to-total calculation of a metric. This bar reflects the values of the second metric on the Grid/Graph that contains the widget.
Specific colors are used to depict good, neutral, and poor performance:
- Green indicates good performance
- Black indicates neutral performance
- Red indicates poor performance

You can change these color settings, as described in *Formatting a Weighted List Viewer widget, page 439.*

---

**To create and add a Weighted List Viewer widget to a document**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Insert** menu, point to **Widgets**, then **Flash**, and select **Weighted List Viewer**.
3. Click the location on your document where you want to place the widget. The Grid/Graph containing the widget is displayed. A small icon at the bottom right corner of the Grid/Graph identifies the type of widget you have added to the document.
4. If desired, resize the widget by clicking and then dragging its handles.

**To add objects to the Grid/Graph that contains the widget**

5. From the **Dataset Objects** panel on the left, select objects and drag them on top of the widget, based on the following requirements for this widget:
   a. Place at least one attribute on the rows. The attribute’s elements are displayed in the grid rows of the widget. For example, if you place the Region attribute on the rows, each region is listed in the grid in the widget, with corresponding metric values on the right and a contribution graph on the left.
   b. Place at least two metrics on the columns. The values of these metrics are displayed in the grid rows of the widget, along with the attribute. The metric data and corresponding colors displayed in the widget reflect the performance of different attribute elements.
      - The first metric on the columns is the threshold metric. This metric is used to set the color of the rows. These colors are also displayed in the grid on the right side of the widget.
      - The second metric on the columns is the weighting metric that determines the percent-to-total value for each business attribute.
It is used to set the relative size of each section of the contribution graph on the left side of the widget.

- Any additional metrics are displayed in the grid, but do not have any effect on the threshold colors or contribution graph on the left side of the widget.

**To enable the widget to be displayed**

6 View and test your results in one of two ways:

- Select **Flash Mode** from the **Home** menu.
  - If Flash Mode is not available in the Home menu, you must make Flash Mode available in the document. For steps, see *Determining the display modes users can choose to work in, page 61.*

- Select **Interactive Mode** from the **Home** menu.
  - To be viewable in Interactive Mode, the widget must be enabled to be displayed in non-Flash mode. For steps to allow a widget to be displayed in non-Flash mode, see *Defining how a widget is displayed in different views and modes, page 369.*

A Weighted List Viewer widget does not need a separate selector to allow a user to interact with it. However, you can use a Weighted List Viewer widget as a selector. For an example and more information, see *Using a Weighted List Viewer widget as a selector, page 456.*

**Defining how a widget is displayed in different views and modes**

You can determine how a widget is displayed in MicroStrategy Web modes, in MicroStrategy Developer views, on various mobile devices, and when exported. The widget can display as:

- The widget itself
- A placeholder
- Empty space; a message can be displayed in place of the widget
- The underlying Grid/Graph that contains the widget, with the Grid/Graph’s border and background formatting
The following table summarizes how widgets can be displayed. Steps to determine how a widget is displayed in each view/mode are below the table.

<table>
<thead>
<tr>
<th>View or Mode</th>
<th>Display Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MicroStrategy Web</strong></td>
<td></td>
</tr>
<tr>
<td>Design Mode</td>
<td>• Grid/Graph placeholder (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Selector placeholder (for widgets created as selectors)</td>
</tr>
<tr>
<td>Editable Mode</td>
<td>• Grid or graph (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Selector (for widgets created as selectors)</td>
</tr>
<tr>
<td>Express Mode</td>
<td>• Widget (except for widgets created as selectors and the Cylinder, Interactive Stacked Graph, Thermometer, and Time Series Slider widgets)</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Placeholder (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Hidden (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Selector (for widgets created as selectors)</td>
</tr>
<tr>
<td>Flash Mode</td>
<td>• Widget (except for widgets for SDK widgets and mobile devices)</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph report (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Selector (for widgets created as selectors)</td>
</tr>
<tr>
<td>Interactive Mode</td>
<td>• Widget (except for widgets created as selectors and the Cylinder, Interactive Stacked Graph, Thermometer, and Time Series Slider widgets)</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Placeholder (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Hidden (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Selector (for widgets created as selectors)</td>
</tr>
</tbody>
</table>

**Note**: While widgets are interactive in Flash View, the changes cannot be saved.

<table>
<thead>
<tr>
<th><strong>MicroStrategy Developer</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Design View</td>
<td>• Grid/Graph placeholder (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Selector placeholder (for widgets created as selectors)</td>
</tr>
<tr>
<td>Flash View</td>
<td>• Widget (except for SDK widgets and widgets for mobile devices)</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Selector placeholder (for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: While widgets are interactive in Flash View, the changes cannot be saved.</td>
</tr>
<tr>
<td>HTML View</td>
<td>• Grid or graph (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Selector placeholder (for widgets created as selectors)</td>
</tr>
<tr>
<td>PDF View</td>
<td>• Grid or graph (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Placeholder (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Hidden (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Selector placeholder (for widgets created as selectors)</td>
</tr>
</tbody>
</table>

**MicroStrategy Mobile**

<p>| Android                    | • Widget (for Android widgets)                                                     |
|                            | • Grid or graph (except for widgets created as selectors)                           |
|                            | • Selector (for widgets created as selectors)                                      |</p>
<table>
<thead>
<tr>
<th>View or Mode</th>
<th>Display Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>iPad</td>
<td>• Widget (for iPad widgets)</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Selector (only for widgets created as selectors)</td>
</tr>
<tr>
<td>iPhone</td>
<td>• Widget (for iPhone widgets)</td>
</tr>
<tr>
<td></td>
<td>• Grid or graph (except for widgets created as selectors)</td>
</tr>
<tr>
<td></td>
<td>• Selector (only for widgets created as selectors)</td>
</tr>
</tbody>
</table>

**Exporting**

| To Excel    | • Grid or graph (except for widgets created as selectors)                       |
|             | • Placeholder (except for widgets created as selectors)                         |
|             | • Hidden (except for widgets created as selectors)                              |
|             | • Selector placeholder (for widgets created as selectors)                       |
| To Flash    | • Widget (except for widgets for mobile devices and SDK widgets)                |
|             | • Grid or graph (except for widgets created as selectors)                       |
| To HTML     | • Grid or graph (except for widgets created as selectors)                       |
|             | • Placeholder (except for widgets created as selectors)                         |
|             | • Hidden (except for widgets created as selectors)                              |
|             | • Selector placeholder (only for widgets created as selectors)                  |
| To PDF      | • Grid or graph (except for widgets created as selectors)                       |
|             | • Placeholder (except for widgets created as selectors)                         |
|             | • Hidden (except for widgets created as selectors)                              |
|             | • Selector placeholder (for widgets created as selectors)                       |

**Displaying widgets in Flash**

In Flash Mode in MicroStrategy Web and Flash View in MicroStrategy Developer, the widget is displayed by default, and a user can interact with it. Any user-initiated changes to the widget can be saved in Flash Mode (Web), but not in Flash View (Developer).

You can specify that the widget displays as a grid or graph report instead. For example, you may want to display the same data as both a widget and a grid or graph report, to allow users to see information at a glance with the widget, and to see in-depth details with the grid or graph report.

SDK widgets and widgets for mobile devices cannot be displayed as widgets in Flash. They are displayed as grid or graph reports in Flash.
Displaying widgets in Editable Mode and Design Mode/View

In Editable Mode in MicroStrategy Web, a grid or graph report based on the widget’s data is always displayed. In Developer’s Design View and Web’s Design Mode, the Grid/Graph container is displayed, without data.

Displaying widgets in HTML View and PDF View

You can determine how widgets are displayed in Developer’s HTML View and PDF View, by setting the Alternative Display, described in Defining how a widget is displayed in different display modes, page 374. The widget can:

• Display a grid or graph report based on the widget’s data.

• Display an empty Grid/Graph placeholder. The Grid/Graph container is shown, with border and background formatting. In Interactive Mode and Express Mode in MicroStrategy Web, the following message is displayed within the container: “Flash Widgets cannot be rendered in this display”, as shown in the example below.

For information on formatting a Grid/Graph container, see the Report Services Document Creation Guide.

• Hide the Grid/Graph so that nothing is displayed.

If you choose to hide the Grid/Graph, you can display a message in place of the widget. To do this, add a text field behind the widget. This text field is displayed only when the widget is hidden. For an example and a procedure, see Displaying a message in place of a widget, page 375.
Displaying widgets in Interactive Mode and Express Mode

In Web’s Interactive Mode and Express Mode, the widget can:

- Display as a widget.
- Display according to the Alternative Display setting described in Defining how a widget is displayed in different display modes, page 374.

The following widgets cannot be displayed as widgets in Interactive Mode or Express Mode: Cylinder, Date Selection widget created as a selector, Fish Eye Selector created as a selector, Interactive Stacked Graph, Thermometer, Time Series Slider, and widgets for mobile devices.

Exporting widgets

A widget exported to Excel or PDF displays according to the Alternative Display setting described in Defining how a widget is displayed in different display modes, page 374.

A widget exported to Flash displays as either a widget or a grid or graph report, depending on the Flash setting. SDK widgets and widgets for mobile devices are always exported to Flash as grid or graph reports.

Widgets in MicroStrategy Mobile

For MicroStrategy Mobile, you can determine whether mobile widgets are displayed as widgets or grid or graph reports on mobile devices. For steps, see Defining how a widget is displayed in different display modes, page 374.

Non-mobile widgets are always displayed as grid or graph reports on mobile devices.

For a list of the widget types that display on each type of mobile device, see the Mobile Design and Administration Guide.
Defining how a widget is displayed in different display modes

If your users may view a widget in a mode that does not support widget display, use the following steps to determine alternative displays for the widget.

To determine how a widget is displayed in different display modes

1. In MicroStrategy Web, open the document in Design or Editable mode.

2. Right-click the Grid/Graph containing the widget and select Properties and Formatting. The Properties and Formatting dialog box opens.

3. From the left, select Widget.

4. From the Alternative Display drop-down list, select a display option to use to display the widget if it cannot be displayed as a widget in a particular display mode. The options are:
   - **Show Grid or Graph**: The widget displays as a grid report or a graph report in a Grid/Graph container.
   - **Show Placeholder**: A placeholder displays in place of the widget, with a message stating that the widget cannot be displayed.
   - **Hide Grid or Graph**: The widget is not displayed.

5. Do one of the following:
   - To display the widget as a widget, select the check box for the display mode in which you want to display the widget.
   - To display the widget as specified in the Alternative Display option above, clear the check box for the display mode in which you want to display the alternative.

   The Will render as column updates to list how the widget is displayed in each display mode.

6. Click OK to apply the changes.
Defining which display modes are available to users

A document designer can select the modes that are available for a specific document by enabling each mode that you want to make available for users of the document. If a display mode is available to a user, it appears on the user's View menu and on the Standard toolbar.

To enable Flash Mode, a project administrator must ensure that Flash Mode is enabled for the project, as described in the *MicroStrategy Web Administrator Help*. A document designer or analyst can also disable Flash Mode on his machine if he knows that Flash is not installed or does not want to use Flash. To do this, select **Preferences** at the top of MicroStrategy Web, select **Report Services** on the left, and select to enable or disable Flash Mode.

**To determine which display modes a user can view a document in**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2. From the **Tools** menu, click **Document Properties**. The Properties dialog box opens.
3. From the left, select **Document**.
4. To make a mode available for users to display the document in, select the check box in the **Available display modes** column for that display mode.
5. Clear the check boxes for any display modes that you do not want users to have access to.
6. Click **OK** to apply your changes and return to the document. The next time the document is executed, only the display modes you selected are available in the View menu or on the Standard toolbar.

Displaying a message in place of a widget

Widgets are not displayed in PDF View in Developer. You can select what is displayed to replace the widget. (For more information on the display options, see *Defining how a widget is displayed in different views and modes, page 369*. )
You can either hide the Grid/Graph to which the widget is attached, display a blank space, or display a message in place of the widget. This message indicates to users that the missing widget cannot be displayed in the current mode.

For example, the following thermometer widget is displayed in Flash Mode:

![Thermometer Widget in Flash Mode](image)

However, in Interactive Mode, the following message is displayed in a text field:

![Message in Interactive Mode](image)

Notice that the selector is still displayed on the right, because it is separate from the widget.

In Editable Mode and Design Mode, the Grid/Graph connected to the widget is displayed. If the Grid/Graph does not completely cover the message and its text field, the message is visible as well.

---

**To display a message in place of a widget**

1. In MicroStrategy Web, open the document in **Design** or **Editable Mode**.
2 Right-click the widget and select **Properties and Formatting**. The Properties and Formatting dialog box opens.

3 From the left, click **Widget**.

4 In the **Alternative Display** area, select **Show Placeholder**. A placeholder is displayed in place of the widget, with a message stating that the widget cannot be displayed.

---

**Converting an existing Grid/Graph into a widget**

You can turn any existing Grid/Graph in your dashboard-style document into a widget that is displayed in MicroStrategy Web, as long as the Grid/Graph meets the data requirements for the selected type of widget.

For example, your dashboard-style document contains a Grid/Graph with the Region attribute on the rows and the Profit Margin metric on the columns. You can assign a Gauge widget to this Grid/Graph. When you open the dashboard-style document in Flash Mode, the Grid/Graph is no longer displayed as a Grid/Graph but rather as a Gauge widget. Viewing the widget in Flash Mode allows you to better visualize the metric data in the Grid/Graph.

---

**To convert a Grid/Graph into a widget**

1 In MicroStrategy Developer, open the dashboard-style document in Design View.

2 Insert a Grid/Graph into the dashboard-style document, if one is not already in the dashboard-style document. For a procedure, see the *Report Services Document Creation Guide*.

   The Grid/Graph that you turn into a widget must follow the data and template requirements for that type of widget. For example, a Gauge widget requires one attribute on the rows and one attribute on the columns. Therefore, any Grid/Graph that you want to turn into a widget must have the same objects on its Grid/Graph. If it does not, the Grid/Graph is not displayed correctly as a widget in Flash Mode. For the requirements for each type of widget, refer to the section that describes that widget.
3 Right-click the Grid/Graph to turn into a widget, and select Properties. The Properties dialog box opens.

4 On the Widget tab, select the type of widget from the Widget drop-down list. In Flash Mode, the Grid/Graph displays as this type of widget.

5 You can determine how the widget is displayed in different MicroStrategy Developer views and MicroStrategy Web modes, as outlined in the steps below. For details, see Defining how a widget is displayed in different views and modes, page 369.

   - **HTML View, PDF View** in Developer, or in **Excel**: Select one of the following from the Alternative Display drop-down list:
     
     – **Show grid or graph** to display the Grid/Graph to which the widget is attached.
     
     – **Show placeholder** to display an empty Grid/Graph placeholder instead of the widget.
     
     – **Hide grid or graph** to hide the widget and display nothing.

   - **Flash**: By default, the widget is displayed as a widget in Flash. To display it as a Grid/Graph instead, clear the Flash check box in the Display Widget As column. This setting affects the display of the widget in Flash View in Developer, Flash Mode in MicroStrategy Web, and when exported to Flash.

   - **iPhone**: By default, an iPhone widget is displayed as a widget on an iPhone. To display it as a Grid/Graph instead, clear the iPhone check box in the Display Widget As column.

   - **iPad**: By default, an iPad widget is displayed as a widget on an iPad. To display it as a Grid/Graph instead, clear the iPad check box in the Display Widget As column.

   - **Interactive Mode, Express Mode**: By default, a widget is displayed as a widget in Interactive Mode and Express Mode. To display it based on the Alternative Display setting, clear the DHTML check box in the Display Widget As column.

6 Click OK to save the changes and return to the dashboard-style document.
To enable Flash Mode for Web

You must enable Flash Mode in the dashboard-style document so that you and other users can view the widget in Flash Mode.


8 In the Available display modes list on the Document tab, select the Flash check box.

9 You can specify that this dashboard-style document always opens in Flash Mode when it is initially opened. To do this, select the Default radio button next to Flash.

10 Click OK to return to the dashboard-style document.

To format the widget

11 By default, many widgets automatically inherit some of the formatting of the underlying grid or graph report on which they are based. For example, a widget can be displayed using the font colors and types defined for its underlying graph report. For steps to determine whether a widget inherits formatting and more information on the types of formatting that can be inherited by a widget, see Inherited formatting, page 385.

12 Each type of widget also has additional formatting specific to it. For example, the numbers of a Bubble Grid widget can display as dollars and cents, as percentages, or even as scientific notation. For a complete listing of all formatting available for a specific type of widget, see the section on that widget.

13 Save the dashboard-style document.

Most widgets can also be displayed as widgets in Interactive Mode and Express Mode. For instructions, see Defining how a widget is displayed in different views and modes below.

Linking in widgets

Linking allows users to connect from a widget in a dashboard-style document (the source) to another document or report (the target).
For example, you can link a widget displaying sales information by customer region to a related document, such as the top ten employees by profit. In MicroStrategy Web, the user can click the link in the widget to view this document, compare data, or retrieve additional information.

This section focuses on links in widgets. For an introduction to linking in a document, see the Report Services Document Creation Guide.

If a link is added to an attribute in the widget’s Grid/Graph, the name of the target report or document displays in the tooltip associated with the attribute when the widget is displayed. In the image below, two documents have been added as links to the Region attribute. When the user hovers the cursor over the Web region, the Links menu is displayed. The user can select a linked document from the menu to open it.

You can add links to the following widgets:

- **Data Cloud**: With a link from a Data Cloud widget to a report/document, a user can hover the cursor over an attribute element in the widget to display a tooltip containing the link. The user can then open and view the target report/document from the tooltip link. For example, if the Call Center attribute on the widget is linked to a report on the top 10 employees per call center, a link to this report is displayed in the tooltip when the user hovers the cursor over the New York attribute element in the widget.

- **Heat Map**: With a link from a Heat Map widget to a report/document, a user can hover the cursor over a rectangle or heading in the widget to display a tooltip containing the link. The user can then open and view the target report/document from the tooltip link. For example, if the Region
attribute on the widget is linked to the report Top 10 Employees by Profit, a link to this report is displayed in the tooltip when the user hovers the cursor over the rectangle for the Web region.

- **Image Layout**: A user can display a list of links by clicking an area or bubble marker in the widget, then clicking the arrow icon. The user can then open and view a target report/document by selecting the appropriate link. For example, if the Customer State region on the widget is linked to the report Top 10 Customers by Region, a link to this report is displayed in the list.

- **Interactive Bubble Graph**: With a link from an Interactive Bubble Graph widget to a report/document, the user can hover the cursor over a bubble in the widget to display a tooltip containing the link. The user can then open and view the target report/document from the tooltip link. For example, if the Region attribute on the widget is linked to the report Top 10 Employees by Profit, a link to this report is displayed in the tooltip when the user hovers the cursor over a bubble.

- **Microcharts**: With a link from a Microcharts widget to a report/document, the user can hover the cursor over a bar chart or sparkline graph in the widget to display a tooltip containing the link. The user can then open and view the target report/document from the tooltip link. For example, if the Quarter attribute on the widget is linked to the report Top 10 Employees by Profit, a link to this report is displayed in the tooltip when the user hovers the cursor over a data point in a sparkline graph for the 2009 Q1 quarter.

For examples of what the user sees with a link in each type of widget, see the *Document and Dashboard Analysis Guide*.

Steps to create a link in a widget are below.

**Specifying how prompts are answered in the target**

For each prompt in the target (the report or document being executed from the link), you must select a prompt answer method, which is how to answer the prompt. You also specify how to answer any other prompts that are not listed. These can be prompts that are created as the result of an answer to one of the original prompts in the target, such as a prompt-in-prompt answer. They can also be prompts added to the target later, after the link is created. These prompts are listed as the **Any other prompt** option in the list of prompts in the interface.
The prompt answer methods are briefly described in the table below. See the *Report Services Document Creation Guide* for an expanded description of each method, with an example.

<table>
<thead>
<tr>
<th>Prompt Answer Method</th>
<th>Requirements</th>
<th>Prompts in the Target Are Answered By...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Answer with the same prompt</td>
<td>Same prompt in the target and source</td>
<td>The prompt answer from the source</td>
</tr>
<tr>
<td>Prompt user</td>
<td>None</td>
<td>The user (prompts are displayed when the target is executed)</td>
</tr>
<tr>
<td>Default answer</td>
<td>None</td>
<td>The default prompt answer for the target prompt</td>
</tr>
</tbody>
</table>
| Dynamically                   | • Attribute element prompt in target  
|                               | • Value prompt in target (available only in MicroStrategy Web)                                         | The object selected in the source (for example, the attribute element that the user clicked on)         |
| Empty answer                  | Target prompt must not be required | Nothing (no prompt answer is provided from the source and the user is not prompted)                    |
| Static element list           | Attribute element prompt in target | List of elements created by the link designer Used to pass attribute elements from conditional metrics to the target |
| Current unit                  | Hierarchy prompt in target        | The object selected in the source (for example, the attribute element that the user clicked on)        |
| All valid units               | Hierarchy prompt in target        | Any object to the left of or above the user selection in the source                                      |

**Creating links in widgets**

**Prerequisites**

- Create the source and target documents or reports.
- In the source dashboard-style document, create the widget to add the link to. For steps, see *Converting an existing Grid/Graph into a widget*, page 377.
- Know what types of prompts the targets contain and how they will be answered.
Adding a link to a widget

To add a link to a widget

1. In MicroStrategy Web, run a document in **Design Mode**.
2. Right-click an attribute in the widget’s Grid/Graph, then select **Edit Links**.
3. Type a name for the link in the **URL display text** field.
   - If this is the first link you are adding to this document, click **New**, then type the name for the link.

To define the link

4. Click the **Select Target** icon below **Run this report or document**, to find and select the report or document you want to link to (the target). The Select Target dialog box opens.
5. Navigate to and select the target report/document. Click **OK** to close the dialog box.

To apply prompt answers to the target if the target contains prompts

6. The box below **Run this report or document** contains a list of any prompts included in the target that you chose. Select a target prompt from the box.

7. Select a prompt answer method from the drop-down list:
   - **Answer with the same prompt from the source**: Select this option to automatically use the same prompt answers for both the source report/document and the target report/document. This option requires that the source and target use the same prompts.
   - **Prompt User**: Select this option to prompt the user for answers in the target. Users can enter prompt answers manually. For example, a prompt requires the user to enter a customer age. Instead of choosing the age from a list, users can type the number in the prompt answer text box.
   - **Answer with an empty answer**: Select this option to ignore the prompt in the target, which means that the prompt is not answered. No prompt answer is provided from the source and users are not
prompted to provide answers. However, if the prompt is designed to require an answer, then the user is presented with a screen to provide an answer.

- **Use default answer**: Select this option to use the default prompt answers for the target report/document.

- **Answer dynamically**: Select this option to automatically answer the prompt using the object that the user clicked in the source. This option is available for attribute element prompts and value prompts.

- **Answer using the current unit**: Select this option to automatically answer the prompt using the object that the user clicked in the source. This option is available for hierarchy prompts.

- **Answer using all valid units**: Select this option to answer the target prompt with any object to the left of or above the object that the user clicked in the source. This method passes all selections made on the source, rather than just the selection made for the link. This option is available for hierarchy prompts.

8 For each prompt in the target, repeat the steps above, starting with *To apply prompt answers to the target if the target contains prompts, page 383.*

**To specify the prompt answer method for any other prompts**

Any other prompts are those prompts that are not in the target report/document when you are creating the link, such as prompts added to the target later. By default, the **Prompt user** method is selected for these prompts, but you can change the method.

9 Select **Any other prompts** in the box.

10 Select a prompt answer method from the list. Each is described above.

- Answer with the same prompt from the source
- Prompt user (default)
- Answer with an empty answer
- Use default answer

11 Select the **Open in new window** check box to have the target report/document open in a new window. This allows the target and the source to be viewed simultaneously.

12 Click **OK** to save changes and return to the document.
Introduction

You can format aspects of widgets such as colors, graph axes scaling, fonts, data markers, and more. Different formatting options are available for each type of widget available for dashboard-style documents. For example, you can format the type of cylinder that is displayed in a Cylinder widget or the color of the bubbles in an Interactive Bubble Graph widget.

For descriptions and examples of the different types of widgets, as well as instructions to create them, see Chapter 5, Providing Flash Analysis and Interactivity: Widgets.

To view and interact with widgets, make sure you have the appropriate version of Adobe Flash Player. See the MicroStrategy Readme for the latest supported versions.

Inherited formatting

By default, most widgets automatically inherit some of the formatting contained in their underlying grid or graph report. For example, you can...
define the font colors and types to display in the underlying graph report for a Time Series Slider widget. These formatting options will be used to display the widget as well as the graph report. In order to have the widget inherit underlying formatting from the grid or graph report on which it is based, you may need to change the View Mode and Graph Type of the report. For specific instructions to determine whether or not a widget inherits the underlying formatting, see the appropriate steps to format the widget, listed below.

For details to format the underlying grid or graph reports that the widgets are based on, click Help in the dialog box you are using to format the report, or see the Reports and Graphing chapters of the Advanced Reporting Guide.

### Formatting a widget

Each type of widget allows formatting specific to the type of widget. For example, you can change the number format of the metric values in a Bubble Grid widget, Cylinder widget, or Gauge widget. For an Interactive Stacked Graph widget, you can change the font of the text that appears in the graph and the color of the check boxes on the left side of the graph.

Use the appropriate link below to learn what formatting options are available for the specific type of widget you are working with, and for steps to format the widget.

- Formatting a Bubble Grid widget, page 387
- Formatting a Cylinder widget, page 389
- Formatting a Data Cloud widget, page 390
- Formatting a Date Selection widget, page 392
  - Formatting a Date Selection widget for a mobile device, page 394
- Formatting a Fish Eye Selector, page 394
- Formatting a Funnel widget, page 398
- Formatting a Gauge widget, page 400
- Formatting a Graph Matrix (deprecated) widget, page 402
- Formatting a Heat Map widget, page 404
- Formatting an Image Layout widget, page 407
• Formatting an Interactive Bubble Graph widget, page 408
• Formatting an Interactive Stacked Graph widget, page 412
• Formatting a Media widget, page 414
• Formatting a Microcharts widget, page 416
• Formatting an RSS Reader widget, page 428
  • Formatting an RSS Reader widget for a mobile device, page 432
• Formatting a Thermometer widget, page 432
• Formatting a Time Series Slider widget, page 433
• Formatting a Waterfall widget, page 435
• Formatting a Weighted List Viewer widget, page 439

Formatting options by widget type

Prerequisite

• The widget must be added to the document. For steps, see Creating widgets, page 243.

Formatting a Bubble Grid widget

For an image of a Bubble Grid widget and steps to add one to a document, see Creating a Bubble Grid widget, page 244.

The table below lists the different aspects of the Bubble Grid widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see Defining how a widget is displayed in different display modes, page 374. For steps to enable DHTML, see the MicroStrategy Web Help.
Prerequisite

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see *Determining the display modes users can choose to work in*, page 61.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Color used for the bubbles representing the smallest metric values (minimum color) | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Bubble Grid dialog box opens.  
2 From the Minimum Color palette, select a color for the smallest metric values in the widget.  
3 Click OK to apply your changes. |
| Color used for the bubbles representing the largest metric values (maximum color) | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Bubble Grid dialog box opens.  
2 From the Maximum Color palette, select a color for the largest metric values in the widget.  
3 Click OK to apply your changes. |
| Background color of the widget | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Bubble Grid dialog box opens.  
2 From the Background Color palette, select a color for the background of the widget.  
3 Click OK to apply your changes. |
| Color of the borders of the widget | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Bubble Grid dialog box opens.  
2 From the Border Color palette, select a color for the borders of the widget.  
3 Click OK to apply your changes. |
| The color and font for the text in labels | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Bubble Grid dialog box opens.  
2 From the Labels Text Color palette, select a color for the text of the labels.  
3 From the Labels font drop-down list, select a font for the text of the labels.  
4 Click OK to apply your changes. |
Formatting a Cylinder widget

For an image of a Cylinder widget and steps to add one to a document, see *Creating a Cylinder widget, page 247.*

The table below lists the different aspects of the Cylinder widget that you can format, and describes the steps to format them in MicroStrategy Web.

**Prerequisite**

- The following procedures assume that you have enabled viewing the document in Flash Mode. For steps, see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Whether the widget legend is displayed or hidden | **1** In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Bubble Grid dialog box opens.  
**2** Select or clear the **Show Legend** check box.  
**3** Click OK to apply your changes. |
| Maximum radius of the bubbles in the widget | **1** In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Bubble Grid dialog box opens.  
**2** Enter a number in the **Maximum Radius** field to determine the radius of the largest bubble in the widget. All other bubbles are sized relative to that bubble.  
**3** Click OK to apply your changes. |

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Colors and shading scheme for the cylinder | **1** In Flash Mode, right-click the widget and select Properties. The Cylinder dialog box opens.  
**2** From the **Cylinder Type** drop-down list, select a shading scheme for the cylinder.  
**3** Click OK to apply your changes. |
Formatting widgets dashboard s and widgets creation guide

Formatting options by widget type © 2015 MicroStrategy, Inc.

Formatting a Data Cloud widget

For an image of a Data Cloud widget and steps to add one to a document, see Creating a Data Cloud widget, page 249.

The table below lists the different aspects of the Data Cloud widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see Defining how a widget is displayed in different views and modes, page 369. For steps to enable DHTML, see the MicroStrategy Web Help.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Numbers that appear at the bottom and top of the cylinder (minimum and maximum) | 1 In Flash Mode, right-click the widget and select Properties. The Cylinder dialog box opens.  
2 From the Min Value and Max Value fields, type the minimum and maximum values for the cylinder.  
3 Click OK to apply your changes. |
| Determine whether or not to apply formatting inherited from the widget’s underlying graph report | 1 In Editable Mode, right-click the widget, then point to View Mode and select Graph View.  
2 From the Format menu, select Graph. The Format: Graph dialog box opens.  
3 From the Graph type drop-down list, select Cylinder.  
4 Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click Help.  
5 Click OK to apply your changes and return to the widget.  
6 In Flash Mode, right-click the widget and select Properties. The Cylinder dialog box opens.  
7 Do one of the following:  
• To apply formatting from the widget’s underlying graph report, select the Inherit graph-grid formatting check box.  
• To display the widget without inheriting formatting, clear the Inherit graph-grid formatting check box.  
8 Click OK to apply your changes. |
**Prerequisite**

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Whether the attribute elements in the widget are sorted alphabetically | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Data Cloud dialog box opens.  
2 To sort the attribute elements alphabetically, select the Sort Alphabetically check box.  
3 Click OK to apply your changes.                                                                                                                                                                                                 |
| Alignment of the data cloud within the widget’s borders           | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Data Cloud dialog box opens.  
2 Select Align Left, Align Right, or Justify from the Alignment drop-down list.  
3 Click OK to apply your changes.                                                                                                                                                                                                 |
| Define the equation used to determine the size of attribute elements | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Data Cloud dialog box opens.  
2 Select Square Root, Logarithm, or Linear from the Equation drop-down list:  
  • **Square Root:** Select this option to display your data in abrupt increments. Selecting this option is beneficial if you have large value differences between each set of data in the widget.  
  • **Logarithm:** Select this option to display your data in gradual, smoother increments. Selecting this option is beneficial if you are using percentage data that drops below 0%.  
  • **Linear:** Select this option to display your data as a weighted average. For example, if you want to display the average sales data for each month of the year, or the average profit for Q1 2007, this option is beneficial.  
3 Click OK to apply your changes.                                                                                                                                                                                                 |
| Font size of the smallest attribute element in the widget         | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Data Cloud dialog box opens.  
2 Select or type the font size (1-15) in the Minimum Font Size (1-15) field.  
3 Click OK to apply your changes. The font size of the smallest attribute element is changed; all other attribute elements are sized proportionally. |
### Formatting a Date Selection widget

For an image of a Date Selection widget and steps to add one to a document, see *Creating a Date Selection widget, page 251.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colors in which the attribute elements are displayed</td>
<td>1 In <strong>Flash Mode</strong>, <strong>Interactive Mode</strong>, or <strong>Express Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Data Cloud dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 Specify colors from the <strong>Font Color 1</strong> and <strong>Font Color 2</strong> palettes.</td>
</tr>
<tr>
<td></td>
<td>3 Click <strong>OK</strong> to apply your changes. Attribute elements in the Data Cloud widget alternate between the two font colors displayed.</td>
</tr>
<tr>
<td>Background color of the widget</td>
<td>1 In <strong>Flash Mode</strong>, <strong>Interactive Mode</strong>, or <strong>Express Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Data Cloud dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 Specify a color from the <strong>Background Color</strong> palette.</td>
</tr>
<tr>
<td></td>
<td>3 Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>Border color of the widget</td>
<td>1 In <strong>Flash Mode</strong>, <strong>Interactive Mode</strong>, or <strong>Express Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Data Cloud dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 Specify a color from the <strong>Border Color</strong> palette.</td>
</tr>
<tr>
<td></td>
<td>3 Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>Determine whether or not to apply additional formatting inherited from the widget's underlying grid report.</td>
<td>1 In <strong>Editable Mode</strong>, right-click the widget, then point to <strong>View Mode</strong> and select <strong>Grid View</strong>.</td>
</tr>
<tr>
<td>By default, a Data Cloud widget inherits the number formatting from its underlying grid report in <strong>Editable Mode</strong>. For example, if a dollar sign ($) is used in the metric values in <strong>Editable Mode</strong>, a dollar sign is also used in the metric values in the tooltips of the widget. You can choose to inherit font formatting from the widget's grid report in addition to the number formatting.</td>
<td>2 Right-click the widget, then select <strong>Properties and Formatting</strong>. The Properties and Formatting dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>3 Format the widget's underlying grid by selecting the appropriate options in the dialog box. For details on each option to format the widget's underlying grid report, click <strong>Help</strong>.</td>
</tr>
<tr>
<td></td>
<td>4 Click <strong>OK</strong> to apply your changes and return to the widget.</td>
</tr>
<tr>
<td></td>
<td>5 In <strong>Flash Mode</strong>, <strong>Interactive Mode</strong>, or <strong>Express Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Data Cloud dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>6 Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• To apply formatting from the widget's underlying grid report, select the <strong>Inherit grid formatting</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>• To apply only the number format from the underlying grid report, clear the <strong>Inherit grid formatting</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>7 Click <strong>OK</strong> to apply your changes.</td>
</tr>
</tbody>
</table>
(You can design a separate type of Date Selection widget to be displayed on a mobile device; for more information, see the Mobile Design and Administration Guide.)

The table below lists the different aspects of the Date Selection widget that you can format. It also lists steps to format them in MicroStrategy Web. These options are applied only to Flash Mode. In other modes/views, how the widget displays is determined by how it was created:

- Date Selection widget created as a widget: It can be hidden or displayed as either a grid or graph report, or as a placeholder. It is displayed using Flash in DHTML interactive documents.
- Date Selection widget created as a selector: It is displayed using the DHTML style and formatting.

### Prerequisite

- The following procedures assume that you have enabled viewing the document in Flash Mode. For steps, see Determining the display modes users can choose to work in, page 61.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Background color of the calendar                         | 1 In **Flash Mode**, right-click the widget and select Properties. The Date Selection dialog box opens.  
2 Click the General tab.  
3 Select a Background color.  
4 Click OK to apply your changes. |
| Border color of the calendar                             | 1 In **Flash Mode**, right-click the widget and select Properties. The Date Selection dialog box opens.  
2 Click the General tab.  
3 Select a Border color.  
4 Click OK to apply your changes. |
| Color displayed when a user rolls over a date on the calendar | 1 In **Flash Mode**, right-click the widget and select Properties. The Date Selection dialog box opens.  
2 Click the General tab.  
3 Select a Highlight color.  
4 Click OK to apply your changes. |
| Color displayed when a user chooses a date on the calendar | 1 In **Flash Mode**, right-click the widget and select Properties. The Date Selection dialog box opens.  
2 Click the General tab.  
3 Select a Selected color.  
4 Click OK to apply your changes. |
### Formatting a Date Selection widget for a mobile device

The Date Selection widget is available to be displayed on a mobile device with MicroStrategy Mobile.

For steps to create and format a Date Selection widget for use on a mobile device, see the *Mobile Design and Administration Guide*.

### Formatting a Fish Eye Selector

For an image of a Fish Eye selector and steps to add one to a document, see *Creating a Fish Eye Selector, page 260*.

A Fish Eye selector is displayed only in Flash Mode. In other modes/views, how the selector displays is determined by how it was created:

- If the Fish Eye selector was created as a widget, it can be hidden or displayed as either a Grid/Graph or a placeholder. For steps and
examples, see *Defining how a widget is displayed in different views and modes, page 369.*

- If the Fish Eye selector was created as a selector, it is displayed using the DHTML style and formatting. For steps, see *Defining a selector, page 124.*

The table below provides formatting ideas and steps to format the Fish Eye selector created as a widget.

### Prerequisite

- The following procedures assume that you have enabled viewing the document in Flash Mode or Express Mode. For steps, see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Display the list of data in the widget in text or image form | 1 In *Flash Mode* or *Express Mode*, right-click the widget and select Properties. The Fish Eye dialog box opens.  
2 Click the General tab.  
3 Do one of the following:  
   - To display the list of data appearing to the left of the Grid/Graph in the widget as text, select Text from the Mode drop-down list.  
   - To display the list of data appearing to the left of the Grid/Graph in the widget as images, select Image from the Mode drop-down list. Type the web address of the image in the Image URL field.  
4 Click OK to apply your changes. |
| Color of highlighted and selected items in the selector | 1 In *Flash Mode* or *Express Mode*, right-click the widget and select Properties. The Fish Eye dialog box opens.  
2 Click the General tab.  
3 From the Highlight color palette, specify the color in which a highlighted item is displayed when you hover the cursor over it.  
4 From the Selected color palette, specify the color in which a selected item is displayed.  
5 Click OK to apply your changes. |
| Automatically determine the scale, magnification speed, and item spacing | 1 In *Flash Mode* or *Express Mode*, right-click the widget and select Properties. The Fish Eye dialog box opens.  
2 Click the Advanced tab.  
3 Select the Auto check box.  
4 Click OK to apply your changes. |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| The scale of the items, or how large or small the items in a selector can become | 1. In **Flash Mode** or **Express Mode**, right-click the widget and select **Properties**. The Fish Eye dialog box opens.  
2. Click the **Advanced** tab.  
3. Clear the **Auto** check box to ensure that you can manually adjust the scaling. The scale is automatically determined if this check box is selected.  
4. Enter a value in the **Default scale** field to specify the default size of the items in the selector. By default, items are sized so that they can all be displayed.  
5. Enter a value in the **Max scale** field to specify the maximum size that an item in the selector can become when you hover the cursor over it. It is recommended that you use a **Max scale** of 0.65 for selectors that contain approximately 20 items.  
6. Enter a value in the **Scale radius** field to specify how many items adjacent to the item increase in size when you hover the cursor over an item in the selector. This number includes the selected item.  
7. Enter a number in the **Scale slope** field to specify the difference in size between a selected item and the items directly adjacent to it.  
8. Click **OK** to apply your changes. |
| Speed of the magnification effect for items in the selector | 1. In **Flash Mode** or **Express Mode**, right-click the widget and select **Properties**. The Fish Eye dialog box opens.  
2. Click the **Advanced** tab.  
3. Clear the **Auto** check box to ensure that you can adjust the Animation Speed option. The speed is automatically determined if this check box is selected.  
4. Enter a number in the **Animation speed** field to determine the animation speed of the displayed data. A smaller Animation speed results in smoother transitions between items. The minimum value is .1 and the maximum value is 1. The default value is .3.  
5. Click **OK** to apply your changes. |
### Formatting Widgets

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Space between the items in the selector | 1 In **Flash Mode** or **Express Mode**, right-click the widget and select **Properties**. The Fish Eye dialog box opens.  
2 Click the **Advanced** tab.  
3 Clear the **Auto** check box to ensure that you can adjust the spacing. The spacing is automatically determined if this check box is selected.  
4 In the **Spacing** field, enter the amount of pixels to display between each item in the selector. The minimum value is 0 and the maximum value is 50. The default value is 0.  
5 Click **OK** to apply your changes. |
| Apply formatting inherited from the widget’s underlying grid report  
This widget automatically inherits some of the formatting contained in its underlying grid report. The following formatting is inherited:  
• Number and date formatting  
• Font alignment and type  
• Background color | 1 In **Editable Mode**, right-click the widget, then point to **View Mode** and select **Grid View**.  
2 Right-click the widget and select **Properties and Formatting**. The Properties and Formatting dialog box opens.  
3 Format the widget’s underlying grid by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying grid report, click **Help**.  
4 Click **OK** to apply your changes and return to the widget. |

### Replacing the selector items of a Fish Eye Selector with images

The Fish Eye Selector can display a series of images from which analysts can choose. These images can replace any attribute element, metric, or panel names in the selector. When the user selects an image, any target panel stacks or Grid/Graphs are updated with related data.

In the example below, the Fish Eye Selector on the left displays a collection of flags from various countries. Each flag represents an attribute element from the Country attribute, which is the attribute used to create the Fish Eye...
Selector. An analyst can select a flag to see relevant data in the target Grid/Graph on the right.

To view images related to a specific attribute element, metric, or panel, you must specify its name when you specify the location of the image. In the example above, images of countries are named the same as the elements of the Country attribute. You specify the image when you format the Fish Eye Selector.

### Formatting a Funnel widget

For an image of a Funnel widget and steps to add one to a document, see *Creating a Funnel widget, page 274.*

The table below lists the different aspects of the Funnel widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in
DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes*, page 369. For steps to enable DHTML, see the *MicroStrategy Web Help*.

**Prerequisite**

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see *Determining the display modes users can choose to work in*, page 61.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine whether the series labels are displayed | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select **Properties**. The Funnel dialog box opens.  
2 Select or clear the **Show series labels** check box.  
3 Click **OK** to apply your changes. |
| The **Show series labels** option displays what each colored section represents, for example, a customer region like Northeast. | |
| Determine whether labels are displayed inside or outside the funnel | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select **Properties**. The Funnel dialog box opens.  
2 Select the **Show series labels** check box.  
3 Select **Outside** or **Inside** from the **Labels Position** drop-down list.  
4 Click **OK** to apply your changes. |
| Determine whether the series values are displayed | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select **Properties**. The Funnel dialog box opens.  
2 Select or clear the **Show series values** check box.  
3 Click **OK** to apply your changes. |
| Determine whether the series values are displayed inside or outside the funnel | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select **Properties**. The Funnel dialog box opens.  
2 Select the **Show series values** check box.  
3 Select **Outside** or **Inside** from the **Values Position** drop-down list.  
4 Click **OK** to apply your changes. |
| Enable legend resize | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select **Properties**. The Funnel dialog box opens.  
2 Select or clear the **Resizeable Legend Area** check box.  
3 Click **OK** to apply your changes. |
| Enabling legend resizing allows a user to change the size of the legend area. If the widget has a lot of items on it, a user might want to expand the legend area so that he can read all of the text in the legend. | |
Formatting Widgets Dashboard s and Widgets Creation Guide

6

Formatting options by widget type © 2015 MicroStrategy, Inc.

Formatting a Gauge widget

For an image of a Gauge widget and steps to add one to a document, see Creating a Gauge widget, page 276.

The table below lists the different aspects of the Gauge widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see Defining how a widget is displayed in different views and modes, page 369. For steps to enable DHTML, see the MicroStrategy Web Help.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine the minimum height for the funnel layer | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Funnel dialog box opens.  
2 Enter the minimum height required in the Funnel Layer Minimum Height field. The size of the layers is representative and should not be considered to be a strict representation of the percent-to-total calculation of each layer.  
3 Click OK to apply your changes. |
| Determine whether or not to apply formatting inherited from the widget’s underlying graph report | 1 In Editable Mode, right-click the widget, then point to View Mode and select Graph View.  
2 From the Format menu, select Graph. The Format: Graph dialog box opens.  
3 From the Graph type drop-down list, select Funnel.  
4 Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click Help.  
5 Click OK to apply your changes and return to the widget.  
6 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Funnel dialog box opens.  
7 Do one of the following:  
• To apply formatting from the widget’s underlying graph report, select the Inherit graph formatting check box.  
• To display the widget without inheriting formatting, clear the Inherit graph formatting check box.  
8 Click OK to apply your changes. |
**Prerequisite**

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Show or hide the value that the gauge needle is pointing to | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Gauge dialog box opens.  
2 Select or clear the **Show Data Labels** check box to show or hide the indicated value in the center of the Gauge widget. For example, if the gauge needle points to $65,000, “$65,000” is displayed in the center of the gauge.  
3 Click **OK** to apply your changes. |
| Select the series color scheme | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Gauge dialog box opens.  
2 Select one of the color schemes from the **Default series colors** drop-down list.  
3 Click **OK** to apply your changes. |
| Show or hide the title | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Gauge dialog box opens.  
2 Select or clear the **Show title** check box to show or hide the title. The title appears at the bottom of the gauge.  
3 Click **OK** to apply your changes. |
| Determine whether or not to apply formatting inherited from the widget’s underlying graph report  
The following formatting can be inherited from the underlying graph:  
* Font type and size  
* Background and border color of the widget  
* The minimum and maximum values that can be displayed in the widget  
* The positioning of the minimum and maximum values on the gauge  
* The display style and color of the gauge faceplate, gauge border, and needle  
* Legend formatting, including legend position, legend background and border color, and font used to display items in the legend | 1 In **Editable Mode**, right-click the widget, then point to **View Mode** and select **Graph View**.  
2 From the **Format** menu, select **Graph**. The Format: Graph dialog box opens.  
3 From the **Graph type** drop-down list, select **Gauge**.  
4 Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click **Help**.  
5 Click **OK** to apply your changes and return to the widget.  
6 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Gauge dialog box opens.  
7 Do one of the following:  
* To apply formatting from the widget’s underlying graph report, select the **Inherit graph formatting** check box.  
* To display the widget without inheriting formatting, clear the **Inherit graph formatting** check box.  
8 Click **OK** to apply your changes. |
Formatting a Graph Matrix (deprecated) widget

For an image of a Graph Matrix (deprecated) widget and steps to add one to a document, see Creating a Graph Matrix (deprecated) widget, page 278.

The table below lists the different aspects of the Graph Matrix (deprecated) widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see Defining how a widget is displayed in different views and modes, page 369. For steps to enable DHTML, see the MicroStrategy Web Help.

Prerequisite

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see Determining the display modes users can choose to work in, page 61.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine whether every area graph uses the same scale and number interval on their Y-axes This option makes all the grids and graphs appear to have the same empty axis values. If you scroll over the X-axis, you can see that the values are unique for each object on the widget.</td>
<td>1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Graph Matrix dialog box opens.  2 Select the Uniform axis option.  3 Click OK to apply your changes.</td>
</tr>
<tr>
<td>Add or remove horizontal reference lines for every area graph The red line provides the average for all graphs in the same row; the black line provides the average for each graph.</td>
<td>1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Graph Matrix dialog box opens.  2 Select or clear the Reference Line check box.  3 Click OK to apply your changes.</td>
</tr>
<tr>
<td>Show or hide the axis labels on the area graphs</td>
<td>1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Graph Matrix dialog box opens.  2 Select or clear the Axis Labels check box.  3 Click OK to apply your changes.</td>
</tr>
<tr>
<td>What to Format in the Widget</td>
<td>How to Format It</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Adjust how transparent or opaque the background of the widget is</td>
<td>1. In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select <strong>Properties</strong>. The Graph Matrix dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2. From the <strong>Background Opacity</strong> drop-down list, select a level of opacity. The higher the percentage, the less transparent the background is.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>Show or hide a legend for the area graphs</td>
<td>1. In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select <strong>Properties</strong>. The Graph Matrix dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2. Select or clear the <strong>View Graph Legend in Zoom View</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>Determine whether to display all series as line graphs or to display the values of the</td>
<td>1. In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select <strong>Properties</strong>. The Graph Matrix dialog box opens.</td>
</tr>
<tr>
<td>first metric as area graphs</td>
<td>2. Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• To display the values of the first metric as area graphs, clear the <strong>All Series as Line Graphs</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>• To display all the series as line graphs, select the <strong>All Series as Line Graphs</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>Determine whether or not to apply formatting inherited from the widget’s underlying graph</td>
<td>1. In <strong>Editable Mode</strong>, right-click the widget, then point to <strong>View Mode</strong> and select <strong>Graph View</strong>.</td>
</tr>
<tr>
<td>report</td>
<td>2. From the <strong>Format</strong> menu, select <strong>Graph</strong>. The Format: Graph dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>3. From the <strong>Graph type</strong> drop-down list, select <strong>Vertical Area</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s</td>
</tr>
<tr>
<td></td>
<td>underlying graph report, click <strong>Help</strong>.</td>
</tr>
<tr>
<td></td>
<td>5. Click <strong>OK</strong> to apply your changes and return to the widget.</td>
</tr>
<tr>
<td></td>
<td>6. In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select <strong>Properties</strong>. The Graph Matrix dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>7. Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• To apply formatting from the widget’s underlying graph report, select the <strong>Inherit grid/graph formatting</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>• To display the widget without inheriting formatting, clear the <strong>Inherit grid/graph formatting</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>8. Click <strong>OK</strong> to apply your changes.</td>
</tr>
</tbody>
</table>
Formatting a Heat Map widget

For an image of a Heat Map widget and steps to add one to a document, see *Creating a Heat Map widget, page 283.*

The table below lists the different aspects of the Heat Map widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 369.* For steps to enable DHTML, see the MicroStrategy Web Help.

**Prerequisite**

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine the attribute or metric used to color rectangles in the widget | 1 In **Flash Mode** or **Interactive Mode**, right-click the widget and select **Interactive**.  
2 In the Controls section, from the **Color** drop-down list, do one of the following:  
  • To have the rectangles colored based on the elements of an attribute, point to **Attribute**, then select the attribute.  
  • To have the rectangles colored based on the value of a metric, point to **Metric**, then select the metric. |
| Determine whether to show metric values                               | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Heat Map dialog box opens.  
2 On the **Display** tab, select or clear the **Show metric values** check box.  
3 Click **OK** to apply your changes. |

This option allows you to determine whether to display the metric values - for example, revenue by state - in each section of the widget. The widget is divided into sections by attributes. For example, you add customer region, quarter, and revenue to the widget. The widget will be divided into the customer region section first and then into quarters within the customer regions. If you select the **Show metric values** check box, you can display revenue values for each quarter in each customer region.
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Display a legend for the heat map                                                          | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Display tab, select the Show Legend check box.  
3 Click OK to apply your changes.                                                                 |
| Determine whether to allow attributes to be removed from the widget                        | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Display tab, select or clear the Remove Attributes from Template check box.  
3 Click OK to apply your changes.                                                                 |
| Determine whether to display labels in each rectangle                                       | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Display tab, select one of the following options from the Show Labels drop-down list:  
• On: Labels are displayed in the rectangles.  
• Off: Labels are not displayed in the rectangles.  
• Proportional: Labels are displayed in the rectangles, with the size of each label reflecting the size of the rectangle. Rectangles that reflect positive values are displayed with larger labels than rectangles that reflect negative values.  
3 Click OK to apply your changes.                                                                 |
| Select the algorithm used to size and position the rectangles                              | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Display tab, select one of the following options under Layout:  
3 Keep readability, not element order: Size the rectangles in the widget to make the data with them as easy to read as possible.  
4 Balance readability and order: Size and position the rectangles to make the data within them as easy to read as possible, while still attempting to display them in the same order in which they appear in the widget’s Grid/Graph.  
5 Keep element order, not readability: Position the rectangles in the widget in the same order in which they appear in the widget’s Grid/Graph.  
6 Click OK to apply your changes.                                                                 |
| Select the color of the background                                                         | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Format tab, select the Background color for the widget.  
3 Click OK to apply your changes.                                                                 |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Select the color of the borders | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Format tab, select a color for the borders of the widget from the Border Color palette.  
3 Click OK to apply your changes. |
| Select the color of the attribute headings | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Format tab, select a color for the headings from the Header Color palette.  
3 Click OK to apply your changes. |
| Enable scale boundaries  
By default, the minimum and maximum range for the color slider is determined automatically by the data in the widget. If the data changes, the minimum and maximum can also change. You can instead set the minimum and maximum range for a specific metric, so that specific colors always represent specific metric values. Outlying metric values use solid colors, rather than shaded colors. | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 On the Metric Options tab, select the metric from the drop-down list.  
3 Select the Scale Boundaries check box.  
4 Type the Minimum and Maximum values in the corresponding fields.  
5 Click OK to apply your changes. |
| Select the aggregation function for the widget  
You can change the aggregation function used to calculate the size of the larger areas in the widget. The value of this function is displayed in a tooltip when the cursor hovers over an area. | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Heat Map dialog box opens.  
2 Click the Metric Options tab.  
3 From the Aggregation Function drop-down list, select an aggregation function:  
• Sum  
• Average  
• Count  
• Maximum  
• Minimum  
• Geometric Average  
4 Click OK to apply your changes. |
| Apply formatting inherited from the widget's underlying grid report  
This widget automatically inherits the number and date formatting from the underlying grid. | 1 In Editable Mode, right-click the widget, then point to View Mode and select Grid View.  
2 Right-click the widget, then select Properties and Formatting. The Properties and Formatting dialog box opens.  
3 Format the widget's underlying grid by selecting the appropriate options in the dialog box. For details on each option to format the widget's underlying grid report, click Help.  
4 Click OK to apply your changes. |
Formatting an Image Layout widget

For an image of an Image Layout widget and steps to add one to a document, see *Creating an Image Layout widget, page 287*.

Once you have created an Image Layout widget, you can specify formatting options to change the background image displayed in the widget, determine whether to display areas or bubble markers on top of the image, and so on. Steps to format an Image Layout widget are below.

**Prerequisites**

- The procedure below assumes that you have already created the widget that you want to format.

---

**To format an Image Layout widget**

1. Open the document in **Design** or **Editable Mode**.
2. Right-click the widget, then select **Properties and Formatting**. The Properties and Formatting dialog box opens.
3. From the left, select **Widget**, then click the **Widget Properties** icon. The Image Layout dialog box opens.
4. You can determine whether the widget displays areas or bubble markers. From the **Display Mode** drop-down list, select one of the following:

   - To allow MicroStrategy to decide whether to show areas or bubble markers, select **Automatic**. If no metrics are placed on the widget’s Grid/Graph, the widget displays areas or bubbles based on whether the shape file displayed in the widget is designed to display areas or bubble markers by default. Otherwise, the widget is displayed with bubble markers. For details to define a shape file and determine whether it displays areas or bubble markers by default, see the MicroStrategy Web Help.
   - To display areas, select **Area**.
• To display bubble markers, select **Bubble**.

5 You can select the shape file to use to display the widget. A shape file is an HTML file that contains the image that you want to display in the widget, as well as the location of each area or bubble marker you want to display on top of the image. Web provides several default shape files for you to choose from, including a map of countries of the world and a map of states in the United States. You can define your own shape file for use in the widget, using the same steps as you would to customize an Image Layout visualization. For steps, see the *MicroStrategy Web Help*.

6 From the **Shape File** drop-down list, select the name of the shape file you want to use. If the attribute that contains each location to display in the widget has a geo role, shape files with the same geo role will be displayed as options in the drop-down list.

7 You can determine how bubble markers in the widget are sized. From the **Type** drop-down list, select one of the following:

- To allow MicroStrategy to decide how to size the bubble markers, select **Automatic**.

- To manually specify the maximum size of bubble markers in the widget, select **Manual**. In the **Value** field, type the maximum size of the bubble markers as a ratio between .01 and 1. For example, type 1 to display the largest bubble markers at the maximum size at which the widget can display bubble markers.

8 From the **Background Color** palette, select the default background color to display in the widget. To access additional colors, click **More Colors**.

9 From the **Default Shape Color** palette, select the default color in which to display areas in the widget. To access additional colors, click **More Colors**.

10 Click **OK** to save your changes.

### Formatting an Interactive Bubble Graph widget

For an image of an Interactive Bubble Graph widget and steps to add one to a document, see *Creating an Interactive Bubble Graph widget, page 295*.

The table below lists the different aspects of the Interactive Bubble Graph widget that you can format, and describes the steps to format them in
MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 369*. For steps to enable DHTML, see the *MicroStrategy Web Help*.

**Prerequisite**

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see *Determining the display modes users can choose to work in, page 61*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Assign colors to the bubbles based on either Series or Category | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the **General** tab, select either **Series** or **Category** from the **Assign colors based on** drop-down list.  
3 Click **OK** to apply your changes. |
| Determine drilling behavior  
If drilling is enabled, a user can click on a bubble in the widget to drill down on that bubble’s data. This displays a drilled-to (child) bubble with related data. To enable drilling, you must also place a second attribute to the right of the attribute in the rows. For details, see *Creating an Interactive Bubble Graph widget, page 295.* | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the **Drilling** tab, select or clear the **Enable drilling** check box. If you are enabling drilling, you must also fulfill additional data requirements for this widget. See *Supporting drilling in an Interactive Bubble Graph widget, page 297.*  
3 To determine whether a line appears between a drilled bubble and its corresponding drilled-to (child) bubble, select or clear the **Connect bubbles when drilling** check box. The line allows you to better visualize which bubbles contain related information.  
4 Click **OK** to apply your changes. |
| Display the graph’s legend inside or outside the graph | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the **General** tab, select or clear the **Display legend outside of graph** check box.  
3 Click **OK** to apply your changes. |
### What to Format in the Widget | How to Format It
--- | ---
Determine size of bubbles in reference to parent bubbles | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the General tab, do one of the following:  
   - Select the **Use width (vs. area) to size the bubbles** check box to use the sum of the diameters of the drilled-to (child) bubbles as the diameter of the parent bubble.  
   - Clear the **Use width (vs. area) to size the bubbles** check box to use the area of the child bubbles as the area of the parent bubble.  
3 You can also specify a maximum bubble size in the **Maximum bubble radius size** field.  
4 Click **OK** to apply your changes.

Determine whether to display bubbles with a rounded effect | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the **General** tab, select or clear the **Apply Rounded Effect to Bubbles** check box.  
3 Click **OK** to apply your changes.

Enable or disable time series animation | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the **Time Analysis** tab, select or clear the **Enable time series analysis** check box. If time series analysis is enabled:  
   - The user can control the time series animation. To enable time series animation, make sure there is a third attribute on the rows of the widget’s Grid/Graph. For information, see **Creating an Interactive Bubble Graph widget, page 295**.  
   - You can select or clear the **Auto-Hide time controls** check box, to determine whether the time series animation control bar is automatically hidden from view unless the cursor hovers over it.  
3 Click **OK** to apply your changes.

Font formatting for the time series labels (the attribute header) | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the **Time Analysis** tab, select the **Font Family**, **Font Size**, and **Color**. Some of the options may not be visible; to view all options, use the scroll bar to scroll down. These options are only available if the **Enable time series analysis** check box is selected.  
3 To bold the labels, select the **Bold** check box.  
4 To italicize the labels, select the **Italic** check box.  
5 Click **OK** to apply your changes.
# What to Format in the Widget | How to Format It

| Color, opacity, and size of time series animation control | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 Click the **Time Analysis** tab.  
3 The following options are available only if the **Enable time series analysis** check box is selected:  
   - To format the background of the control:  
     - Select a color from the **Control background color** palette.  
     - Select an opacity percentage from the **Control background opacity** drop-down list to determine how opaque the background is. 100% is a solid color, 0% is transparent.  
   - To format the background of the Play button, select colors from the **Button background colors** palettes.  
     - If you specify two different colors, they are blended to create a gradient effect.  
     - If you specify the same color, the button background is displayed in a single color.  
4 To format the background of the Play button when the user hovers his cursor over the button, select a color from the **Control highlight color** palette.  
5 From the **Control size** drop-down list, specify the size of the time series animation control.  
6 Click **OK** to apply your changes. |

| Change selection on mouse over | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the **Selectors** tab, you can change what is displayed in the selectable area when you hover the cursor over the area that you want to see. To do this, select the **Change selection on mouse over** option.  
3 Click **OK** to apply your changes. |

| Allow the selection box (the lasso) to automatically update the targeted Grid/Graphs and panel stacks, if the widget is used as a selector  
For example, when this option is enabled, an analyst can drag a selection box around two brand bubbles in the widget to automatically display those brands in the targeted Grid/Graph. | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Interactive Bubble Graph dialog box opens.  
2 On the **Selectors** tab, select **Trigger selector with lasso automatically**.  
3 Click **OK** to apply your changes.  
The widget must also be enabled to be used as a selector.  
You must enable attributes or attribute elements in the Grid/Graph that contains the widget. For details, see **Using an Interactive Bubble Graph widget as a selector, page 446**. |
## What to Format in the Widget

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Whether to display the widget in scatter plot mode                                            | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Interactive Bubble Graph dialog box opens.  
2 Click the Scatter Mode tab. 
3 Do one of the following:  
• To display the widget as a scatter plot, select the Scatter Plot Mode Only check box. Type the size of the scatter plot bubbles in the Scatter Plot Bubble Radius field. All bubbles in the widget are displayed in this size.  
• To display the widget as a bubble graph, clear the Scatter Plot Mode Only check box.  
4 Click OK to apply your changes.                                                                 |
| Enable or disable zooming and changing the metric displayed on an axis in the widget         | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget.  
2 Do one of the following:  
• To enable zooming and changing the metric displayed on an axis using the drop-down lists, select Show Interactive Controls.  
• To disable zooming and changing the metric displayed on an axis using the drop-down lists, select Hide Interactive Controls. |
| Apply formatting inherited from the widget's underlying graph report                          | 1 In Editable Mode, right-click the widget, point to View Mode, and select Graph View.  
2 From the Format menu, select Graph. The Format: Graph dialog box opens.  
3 Format the widget's underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget's underlying graph report, click Help.  
4 Click OK to apply your changes.                                                                 |

### Formatting an Interactive Stacked Graph widget

For an image of an Interactive Stacked Graph widget and steps to add one to a document, see *Creating an Interactive Stacked Graph widget, page 301*.

The table below lists the different aspects of the Interactive Stacked Graph widget that you can format, and describes the steps to format them in MicroStrategy Web.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Whether to display the widget in scatter plot mode                                            | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Interactive Bubble Graph dialog box opens.  
2 Click the Scatter Mode tab. 
3 Do one of the following:  
• To display the widget as a scatter plot, select the Scatter Plot Mode Only check box. Type the size of the scatter plot bubbles in the Scatter Plot Bubble Radius field. All bubbles in the widget are displayed in this size.  
• To display the widget as a bubble graph, clear the Scatter Plot Mode Only check box.  
4 Click OK to apply your changes.                                                                 |
| Enable or disable zooming and changing the metric displayed on an axis in the widget         | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget.  
2 Do one of the following:  
• To enable zooming and changing the metric displayed on an axis using the drop-down lists, select Show Interactive Controls.  
• To disable zooming and changing the metric displayed on an axis using the drop-down lists, select Hide Interactive Controls. |
| Apply formatting inherited from the widget's underlying graph report                          | 1 In Editable Mode, right-click the widget, point to View Mode, and select Graph View.  
2 From the Format menu, select Graph. The Format: Graph dialog box opens.  
3 Format the widget's underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget's underlying graph report, click Help.  
4 Click OK to apply your changes.                                                                 |
Prerequisite

- The following procedures assume that you have enabled viewing the document in Flash Mode. For steps, see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine color of the area graph's series</td>
<td>1 In <strong>Flash Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Interactive Stacked Graph dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 From the <strong>Aggregate area series color</strong> palette, select a color for the series.</td>
</tr>
<tr>
<td></td>
<td>3 Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>Determine color of the line that appears between different series</td>
<td>1 In <strong>Flash Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Interactive Stacked Graph dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 From the <strong>Series line color</strong> palette, select a color for the line that appears between different series when more than one attribute is selected from the checklist on the left.</td>
</tr>
<tr>
<td></td>
<td>3 Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>Determine whether the legend or the graph is selectable</td>
<td>1 In <strong>Flash Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Interactive Stacked Graph dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 Select either <strong>Graph</strong> or <strong>Legend</strong> from the <strong>Selective area</strong> drop-down list.</td>
</tr>
<tr>
<td></td>
<td>3 If Graph is selected, select or clear the <strong>Change selection on mouse over</strong> check box. If selected, the user can change what is displayed in the selectable area when he hovers the cursor over the area that he wants to see.</td>
</tr>
<tr>
<td></td>
<td>4 Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>Determine whether to apply formatting inherited from the widget's underlying graph report</td>
<td>1 In <strong>Editable Mode</strong>, right-click the widget, point to <strong>View Mode</strong>, and select <strong>Graph View</strong>.</td>
</tr>
<tr>
<td>The following formatting can be inherited from the underlying graph:</td>
<td>2 From the <strong>Format</strong> menu, select <strong>Graph</strong>. The Format: Graph dialog box opens.</td>
</tr>
<tr>
<td>• Number formatting</td>
<td>3 Format the widget's underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget's underlying graph report, click <strong>Help</strong>.</td>
</tr>
<tr>
<td>• Font type, size, and color</td>
<td>4 Click <strong>OK</strong> to apply your changes and return to the widget.</td>
</tr>
<tr>
<td>• The maximum and minimum values that can be displayed in the graph</td>
<td>5 In <strong>Flash Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Interactive Stacked Graph dialog box opens.</td>
</tr>
<tr>
<td>• The interval between tick marks on the graph axes</td>
<td>6 Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• To apply formatting from the widget’s underlying graph, select the <strong>Inherit graph formatting</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>• To display the widget without inheriting formatting, clear the <strong>Inherit graph formatting</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>7 Click <strong>OK</strong> to apply your changes.</td>
</tr>
</tbody>
</table>
Formatting a Media widget

For an image of a Media widget and steps to add one to a document, see *Creating a Media widget, page 314.*

The table below lists the different aspects of the Media widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 369.* For steps to enable DHTML, see the *MicroStrategy Web Help.*

**Prerequisite**

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine the content type that will display in the widget | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Media dialog box opens.  
2 Select the General tab.  
3 From the Content type drop-down list, specify the content type that will display in the widget.  
4 Click OK to apply your changes. |
| Define the text that is displayed when an analyst hovers the cursor over the widget | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Media dialog box opens.  
2 Select the General tab.  
3 In the Tooltip Text field, type the text that you want to display when users hover the cursor over the widget.  
4 Click OK to apply your changes. |
| Set the background color of the widget | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Media dialog box opens.  
2 Select the General tab.  
3 Select a color from the Background color drop-down list.  
4 Click OK to apply your changes. |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine whether to display the widget automatically or after clicking a button | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Media dialog box opens.  
2 Select the **General** tab.  
3 Do one of the following:  
   - Clear the **Popup content when clicked** check box to display the widget immediately when the document is opened.  
   - Select the **Popup content when clicked** check box to hide the widget and display a button. The user can click the button to display the widget. From the **Display Content** drop-down list, select whether the widget displays in a new window or in the existing window:  
     - **Inline**: The widget will be displayed in the document after the button is clicked.  
     - **New Window**: The widget will be displayed in a new browser window after the button is clicked.  
     Type the text to display on the button in the **Button Text** field.  
4 Click **OK** to apply your changes. |
| Determine whether to display the Play button in the widget  
This option is for video and audio content types only. | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Media dialog box opens.  
2 Select the **Play Frequency** tab. This tab is available only when the Content Type is video or audio.  
3 Select or clear the **Show Play Button Control** check box.  
If the Play button is not displayed, the media cannot be controlled by the user.  
4 Click **OK** to apply your changes. |
| Determine whether to play the feed data automatically  
This option is for video and audio content types only. | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Media dialog box opens.  
2 Select the **Play Frequency** tab. This tab is available only when the Content Type is video or audio.  
3 Select the **Auto Play on Start** check box to have the media automatically being to play when the document is opened.  
4 Click **OK** to apply your changes. |
| Determine whether to play the feed data once or loop it continuously  
This option is for video and audio content types only | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Media dialog box opens.  
2 Select the **Play Frequency** tab. This tab is available only when the Content Type is video or audio.  
3 Select either **Play Once** or **Continuous Play** from the drop-down list.  
4 Click **OK** to apply your changes. |
Formatting a Microcharts widget

For an image of a Microcharts widget and steps to add one to a document, see Creating a Microcharts widget, page 320.

A Microcharts widget is made up of several small types of graphs or charts. The bar, sparkline, and bullet microcharts make up the Microcharts widget. You can format some aspects of the entire Microcharts widget, and you can also format some aspects of each type of microchart differently. The formatting options described below are grouped into the following sections:

- Formatting a Microcharts widget, page 416
- Formatting bar microcharts, page 421
- Formatting sparkline microcharts, page 423
- Formatting bullet microcharts, page 425

**Formatting a Microcharts widget**

**Prerequisite**

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see Determining the display modes users can choose to work in, page 61.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Show or hide metrics for hidden graphs                    | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 Select or clear the Display metrics for hidden graphs check box.  
3 Click OK to apply your changes. |
| Determine opacity of the widget's background              | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Opacity.  
3 From the Background opacity drop-down list, select the level of opacity. The higher the percentage, the less transparent the background is.  
4 Click OK to apply your changes. |

This option is available if the custom theme is selected.
### What to Format in the Widget

| Change how the rows of microcharts are displayed, to Grid, Vertical Scroll, or Ticker | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
2 From the drop-down list, select **Mode**.  
3 Click the **Mode** tab.  
4 From the **Operation mode** drop-down list, choose a display method from one of the following:  
   - **Grid**: This is the default operation mode for a Microcharts widget. In this mode, all the rows of microcharts are displayed at the same time in a grid layout.  
   - **Vertical Scroll**: In this mode, users can view each row of microcharts as they automatically scroll from the top to the bottom. Users can also manually navigate from one row to the next using Previous and Next buttons on the right side of the widget.  
   - **Ticker**: In this mode, microcharts and supplemental text are displayed in a scrolling ticker that moves from right to left. You can add text next to each microchart to provide background information or highlight a trend displayed in the microchart. This text is displayed alongside the microcharts as they scroll horizontally. This mode is not available if the widget is set up to display in KPI List mode. For details, see *Creating a Microcharts widget*, page 320.  
5 Click **OK** to apply your changes. |
| Define the number of metrics used to calculate each row of microcharts in KPI List mode | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
2 From the drop-down list, select **Mode**.  
3 Click the **Mode** tab.  
4 Type a number in the **Metrics per KPI** field.  
5 Click **OK** to apply your changes. |
| Show or hide the column headings | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
2 From the drop-down list, select **Mode**.  
3 Click the **Mode** tab.  
4 Select or clear the **Hide column headers** check box.  
5 Click **OK** to apply your changes. |
| Show or hide the text columns | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
2 From the drop-down list, select **Mode**.  
3 Click the **Mode** tab.  
4 Select or clear the **Hide text columns** check box.  
5 Click **OK** to apply your changes. |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Lock or unlock the Microcharts layout                                                       | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 Click the Mode tab.  
4 Select or clear the Lock layout check box.  
5 Click OK to apply your changes.                                                                 |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Set the scroll speed in Ticker mode This option is only available | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 Click the Ticker tab.  
4 In the Motion drop-down list, select a scroll speed from Slow, Normal, and Fast.  
5 Click OK to apply your changes.                                                                                                                                 |
| if the operation mode is set to Ticker.                          |                                                                                                                                                                                                             |
| Define the text displayed for the tickers in Ticker mode         | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 Click the Ticker tab.  
4 Type a value to be displayed when the ticker is below its target value, in the Ticker 1(M3 < M7) field.  
5 Type a value to be displayed when the ticker is above its target value, in the Ticker 2(M3 >= M7) field.  
6 Click OK to apply your changes.                                                                                                                                 |
| This option is only available if the operation mode is set to Ticker. |                                                                                                                                                                                                             |
| Adjust the color of tickers displayed in Ticker mode             | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 Click the Ticker tab.  
4 From the Ticker 1 color and Ticker 2 color palettes, select a color for Ticker 1 and Ticker 2.  
5 Click OK to apply your changes.                                                                                                                                 |
| This option is only available if the operation mode is set to Ticker. |                                                                                                                                                                                                             |
| Determine whether widget rows are shown in a tree display        | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 Select the Tree display check box.  
4 Click OK to apply your changes.                                                                                                                                 |
| With a tree, rows are displayed in groups that can be collapsed and expanded. This option is available only if the operation mode is set to Grid. This option is not available in KPI List mode. |                                                                                                                                                                                                             |
| Set the aggregation function in the tree display This function determines how the totals for the groups within the tree display are calculated. For example, if a group consists of several regions, the user can view the average of metric values taken across all the regions in the group. This option is available only if the Tree display check box is selected. | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Mode.  
3 From the Aggregation function drop-down list, select one of the following:  
• Sum  
• Average  
• Count  
• Max  
• Min  
4 Click OK to apply your changes.                                                                                                                                 |

<table>
<thead>
<tr>
<th>Note:</th>
<th></th>
</tr>
</thead>
</table>
### What to Format in the Widget

- **Display only a single metric column in the widget when it is displayed on the iPad or Android tablet.**
  - Users can tap the metric column on the iPad or Android tablet to toggle the metric displayed in the widget. This option is available only for widgets displayed in KPI List mode or Grid mode on the iPad or Android Tablet. For details, see *Creating a Microcharts widget, page 320.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
  | **Display only a single metric column in the widget when it is displayed on the iPad or Android tablet.** Users can tap the metric column on the iPad or Android tablet to toggle the metric displayed in the widget. This option is available only for widgets displayed in KPI List mode or Grid mode on the iPad or Android Tablet. For details, see *Creating a Microcharts widget, page 320.* | **1.** In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
  **2.** From the drop-down list, select **Mode**.  
  **3.** Select the Enable smooth scroll mode for metrics (mobile only) check box.  
  **4.** Click OK to apply your changes. |
  | **Determine whether to apply formatting inherited from the widget’s underlying grid.** The following formatting can be inherited from the underlying grid:  
  - Number and date formatting  
  - Font type, alignment, and color  
  - Background and border color of row axis heading  
  - The color used to highlight items selected in the widget | **1.** In Editable Mode, right-click the widget, then point to **View Mode** and select Grid View.  
  **2.** Right-click the widget, then select **Properties and Formatting**. The Properties and Formatting dialog box opens.  
  **3.** Format the widget’s underlying grid by selecting the appropriate options to format the row axis headers and values in the Properties and Formatting dialog box. For details on each formatting option, click Help.  
  **4.** Click OK to apply your changes and return to the widget.  
  **5.** In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
  **6.** From the drop-down list, select Options.  
  **7.** Do one of the following:  
  - To apply formatting from the widget’s underlying grid, select the Inherit grid formatting check box.  
  - To display the widget without inheriting formatting, clear the Inherit grid formatting check box.  
  **8.** Click OK to apply your changes. |
The table below lists the different aspects of the Media widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 369*. For steps to enable DHTML, see the *MicroStrategy Web Help*.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine the color used to highlight items selected in the widget</td>
<td>1 In Design or Editable Mode, right-click the widget's Grid/Graph, then select <code>Properties and Formatting</code>. The Properties and Formatting dialog box opens. &lt;br&gt;2 From the left under Format, click <code>Color and Lines</code>. &lt;br&gt;3 From the <code>Selection Color</code> drop-down list, select the color to use to highlight items. &lt;br&gt;4 Click OK to apply your changes.</td>
</tr>
<tr>
<td>Notes:</td>
<td></td>
</tr>
</tbody>
</table>
| • The widget must be configured as a selector in order for users to choose items in the widget. For steps, see *Using a Microcharts widget as a selector, page 451*.  
• You must apply formatting inherited from the widget's underlying grid, as described in the steps above.  
• To display the selection color on a mobile device, you must display the widget using the Custom display theme, as described below. |                                                                                                                                                                                                                 |
| Determine the display theme to use to display the Microcharts widget on an iOS or Android device | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select `Properties`. The Microcharts dialog box opens.  
2 From the drop-down list, select `Options`.  
3 From the `Choose Theme` drop-down list, select a color theme to use to display the widget, as follows:  
• To display the widget using a light-colored theme, select `Light` (default).  
• To display the widget using a dark-colored theme, select `Dark`.  
• To display the widget using custom color options that you define, select `Custom`. The colors that you select for the widget in the Microcharts dialog box will be used to display the widget on a mobile device. |
**Prerequisite**

- The following procedures assume that you have enabled viewing the
document in Flash Mode, Interactive Mode, or Express Mode. For steps,
see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show or hide the bar microcharts in the widget</td>
<td>1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  2 From the drop-down list, select Options.  3 Click the Bar tab.  4 Select or clear the Show bar graph check box.  5 Click OK to apply your changes.</td>
</tr>
<tr>
<td>Show or hide the minimum and maximum values for the bar microcharts</td>
<td>1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  2 From the drop-down list, select Options.  3 Click the Bar tab.  4 Select or clear the Min/max legend check box.  5 Click OK to apply your changes.</td>
</tr>
<tr>
<td>Show or hide the reference line</td>
<td>1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  2 From the drop-down list, select Options.  3 Click the Bar tab.  4 Select or clear the Reference line check box.  5 Click OK to apply your changes.</td>
</tr>
<tr>
<td>Show or hide tooltips</td>
<td>1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  2 From the drop-down list, select Options.  3 Click the Bar tab.  4 Select or clear the Show Tooltips check box.  5 Click OK to apply your changes.</td>
</tr>
</tbody>
</table>
The table below lists the different aspects of the Media widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 369*. For steps to enable DHTML, see the *MicroStrategy Web Help*.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Adjust the color of the bars (series) in the bar microcharts  
These options are available if the custom theme is selected. | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
2 From the drop-down list, select **Colors**.  
3 Click the **Bar** tab.  
4 From the **Positive values** palette, select a color for the positive bars.  
5 From the **Negative values** palette, select a color for the negative bars.  
6 From the **Reference Line** palette, select a color for the reference line.  
7 Click **OK** to apply your changes. |
| Add a descriptive column header name above the bar microcharts | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
2 From the drop-down list, select **Labels**.  
3 Click the **Bar** tab.  
4 In the **Header** field, type a descriptive name for the column heading that is displayed above the bar charts.  
5 Click **OK** to apply your changes. |

**Formatting sparkline microcharts**

![Sparkline screenshot](image)

...
Prerequisite

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Show or hide the sparkline microcharts in the widget            | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
  2 From the drop-down list, select **Options**.  
  3 Click the **Sparkline** tab.  
  4 Select or clear the **Show sparkline graph** check box.  
  5 Click **OK** to apply your changes.                                                                                                                                                                                                                                            |
| Show or hide the markers on the line graph in the sparkline microcharts | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
  2 From the drop-down list, select **Options**.  
  3 Click the **Sparkline** tab.  
  4 To show or hide all of the markers between the first and last markers, select or clear the **All points** check box.  
  5 To show or hide the first and last markers on the line graph, select or clear the **End points** check box. If All points is selected above, this option is not available.  
  6 Click **OK** to apply your changes.                                                                                                                                                                                                                                             |
| Show or hide the horizontal reference line or sparkline background (reference area) | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
  2 From the drop-down list, select **Options**.  
  3 Click the **Sparkline** tab.  
  4 Select or clear the **Reference line** check box to show or hide the reference line.  
  5 Select or clear the **Reference area** check box to show or hide the reference area background.  
  6 Click **OK** to apply your changes.                                                                                                                                                                                                                                             |
| Show or hide the metric column and values associated with the sparkline microcharts | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
  2 From the drop-down list, select **Options**.  
  3 Click the **Sparkline** tab.  
  4 Select or clear the **Associated metric** check box.  
  5 Click **OK** to apply your changes.                                                                                                                                                                                                                                             |
| Show or hide tooltips                                           | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Microcharts dialog box opens.  
  2 From the drop-down list, select **Options**.  
  3 Click the **Sparkline** tab.  
  4 Select or clear the **Show Tooltips** check box.  
  5 Click **OK** to apply your changes.                                                                                                                                                                                                                                             |
## What to Format in the Widget | How to Format It

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Select series line, reference line, and reference area (background) colors These options are available if the custom theme is selected. | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Colors.  
3 Click the Sparkline tab.  
4 Select a color from the Series line, the Reference line, and the Reference area palettes.  
5 Click OK to apply your changes. |
| Add a descriptive column heading name above the sparkline microcharts                          | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Labels.  
3 Click the Sparkline tab.  
4 Type a name in the Header field. This text displays above the sparkline microcharts.  
5 Click OK to apply your changes. |
| Add a descriptive heading name for the metric column associated with the sparkline microcharts | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Labels.  
3 Click the Sparkline tab.  
4 Type a name or value in the Associated metric field. This text displays above the metric column.  
5 Click OK to apply your changes.  
6 The heading name is only displayed when the Associated metric check box is selected from the Sparkline tab in the Options menu. |

## Formatting bullet microcharts

The table below lists the different aspects of the Media widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 369*. For steps to enable DHTML, see the *MicroStrategy Web Help*. 
Prerequisite

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show or hide the bullet microcharts in the widget</td>
<td>1 In <strong>Flash Mode</strong>, <strong>Interactive Mode</strong>, or <strong>Express Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 From the drop-down list, select <strong>Options</strong>.</td>
</tr>
<tr>
<td></td>
<td>3 Click the <strong>Bullet</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>4 Select or clear the <strong>Show bullet graph</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>5 Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>Show or hide the vertical reference line or color bands</td>
<td>1 In <strong>Flash Mode</strong>, <strong>Interactive Mode</strong>, or <strong>Express Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 From the drop-down list, select <strong>Options</strong>.</td>
</tr>
<tr>
<td></td>
<td>3 Click the <strong>Bullet</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>4 Select or clear the <strong>Reference line</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>5 Select or clear the <strong>Reference bands</strong> check box to show or hide color bands.</td>
</tr>
<tr>
<td></td>
<td>6 Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>Show or hide a legend for the bullet microcharts</td>
<td>1 In <strong>Flash Mode</strong>, <strong>Interactive Mode</strong>, or <strong>Express Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 From the drop-down list, select <strong>Options</strong>.</td>
</tr>
<tr>
<td></td>
<td>3 Click the <strong>Bullet</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>4 Select or clear the <strong>Band legend</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>5 Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>Show or hide the metric column and values associated with the bullet microcharts</td>
<td>1 In <strong>Flash Mode</strong>, <strong>Interactive Mode</strong>, or <strong>Express Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 From the drop-down list, select <strong>Options</strong>.</td>
</tr>
<tr>
<td></td>
<td>3 Click the <strong>Bullet</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>4 Select or clear the <strong>Associated metric</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>5 Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>Determine whether the bullet microchart is displayed from left to right or right to left (inverted)</td>
<td>1 In <strong>Flash Mode</strong>, <strong>Interactive Mode</strong>, or <strong>Express Mode</strong>, right-click the widget and select <strong>Properties</strong>. The Microcharts dialog box opens.</td>
</tr>
<tr>
<td></td>
<td>2 From the drop-down list, select <strong>Options</strong>.</td>
</tr>
<tr>
<td></td>
<td>3 Click the <strong>Bullet</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>4 Select or clear the <strong>Invert graph axis</strong> check box.</td>
</tr>
<tr>
<td></td>
<td>5 Click <strong>OK</strong> to apply your changes.</td>
</tr>
<tr>
<td>What to Format in the Widget</td>
<td>How to Format It</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------</td>
</tr>
</tbody>
</table>
| **Show or hide tooltips**    | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Options.  
3 Click the Bullet tab.  
4 Select or clear the Show Tooltips check box.  
5 Click OK to apply your changes. |
| **Define a minimum scale-setting value**  
Bullet graphs with performance bars below the minimum value will not be displayed in the widget. | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Options.  
3 Click the Bullet tab.  
4 Click the Bullet tab.  
5 Select or clear the Show Tooltips check box.  
6 Click OK to apply your changes. |
| **Adjust the color of the performance bar**  
These options are available if the custom theme is selected. | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Colors.  
3 Click the Bullet tab.  
4 From the Positive values palette, select a color for the positive parts of the performance bar.  
5 From the Negative values palette, select a color for the negative parts of the performance bar.  
6 Click OK to apply your changes. |
| **Adjust the color of the vertical target line**  
These option is available if the custom theme is selected. | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Colors.  
3 Click the Bullet tab.  
4 From the Reference line palette, select a color for the vertical target line.  
5 Click OK to apply your changes. |
| **Adjust the color of the reference bands**  
These options are available if the custom theme is selected. | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Colors.  
3 Click the Bullet tab.  
4 From the Band 1, Band 2, and Band 3 palettes, select a color for each reference band, from left to right.  
5 Click OK to apply your changes. |
| **Add a descriptive column heading name above the bullet microcharts** | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
2 From the drop-down list, select Labels.  
3 Click the Bullet tab.  
4 In the Header field, type a descriptive name for the column heading above the bullet charts.  
5 Click OK to apply your changes. |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Add a descriptive heading name for the metric column associated with the bullet microcharts | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
  2 From the drop-down list, select Labels.  
  3 Click the Bullet tab.  
  4 Type a name in the Associated metric field. This text displays above the metric column.  
  5 Click OK to apply your changes.  
  6 The heading name is only displayed when the Associated metric check box is selected from the Bullet tab in the Options menu. |
| Add descriptive names to the legend that describes the different reference band colors     | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Microcharts dialog box opens.  
  2 From the drop-down list, select Labels.  
  3 Click the Bullet tab.  
  4 In the Band 1, Band 2, and Band 3 fields, type a descriptive name for each reference band name displayed on the legend, from left to right.  
  5 Click OK to apply your changes. |

**Formatting an RSS Reader widget**

For an image of an RSS Reader widget and steps to add one to a document, see *Creating an RSS Reader widget, page 335.*

(You can design a separate type of RSS Reader widget to be displayed on a mobile device; for more information, see the *Mobile Design and Administration Guide.*)

The table below lists the different aspects of the RSS Reader widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see *Defining how a widget is displayed in different views and modes, page 369.* For steps to enable DHTML, see the *MicroStrategy Web Help.*
Prerequisite

- The following procedures assume that you have enabled viewing the
document in Flash Mode, Interactive Mode, or Express Mode. For steps,
see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Add a title to the RSS news feed | 1 In *Flash Mode, Interactive Mode,* or *Express Mode,* right-click the widget and select *Properties.* The RSS Reader dialog box opens.  
2 Select the *General* tab.  
3 Type a title in the *RSS reader title* field. This title appears in the top right of the widget.  
4 To format the color of the title, select a color from the *RSS reader title color* palette.  
5 Click *OK* to apply your changes. |
| Define the web address of the RSS content displayed in the widget | 1 In *Flash Mode, Interactive Mode,* or *Express Mode,* right-click the widget and select *Properties.* The RSS Reader dialog box opens.  
2 Select the *General* tab.  
3 Type the web address of the RSS content in the *Default RSS Field.*  
4 Click *OK* to apply your changes. |
| Determine the frequency with which the widget refreshes its content | 1 In *Flash Mode, Interactive Mode,* or *Express Mode,* right-click the widget and select *Properties.* The RSS Reader dialog box opens.  
2 Select the *General* tab.  
3 Type the refresh frequency in seconds in the *Default refresh frequency (Sec)* field.  
4 Click *OK* to apply your changes. |
| Determine the number of RSS feed items to show on one page of the widget | 1 In *Flash Mode, Interactive Mode,* or *Express Mode,* right-click the widget and select *Properties.* The RSS Reader dialog box opens.  
2 Select the *General* tab.  
3 Type the number of items in the *Items shown at a time* field.  
4 Click *OK* to apply your changes. |
| Open the entire article in a new window when an RSS item is clicked in the widget | 1 In *Flash Mode, Interactive Mode,* or *Express Mode,* right-click the widget and select *Properties.* The RSS Reader dialog box opens.  
2 Select the *General* tab.  
3 Select the *Open full article when clicked* check box.  
4 Click *OK* to apply your changes. |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Allow the widget to display RSS content that is located on a different web domain than the one used for MicroStrategy Web | 1 In **Flash Mode, Interactive Mode, or Express Mode**, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
   2 Select the **General** tab.  
   3 Select the **Use Proxy** check box.  
   4 Click **OK** to apply your changes.                                                                                                                                 |
| Choose the background color of the widget                                                    | 1 In **Flash Mode, Interactive Mode, or Express Mode**, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
   2 Select the **General** tab.  
   3 Choose a color from the **Background color** palette.  
   4 Click **OK** to apply your changes.                                                                                                                                 |
| Choose the border color of the widget                                                       | 1 In **Flash Mode, Interactive Mode, or Express Mode**, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
   2 Select the **General** tab.  
   3 Choose a color from the **Border Color** palette.  
   4 Click **OK** to apply your changes.                                                                                                                                 |
| Specify the area occupied by the news items                                                | 1 In **Flash Mode, Interactive Mode, or Express Mode**, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
   2 Select the **News Items** tab.  
   3 From the drop-down list, select **General**.  
   4 In the **Percentage height occupied by the news items list** field, specify how much of the total area the list of news items should occupy.  
   5 Click **OK** to apply your changes.                                                                                                                                 |
| Determine whether news items scroll automatically, how fast, and in what direction         | 1 In **Flash Mode, Interactive Mode, or Express Mode**, right-click the widget and select **Properties**. The RSS Reader dialog box opens.  
   2 Select the **News Items** tab.  
   3 From the drop-down list, select **General**.  
   4 To allow news items to scroll automatically, select the **Auto Scroll News Item List** check box.  
   5 From the **Auto Scroll Direction** drop-down list, specify the direction in which news items automatically scroll by selecting **Up** or **Down**.  
   6 From the **Auto Scroll Speed (Sec)** drop-down list, specify the speed in seconds at which the news items scroll.  
   7 Click **OK** to apply your changes.                                                                                                                                 |
<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine the font and font size of news items | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the News Items tab.  
3 From the drop-down list, select Fonts.  
4 From the Font Type and Font Size drop-down lists, select a font and size, respectively.  
5 Select the Italic and Bold check boxes to display the text in italics and bold, respectively.  
6 Click OK to apply your changes. |
| Choose the color of news items | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the News Items tab.  
3 From the drop-down list, select Colors.  
4 To display the news items with alternating colors, select the Alternating color for news items check box.  
5 From the drop-down list, specify whether to format the Background, Rollover background, Font, or Rollover font.  
6 Once you select an aspect of the news items to format, from the color palettes, select the two colors in which to display the news items.  
7 Click OK to apply your changes. |
| Determine how news articles that have been read are displayed | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the News Items tab.  
3 From the drop-down list, select Read Articles.  
4 To ensure that news articles that have been read are displayed in a separate color, select the Mark as read check box.  
5 From the color palettes, select the color in which to display all articles that have been read.  
6 Click OK to apply your changes. |
| Format the font of the news details section | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The RSS Reader dialog box opens.  
2 Select the News Detail tab.  
3 From the Font Type and Font Size drop-down lists, select a font and font size.  
4 From the Font color palette, select a font color.  
5 You can also select the Italic and Bold check boxes to display the text in italics and bold, respectively.  
6 Click OK to apply your changes. |
### Formatting an RSS Reader widget for a mobile device

The RSS Reader widget is available to be displayed on a mobile device with MicroStrategy Mobile.

For steps to create and format an RSS Reader widget for a mobile device, see the *Mobile Design and Administration Guide*.

### Formatting a Thermometer widget

For an image of a Thermometer widget and steps to add one to a document, see *Creating a Thermometer widget, page 358*.

The table below lists the different aspects of the Thermometer widget that you can format, and describes the steps to format them in MicroStrategy Web.
**Prerequisite**

- The following procedures assume that you have enabled viewing the document in Flash Mode. For steps, see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine the colors and shading scheme of the thermometer | 1 In *Flash Mode*, right-click the widget and select Properties. The Thermometer dialog box opens.  
2 From the Thermometer Type drop-down list, select a shading scheme for the thermometer.  
3 Click OK to apply your changes. |
| Determine the numbers that appear at the bottom and top of the thermometer (the minimum and maximum values) | 1 In *Flash Mode*, right-click the widget and select Properties. The Thermometer dialog box opens.  
2 In the Min Value and Max Value fields, type the minimum and maximum values for the thermometer.  
3 Click OK to apply your changes. |
| Determine whether to apply formatting inherited from the widget’s underlying graph report | 1 In *Editable Mode*, right-click the widget, point to View Mode, and select Graph View.  
2 From the Format menu, select Graph. The Format: Graph dialog box opens.  
3 From the Graph type drop-down list, select Vertical Bar.  
4 Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click Help.  
5 Click OK to apply your changes and return to the widget.  
6 In *Flash Mode*, right-click the widget and select Properties. The Thermometer dialog box opens.  
7 Do one of the following:  
   • To apply formatting from the widget’s underlying graph, select the Inherit grid-graph formatting check box.  
   • To display the widget without inheriting formatting, clear the Inherit grid-graph formatting check box.  
8 Click OK to apply your changes. |

**Formatting a Time Series Slider widget**

For an image of a Time Series Slider widget and steps to add one to a document, see *Creating a Time Series Slider widget, page 360.*

The table below lists the different aspects of the Time Series Slider widget that you can format, and describes the steps to format them in MicroStrategy Web.
### Prerequisite

- The following procedures assume that you have enabled viewing the document in Flash Mode. For steps, see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Display the graph legend inside or outside the graph | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Time Series Slider dialog box opens.  
2 Select or clear the **Display legend outside of graph** check box.  
3 Click **OK** to apply your changes. |
| Maintain height of the Y-axis or have it resize automatically | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Time Series Slider dialog box opens.  
2 Select or clear the **Enable fixed Y-axis** check box.  
If this check box is selected, the Y-axis of the primary graph remains at a fixed height regardless of the data or any changes to the data.  
If this check box is cleared, the Y-axis automatically resizes based on the data that is displayed.  
3 Click **OK** to apply your changes. |
| View only a subset of the dataset on the graph  
Enable this option only if you are working with datasets in which removing data points will not affect the overall meaning of the graph. | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Time Series Slider dialog box opens.  
2 Select the **Enable Data Sampling** check box.  
If this check box is selected, an equally dispersed set of X-axis values are displayed on the graph to give you an overall impression about the graph’s values.  
3 In the **Data Sampling Maximum Window Size**, type the maximum number of values to display in the data sampling.  
4 Click **OK** to apply your changes. |
| Display all series as line graphs  
By default, the first series in the graph is displayed as an area graph. You can choose to display this series as a line graph. | 1 In **Flash Mode**, right-click the widget and select **Properties**. The Time Series Slider dialog box opens.  
2 Select the **All series as line graphs** check box.  
3 Click **OK** to apply your changes. |
Formatting a Waterfall widget

For an image of a Waterfall widget and steps to add one to a document, see Creating a Waterfall widget, page 363.

The table below lists the different aspects of the Waterfall widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see Defining how a widget is displayed in different views and modes, page 369. For steps to enable DHTML, see the MicroStrategy Web Help.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define the slider position</td>
<td>1 In Flash Mode, right-click the widget and select Properties. The Time Series Slider dialog box opens.</td>
</tr>
<tr>
<td>The slider can be given a default position, or return to the same position it was in when</td>
<td>2 Do one of the following:</td>
</tr>
<tr>
<td>the document was last saved.</td>
<td>• To save the slider position, select the Save Slider Position option. When this document is saved and</td>
</tr>
<tr>
<td></td>
<td>re-executed, the most recent slider position is used to determine what range is displayed.</td>
</tr>
<tr>
<td></td>
<td>• To set a default slider position, select the Set Default Slider Position option. Then choose one of</td>
</tr>
<tr>
<td></td>
<td>the following:</td>
</tr>
<tr>
<td></td>
<td>Select Entire Available Range to display the entire graph.</td>
</tr>
<tr>
<td></td>
<td>Select Last Points in the Range and type a number in the field to specify the total number of data</td>
</tr>
<tr>
<td></td>
<td>points to display, starting from the last point in the graph. For example, type 5 in the field to</td>
</tr>
<tr>
<td></td>
<td>display the last five data points in the graph.</td>
</tr>
<tr>
<td></td>
<td>3 Click OK to apply your changes.</td>
</tr>
<tr>
<td>Define the slider or primary graph as a selector</td>
<td>1 In Flash Mode, right-click the widget and select Properties. The Time Series Slider dialog box opens.</td>
</tr>
<tr>
<td>You can use either the slider or the primary graph portion of the Time Series Slider widget</td>
<td>2 Do one of the following:</td>
</tr>
<tr>
<td>as a selector, which will update a target Grid/Graph on the dashboard-style document when</td>
<td>• To use the slider as the selector, select Slider from the Selectable Area drop-down list.</td>
</tr>
<tr>
<td>the user clicks the selector. For details, see Using a Time Series Slider widget as a selector,</td>
<td>• To use the primary graph as the selector, select Primary Graph from the Selectable Area drop-down</td>
</tr>
<tr>
<td>page 453.</td>
<td>list. To update the target with a mouseover rather than a click, select the Change selection on mouse</td>
</tr>
<tr>
<td></td>
<td>over option.</td>
</tr>
<tr>
<td></td>
<td>3 Click OK to apply your changes.</td>
</tr>
</tbody>
</table>
### Prerequisite

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see *Determining the display modes users can choose to work in, page 61.*

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine colors and shadow effects for the increments and decrements bars | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens.  
2 Click the **Color** tab.  
3 Select the **Apply Increment/Decrement Color** check box.  
4 Select a color for the increments bars from the **Increments Base Color** drop-down list.  
5 Select a color for the decrements bars from the **Decrements Base Color** drop-down list.  
6 Select or clear the **Apply Shadow Effect on Bars** check box.  
7 Click **OK** to apply your changes.  
The first increment/decrement series uses the base color, and subsequent series are colored in a shade of the base color. If the base color is dark, additional series use lighter shades; if the base color is light, additional series use darker shades. |
| Determine border color | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens.  
2 On the **Color** tab, select a color from the **Border color** palette.  
3 Click **OK** to apply your changes. |
| Determine whether increments and decrements are calculated by the widget or based on the metrics | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens.  
2 Click the **Data** tab.  
3 Do one of the following:  
  - If the data contains the amounts of increase or decrease per period, select the **Increments/Decrements Provided** check box to display the increment or decrement data. To use this setting, the widget should contain metrics on the rows and attributes on the columns, which allows you to place the metrics along the X-axis in a specified order. This displays the increment and decrement bars in the order specified.  
  - To have the widget calculate the increments or decrements, clear the **Increments/Decrements Provided** check box. To use this setting, the widget should contain metrics in the columns and attributes in the rows. The metrics should depict the total value of each unit of time.  
4 Click **OK** to apply your changes. |
## What to Format in the Widget | How to Format It

| Determine whether the final bar (located on the far right of the widget) is calculated by the widget or provided by the Grid/Graph data | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens.  
2 Click the **Data** tab.  
3 Do one of the following:  
   • If the data contains the information for the final bar, select the **Final Bar Provided** check box.  
   • If you want the widget to calculate the final bar, clear the **Final Bar Provided** check box. You can also define a name for the final bar (see below).  
4 Click **OK** to apply your changes. |
|---|---|
| Provide a label or name for the final bar  
The name is used as a label for the bar on the far right of the widget. By default, it is named Final. This option is available only if the final bar is calculated by the widget (see above). | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens.  
2 Click the **Data** tab.  
3 Specify the label text in the **Text for Last Entry** field.  
4 Click **OK** to apply your changes. |
| Determine whether lines connecting adjacent bars of the same series are displayed  
This option is available only if the widget contains a single series. | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens.  
2 Click the **Data** tab.  
3 Select or clear the **Add Connecting Lines** check box.  
4 Click **OK** to apply your changes. |
| Determine whether to show additional series in tooltips  
This option is available only if the Grid/Graph contains attributes and metrics on different axes. | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens.  
2 Click the **Data** tab.  
3 Select or clear the **Show Additional Series in Tooltip** check box.  
4 Click **OK** to apply your changes. |
| Determine whether to display X-axis labels on a single line or on staggered lines  
Staggering labels allows all labels to be visible if they do not all fit below the widget when in a single line. | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens.  
2 Click the **Data** tab.  
3 Do one of the following:  
   • To stagger X-axis labels if all the labels do not fit below the widget, select the **Stagger But Do Not Drop X-Axis Labels** check box. All labels are displayed; none are removed from the widget.  
   • To display the labels on a single line, clear the **Stagger But Do Not Drop X-Axis Labels** check box. Labels that do not fit are not displayed.  
4 Click **OK** to apply your changes. |
## What to Format in the Widget

| Determine whether horizontal target lines are displayed in the widget, and the number of target lines to display | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens.  
2 Click the **What-if** tab.  
3 Do one of the following:  
   - To hide the target lines, select 0 in the **Number of Target Lines** field.  
   - To display horizontal target lines, select the number of lines in the **Number of Target Lines** field.  
4 Click **OK** to apply your changes.  
5 If target lines are displayed, you can move the target lines up and down in the widget. |
|---|---|
| Determine whether “what-if” analysis is enabled  
“What-if” analysis allows users to modify the size of bars using bar handlers. Increasing or decreasing the size of a bar affects the values in the widget. A user can also review the history of his changes to the bar size, and reset the bars to their original values. | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens.  
2 Click the **What-if** tab.  
3 Select or clear the **Enable What-if Analysis** check box.  
4 Click **OK** to apply your changes.  
5 Use the steps below to enable bar handlers so users can modify the size of bars to perform a what-if analysis. |
| Determine whether bar handlers are displayed  
Bar handlers enable users to perform “what-if” analysis with the widget. If bar handlers are hidden, a user can display them by pointing to a bar.  
This option is available only if “what-if” analysis is enabled. | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens.  
2 Click the **What-if** tab.  
3 Select or clear the **Show Bar Handlers** check box.  
4 Click **OK** to apply your changes. |
| Determine whether to apply formatting inherited from the widget’s underlying graph report  
The following formatting can be inherited from the underlying graph:  
• Number formatting  
• Font type and color  
• Background and border color of the widget  
• Legend formatting, including background color, border color, and font used to display items in the legend  
• Whether the y-axis always includes a value of zero | 1 In **Editable Mode**, right-click the widget, point to **View Mode**, and select **Graph View**.  
2 From the **Format** menu, select **Graph**. The Format: Graph dialog box opens.  
3 From the **Graph type** drop-down list, select **Vertical Bar**.  
4 Format the widget’s underlying graph by selecting the appropriate options in the dialog box. For details on each option to format the widget’s underlying graph report, click **Help**.  
5 Click **OK** to apply your changes and return to the widget.  
6 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Waterfall dialog box opens.  
7 Do one of the following:  
   - To apply formatting from the widget’s underlying graph, select the **Inherit graph formatting** check box.  
   - To display the widget without inheriting formatting, clear the **Inherit graph formatting** check box.  
8 Click **OK** to apply your changes. |
Formatting a Weighted List Viewer widget

For an image of a Weighted List Viewer widget and steps to add one to a document, see Creating a Weighted List Viewer widget, page 366.

The table below lists the different aspects of the Weighted List Viewer widget that you can format, and describes the steps to format them in MicroStrategy Web. The steps can be performed in Flash Mode. They can also be performed in Interactive Mode if the widget has been defined to display as a widget in DHTML, and DHTML is enabled in Web. For steps to determine how the widget is displayed, see Defining how a widget is displayed in different views and modes, page 369. For steps to enable DHTML, see the MicroStrategy Web Help.

Prerequisite

- The following procedures assume that you have enabled viewing the document in Flash Mode, Interactive Mode, or Express Mode. For steps, see Determining the display modes users can choose to work in, page 61.

<table>
<thead>
<tr>
<th>What to Format in the Widget</th>
<th>How to Format It</th>
</tr>
</thead>
</table>
| Determine the band colors in the widget  
These bands appear in the stacked bar chart on the left side of the widget and in the grid on the right side. Each color corresponds to good, neutral, or bad performance | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Weighted List Viewer dialog box opens.  
2 Choose colors from the Band 1, Band 2, and Band 3 color palettes. If only two color bands are enabled, then Band 2 is not available.  
3 Click OK to apply your changes. |
| Determine whether two or three color bands are displayed  
When only two bands are displayed, the colors of Band 1 and Band 3 are used to display the two bands in the widget. | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Weighted List Viewer dialog box opens.  
2 Select or clear the Use only two bands check box.  
3 Click OK to apply your changes. |
| Show or hide the lines on the stacked graph on the left side of the widget | 1 In Flash Mode, Interactive Mode, or Express Mode, right-click the widget and select Properties. The Weighted List Viewer dialog box opens.  
2 Select or clear the Graph gridlines check box.  
3 Click OK to apply your changes. |
### What to Format in the Widget | How to Format It

| Apply a glass-like effect to the widget | 1 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Weighted List Viewer dialog box opens.  
2 Select or clear the **Glass effect** check box.  
3 Click **OK** to apply your changes. |
|----------------------------------------|--------------------------------------------------------------------------------------------------|
| Determine whether to apply formatting inherited from the widget's underlying grid report | 1 In **Editable Mode**, right-click the widget, then point to **View Mode** and select **Grid View**.  
2 Right-click the widget, then select **Properties and Formatting**. The Properties and Formatting dialog box opens.  
3 Format the widget's underlying grid by selecting the appropriate options in the dialog box. For details on each option to format the widget's underlying grid report, click **Help**.  
4 Click **OK** to apply your changes and return to the widget.  
5 In **Flash Mode**, **Interactive Mode**, or **Express Mode**, right-click the widget and select **Properties**. The Weighted List Viewer dialog box opens.  
6 Do one of the following:  
   - To apply formatting from the widget's underlying grid, select the **Inherit grid formatting** check box.  
   - To display the widget without inheriting formatting, clear the **Inherit grid formatting** check box.  
7 Click **OK** to apply your changes. |
VIEWING DATA RELATED TO WIDGETS: USING WIDGETS AS SELECTORS

Introduction

When a user clicks an element in a widget, data related to that element can be automatically displayed in other grid and graph reports on the dashboard-style document. To enable this, you make the widget a selector, and the grid or graph report a target. When the user clicks the selector, all targets automatically display data related to what the user clicked. For example, clicking a bubble for the Southeast region in an Interactive Bubble Graph widget automatically updates all target grid and graph reports and panel stacks on the same dashboard-style document, which now display Southeast data.

Widgets that can be designated as selectors are described in this chapter, along with how users interact with them when they are designated as a selector. This chapter also contains steps to designate a widget as a selector in a dashboard-style document. For basic descriptions and images of the different types of widgets, as well as steps to create the widget, see Chapter 5, Providing Flash Analysis and Interactivity: Widgets. For an introduction to selectors, see Chapter 4, Providing Interactivity to Users: Selectors.

To view and interact with widgets, you must have a supported version of Flash Player. See the MicroStrategy Readme for a list of supported versions.
For details on using other objects in a dashboard-style document as a selector, such as an attribute, metric, custom group, or consolidation, see Using Grid/Graphs as selectors to control other Grid/Graphs, page 219.

Using widgets as selectors

You can use report objects on the widget’s template as selectors. This allows a user to select which elements to display in other grid and graph reports and panel stacks in the dashboard-style document. The widget is used as a selector targeting a grid or graph report or panel stack.

For an introduction to all types of selectors, including examples, see Chapter 4, Providing Interactivity to Users: Selectors.

You can create selectors from the following widgets:

- Bubble Grid, page 443
- Data Cloud, page 443
- Graph Matrix (deprecated), page 443
- Heat Map, page 445
- Image Map, page 446
- Interactive Bubble Graph, page 446
- Interactive Stacked Graph, page 449
- Map, page 451
- Microcharts, page 451
- Network, page 452
- Time Series Slider, page 453
- Waterfall, page 456
- Weighted List Viewer, page 456

For steps to designate a widget to be used as a selector, see Creating the widget used as a selector, page 457.
Using a Bubble Grid widget as a selector

You can enable the bubbles of a Bubble Grid widget as selectors, so that clicking a bubble displays data related to it in all target Grid/Graphs and panel stacks in the dashboard-style document.

For example, an attribute in the widget is enabled as a selector. The elements of that attribute are displayed as bubbles in the widget. An analyst can click a bubble to update target Grid/Graphs and panel stacks in the dashboard-style document.

You can also enable the data labels along the X and Y axes of a Bubble Grid widget as selectors.

To create a Bubble Grid widget, see Creating a Bubble Grid widget, page 244. For steps to enable a Bubble Grid widget as a selector, see Creating the widget used as a selector, page 457.

Using a Data Cloud widget as a selector

The attribute elements displayed in a Data Cloud widget can be defined as selectors. Users can click attribute elements within the widget (in Flash or Interactive modes) to display related data in targeted grid and graph reports and panel stacks in the dashboard-style document.

If an attribute element has been designated to be used as a selector, the cursor changes to a hand pointer. For example, if the Region attribute is defined as a selector, the elements Northeast and Southeast can be used as selectors.

To create a Data Cloud widget, see Creating a Data Cloud widget, page 249. For steps to enable a Data Cloud widget as a selector, see Creating the widget used as a selector, page 457.

Using a Graph Matrix (deprecated) widget as a selector

A Graph Matrix (deprecated) widget consists of several attributes and elements in its column and row headers, and corresponding graphs at the intersection of those objects. You can enable these attributes, elements, graphs, and attribute names displayed in column headers as selectors. This allows an analyst to select an attribute, an attribute element, or a graph, and
then view specific data related to it in grid and graphs in the dashboard-style document. An analyst can also view data related to elements from different attributes simultaneously by clicking those elements.

The following scenarios describe how Graph Matrix (deprecated) widgets can be used as selectors:

- When you hover the cursor over an attribute name or attribute element that is enabled as a selector, the attribute name or element becomes a hyperlink. If you select the attribute name or element, all target Grid/Graphs and panel stacks display data related to it.

For example, the Electronics category and Southeast region are selected in the Graph Matrix (deprecated) widget below. Therefore, data related to the Southeast region and Electronics category is displayed in the target Grid/Graph on the right.

You cannot select multiple elements from the same attribute. If you select an attribute name from the headers, all corresponding attribute element selections are cleared. For example, if you select Category in the widget above, the Electronics category is no longer highlighted and data for all categories is displayed in the target Grid/Graph on the right.

The Category and Region attributes in the Graph Matrix (deprecated) widget can be used as selectors because they are enabled as selectors in
Editable Mode, as shown below. Notice that all categories and regions are hyperlinked because they are enabled as selectors.

- When you hover the cursor over a graph in the widget, the cursor is displayed as a hand pointer to indicate that the graph is a selector. If you click the graph, the two corresponding attribute elements in the headers are automatically selected. Therefore, all target Grid/Graphs and panel stacks display data related to those two elements. For example, if you select the graph at the intersection of the Mid-Atlantic region and Electronics product category, all data for Electronics sales in the Mid-Atlantic region is displayed.

- When you hover the cursor over a graph and click a specific data point in the graph, all data related to that data point is displayed in all target Grid/Graphs and panel stacks only if the time-based attribute on the Grid/Graph that contains the widget is enabled as a selector. You can also perform this task after maximizing a graph.

To create a Graph Matrix (deprecated) widget, see Creating a Graph Matrix (deprecated) widget, page 278. For steps to enable a Graph Matrix (deprecated) widget as a selector, see Creating the widget used as a selector, page 457.

Using a Heat Map widget as a selector

Report objects in a Heat Map widget can be defined as selectors, as described in Creating the widget used as a selector, page 457. In Flash Mode or Interactive Mode, users can interact with the widget to control targeted Grid/Graphs and panel stacks in the dashboard-style document.
You can use any related area headers or rectangles in the widget as selectors. A user can hover over and select a header or rectangle in the widget to display related data in target Grid/Graphs and panel stacks. If a rectangle or header can be used as a selector, the cursor changes to a hand pointer. For example, if the Category attribute is defined as a selector, the Category header can be used as a selector. If an additional attribute such as Region is also enabled as a selector, individual rectangles can be used as selectors. All data in target Grid/Graphs and panel stacks is updated after a user selects the header or rectangle.

To create a Heat Map widget, see Creating a Heat Map widget, page 283. To use a Heat Map widget as a selector, see Creating the widget used as a selector, page 457.

**Using an Image Layout widget as a selector**

Report objects in an Image Layout widget can be defined as selectors, as described in Creating the widget used as a selector, page 457. In Flash Mode, Express Mode, or Interactive Mode, users can interact with the widget to control targeted Grid/Graphs and panel stacks in the dashboard-style document.

You can use areas or bubble markers in the widget as selectors. A user can select an area or bubble marker in the widget to display related data in target Grid/Graphs and panel stacks. For example, if several customer regions are displayed in an Image Layout widget, you can allow users to select a region to update the data displayed in a grid in the document.

To create an Image Layout widget, see Creating an Image Layout widget, page 287. To use an Image Layout widget as a selector, see Creating the widget used as a selector, page 457.

**Using an Interactive Bubble Graph widget as a selector**

Report objects in an Interactive Bubble Graph widget can be defined as selectors, as described in Creating the widget used as a selector, page 457. In Flash Mode or Interactive Mode, users can interact with the widget to control targeted Grid/Graphs and panel stacks in the dashboard-style document.

The following parts of an Interactive Bubble Graph widget can be used as selectors to display data in Grid/Graphs and panel stacks:
• The **bubbles** in the widget can be used as selectors if their corresponding attributes are enabled as selectors in the Grid/Graph that contains the widget.

For example, in Flash Mode or Interactive Mode, a user can click a Northeast region bubble to display Northeast data in all target Grid/Graphs and panel stacks.

In Flash Mode or Interactive Mode, a user can double-click a bubble to drill down to the child elements of that bubble and to display data in the dashboard-style document related to the bubble. To display data related to the drill-to element, a user can click the child bubble. All target Grid/Graphs and panel stacks are updated with data related to the selection. For more information about drilling in an Interactive Bubble Graph widget, see *Supporting drilling in an Interactive Bubble Graph widget*, page 297.

• The **attribute elements in the legend** can be used as selectors if the columns of the Grid/Graph that contains the widget have an attribute that is enabled as a selector.

In Flash Mode or Interactive Mode, a user can click an attribute element in the legend. Only one item in the legend can be selected at a time. For example, a user can click the legend item for the Central region to display data for the Central region in all target Grid/Graphs and panel stacks.

When a user hovers the cursor over these selectable parts of the widget, the cursor turns into a hand, indicating that it can be selected.

For example, the Region attribute in the Interactive Bubble Graph widget below is enabled as a selector. When you select a region bubble from the
A user can also select multiple bubbles, by dragging a selection box (or lasso) around the bubbles. For example, a user drags a selection box around the two Electronics and Books bubbles in the middle of the widget. If the selection box is set to automatically update the target, the target graph displays data related to those bubbles. Otherwise, the user must click the Select icon in the button bar to update the target graph.

To use a widget as a selector, you first choose the target Grid/Graph and/or panel stack in Design Mode or Editable Mode.

In Flash Mode or Interactive Mode, you can ensure that target Grid/Graphs and panel stacks are updated when a user hovers over a bubble or an item in the legend, instead of clicking it.
To create an Interactive Bubble Graph widget, see *Creating an Interactive Bubble Graph widget*, page 295. To enable an Interactive Bubble Graph widget as a selector, see *Creating the widget used as a selector*, page 457.

## Using an Interactive Stacked Graph widget as a selector

Report objects in an Interactive Stacked Graph widget can be defined as selectors, as described in *Creating the widget used as a selector*, page 457. In Flash Mode, users can interact with the widget to control targeted Grid/Graphs and panel stacks in the dashboard-style document.

The following parts of an Interactive Stacked Graph widget can be used as selectors to display data in Grid/Graphs and panel stacks in the dashboard-style document:

- **The attribute elements in the legend on the left** can be used as selectors if one or more of the attributes on the columns of the Grid/Graph that contains the widget are enabled as selectors. A user can choose only one attribute element to update the target panel stacks and Grid/Graphs.

  If more than one element is chosen, only data related to the last element selected is displayed in the target panel stacks and Grid/Graphs.

- **The area graphs** can be used as selectors if the attribute used to generate the graph series is enabled as a selector. A user can select only one graph at a time.
For example, the Region attribute in an Interactive Stacked Graph widget is enabled as a selector. When a user selects a region from the widget, the target grid is updated with data related to that region.

To use a widget as a selector, you first choose the target Grid/Graph and/or panel stack in Design Mode or Editable Mode. For an Interactive Stacked Graph widget, you must then switch to Flash Mode to determine which part of the widget is enabled as a selector. In Flash Mode, you can also ensure that target Grid/Graphs and panel stacks are updated when a user hovers over the graph or legend, instead of clicking it.

To create an Interactive Stacked Graph widget, see Creating an Interactive Stacked Graph widget, page 301. To enable an Interactive Stacked Graph widget as a selector, see Creating the widget used as a selector, page 457.
Using a Map widget as a selector

You can allow users to click locations in a Map widget to update data in a dashboard-style document. In Flash Mode, users can update the data displayed in targeted Grid/Graphs and panel stacks in the dashboard-style document.

The following parts of a Map widget can be used as selectors:

- Image markers
- Bubble markers
- Locations on a density map
- Map areas

To use a Map widget as a selector, you must define the attribute that provides the location information for each marker, area, or map area as a selector on the widget’s Grid/Graph.

For example, in the image below, the location of each image marker on the map is provided by the City attribute. The City attribute is enabled as a selector and targets the grid to the right. When a user selects the map marker for New York City, the target grid is updated with data related to that city.

To create a Map widget, see *Creating a Map widget, page 303*. To enable a Map widget as a selector, see *Creating the widget used as a selector, page 457*.

Using a Microcharts widget as a selector

The Grid/Graph that contains a Microcharts widget often consists of several attributes in the row headers and the elements of those attributes in the
rows. You can enable these attributes and elements as selectors to allow analysts to select an attribute or element and view specific data related to it in other Grid/Graphs in the dashboard-style document.

When an analyst hovers the cursor over an attribute element that is enabled as a selector, it becomes a hand pointer to indicate that a link exists. When the link is clicked, all target Grid/Graphs on the dashboard-style document are updated with a set of data related to the attribute element that was clicked. For example, if you click Southeast, all data related to the Southeast region is displayed in the target Grid/Graphs on the dashboard-style document.

Each attribute element in the Grid/Graph, including the attribute names in the row headers, can act as a selector. When you click an attribute name displayed in a row header, all elements of that attribute are selected. This overrides the selection of any of the individual attribute elements. The background color of the attribute in the row header appears in gray to indicate that the attribute is selected.

Note the following:

- Metric columns cannot be used as selectors.
- When multiple attributes are set as selectors, the selections occur independently of each other.

You can also use the sparklines and bar charts in the widget as selectors by enabling a time-based attribute, such as Month, on the Grid/Graph as a selector. When you hover the cursor over a sparkline or bar chart, and then click a specific data point, all data related to that data point is displayed in all target Grid/Graphs and panel stacks in the dashboard-style document.

To create a Microcharts widget, see Creating a Microcharts widget, page 320. To enable a Microcharts widget as a selector, see Creating the widget used as a selector, page 457.

**Using a Network widget as a selector**

You can enable users to display data related to an attribute element in a Network widget by clicking the node that represents the element. To do so, you must define the attribute that contains the element as a selector on the widget's Grid/Graph.

Users can click a node to display data in the following:
• All target Grid/Graphs and panel stacks in the dashboard-style document
• A pop-up Information Window

For example, nodes representing different sales departments, such as movies and music, are displayed in a Network widget. Users can click on the Music node to display an Information Window that contains a graph of the contribution of each music genre to overall sales figures in the Music department.

To create a Network widget, see Creating a Network widget, page 332. To enable a Network widget as a selector, see Creating the widget used as a selector, page 457.

Using a Time Series Slider widget as a selector

Report objects on a Time Series Slider widget can be defined as selectors. In Flash Mode, users can then interact with the widget to control targeted Grid/Graphs and panel stacks in the dashboard-style document.

In Design Mode or Editable Mode, you must define one or more of the objects on the Grid/Graph that contains the widget as selectors. Next, switch to Flash Mode to use the primary graph at the bottom of the widget as a selector. A user can hover over and select an individual data point in the graph to display related data in the target Grid/Graphs and panel stacks. For example, a user can select the data point for January 2006 revenue, and all data in the target Grid/Graphs and panel stacks is updated.
The following dashboard-style document is shown in Flash Mode. Revenue data related to the last data point in the Time Series Slider widget, in this case December 2009, is shown in the grid report below the widget.

Table:

<table>
<thead>
<tr>
<th>Month</th>
<th>Average Revenue</th>
<th>Last Month’s Revenue</th>
<th>Last Quarter's Revenue</th>
<th>Last Year's Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dec 2009</td>
<td>$393,903</td>
<td>$1,506,236</td>
<td>$1,288,219</td>
<td>$1,087,697</td>
</tr>
</tbody>
</table>

If you click the data point for January 2009, the grid report displays the revenue data related to that date, as shown below.

Table:

<table>
<thead>
<tr>
<th>Month</th>
<th>Average Revenue</th>
<th>Last Month’s Revenue</th>
<th>Last Quarter's Revenue</th>
<th>Last Year's Revenue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan 2009</td>
<td>$246,277</td>
<td>$1,087,697</td>
<td>$1,083,047</td>
<td>$749,779</td>
</tr>
</tbody>
</table>

This example uses the primary graph as the selector, but you can change it to use the slider instead. Instead of clicking a single data point (in this case, a
single month) you can instead select a range of months. In the following example, the slider is set to January 2009 through June 2009, and the grid report displays the data for that time frame.

![Slider Example]

<table>
<thead>
<tr>
<th>Month</th>
<th>Average Revenue</th>
<th>Last Month's</th>
<th>Last Quarter's</th>
<th>Last Year's</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan 2009</td>
<td>$246,277</td>
<td>$1,087,697</td>
<td>$1,083,047</td>
<td>$749,779</td>
</tr>
<tr>
<td>Feb 2009</td>
<td>$253,657</td>
<td>$985,107</td>
<td>$1,096,324</td>
<td>$851,921</td>
</tr>
<tr>
<td>Mar 2009</td>
<td>$278,064</td>
<td>$1,014,628</td>
<td>$1,087,697</td>
<td>$897,056</td>
</tr>
<tr>
<td>Apr 2009</td>
<td>$281,064</td>
<td>$1,112,254</td>
<td>$985,107</td>
<td>$827,244</td>
</tr>
<tr>
<td>May 2009</td>
<td>$303,776</td>
<td>$1,124,255</td>
<td>$1,014,620</td>
<td>$892,637</td>
</tr>
<tr>
<td>Jun 2009</td>
<td>$291,280</td>
<td>$1,215,105</td>
<td>$1,112,254</td>
<td>$964,882</td>
</tr>
</tbody>
</table>

To change from using the primary graph as the selector to using the slider, you must format the settings of the widget in Flash Mode. For more information, see the MicroStrategy Web Help.

While the widget in this example targets a Grid/Graph, it could target multiple Grid/Graphs, a panel stack, or multiple panel stacks instead.

To use a widget as a selector, you first choose the target Grid/Graph and/or panel stack in Design Mode or Editable Mode.

In Flash Mode, you can ensure that target Grid/Graphs and panel stacks are updated when a user hovers over a data point in the primary graph, instead of clicking the data point.

To create a Time Series Slider widget, see Creating a Time Series Slider widget, page 360. To enable a Time Series Slider widget as a selector, see Creating the widget used as a selector, page 457.
Using a Waterfall widget as a selector

You can enable the bars of a Waterfall widget as selectors. In Flash Mode or Interactive Mode, users can click a bar or a section of a bar to display data related to it in all target Grid/Graphs and panel stacks in the dashboard-style document.

For example, an attribute is placed on the columns of the Grid/Graph that contains the widget. This attribute is then enabled as a selector. The elements of that attribute are displayed in the widget’s legend in Flash Mode or Interactive Mode. An analyst can select items from the legend to update target Grid/Graphs and panel stacks in the dashboard-style document. Metrics on a Waterfall widget can also be used as selectors.

To create a Waterfall widget, see Creating a Waterfall widget, page 363. To enable a Waterfall widget as a selector, see Creating the widget used as a selector, page 457.

Using a Weighted List Viewer widget as a selector

The grid in a Weighted List Viewer widget often consists of several attributes in the column headers and the elements of those attributes in the rows. You can enable these attributes and elements as selectors. This allows an analyst to select an attribute or an element, and then view specific data related to it in grids and graphs in the dashboard-style document.

When you click an attribute element that is enabled as a selector, any targeted grids and graphs are updated with a set of data related to the attribute element. For example, if you click Southeast, all data related to the Southeast region is displayed in the grids and graphs on the dashboard-style document. You can select elements from different attributes simultaneously by clicking those elements. However, you cannot select multiple elements from the same attribute.

Each column in the grid, including the column headers, can act as a selector. When you click an attribute name displayed in a column header, all elements of that attribute are selected. This overrides the selection of any of the individual attribute elements within the column. The background color of the attribute changes to a lighter shade to indicate that the attribute is selected.

When two or more attributes in the widget are set as selectors, both of the selections occur independently of each other.
The stacked contribution bar graph on the left side of the widget can also be used as a selector. When you hover the cursor over the graph, the cursor is displayed as a hand pointer to indicate that the graph is a selector. Since each section of the graph represents a row in the grid, the graph can be used to trigger all of the selectors enabled in the widget. Clicking a section of the stacked graph updates the Grid/Graphs within the dashboard-style document with a set of data related to the attribute element you clicked.

If only one attribute is set as a selector in the stacked graph, when you click that section in the graph, the dashboard-style document displays data for only that attribute’s elements.

To create a Weighted List Viewer widget, see Creating a Weighted List Viewer widget, page 366. To enable a Weighted List Viewer widget as a selector, see Creating the widget used as a selector, page 457.

Creating the widget used as a selector

This section provides steps to designate the target Grid/Graph or panel stack as a selector.

Enabling widgets to be used as selectors

To enable a widget to be used as a selector, the widget must be a Bubble Grid, Data Cloud, Heat Map, Image Layout, Interactive Bubble Graph, Interactive Stacked Graph, Time Series Slider, or Waterfall widget.

Prerequisites

- You have already created a widget that contains the report objects to use as selectors. For steps, see To convert a Grid/Graph into a widget, page 377.

- You have created the panel stack or Grid/Graph to use as the target. For steps, see Inserting a panel stack, page 76.

- The selector and target must have an attribute in common.
To use a widget as a selector

1. In MicroStrategy Web, open the document in Design or Editable Mode.
2. Select the Grid/Graph containing the widget.
3. Do one of the following:
   - Right-click the attribute, custom group, or consolidation in the Grid/Graph to use as the selector, and choose Use as Selector.
   - Right-click the Metrics column in the Grid/Graph, and choose Use as Selector.
4. Right-click the object or the Metrics column used as a selector, and choose Edit Selector. The Configure Selector dialog box opens.
5. Select the target Grid/Graph or panel stack in the list of available controls on the left. Click > to add it to the list of selected targets on the right. You can select multiple targets.

The attribute, custom group, or consolidation that you selected in the Grid/Graph is the source, and the selected Grid/Graph is the target. The Action Type of the selector is set to Select Element.

If targets are automatically maintained, the available and selected target lists are unavailable. For more information about automatically maintaining targets and steps to enable or disable automatic targets, see Automatically maintaining targets for selectors, page 169.

6. Determine whether the selector filters or slices the data, by selecting or clearing the Apply selections as a filter check box. The difference is briefly described below; for more details on the differences, including examples, see Applying selections as filters or slices, page 158.

   - The selections made in a filtering selector are used to filter the underlying dataset before the metric values are aggregated at the level of the Grid/Graph that is displayed in the document.
   - The selections made in a slicing selector are used to determine which slices of data are combined and shown in the Grid/Graph.

The Apply selections as a filter check box is unavailable and cleared if you selected the Metrics column as the selector.
7 To ensure that the user can select more than one element in the widget, select the **Show option for All** check box.

Note the following:

- The data labels along the X and Y axes of a Bubble Grid widget can be used as selectors if the **Show option for All** check box is selected.

- The attribute names in the headers of a Graph Matrix (deprecated) widget, Microcharts widget, or Weighted List widget can be used as selectors if the **Show option for All** check box is selected.

- A user can select more than one element from the checklist in the Interactive Stacked Graph widget if the **Show option for All** check box is selected.

- The attribute elements in the legend of a Waterfall widget can be used as selectors if the **Show option for All** check box is selected.

8 If the selector slices the data (the **Apply selections as a filter** check box is cleared), the **Show option for Total** check box is available. This check box specifies whether the Total option is shown, which allows the user to display totals. For an example and more details, see **Showing totals for selectors, page 197**.

9 If the selector slices the data (the **Apply selections as a filter** check box is cleared), the **Automatically update when there is no data for the current selection** check box is available. This check box determines how the target displays when no data exists. For an example, see **Determining how the target of a selector displays when no data exists, page 185**.

- To display a message that no data is returned, clear the check box.

- To display an item, select the check box.

10 Click **OK** to apply the changes and return to the dashboard-style document.

11 Press **ESC** to exit edit mode.

12 If you enabled an Interactive Stacked Graph widget as a a selector, you must complete the steps to designate which part of the widget is enabled as a selector. You can also determine whether the target updates when the user hovers his cursor over the location. For steps, see **Designating sections of an Interactive Stacked Graph widget as a selector, page 460**.
13 If you enabled a Time Series Slider or Interactive Bubble Graph widget as a selector, you can designate whether the target updates when the user hovers his cursor over the location. For steps, see *Ensuring targets are updated with hovering rather than clicking, page 461*.

**Designating sections of an Interactive Stacked Graph widget as a selector**

After you complete the steps to enable an Interactive Stacked Graph widget as a selector, you must complete the following steps to determine whether the graph or the legend serves as the selector on which the user clicks.

You can also determine whether the target is updated when the user hovers his cursor over the graph or legend, instead of requiring the user to click on the graph or legend.

**Prerequisites**

- The Interactive Stacked Graph widget has been enabled as a selector. For steps, see *Enabling widgets to be used as selectors, page 457*.
- Flash Mode must be enabled for the dashboard-style document. For steps, see *Determining the display modes users can choose to work in, page 61*.

---

**To determine which part of an Interactive Stacked Graph widget is enabled as a selector**

1. In MicroStrategy Web, open the dashboard-style document in **Flash Mode**.
2. Right-click the widget and select **Properties**. The Properties dialog box opens.
3. From the **Selectable Area** drop-down list, select **Graph** or **Legend**.
4. You can determine that target Grid/Graphs and panel stacks are updated when a user hovers over the cursor over the graph or legend. To do so, select the **Change Selection on Mouse Over** check box.
5. Click **OK** to apply the changes.
Ensuring targets are updated with hovering rather than clicking

For a Time Series Slider widget, an Interactive Bubble Graph widget, and an Interactive Stacked Graph widget, you can determine that target Grid/Graphs and panel stacks are updated when a user hovers the cursor over the widget instead of requiring the user to click.

Specifically, the target can be updated when the user hovers the cursor over the following:

- A data point in the primary graph of a Time Series Slider widget.
- A bubble or an item in the legend of an Interactive Bubble Graph widget.
- The graph or legend of an Interactive Stacked Graph widget.

Prerequisites

- The widget has been enabled as a selector. For steps, see Enabling widgets to be used as selectors, page 457.
- Flash Mode must be enabled for the dashboard-style document. For steps, see Determining the display modes users can choose to work in, page 61.

To ensure that targets are updated when a user hovers the cursor over the widget

1. In MicroStrategy Web, open the dashboard-style document in Flash Mode.
2. Right-click the widget and select Properties. The Properties dialog box opens.
3. Select the Change Selection on Mouse Over check box.
4. Click OK to apply the changes.
Introduction

A dashboard-style document is a special type of document, commonly one page long and usually viewed online. Dashboard-style documents contain interactive features that allow analysts to control how they view data. Each user can interact with the dashboard-style document to display only the data they are interested in (using panels and selectors) or only specific attribute elements or metrics (using a selector).

Dashboard-style documents are often used to assess performance, to provide a status check, or to monitor contributions to overall goals of the business. Dashboard-style documents summarize key business indicators by presenting them in visually intuitive, easy-to-read, interactive documents.

This appendix walks you through creating a dashboard-style document that incorporates widgets in a panel stack, using data from the MicroStrategy Tutorial. You can use this appendix as a tutorial, bringing together the information described in the chapters of this book to create a dashboard-style document.
Before you begin

This appendix assumes that you know how to create reports and documents, and that you are familiar with the terminology and basic concepts of documents and dashboard-style documents.

- For instructions on creating reports, refer to the Developer Help (formerly the Desktop Help) or the Basic Reporting Guide.
- For instructions on creating a document, refer to the Developer Help or the Report Services Document Creation Guide.
- For background information on dashboard-style documents, refer to Chapter 2, Designing Dynamic Enterprise Dashboard-style Documents.

To format some parts of widgets and to view the dashboard-style document in Flash Mode, you must be able to access and log in to MicroStrategy Web.

Dates in the MicroStrategy Tutorial project metadata are updated to reflect the current year. The sample dashboard-style documents and images in this section, as well as the procedures, were created with dates from 2004 to 2006.

The completed dashboard-style document

The dashboard-style document uses a panel stack that contains three panels. Each panel is shown below with a description.

It may be helpful to print these images and refer to them as you create your own dashboard-style document.

Panel 1: Daily Order Count

The Daily Order Count panel contains two widgets which are based on the Daily Order Count dataset. The widgets are:

- A Time Series Slider widget, which is an area graph that allows a dashboard-style document analyst to choose which section of the graph to view at a time.

  This widget displays order count data at the day level. You can change the specific days which are displayed, as well as the length of time displayed.
For example, you can view the data for January, for February, or for January through March.

- A Gauge widget, which is a simple status indicator, such as a car speedometer, that displays a needle that moves within a range of numbers displayed on its outside edges.

This widget displays the profit margin percentage at the category level, independent of time. You can select which category to display.

---

**Panel 2: Inventory Analysis**

The Inventory Analysis panel contains one widget, a Heat Map widget. The widget is based on a dataset that calculates a Growth metric from the Beginning on Hand Inventory and the End on Hand Inventory data. The Heat Map widget shows the monthly increase or decrease in inventory for each item, weighted by the Beginning on Hand Inventory. It allows you to
visualize the growth of inventory across time. You can choose which month to display by using the selector.

Notice the scroll bars. The heat map is too wide and long to appear in the browser window, so the entire widget is not displayed in the image.

A Heat Map widget presents a combination of colored rectangles, each representing an attribute element (Growth in this example), that allow you to quickly grasp the state and impact of a large number of variables at the same time. The rectangles contain a wide variety of shades and colors, which emphasize the status of the various components. In a Heat Map, the size of each rectangle represents its relative weight and the color represents the relative change in value of that rectangle.

*Exploring the Inventory Analysis panel, page 491* describes this widget in more detail, providing instructions to guide you through the various features. This section assumes you have already created the dashboard-style document. Directions to create this widget begin in *Creating the Inventory Analysis panel, page 483.*
Panel 3: Employee Performance

The Employee Performance panel contains one widget, a Interactive Bubble Graph widget. This widget allows you to visualize employee performance, animated over time, and also to drill into the components of individual bubbles to view the distribution of the underlying data.

The bubbles represent custom group elements, which are created from groups of selected call centers. For example, the element Northeast consists of the Boston and New York call centers. The size of the bubbles indicates the number of units sold, while the position on the graph indicates the profit and revenue at the employee level. The color of the bubbles indicates the year, as shown on the color key at the bottom left.

Unlike the previous widgets, this widget does not use a selector. However, drilling has been enabled so if you click a bubble, the widget drills down to the call centers that comprise the custom group element.

Exploring the Employee Performance panel, page 503 describes this widget in more detail, providing instructions to guide you through the various features. This section assumes you have already created the dashboard-style document. Directions to create this widget begin in Exploring the Employee Performance panel, page 494.
High-level steps

You will create reports to be used as datasets for the dashboard-style document, and then use these datasets to create a dashboard-style document. You will add a panel stack with three panels, and then add and define different widgets to the panels. You will display the dashboard-style document in Flash Mode in MicroStrategy Web to interact with the widgets. The goal is to create a single dashboard-style document that intelligently, efficiently, and interactively displays all of the data contained within the individual datasets.

The high-level steps for this procedure are outlined below. While each step is self-contained, the steps are meant to be completed in order.

You should save the reports and dashboard-style document in a folder, such as My Reports or Shared Reports, that can be accessed from MicroStrategy Web.

Creating the Daily Order Count panel

1. Creating the Daily Order Count report to be used as a dataset, page 470
2. Creating the new dashboard-style document and selecting the dataset, page 470
3. Adding a panel stack and panels to the dashboard-style document, page 471
4. Adding a selector to the dashboard-style document, page 474
5. Creating a Time Series Slider widget, page 474
6. Adding a Gauge widget, page 476
7. Creating a selector for the Gauge widget, page 478
8. Specifying Flash Mode as the default display mode, page 479
9. Saving the dashboard-style document, page 480
10. Viewing the Daily Order Count panel in Flash Mode in MicroStrategy Web, page 480
Creating the Inventory Analysis panel

11 Creating the Inventory Analysis report to be used as a dataset, page 483
12 Adding a dataset to the dashboard-style document, page 484
13 Switching panels in Design View, page 485
14 Renaming and formatting a panel, page 485
15 Creating a Heat Map widget, page 486
16 Creating a selector for the Heat Map widget, page 489
17 Saving the dashboard-style document, page 490
18 Viewing the Inventory Analysis panel in Flash Mode in MicroStrategy Web, page 490

Creating the Employee Performance panel

19 Creating a custom group, page 494
20 Creating the Employee Performance report to be used as a dataset, page 497
21 Adding a dataset to the dashboard-style document, page 498
22 Switching panels in Design View, page 498
23 Renaming and formatting a panel, page 499
24 Creating a Bubble Graph widget, page 500
25 Saving the dashboard-style document, page 501
26 Viewing the Employee Performance panel in Flash Mode in MicroStrategy Web, page 502
27 Enabling drilling and time series animation, page 502
Creating the Daily Order Count panel

Creating the Daily Order Count report to be used as a dataset

The data for a document or dashboard-style document is derived from at least one report, so the preliminary step to creating any dashboard-style document is to create a report. When the data from a report is used in a dashboard-style document, the report is referred to as a dataset. For more information on datasets, see Accessing data in a document: The dataset, page 11.

To create the report

1. In MicroStrategy Developer, point to New from the File menu, and then select Report. The Report Editor opens.
   - If the New Grid dialog box opens, select Blank Report as the report object template.

2. Add the following objects to the rows of the grid:
   - **Category** (from the Products hierarchy)
   - **Day** (from the Time hierarchy)

3. Add the following metrics to the columns of the grid:
   - **Order Count** (from the Public Objects\Metrics\Count Metrics folder)
   - **Profit Margin** (from the Public Objects\Metrics\Sales Metrics folder)

4. Save and close the report, naming it Daily Order Count Dataset Report.

Creating the new dashboard-style document and selecting the dataset

Next, create the shell of the new dashboard-style document and select the report that you just created as the dataset. Recall that the dataset provides data for the dashboard-style document.
To create the new dashboard-style document and select the dataset

1. In MicroStrategy Developer, point to New from the File menu, and then select Document. The New Document dialog box opens.

2. Select Blank Dashboard and click OK. The Select a report dialog box opens.

3. To use the report that you just created as a dataset for this dashboard-style document, navigate to the Daily Order Count Dataset Report and double-click it. The Document Editor opens.

Notice that the Layout area contains only one section, as dictated by the Blank Dashboard template. This is ideal for creating a dashboard-style document, when all the different header and footer sections are unnecessary. For more information about the template, see Creating a dashboard-style document: the Blank Dashboard template, page 53.

You can display additional sections by selecting Sections from the View menu, and then choosing the sections to display. For a more complete procedure, see the Developer Help (formerly the Desktop Help).

The Datasets pane contains the Daily Order Count Dataset Report and all the objects on that report. These objects, as well as the dataset itself, are available for use on the dashboard-style document.

Adding a panel stack and panels to the dashboard-style document

Next, create a panel stack, which initially contains one panel. A panel is a “page” or subset of data. A group of panels is called a panel stack. For more information about panels and panel stacks, including examples, see Chapter 3, Layering Data: Panels and Panel Stacks.

You will also add two more panels to the panel stack. In the dashboard-style document, each panel contains at least one widget that offers the user a unique data visualization.
To add a panel stack

1. From the Insert menu, select Panel Stack. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click in the Layout area to add the panel stack.

3. Right-click the panel stack and select Properties. The Properties dialog box opens.

4. On the Layout tab, position and size the panel stack by setting the following options:
   - Left: .15 inches
   - Top: .35 inches
   - Height: 5.7 inches
   - Width: 10.1 inches

   To resize the height of the title bar

5. Set Title height to .2 inches.

6. Click OK to return to the dashboard-style document.

   To add panels to the panel stack

7. Next, add a panel to the panel stack. Right-click the panel stack, point to Panels, and select Add.

8. Add a third panel by repeating the previous step.

   To rename a panel

   Panel names are displayed in the title bar and in the selector associated with the panel stack, so it is important to make them meaningful.

9. Right-click the panel stack, point to Panels, and select Manage. The Panels tab of the Properties dialog box opens.

10. Select Panel1 in the list of panels.

11. Click Rename.
12 Type **Daily Order Count** in the panel list, and then press **ENTER**.

**To set the current panel to Daily Order Count**

13 Select **Daily Order Count** in the list of panels.

14 Click **Set as Current**.

15 Click **OK** to return to the dashboard-style document.

Notice that the title bar of the panel stack displays “Daily Order Count” (you may have to scroll the Layout area to the right to view it). Since all the panels are identical right now, this is the only indication as to which panel is being displayed.

**To apply a gradient color to the current panel (Panel1)**

16 Right-click the panel stack and select **Format**. The Format Objects dialog box opens.

17 Select **Container** in the list of objects on the left.

18 Click the **Background** tab.

19 Select **Gradient** from the **Background style** drop-down list.

20 Select **Sea Green** from the **Color 1** drop-down list (the color name appears when you hover over the color swatches).

21 Select **Grey-25%** from the **Color 2** drop-down list.

**To format the title bar**

22 Select **Title** in the list of objects on the left.

23 Click the **Font** tab.

24 Set **Size** to 8.

25 Set **Color** to **White**.

26 Click the **Background** tab.

27 Select **Black** from the Fill color drop-down list.

28 Click **OK** to return to the dashboard-style document.
Adding a selector to the dashboard-style document

A selector allows the user to control which panel is displayed in Interactive Mode, Editable Mode, and Flash Mode in MicroStrategy Web. Selectors provide dashboard-style documents with interactivity, allowing each user to change how he sees the data. For more information about selectors, including examples, see Chapter 4, Providing Interactivity to Users: Selectors.

To add a selector

1. Right-click the panel stack and choose Insert Panel Stack Selector. The selector is created above the panel stack.

2. Right-click the selector and choose Properties. The Properties dialog box opens.

3. On the Layout tab, position and size the selector by setting the following options:
   - **Left**: .15 inches
   - **Top**: .05 inches
   - **Height**: .3 inches
   - **Width**: 5.0 inches

4. Click the Selector tab.

5. From the Style drop-down list, choose Button Bar.

6. Set Orientation to Horizontal.

7. Click OK to return to the dashboard-style document.

Creating a Time Series Slider widget

To create a widget in Developer, you must first insert a Grid/Graph into a dashboard-style document and add report objects such as attributes and metrics to it. You then select a widget type for the Grid/Graph. In Flash Mode in Web, the Grid/Graph is displayed as a widget, and users can control how they view the data on it.
A Time Series Slider widget requires only one attribute, preferably one with many values. This attribute is normally time-based, although it does not have to be. In this dashboard-style document, only one attribute, Day, is used. The widget also requires only one metric; Order Count is used in this widget. For more information about Time Series Slider widgets, see *Creating a Time Series Slider widget, page 360.*

---

**To create a Time Series Slider widget**

1. Create an empty Grid/Graph by selecting **Grid** from the **Insert** menu. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click and drag in the panel stack to add the Grid/Graph. Do not worry about the size or position; you will adjust them later.

3. Drag **Day** from the Datasets pane and drop it on the row axis of the Grid/Graph, as shown below:

4. Drag **Order Count** from the Datasets pane and drop it on the column axis of the Grid/Graph, as shown below:

5. Format the Day attribute:
   - From the **Format** menu, point to **Day**, and then select **Values**. The Format Cells dialog box opens.
   - On the **Number** tab, select **Date** in the **Category** list.
   - In the **Formatting** list, select **7/19/00**.
   - Click **OK**.
6  The Grid/Graph is in edit mode, as indicated by its red hashed border. Press ESC to exit edit mode.

7  Right-click the Grid/Graph and choose Properties. The Properties dialog box opens.

8  On the Layout tab, set the following options to position and size the Grid/Graph:
   - **Left**: 1.5 inches
   - **Top**: .2 inches
   - **Height**: 5.25 inches
   - **Width**: 8.6 inches

9  On the Flash tab, turn the Grid/Graph into a widget:
   - Select Time Series Slider from the Selected widget drop-down list.

10 Click OK to return to the dashboard-style document.

Adding a Gauge widget

Like creating the Time Series widget, to create a Gauge widget you must create a Grid/Graph and then turn it into a widget.

A Gauge widget is designed to display the value of a single metric, in this example, Profit Margin. The needle within the gauge is a visual representation of that single metric value. The Gauge widget is most useful when combined with a selector because then users can display specific metric values in the gauge. After you create the Gauge widget, you will create a selector for it. For more information on Gauge widgets, see Creating a Gauge widget, page 276.

To add a Gauge widget

1  Create an empty Grid/Graph by selecting Grid from the Insert menu. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2  Click and drag in the panel stack to add the Grid/Graph. Do not worry about the size or position; you will adjust them later.
3 Drag **Profit Margin** from the Datasets pane and drop it on the column axis of the Grid/Graph.

4 The Grid/Graph is in edit mode, as indicated by its red hashed border. Press **ESC** to exit edit mode.

5 Right-click the Grid/Graph and choose **Properties**. The Properties dialog box opens.

6 On the Layout tab, set the following options to position and size the Grid/Graph:
   - **Left**: .1 inches
   - **Top**: 2 inches
   - **Height**: 1.7 inches
   - **Width**: 1.3 inches

7 On the Flash tab, turn the Grid/Graph into a widget:
   - Select **Gauge** from the **Selected widget** drop-down list.

8 Click **OK** to return to the dashboard-style document.

   **To format the Gauge widget**

   You must format the Grid/Graph that is used as the Gauge widget, so that it appears correctly in Flash Mode.

9 In the Property List, set **View mode** to **Graph**.

10 Right-click the Grid/Graph and select **Edit Graph**.

11 From the **Graph** menu, select **Grids and Scales**. The Numeric Axis Grids and Scales dialog box opens.

12 Click the **Y1 Axis** tab on the left.

13 Click the **Scales** tab at the top.

14 Select the **Use Manual Setting for Maximum Value** check box.

15 In the **Maximum Value** field, enter **1**.

16 Click the **Numbers** tab at the top.
17 Choose **Percent** from the **Category** drop-down list.

18 Set **Decimal Places** to 0.

19 Click **OK**.

20 Press **ESC** to exit edit mode.

21 Note the name of the Grid/Graph at the top of the Property List; it should be GridGraph2. You will need to know this name to create the selector for this Grid/Graph.

### Creating a selector for the Gauge widget

A Gauge widget is most useful when combined with a selector because then users can display specific metric values in the gauge. The selector for the Gauge widget allows users to choose which category to display in the gauge. For more information on selectors in general, see *Chapter 4, Providing Interactivity to Users: Selectors*.

---

**To create a selector**

1. From the **Insert** menu, point to **Selector**, and then choose **Link Bar**. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click in the Layout area to add the selector.

3. Right-click the selector and choose **Properties**. The Properties dialog box opens.

4. On the Layout tab, set the following options to position and size the selector:
   - **Left**: .08 inches
   - **Top**: .5 inches
   - **Height**: 1.45 inches
   - **Width**: 1.3 inches

5. Click the **Selector** tab.
6  Set **Action type** to **Select attribute element**.

7  Select **Category** as the **Source**, so that the user can change the category.

8  Select **Link Bar** as the **Style**.

9  Select **Vertical** for the **Orientation**.

10 By default, the selector shows the All option, which allows the user to display all the attribute elements in the Target at the same time. Clear the **Show option for All** check box so that the all categories link is not available in the selector.

11 Clear the **Allow multiple selections** check box, so that a user cannot select more than one category at the same time.

12 Set the Gauge widget as the target of the selector:
   a  Select **GridGraph2** (or the name of the Grid/Graph, as noted previously) in **Available targets**.
   b  Click > to move GridGraph2 to Selected targets.

13 Click **OK** to return to the dashboard-style document.

**Specifying Flash Mode as the default display mode**

Flash Mode in MicroStrategy Web allows you to view and interact with the widgets you have created on the dashboard-style document. Flash Mode is automatically available for dashboard-style documents created using the Blank Dashboard template. Specifying Flash Mode as the default display mode ensures that the dashboard-style document opens in Flash Mode in MicroStrategy Web. For more information on Flash Mode and other MicroStrategy Web display modes, see *Display modes in MicroStrategy Web, page 3.*

**To specify Flash Mode as the default display mode**

1  From the **Format** menu, select **Document Properties**. The Document Properties dialog box opens.
2 On the Document tab, select the **Default** radio button for **Flash**. The dashboard-style document will initially open in Flash Mode in MicroStrategy Web.

3 Click **OK** to return to the dashboard-style document.

### Saving the dashboard-style document

Save the dashboard-style document in a directory that you can access from MicroStrategy Web, such as My Reports.

---

**To save the dashboard-style document**

1 Save and close the dashboard-style document, naming it **Dashboard Sample**.

### Viewing the Daily Order Count panel in Flash Mode in MicroStrategy Web

To interact with the widgets, you must view the dashboard-style document in Flash Mode in MicroStrategy Web. Use Full Screen Mode to maximize the amount of the dashboard-style document that is displayed.

---

**To view the dashboard-style document in Flash Mode**

1 Sign in to MicroStrategy Web.

2 Navigate to the Dashboard Sample dashboard-style document in your project, and click **Dashboard Sample**. The dashboard-style document opens in Flash Mode.

3 Switch to Full Screen mode by clicking the **Full Screen Mode** button in the toolbar. Most of the MicroStrategy toolbars and panels are hidden, which maximizes the amount of the dashboard-style document that can be shown at the same time.

   To display the toolbars and panels, click the **Restore Normal Screen Mode** button in the toolbar.
Exploring the Daily Order Count panel

The Gauge widget allows you to monitor the value of a single metric, in this case, Profit Margin. The selector for the Gauge widget displays a list of categories. Click Movies to change the category displayed in the gauge; note the gauge needle moves to about 10%. Click Books, and the gauge needle now points to just above 20%. Notice that the transition between the data points is animated fluidly.

Notice that the date range for the bar graph (the Time Series Slider widget) runs from 9/13/06 to 12/31/06.

Dates in the MicroStrategy Tutorial project metadata are updated to reflect the current year. The sample was created with 2006 dates; your Tutorial project may contain different dates.

A Time Series Slider widget consists of two related graphs, one positioned above the other.

- The top graph is the controller, and contains a slider. To open the controller, hover your cursor over the down arrow at the top of the time series graph (the area graph).
- The bottom graph is the primary graph. Use the slider on the controller to select some portion of the controller, which determines the range of data visible in the primary graph.
The following sample shows the controller.

The slider allows you to change the range of dates and the length of time that is displayed. For example, click and drag the bottom of the slider (which is circled in the image above) to change the range of dates displayed. The bottom graph dynamically displays the data for the dates. To change the length of time displayed, drag an edge of the slider (as indicated by the arrows in the image above). For example, the sample below displays data for the period 1/15/2005 to 5/3/2006. Notice that the length of the slider is
longer than in the previous sample, indicating a longer length of time that is displayed in the bottom graph.

Notice also that the cursor is hovered over a particular day, 8/8/2005, and a pop-up displays information for that day.

A series of tabs is displayed across the top of the dashboard-style document. Daily Order Count is selected. Click Panel2. A blank rectangle is displayed, since no objects have been added to this panel. The next section of this tutorial contains the procedures to define this panel.

You can log out of MicroStrategy Web, as you will be working in Developer again.

Creating the Inventory Analysis panel

Creating the Inventory Analysis report to be used as a dataset

Inventory data is not included on the Daily Order Count report you created earlier. However, you can have multiple datasets on the same
dashboard-style document. To use inventory data on the dashboard-style document, create a report to be used as a dataset. For more information on datasets, see *About Visual Insight dashboards, page 22.*

To create the report

1. In MicroStrategy Developer, point to **New** from the **File** menu, and then select **Report**. The Report Editor opens.

   If the New Grid dialog box opens, select **Blank Report** as the report object template.

2. Add the following attributes to the rows of the grid:
   - **Month** (from the Time hierarchy)
   - **Category** (from the Products hierarchy)
   - **Item** (from the Products hierarchy)

3. Add the following metrics to the columns of the grid:
   - **Begin on Hand** (from the Public Objects\Metrics\Inventory Metrics folder)
   - **End on Hand** (from the Public Objects\Metrics\Inventory Metrics folder)

4. Save and close the report, naming it Inventory Analysis Dataset Report.

Adding a dataset to the dashboard-style document

Add the dataset report to the dashboard-style document to access the inventory data.

To add a dataset

1. If the Dashboard Sample dashboard-style document is not open, open it in the Document Editor in Developer.

2. From the **Data** menu, select **Add Dataset**. The Select a report dialog box opens.
3  Locate and select the **Inventory Analysis Dataset Report**.

4  Click **Open**.

   The dataset and all the objects on that report are now displayed in the Datasets pane.

---

### Switching panels in Design View

The first panel, Daily Order Count, is displayed. The inventory data needs to be added to a separate panel.

---

**To switch panels**

1  Right-click the panel stack, point to **Panels**, and then choose **Display Next**.

   Panel2 is displayed (you may have to scroll to the right to see its name on the title bar). Panel2 is a blank rectangle, without any objects.

   This also sets Panel2 as the current panel. When you open the dashboard-style document in MicroStrategy Web, this panel will be displayed initially, rather than Daily Order Count.

---

### Renaming and formatting a panel

The default name of the panel, Panel2, is not very informative. Rename it to be more useful. Also, the white background is dull, so apply a gradient for a more professional look.

---

**To rename a panel**

1  Right-click the panel stack, point to **Panels**, and then select **Manage**. The Panels tab of the Properties dialog box opens.

2  Select **Panel2** in the list of panels.

3  Click **Rename**.
4 Type **Inventory Analysis**, and then press **ENTER**.

5 Click **OK** to return to the dashboard-style document.

---

**To apply a gradient to a panel**

1 Right-click the panel and select **Format**. The Formatting Objects dialog box opens.

2 Select **Container** in the list of objects on the left.

3 Click the **Background** tab.

4 From the **Background style** drop-down list, select **Gradient**.

5 Select **Light Turquoise** from the **Color 1** drop-down list (the color name appears when you hover over the color swatches).

6 Select **Light Green** from the **Color 2** drop-down list.

7 Click **OK** to return to the dashboard-style document.

---

**Creating a Heat Map widget**

As with the other widgets for this dashboard-style document, to create a Heat Map widget you must first create a Grid/Graph and then turn it into a widget.

A Heat Map widget must have one or more attributes on the rows of the Grid/Graph and two metrics on the columns. For an in-depth explanation of what the different objects on the widget represent, see *Creating a Heat Map widget, page 283*.

The Grid/Graph used as the Heat Map widget must contain the percentage growth of inventory in a month, otherwise the heat map will not display properly. The inventory growth is computed by subtracting the beginning inventory from the ending inventory, and then dividing by the beginning inventory. While this metric is not present on the dataset, it can be calculated from the metrics on the dataset, Begin on Hand and End on Hand. A new metric created from the metrics on the dataset is called a derived metric. For a brief description of the various types of metrics that you can create in dashboard-style documents, including derived metrics, see *Objects in a*
document: Controls, page 13; for a more in-depth discussion, including a comparison between derived metrics and calculated expressions, see the Report Services Document Creation Guide or Developer Help (formerly the Desktop Help).

To create a Heat Map widget

1. Create an empty Grid/Graph by selecting Grid from the Insert menu. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click and drag in the panel stack to add the Grid/Graph. Do not worry about the size or position; you will adjust them later.

3. Drag the following from the Datasets pane to the row axis of the Grid/Graph:
   - Category
   - Item

4. Drag Begin on Hand from the Datasets pane and drop it on the column axis of the Grid/Graph.

5. The Grid/Graph is in edit mode, as indicated by its red hashed border. Press ESC to exit edit mode.

6. Right-click the Grid/Graph and choose Properties. The Properties dialog box opens.

7. On the Layout tab, set the following options to position and size the Grid/Graph:
   - Left: .04 inches
   - Top: .4 inches
   - Height: 5 inches
   - Width: 11 inches

8. Click OK to return to the dashboard-style document.
To create a derived metric

9  Right-click Inventory Analysis Dataset Report in the Datasets pane and select New Metric. The Input Metric Formula dialog box opens.

10  Double-click End on Hand in the list on the left, to add it to the metric expression.

11  Click the minus sign (-) in the toolbar.

12  Double-click Begin on Hand in the list on the left.

13  Click the division symbol (/) on the toolbar.

14  Double-click Begin on Hand in the list on the left.

15  The metric expression should look like the following:

   \[ \frac{([\text{End on hand}] - [\text{Begin on Hand}])}{[\text{Begin on Hand}]} \]

16  Click Validate to ensure that the expression is complete. If the expression is not valid, click Clear to delete the entire expression and start again, or modify the expression until it is valid.

17  In the Metric Name text field on the upper right, type Percent Growth.

18  Click OK to add the new metric to the dashboard-style document. The Input Metric Formula dialog box closes. The new metric is added to the Inventory Analysis Dataset Report in the Datasets pane.

19  Right-click Percent Growth in the Datasets pane and select Number Format. The Number Format dialog box opens.

20  In the Category list, select Percent.

21  Set Decimal places to 0 (zero).

22  Click OK to return to the dashboard-style document.

23  Select the Grid/Graph.

24  Drag Percent Growth from the Datasets pane and drop it on the column axis of the Grid/Graph.

25  The Grid/Graph is once again in edit mode, as indicated by its red hashed border; press ESC to exit edit mode.
To turn the Grid/Graph into a widget

26 Select the Grid/Graph.

27 In the Property List, choose Heat Map from the Selected widget drop-down list.

28 Note the name of the Grid/Graph at the top of the Property List; it should be GridGraph3. You will need to know this name to create the selector for this widget.

Creating a selector for the Heat Map widget

A dynamic Heat Map widget has a selector that targets or controls it. The selector allows a user to choose a different attribute element to be displayed by the heat map. For information on dynamic Heat Map widgets, see Creating a Heat Map widget, page 283. For more information on selectors in general, see Chapter 4, Providing Interactivity to Users: Selectors.

To create a selector

1 From the Insert menu, point to Selector, and then choose Drop-down. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2 Click in the Layout area to add the selector.

3 Right-click the selector and choose Properties. The Properties dialog box opens.

4 On the Layout tab, set the following options to position and size the selector:
   • Left: .1 inches
   • Top: .1 inches
   • Height: .25 inches
   • Width: 2 inches

5 Click the Selector tab.
6 Set **Action type** to **Select attribute element**.

7 Select **Month** as the **Source**, so that the user can change the month.

8 Clear the **Show option for All** check box, so that the user cannot select all the months at the same time.

9 Set the Heat Map widget as the target of the selector:
   a Select **GridGraph3** (or the name of the Grid/Graph, as noted previously) in **Available targets**.
   b Click > to move GridGraph2 to Selected targets.

10 Click **OK** to return to the dashboard-style document.

---

**Saving the dashboard-style document**

Save the dashboard-style document so that you can view the new widget in MicroStrategy Web.

**Viewing the Inventory Analysis panel in Flash Mode in MicroStrategy Web**

To interact with the widgets, you must view the dashboard-style document in Flash Mode in MicroStrategy Web.

---

**To view the dashboard-style document in Flash Mode**

1 Sign in to MicroStrategy Web.

2 Navigate to the Dashboard Sample dashboard-style document in your project, and click **Dashboard Sample**. The dashboard-style document opens in Flash Mode.

3 Switch to Full Screen mode by clicking the **Full Screen Mode** button in the toolbar. Most of the MicroStrategy toolbars and panels are hidden,
which maximizes the amount of the dashboard-style document that can be shown at the same time.

To display the toolbars and panels, click the Restore Normal Screen Mode button in the toolbar.

**Exploring the Inventory Analysis panel**

The Inventory Analysis panel is displayed first. You set it as the current panel, and hence the initial panel, when you switched panels.

The largest rectangles, which themselves contain more rectangles, on the heat map are generated by the first attribute on the rows of the Grid/Graph. This is Category in this sample heat map. In the following image, which shows only a portion of the entire heat map, the Categories displayed are Movies, Books, and Electronics. The smaller rectangles are generated by the second attribute, Item, on the rows of the Grid/Graph.

The size of each rectangle, large or small, represents its relative weight, as determined by the first metric on the columns of the Grid/Graph, which is Begin on Hand. The portion of the heat map shown above indicates that the Movies category is weighted more heavily than Books. More movies than books were on hand at the beginning of the month. (The entire Movies rectangle is not shown in this image.)
Similarly, the smaller rectangles are also sized according to the beginning inventory. The rectangles in the first row of the Movies rectangle are larger than the rectangles in the first row of the Books rectangle. This indicates that more copies of each movie were on hand than copies of each book.

The colors displayed in the widget represent the state of the individual items (positive or negative growth). In this heat map, blue denotes positive growth and green denotes negative growth. The colors applied to each rectangle are generated by the second metric on the Grid/Graph, Percent Growth. For example, all the items in the image above had negative growth during the month, since more items were sold than were added to inventory. The exception is one item in Electronics, the Hewlett Packard CD-Writer Plus, displayed in green in the previous image. As shown in the following image, its inventory grew 20%.

In Flash Mode in MicroStrategy Web, you can change the colors used to denote positive and negative growth. For the steps to do this, see *Formatting a Heat Map widget, page 404.*

When you hover over a rectangle in the heat map, information about that rectangle is displayed. For example, in the sample above, the cursor is pointing to the rectangle representing the Hewlett Packard CD-Writer Plus. The information displays the metric data for that attribute element, in this case, Begin on Hand and Percent Growth.

Compare the data for the Hewlett Packard CD-Writer Plus shown above with the data for the Beatles Anthology displayed below. Note the difference in the size of the rectangles, since the album had 320 copies on hand at the beginning of the month, compared to only 40 CD-Writers. The CD-Writer rectangle is green, representing positive inventory growth, while the album is blue-green, representing a small negative growth. The rectangles around the
title Music are bluer than the Beatles rectangle, because their growth percentage was more negative.

The selector at the top of the panel stack allows you to choose the month to display. The previous images were calculated for January 2004. When November 2004 is selected, the data changes, so the size, position, and color of the rectangles are different. A portion of the November 2004 heat map is shown below. Note that Books is now to the left of Music and is larger than in
January. The rectangle for the Beatles Anthology is about half the size it was in January, and is now greener since its inventory growth is positive, at 32%.

Creating the Employee Performance panel

Creating a custom group

An Interactive Bubble Graph widget is a conventional bubble plot that allows you to visualize the trends of three different metrics for a set of attribute elements. The data structure for an interactive bubble graph is very specific. At minimum, one attribute and three metrics are required. The dataset for this widget contains Month of Year and Region, and the metrics Revenue per Employee, Profit per Employee, and Units Sold.

To enable drilling on a Bubble Graph widget, an additional attribute is added to the dataset. This attribute must be a child attribute of a parent attribute already on the rows. In this case, the child attribute is a custom group element that contains call centers, and its parent attribute is Region.
The custom group organizes the data in a form that can be used by the Drilling Bubble Graph widget. The data in the grid for the child attribute must be displayed so that the total for the child attribute is in the top row of data, followed by the data for the child attribute. You can specify this structure in a custom group. For a more detailed explanation of these requirements, with examples, see Supporting drilling using a custom group, page 297.

The following procedure guides you through creating a custom group with two elements, Northeast and Central. Northeast contains the New York and Boston call centers, while Central contains the Milwaukee and Fargo call centers.

For more information about custom groups in general, see the Advanced Reporting Guide.

---

**To create the custom group**

1. In MicroStrategy Developer, point to **New** from the **File** menu, and then select **Custom Group**. The Custom Group Editor opens.
   - If the New Custom Group dialog box opens, select **Empty Custom Group** as the custom group object template.

2. Double-click **Geography (Browsing)** in the Object Browser to open the Geography hierarchy.

   **To create the Northeast element**

3. Drag **Call Center** from the Object Browser and drop it in the CUSTOM GROUP definition pane (which displays the message “Double-click here or drag an object”). The Attribute Qualification pane opens.

4. To indicate that a list of attribute elements will comprise this custom group element:
   - From the **Qualify On** drop-down list, choose **Elements**.
   - From the **Operator** drop-down list, choose **In List**.

5. To specify the list of Call Center elements to include:
   - Click **Add**. The Select Objects dialog box opens.
   - In the **Available objects** list, select **Boston** and **New York**.
c Click > to add them to the Selected objects list.

d Click OK to return to the Attribute Qualification pane.

6 Click OK to return to the custom group.

7 Right-click Custom Group Element1 and select Rename.

8 Type Northeast and press ENTER.

To create the Central element

9 Repeat steps 3 through 6 above, selecting Milwaukee and Fargo instead of Boston and New York.

Drop Call Center on the “Double-click here or drag an object” text, not the “[Add Qualification]” text.

10 Right-click Custom Group Element2 and select Rename.

11 Type Central and press ENTER.

To format the custom group elements

To ensure that the Bubble Graph widget works correctly, the custom group elements must be formatted to display data in a format that can be used by the widget.

12 Right-click Northeast and select Show Display Options. The Choose a display option dialog box opens.

13 Select Show element names, individual items within this element and also, expand these individual items if possible.

14 Click OK.

15 Repeat steps 12 through 14 for the Central element.

16 From the Custom Group menu, select Options. The Options dialog box opens.

17 Clear the Enable Hierarchical Display check box.

18 Select the Enable Subtotals Display check box.

19 Ensure that Above child elements is selected for Custom Group Element Header Display Position.
20 Click OK.

To save the custom group

21 Save and close the custom group, naming it **Call Center CG**.

### Creating the Employee Performance report to be used as a dataset

Employee performance data is not included on any of the datasets that you created earlier. To use employee performance data on the dashboard-style document, create another report to be used as a dataset. For more information on datasets, see *About Visual Insight dashboards, page 22.*

---

#### To create the report

1. In MicroStrategy Developer, point to **New** from the **File** menu, and then select **Report**. The Report Editor opens.

   ![If the New Grid dialog box opens, select Blank Report as the report object template.](image)

2. Add the following objects to the rows of the grid:
   - **Year** (from the Time hierarchy)
   - **Month of Year** (from the Time hierarchy)
   - **Region** (from the Geography hierarchy)
   - **Call Center CG** (that you created in the previous procedure)

3. Add the following metrics to the columns of the grid:
   - **Units Sold** (from the Public Objects\Metrics\Sales Metrics folder)
   - **Revenue per Employee** (from the Public Objects\Metrics\Sales Metrics folder)
   - **Profit per Employee** (from the Public Objects\Metrics\Sales Metrics folder)

4. Save and close the report, naming it **Employee Performance Dataset Report**.
Adding a dataset to the dashboard-style document

To access the employee performance data, add the dataset to the dashboard-style document.

To add a dataset

1. If the Dashboard Sample dashboard-style document is not open, open it in the Document Editor in Developer.

2. From the Data menu, select Add Dataset. The Select a report dialog box opens.

3. Locate and select the Employee Performance Dataset Report.

4. Click Open.

The dataset and all the objects on that dataset are now displayed in the Datasets pane.

Switching panels in Design View

The Inventory Analysis panel is displayed. The employee performance data needs to be added to a separate panel.

To switch panels

1. Right-click the panel stack, point to Panels, and then choose Display Next.

Panel3 is displayed (you may have to scroll to the right to see its name on the title bar). Panel3 is a blank rectangle, without any objects.

This also sets Panel3 as the current panel. When you open the dashboard-style document in MicroStrategy Web, this panel will be displayed initially, rather than Daily Order Count or Inventory Analysis.
Renaming and formatting a panel

The default name of the panel, Panel3, is not very informative. Rename it to be more useful. Also, the white background is dull, so apply a gradient for a more professional look.

To rename a panel

1. Right-click the panel stack, point to Panels, and then select Manage. The Panels tab of the Properties dialog box opens.
2. In the list of panels, select Panel3.
3. Click Rename.
4. Type Employee Performance, and press ENTER.
5. Click OK to return to the dashboard-style document.

To apply a gradient to a panel

1. Right-click the panel and select Format. The Formatting Objects dialog box opens.
2. Select Container in the list of objects on the left.
3. Click the Background tab.
4. From the Background style drop-down list, select Gradient.
5. Select Tan from the Color 1 drop-down list (the color name appears when you hover over the color swatches).
6. Select Dark Teal from the Color 2 drop-down list.
7. Click OK to return to the dashboard-style document.
Creating a Bubble Graph widget

As with creating the other widgets for this dashboard-style document, you must first create a Grid/Graph and then turn it into a widget.

A Bubble Graph widget must have at least one attribute on the rows of the Grid/Graph and three metrics on the columns. These metrics are displayed along the X-axis, Y-axis, and Z-axis (the size of the bubble) of the widget, in order from left to right. In this widget, the X-axis is the Profit per Employee metric, the Y-axis is the Revenue per Employee metric, and the Z-axis is the Units Sold metric.

To display a different color bubble (series) for each attribute element on the bubble graph, an attribute is placed above the three metrics on the columns. In this widget, that attribute is Year. For an in-depth explanation of the different objects on the widget, see Creating an Interactive Bubble Graph widget, page 295.

To enable drilling on the bubble graph, an attribute must be placed to the right of the attribute in the rows. This attribute must be a child of the attribute already on the rows. The custom group you created in Creating a custom group, page 494 provides the correct structure for this attribute. For detailed information on this requirement, with an example, see Supporting drilling using a custom group, page 297.

To create a Bubble Graph widget

1. Create an empty Grid/Graph by selecting Grid from the Insert menu. When you move the cursor to the Layout area, the pointer becomes crosshairs.

2. Click and drag in the panel stack to add the Grid/Graph. Do not worry about the size or position; you will adjust them later.

3. Drag the following objects from the Datasets pane to the row axis of the Grid/Graph:
   - Month of Year
   - Region
   - Call Center CG

4. Drag the following objects from the Datasets pane to the column axis of the Grid/Graph:
• Revenue per Employee
• Profit per Employee
• Units Sold
• Year

It is imperative that these objects are placed in the correct order on the Grid/Graph for the widget to work properly. Year must be placed on the columns.

5 The Grid/Graph is in edit mode, as indicated by its red hashed border. Press ESC to exit edit mode.

6 Right-click the Grid/Graph and choose Properties. The Properties dialog box opens.

7 On the Layout tab, set the following options to position and size the Grid/Graph:

- **Left**: .04 inches
- **Top**: .1 inches
- **Height**: 5.3 inches
- **Width**: 8.5 inches

8 Click OK to return to the dashboard-style document.

To turn the Grid/Graph into a widget

9 Select the Grid/Graph.

10 In the Property List, choose Interactive Bubble Graph from the Selected widget drop-down list.

Saving the dashboard-style document

Save the dashboard-style document so that you can view the new widget in MicroStrategy Web.
Viewing the Employee Performance panel in Flash Mode in MicroStrategy Web

To interact with the widgets, you must view the dashboard-style document in Flash Mode in MicroStrategy Web.

To view the dashboard-style document in Flash Mode


3. Switch to Full Screen mode by clicking the Full Screen Mode button in the toolbar. Most of the MicroStrategy toolbars and panels are hidden, which maximizes the amount of the dashboard-style document that can be shown at the same time.

   To display the toolbars and panels, click the Restore Normal Screen Mode button in the toolbar.

Enabling drilling and time series animation

The widget shows all of the parents (custom group elements) and children (call centers) together. When drilling is enabled, only the custom groups are displayed initially. Users can then drill to the call centers.

   For an image of the widget showing the custom group elements and call centers combined, see Panel 3: Employee Performance, page 467.

The time series animation moves the bubble values through time, to provide rapid insight into business trends. A user can run through the entire animation, rewind, fast forward, or move a slider to a specific time. The time range in this widget is January through December.
To enable drilling and time series animation

You must be in Flash Mode in MicroStrategy Web; you cannot enable drilling and time series animation in Developer or in any other mode in MicroStrategy Web.

1. Right-click the Interactive Bubble Graph widget and select Properties. The Interactive Bubble Graph dialog box opens.

2. Select the Enable drilling check box.

3. Select the Enable time series analysis check box.

4. Click OK to return to the dashboard-style document.

Exploring the Employee Performance panel

Now that drilling has been enabled, the bubbles represent the custom group elements only. The following image shows that the larger red bubble represents the Northeast. When you hover the cursor over a bubble in the widget, information about that bubble is displayed, as shown below.
The color of the bubbles is derived from the attribute placed on the columns of the Grid/Graph. In this widget, that attribute is Year, as indicated by the color key at the bottom left of the widget. If you hover over a year, the related bubbles are highlighted on the widget.

The metrics on the Grid/Graph determine the position and size of the bubbles, as described below:

- The value of the first metric on the Grid/Graph defines the position of each bubble on the X-axis.
- The value of the second metric defines the position of each bubble on the Y-axis.
- The value of the third metric determines the size of each bubble.

Double-click the January 2006 Northeast bubble to drill down to the call centers that comprise the Northeast (the children). The drilling is animated, so you can follow the bubbles as they split and separate. In the sample below, New York is highlighted. Notice that the bubbles from the earlier view remain for comparison, but are shaded to focus attention on the drilled bubbles.
The widget can display more than one drilled-down attribute. Double-click the January 2005 Northeast bubble, and the widget drills down to the call centers that comprise the Northeast, as shown below.

To return to the original graph, click one of the child bubbles, and the drilled bubbles return to the parent attribute.

The time series animation moves the bubble values through time, in this case from January to December. Note that in the preceding images, January is displayed in the upper right corner. To start the time series animation, hover your cursor at the top left corner of the widget, just below the title bar. Click the play button that appears, and notice the months changing in the upper right corner, and the bubbles moving around the graph.

The time series animation moves the bubble values through time, to provide rapid insight into business trends. A user can run the entire animation, rewind, fast forward, or move a slider to a specific time. In this widget, the time range is from January through December.
The widget in the following image shows the values for May, and also displays the time controls that allow you to interact with the time series animation.

By default, the time controls display only when you hover the cursor over the left corner, but you can choose to always display them.

You can change this setting only in Flash Mode in MicroStrategy Web.

**To always display the time controls for a widget**

1. In Flash Mode, right-click the widget and select **Properties**. The Properties dialog box opens.

2. Clear the **Auto-Hide time controls** check box.

3. Click **OK** to return to the dashboard-style document.

4. Save the dashboard-style document.
Troubleshooting dashboard-style documents

Introduction

This section provides explanations of some of the most common issues you may encounter when creating dashboard-style documents, in a question and answer format. For more detailed discussions, refer to the relevant sections of this guide.

Troubleshooting selectors

I cannot change the target of a selector.

Automatic target maintenance is enabled on this layout, which means that all attribute and metric selectors automatically target all Grid/Graphs and panel stacks that are in the same panel or document section as the selector. You can do any of the following:

• Disable automatic target maintenance. This affects the entire layout, so be sure you want to do this. After you disable it, you must manually maintain selector targets. For instructions on disabling this feature, see
Disabling automatic target maintenance to allow manual target selection, page 177.

- When targets are automatically maintained, you can control what target is chosen for a selector, by placing controls in different document sections.
- If you cannot move controls to different document sections, you can place them in different panel stacks in the same document section.

For more information about the last two options, including examples, see Controlling targets when targets are automatically maintained, page 174.

Selector targets have changed in my document.

Automatic target maintenance was probably enabled after you created the selectors. When automatic target maintenance is enabled, the targets of all existing attribute and metric selectors are replaced with all the Grid/Graphs and panel stacks that are in the same panel or document section as the selector. Automatic target maintenance affects all the selectors on a layout. For more information about the effects of automatic target maintenance, see Enabling automatic target maintenance, page 179.

If this is the case, you cannot change the targets unless you disable automatic target maintenance. However, be sure that you do want to disable it. For instructions, see Disabling automatic target maintenance to allow manual target selection, page 177.

When targets are automatically maintained, you can control what target is chosen for a selector by either:

- Moving controls to different document sections
- Placing controls in different panel stacks in the same document section

For more information, including examples, see Controlling targets when targets are automatically maintained, page 174.
Troubleshooting during document execution

I cannot open a document.

If a document has embedded Transaction Services, the document does not open. Instead, a message is displayed, indicating that transaction-enabled documents are not supported in MicroStrategy Developer. Open the document in MicroStrategy Web.

An image does not display in PDF View, when exported to PDF, or in MicroStrategy Mobile.

Ensure that the image is saved in one of the image types listed below; other image types cannot be displayed in PDF View, when exported to PDF, or in MicroStrategy Mobile.

- bmp
- jpg
- jpeg
- gif

If the image file path is using an http reference to a central Web Server machine, such as http://microstrategy/Test/myimage.jpg, ensure that the URL does not contain any spaces. You can remove the space from the image name or replace the space with %20.

For more information about inserting images into documents, see the Report Services Document Creation Guide.

Troubleshooting common Flash Mode issues

This section describes some common issues you may encounter as you use Flash Mode while viewing a document. The issues described in this section are not necessarily issues related to defects in the software itself, but rather notes about how Flash Mode is designed to work.
I cannot switch to Flash Mode; it is not an option in the View menu.

To display a document in Flash Mode, Flash Mode must be enabled for the document, the user, and the project, as described below.

• A user with the appropriate privileges can enable Flash Mode for a document.
  
  a In MicroStrategy Web, open a document in Design or Editable Mode.
  
  b From the Tools menu, select Document Properties. The Properties dialog box opens.
  
  c From the list on the left, select Document under Document Properties.
  
  d In the Available display modes list, select the Flash check box.
  
  e You can specify that this document always opens in Flash Mode when it is initially opened in Web. To do this, select Flash from the Run by default as drop-down list.
  
  f Save the document.

• Enable Flash Mode in your User Preferences.
  
  a In MicroStrategy Web, click the MicroStrategy icon at the top of the page and select Preferences.
  
  b On the left, click Report Services.
  
  c Select the Enable Flash Mode check box.

• In MicroStrategy Web, a project administrator can enable Flash Mode for a project, using the project default preference. Contact your project administrator to enable it.

A graph displays in Interactive Mode but does not display properly in Flash Mode.

Some graph styles are not supported in Flash Mode. You may also encounter issues with other aspects of graph formatting which are not supported in Flash Mode. If issues such as these occur, you must change the graph style of the report to a supported style.
The following graph styles are the only graph styles supported in Flash Mode:

<table>
<thead>
<tr>
<th>Graph Style</th>
<th>Graph Sub-type</th>
</tr>
</thead>
</table>
| Vertical Bar  | • Clustered  
|               | • Absolute  
|               | • Percent  
|               | • Stacked  
|               | • Dual-axis Clustered  
|               | • Dual-axis Absolute  
|               | • Dual-axis Stacked  |
| Horizontal Bar| • Clustered  
|               | • Absolute  
|               | • Percent  
|               | • Stacked  
|               | • Dual-axis Clustered  
|               | • Dual-axis Absolute  |
| Vertical Line | • Absolute  
|               | • Percent  
|               | • Stacked  
|               | • Dual-axis Absolute  
|               | • Dual-axis Stacked  |
| Horizontal Line| • Absolute  
|                | • Dual-axis Absolute  |
| Vertical Area | • Absolute  
|               | • Percent  
|               | • Stacked  
|               | • Dual-axis Absolute  
|               | • Dual-axis Stacked  |
| Horizontal Area| • Absolute  
|                | • Dual-axis Absolute  |
| Pie           | • Pie  
|               | • Ring Pie  
|               | • Multiple Proportional Pies  
|               | • Multiple Proportional Ring Pies  
|               | **Note**: Pie graphs may appear slightly larger in Flash Mode than they do in other display modes. The Proportional styles are not displayed proportionally in Flash Mode.  
| Stock         | • Hi-Low-Open-Close  
| Scatter       | • X-Y Scatter  
|               | • Dual-axis X-Y Scatter  |
Other display issues include the following:

- Nested labels in graphs are not displayed in Flash Mode. If the graph currently uses nested labels, switch to another label type before opening the graph in Flash Mode.

- If a graph legend is positioned manually rather than automatically, the graph legend may not be displayed in exactly the same position in Flash Mode.

- Donut bevel effects for circular data markers in a graph may appear different in Flash Mode. For a more consistent look across modes, consider using a different bevel effect, such as Sphere or Smooth Edge.

For more information on working with graphs, see the *Advanced Reporting Guide*.

---

**An image displays in Interactive Mode but does not display in Flash Mode.**

The image file path may be incorrect or unsupported in Flash Mode. The file location of the image must use an HTTP-based path, not a network or local image path. For information about adding images to documents and using the correct image path, see the *Report Services Document Creation Guide*.

---

**A widget is not displayed in Flash Mode.**

The widget may not have been designed correctly. Each widget must contain a specific number of attributes and metrics on its template. For more
information on these requirements, see *Chapter 5, Providing Flash Analysis and Interactivity: Widgets*. 
**auto text code**  Dynamic text that is populated by the document or dataset, consisting of the document’s or dataset’s settings rather than data from the data warehouse. Examples of auto text codes, which can be considered as a type of variable, are document name, page number, and execution time. Auto text codes are contained in text field controls on a document.

See also:

- Data field
- Text field

**cache**  A special data store holding recently accessed information for quick future access. Caching is normally done for frequently requested reports or documents so that they execute faster, because they need not run against the data warehouse. Results from the data warehouse are stored separately and can be used by new job requests that require the same data.

In the MicroStrategy environment, when a user runs a report for the first time, the job is submitted to the database for processing. However, if the results of that report are cached, the results can be returned immediately without having to wait for the database to process the job the next time the report is run.

Document caching generates the document only once—the first time that you execute a document in a specific mode (such as Express Mode or Interactive Mode) in MicroStrategy
Web. Subsequent document executions in the same mode use the cache. If document caching is disabled, the document query is submitted to your data warehouse every time that you execute the document in a different mode.

**calculated expression** A metric obtained dynamically, directly from metrics on a document dataset, by using at least one of the metrics in the document. Calculated expressions allow you to use simple arithmetic operators (+, -, *, /) to combine metrics from different datasets in the document.

See also:

- Derived metric

**conditional formatting** Used to format specified controls in a document depending on predefined criteria. It allows certain settings of controls, including sections, to be controlled by data-driven conditions. Conditional formatting in documents is similar to thresholds in reports.

**control** Any item in the document’s Layout area that you can select. This can be a text field, line, rectangle, image, panel stack, selector, Grid/Graph, or HTML container. These different kinds of controls are referred to as control types.

See also:

- Grid/Graph
- HTML container
- Panel stack
- Selector
- Text field

**control default** A set of options that can be set for each type of control and each section in a document. You can set the defaults according to the control that is currently selected; afterward, its format is applied to any object of the same type that you create in the document.
**dashboard** An interactive, visually intuitive display of data. A dashboard can summarize key business indicators (KPIs) to provide a status check. Users can change how they view the dashboard's data using interactive features, such as selectors, grouping, widgets, and visualizations. Users can explore their data via multiple paths, using text, data filtering, and layers of organization.

MicroStrategy has two kinds of dashboards:

- **Visual Insight dashboard**: Simple visualizations and pre-defined, presentation-quality formatting allow you to quickly display your data in a visually-striking, interactive dashboard.

- **Dashboard-style document**: A broad selection of widgets and a wide variety of formatting options allow you to design a customized, interactive dashboard. Dashboard-style documents provide the freedom to design a dashboard pixel-by-pixel in multiple editing and previewing modes. The abundant design options deliver full control over position, formatting, and interactivity.

**dashboard-style document** A visually intuitive display of data that summarizes key business indicators for a quick status check. A special type of document, dashboard-style documents usually provide interactive features that let users change how they view the dashboard-style document’s data.

**data field** Dynamic text that is populated from a dataset with data that originated in the data warehouse (or an Intelligence Server cache). A data field is only a reference to the metric, attribute, consolidation, or custom group on a report. Data fields are contained in text field controls on a document.

See also:

- **Auto text code**
- **Text field**

**dataset** A dataset is a set of data that can be displayed on a document, dashboard-style document, or Visual Insight dashboard. A dataset can be a MicroStrategy report, a MicroStrategy...
Intelligent Cube, or data imported directly from an external data source. Reports include Freeform SQL reports, Query Builder reports, MDX cube reports, and reports that access Intelligent Cubes. Intelligent Cubes can be based on MicroStrategy data or imported data. The information in a dataset can include MicroStrategy objects such as attributes, custom groups, consolidations, and metrics.

**Datasets**

1. A pane in the Document Editor that shows all objects (grouped by datasets) that can be used in the document.

2. All objects that can be used in the document as supplied by the datasets. Dataset objects are attributes, consolidations, custom groups, and metrics.

**data warehouse**

1. A database, typically very large, containing the historical data of an enterprise. Used for decision support or business intelligence, it organizes data and allows coordinated updates and loads.

2. A copy of transaction data specifically structured for query, reporting, and analysis.

**derived metric**

A metric based on data already available from metrics on a document dataset. It is calculated on the Intelligence Server, not in the database. Use a derived metric to perform calculations on other metrics (column math), on data after it has been returned from the database.

See also:

- **Calculated expression**

**drill**

A link from one document to another document, report, or HTML document. Prompt answers for the destination can be included in the drill.

**document**

1. A container for objects representing data coming from one or more reports, as well as positioning and formatting information. A document is used to format data from multiple reports in a single display of presentation quality.
2. The MicroStrategy object that supports the functionality defined in (1).

**Grid/Graph** A control placed in a document that displays information in the same way a MicroStrategy report does.

**grouping** A way to create a hierarchical structure for a document.

**HTML container** A control that either displays real-time information from the web or displays formatted HTML.

**Layout area** The middle panel of the Document Editor in which you place data or other controls to determine the appearance of the document when it is viewed as a PDF.

**link** A connection from a document to another document or a report. A link lets an analyst execute another document or report (the target) from a document (the source), and to pass parameters to answer any prompts that are in the target.

**page-by** Interactively displaying groups on separate pages in PDF View. It allows the end user to dynamically select group elements as criteria for analysis. The PDF that results from this selection is called a page of the original document.

**panel** A way of grouping data in a document so that users can navigate subsets of data as if the subsets were pages in a smaller document. Each “page”, or layer of data, is a panel; a group of panels is called a panel stack.

**panel stack** The holder for a collection of panels, or layers of data, in a document. A user can navigate or flip through the panels in a panel stack; only one panel is displayed at a time.

**project** 1. The MicroStrategy object in which you define all of the schema and application objects, which together provide a flexible reporting environment. A project is the highest-level
intersection of a data warehouse, metadata repository, and user community, containing reports, filters, metrics, and functions.

2. An object containing the definition of a project, as defined in (1). The project object is specified when requesting the establishment of a session.

**Property List**  The list of settings used to specify the appearance or any other characteristic of a control on a document.

**selector**  A type of control in a document that allows a user to:
- Flip through the panels in a panel stack, to see different predefined layers of data, or “pages”, in the same document
- Display different attribute elements or metrics in a Grid/Graph

**summary metric**  A shortcut to a subtotal, or a subtotal metric allowing explicit aggregation in documents. A summary metric allows you to select the function to use to calculate the subtotal.

**text field**  A type of control in a document that displays text in the document. These different types of text content are:
- Static text, which does not change and serves as a label
- Dynamic text, which is populated by the document or dataset. There are two types of dynamic text:
  - Data field, which is populated from a dataset with data that originated in the data warehouse (or an Intelligence Server cache). A data field is only a reference to an object on a report.
  - Auto text code, which is populated by the document or dataset, consisting of their settings rather than data from the data warehouse
- A combination of any or all of the above types in one text field
See also:

- Data field
- Auto text code

**Visual Insight dashboard** A visually-striking, interactive display that takes a minimal amount of time to set up and use. You can add text, interactive data visualizations, data filtering, and multiple layers of organization to your dashboard, then take advantage of Visual Insight's formatting options to customize your display.

**Widget** A type of control that presents data in a visual and interactive way; an interactive Flash-only graph that dynamically updates when a new set of data is selected. Some types include Gauge, Heat Map, and Stacked Area widgets.
INDEX

A
animation 61
audience for manual xxvi
automatic submission for selectors 182
automatic target maintenance
panel stack and 74
target selection mode and 132
automatically applying selector changes 182
automatically maintaining targets for selectors 169
controlling targets 174
disabling 177
enabling 179

B
background of a selector's selected item 213
bar microchart 321
best practices
dashboard-style document design 41, 43
dataset 44
Flash dashboard-style document for printing 52
formatting 50
panel stack 46
quick switch for a Grid/Graph 49
selector 49
tooltip 49
Blank Document template 58
Bubble Grid widget 244
creating 246
example 244
formatting 387
using as a selector 443
bullet microchart 321

C
conditional formatting and selector totals 198
control defined on 13
types of 13, 19
creating a dashboard-style document 53
current panel of a panel stack 86
Cylinder widget 247
creating 248
example 33, 248
formatting 389
D

dashboard
  See dashboard-style document.
  See also document.
  Visual Insight dashboard 22
  dashboard-style document 1, defined on 1, 25
best practices 41, 43
creating 53
designing 41
example 26, 463
exporting to Flash 60
FAQs 507
formatting 61
interactive 28
opening 4
printing 8
tutorial 463
Data Cloud widget 249
  creating 250
  example 249
  formatting 390
  Grid/Graph and 251
  link in 251, 380
  using as a selector 443
data layering 68
dataset 11
  best practices 44
  Intelligent Cube 12
  multiple 12
dataset object 19
Date Selection widget 251
  creating as a selector 257
  example 253
  creating as a widget 254
  example 252
  example 251
  formatting 392

MicroStrategy Mobile 253
  selector vs. widget 253
  widget vs. selector 253
Design Mode 4
designing a dashboard-style document 38
Developer 237
disabling automatic maintenance of selector targets 177
display mode for MicroStrategy Web 3
default 61
selecting 61
document defined on 1
creating 11, 13
dataset 11
designing xxvi, 2
does not open 509
multi-layout 21
previewing for printing 10
printing 8
document section 20
document template 53
  creating 58
  displaying Object Templates folder 59
  exporting to another project 59
  importing from another project 59
  predefined 54
drilling and selector 121
drilling in an Interactive Bubble Graph widget
  using a custom group 297
  using subtotals 298

E

Editable Mode 3
  enabling 61
  quick switch for a Grid/Graph 36
  selector display 124
  widget display 237
enabling
  automatic maintenance of selector targets 179
  display modes for MicroStrategy Web 61
  transition animation for Flash Mode 62
example
  button bar 28, 29
  dashboard-style document 27, 38, 45, 70, 463
  filter panel 96
  Full Screen mode 63
  Grid/Graph
    background when used as a selector 224
    controlling another Grid/Graph 219
  key performance indicators dashboard-style document 39
  multiple dashboard-style documents in a single document 70
  panel stack. See also example - panel stack. 69
  selector. See also example - selector. 118, 135
  slider 30
  widget. See example - widget.
example - panel stack 69
  formatting 103
  layering Grid/Graphs 69
  panel selector arrows 79
  rounded corners 107
  title bar 78
example - selector
  attribute 118, 135
  automatic target maintenance
    disabling 178
    enabling 179
  dynamic text field 146
  element display and sort 201
  filtering 160
  filtering a metric 137, 138
  metric 143
  metric condition 137, 138
  panel stack 134
  sizing items 208
  slicing 159
  style 124
  title bar 202
  updated by another selector 185
example - widget
  Bubble Grid 244
  Cylinder 33, 248
  Data Cloud 249
  Date Selection 251
    created as a selector 253
    created as a widget 251
  Fish Eye Selector 261
    created as a selector 262
    created as a widget 261
    targeting a panel stack 263
    with images 397
  Funnel 274
  Gauge 276
  Graph Matrix 282
  Graph Matrix (deprecated) 278
    used as a selector 444
  Heat Map 284
  Image Layout 287
  Interactive Bubble Graph 36, 235, 296
    used as a selector 447
  Interactive Stacked Graph 301
    used as a selector 450
  link 380
  Media 314
  message behind 376
  Microcharts 320
  Network 332
Index

RSS Reader 335
Thermometer 33, 358
Time Series Slider 360
    used as a selector 454
Waterfall 363
Weighted List Viewer 366

exporting 4
    document as a template to another project 59
    formatting a panel stack for 112
Grid/Graph 7
template to another project 59
to Flash 60
    file format 60
exporting a dashboard-style document to PDF 8
exporting a document to PDF 8
Express Mode 3
    enabling 61
    filter panel 97
Information Window 90
Internet Explorer version requirements 3
panel selector 73
selector display 124
widget 373

F
filter panel 96
    automatically applying selector changes 100
    automatically update the target 100
    controlling how data updates 100
    example 96
inserting 98
    MicroStrategy Mobile 98
    using 97
filtering selector 158
example 160
initial display 120
viewed off-line 163
Fish Eye Selector 260
    creating as a selector 269
    creating as a widget 266
display in various views and modes 265
    example 261
    panel stack 263
    selector 262
    widget 261
    with images 397
    formatting 394
    images in 397
    selector vs. widget 265
    widget vs. selector 265
fixed size for selector items 208
Flash file 60
Flash Mode 3
    enabling 61, 510
    filter panel 97
graph not displaying in 510
graph styles supported in 511
image not displaying in 512
Information Window 90
selector display 126
    custom 216
    switching to 510
    transition animation 61
troubleshooting 509
    widget 235
    widget not displaying in 512
Flash widget 235
    formatting
        best practices 50
dashboard-style document 61
    Gauge widget 400
selector 205
  background 213
  item text 210
Weighted List Viewer widget 439
  widget. See also formatting a widget 386
formatting a widget 386
  Bubble Grid widget 387
  Cylinder widget 389
  Data Cloud widget 390
  Date Selection widget 392
  Fish Eye Selector 394
  Funnel widget 398
  Graph Matrix (deprecated) widget 402
  Heat Map widget 404
  Image Layout widget 407
  inherited from graph report 385
  Interactive Bubble Graph widget 408
  Interactive Stacked Graph widget 412
  Media widget 414
  Microcharts widget 416
  RSS Reader widget 428
  Thermometer widget 432
  Time Series Slider widget 433
  Waterfall widget 435
Full Screen mode 63
  setting a document to open in 64
Funnel widget 274
  creating 275
  example 274
  formatting 398

G
Gauge widget 276
  creating 276
  example 276
  formatting 400
Google Graph Visualization widget 242

Graph Matrix (deprecated) widget 278
  creating 280
  example 278
  formatting 402
  using as a selector 443
  example 444
Graph Matrix widget 281
  creating 283
  example 282
  graph not displaying in Flash Mode 510
  graph styles for a dashboard-style document 37
Grid/Graph 15
  controlling another Grid/Graph 220, 223
  converting to a widget 377
  formatting background of selected items 224
  selector and 135
  transition animation 61
  updating dataset results 226
  used as a selector 220, 223, 226

H
Heat Map widget 283
  creating 285
  example 284
  formatting 404
  link in 287, 380
  using as a selector 445
HTML container 16

I
image
  missing in Flash Mode 512
  missing in MicroStrategy Mobile 509
  missing in PDF View 509
missing when exported to PDF  509
Image Layout widget  287
creating  291
example  287
formatting  407
importing
  document as template from another project  59
template from another project  59
Information Window  90
  defining for a Grid/Graph or selector  95
defining for a text field or image  93
Express Mode  90
Flash Mode  90
iPad  90
panel stack  90
Interactive Bubble Graph widget  295
creating  299
data structure  295
Drilling  297
  using a custom group  297
  using subtotals  298
example  36, 235, 296
formatting  408
link in  300, 381
using as a selector  446
  example  447
  updating targets by hovering  461
Interactive dashboard-style document  28
Interactive Mode  3
  enabling  61
  quick switch for a Grid/Graph  36
  selector display  124
  widget  373
Interactive Stacked Graph widget  301
creating  302
example  301
formatting  412
using as a selector  449
  defining the selector  460
  example  450
  updating targets by hovering  461
L
  Layout area, controls in  13
  layouts of a document  21
  linking in a widget
    attribute  379
    creating  382
    Data Cloud  380
    example  380
    Heat Map  380
    Interactive Bubble Graph  381
    Microcharts  381
    prompt answer method  381
loading panels  87
M
  Media widget  314
    creating  316
    example  314
    formatting  414
    prerequisites  316
  metric condition selector  137
    qualification  138
    qualification types  139
    slider  137
  metric selector  143
  Microcharts widget  320
    bar microchart  321
    bullet microchart  321
    creating  323
    example  320
P

panel defined on 68
  adding to a panel stack 82
  copying 84
  current 86
  current panel 73
  deleting 87
  display order of 85
  exporting all or only current 114
  formatting 102
    background 110
  image updated by a selector 232
  loading 87
    current panel only 87
    on demand 87
  pre-loading 87
  renaming 84

panel stack defined on 68, 72
  automatic target maintenance and 74
  best practices 46
  clipped for export 112
  filter panel. See also filter panel. 96
  formatting 102
    border 106
    example 103
    export options 112
    rounded corners 107
    title bar 109

Information Window 90
  inserting 75, 77

panel selector arrows 79
  displaying 81
  hiding 81

panel. See also panel. 72
  adding to 82
  display order 85

selector and 73, 134

title bar. See panel stack title bar.

transition animation 61

P

Panel defined on 68
  adding to a panel stack 82
  copying 84
  current 86
  current panel 73
  deleting 87
  display order of 85
  exporting all or only current 114
  formatting 102
    background 110
  image updated by a selector 232
  loading 87
    current panel only 87
    on demand 87
  pre-loading 87
  renaming 84

Panel stack defined on 68, 72
  automatic target maintenance and 74
  best practices 46
  clipped for export 112
  filter panel. See also filter panel. 96
  formatting 102
    border 106
    example 103
    export options 112
    rounded corners 107
    title bar 109

Information Window 90
  inserting 75, 77

Panel selector arrows 79
  displaying 81
  hiding 81

Panel. See also panel. 72
  adding to 82
  display order 85

Selector and 73, 134

Title bar. See panel stack title bar.

Transition animation 61

© 2015 MicroStrategy, Inc.
<table>
<thead>
<tr>
<th>Panel Stack Title Bar</th>
<th>Displaying</th>
<th>Example</th>
<th>Height</th>
<th>Hiding</th>
<th>PDF Export, Selector Display in</th>
<th>PDF View (Developer)</th>
<th>Image Missing</th>
<th>Panel Selector in</th>
<th>Printing a Document</th>
<th>Prompt Answer Method</th>
<th>Proportional Selector Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>73, 77</td>
<td>80</td>
<td>78</td>
<td>82</td>
<td>80</td>
<td>217</td>
<td>10</td>
<td>509</td>
<td>73</td>
<td>8</td>
<td>381</td>
<td>208</td>
</tr>
</tbody>
</table>

**Q**

Quick Switch for a Grid/Graph | 36
--- | ---
Best Practices | 49

**R**

Really Simple Syndication (RSS). See RSS Reader widget.


RSS Reader Widget | 335
--- | ---
Creating | 336
Example | 335
Formatting | 428
MicroStrategy Mobile | 432
MicroStrategy Mobile | 336

**S**

SDK Widget | 242
--- | ---
Section of a Document | 20
Selector Defined On | 117
--- | ---
All Option | 184
Renaming | 184
 Automatically Applying Changes | 182
 Automatically Applying Selector Changes | 182

Automatically Updating When There Is No Data For The Current Selection | 187
Best Practices | 49
Cascading | 188, 221
Creating | 129
Current State. See Also Selector - Current State | 189
Date Selection Widget | 251
Disabling Autosubmission | 183
Drilling and | 121
Element Form | 
Displaying | 200
Sorting | 200
Filter Panel and | 96
Filtering Another Selector | 150
Filtering On Metric Values | 137
Filtering. See Filtering Selector.
Fish Eye | 260
Flash-Only Interactive | 251, 260
Formatting. See Selector Formatting.
Grid/Graph | 135
Initial Display | 120
Interactive Flash-Only | 251, 260
Metric | 143
Metric Condition | 137
Panel Stack And | 73, 134
PDF Export Display | 217
Selecting A Metric | 143
Selection Types | 166
Selector Filter | 150
Slicing. See Slicing Selector.
Style | 124
Target. See Also Selector Target | 128
Title Bar | 202
Totals | 197
Conditional Formatting And | 198
Updating An Image On A Panel | 232
Updating Another Selector | 187
widget as 442
selector - current state
defining 195
filtering selector and 191
multiple targets and 193
slicing selector and 190
selector formatting 205, 207
body vs. title bar 205
item 210, 213
title bar vs. body 205
selector item
formatting 210, 213
multiple 181
showing all simultaneously 183
disabling 184
size 208
fixed 208
proportional 208
selector target 128
automatic maintenance 169
widget and 243
cannot be changed 507
display (current state) 189
selection mode 132
setting interactively 132
slicing selector 159
example 159
initial display 120
viewed off-line 163
sparkline microchart 321
Store Layout widget 242
support. See technical support.

target selection mode 132
automatic target maintenance and 132
technical support xxxvii
template 53
creating a document template 58
displaying Object Templates folder 59
exporting to another project 59
importing from another project 59
predefined document template 54
text field 14
Thermometer widget 358
creating 359
example 33, 358
formatting 432
Time Series Slider widget 360
creating 361
time example 360
formatting 433
using as a selector 453
time example 454
updating targets by hovering 461
Timeline widget 242
title bar 35
panel stack 77
selector 202
totals for a selector 197
cannot be changed 197
conditional formatting and 198
Transaction Services 509
transition 61
transition animation 61
troubleshooting 507
Flah Mode 509
True Type font on UNIX 2
tutorial, dashboard-style document 463

T
Table widget 242
target of selector 128
cannot be changed 507
changed 508

U
UNIX, True Type font on 2
USA Map widget 242
V
viewing a document 3
viewing a document (PDF View) 10
Visual Insight dashboard 22

W
Waterfall widget 363
    creating 364
    displaying increments and decrements 364
    example 363
    formatting 435
    using as a selector 456
Weighted List Viewer widget 366
    creating 368
    example 366
    formatting 439
    using as a selector 456
widget defined on 235
    automatic target maintenance for a selector and 243
    creating, prerequisites for 243
    custom 242
    display. See also widget display. 369
    displaying a message behind 375
    example 376
    formatting. See also formatting a widget. 386
    Grid/Graph converted to 377
    linking. See also linking in a widget. 379
    MicroStrategy Developer views 237
    MicroStrategy Mobile display 237
    MicroStrategy Web modes 237
    mobile device 241
    not displaying in Flash Mode 512
    SDK 242
    selector and 216
    types. See also widget types. 238
    used as a selector 222
    using as a selector 442
        creating 457
        updating targets by hovering 461
    viewing data related to 442
    widget display
        defining 374
        Design Mode/View 372
        Editable Mode 372
        export 373
        Express Mode 373
        Flash Mode/View 371
        HTML View 372
        Interactive Mode 373
        MicroStrategy Mobile 373
        PDF View 372
        selecting display modes 375
    widget types 238
        Bubble Grid 244
        Cylinder 247
        Data Cloud 249
        Funnel 274
        Gauge 276
        Graph Matrix 281
        Graph Matrix (deprecated) 278
        Heat Map 283
        Image Layout 287
        Interactive Bubble Graph 295
        Interactive Stacked Graph 301
        Media 314
        Microcharts 320
        Network 332
        RSS Reader 335
SDK
  Google Graph Visualization  242
  Store Layout  242
  Table  242
  Timeline  242
  USA Map  242
Thermometer  358
Time Series Slider  360
Waterfall  363
Weighted List Viewer  366